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Bio-Rad techninė pagalba
Bio-Rad techninės pagalbos skyrius JAV dirba nuo pirmadienio iki penktadienio, 5:00–17:00, Ramiojo
vandenyno laiku.

Telefonas: 1-800-424-6723, 2 variantas

El. paštas: Support@bio-rad.com (tik JAV / Kanada)

Techninės pagalbos už JAV ir Kanados ribų kreipkitės į savo vietinį techninės pagalbos biurą arba
spustelėkite nuorodą svetainėje www.bio-rad.com.

Pranešimas
Jokios šio leidinio dalies negalima atkurti ar perduoti bet kokia forma ar bet kokiomis priemonėmis,
elektroniniu, mechaniniu, fotokopijavimo, įrašymo ar kitu būdu, arba laikyti informacijos saugojimo ar
paieškos sistemoje be rašytinio Bio-Rad leidimo.

Bio-Rad pasilieka teisę bet kuriuo metu keisti savo produktus ir paslaugas. Ši instrukcija gali būti
keičiama be išankstinio įspėjimo. Nors Bio-Rad pasirengusi užtikrinti tikslumą, ji neprisiima jokios
atsakomybės už klaidas ar netikslumus arba dėl bet kokios žalos, atsiradusios dėl šios informacijos
taikymo ar naudojimo.

BIO-RAD yra Bio-Rad Laboratories, Inc. prekių ženklas

BIO-RAD, HARD-SHELL ir MICROSEAL yra Bio-Rad Laboratories, Inc. prekių ženklai tam tikrose
jurisdikcijose.

SYBR yra „Thermo Fisher Scientific Inc.“ prekės ženklas. Bio-Rad Laboratories, Inc. turi licenciją
parduoti reagentus, kurių sudėtyje yra „SYBR Green I“, skirtus naudoti realiojo laiko PGR, tik tyrimų
tikslais.

„EvaGreen“ yra „Biotium, Inc.“ prekių ženklas. Bio-Rad Laboratories, Inc. turi „Biotium, Inc.“ licenciją
parduoti reagentus, kurių sudėtyje yra dažų „EvaGreen“, skirtus naudoti realiojo laiko PGR, tik tyrimų
tikslais.

Visi čia naudojami prekių ženklai yra atitinkamų jų savininkų nuosavybė.

© „Bio-Rad Laboratories, Inc.“, 2022. Visos teisės saugomos.

http://www.bio-rad.com/


Paskirtis

Paskirtis
Sistema „CFX96 Dx“ ir sistema „CFX96 Deep Well Dx“ su „CFX Manager Dx“ programine įranga skirta
fuorescencinei PGR atlikti siekiant aptikti ir kiekybiškai įvertinti nukleino rūgšties sekas. Sistemos ir
programinė įranga skirtos „in vitro“ diagnostikai naudoti kvalifikuotų laborantų. Sistema skirta naudoti
su trečiųjų šalių diagnostikos nukleino rūgščių testais, kurie buvo pagaminti ir paženklinti diagnostikos
tikslais.

Simbolių žodynas
Svarbu. Svarbūs pokyčiai paryškinti!

Gamintojas Partijos numeris

Sunaudoti iki „In vitro“ diagnostikai

Temperatūros riba Katalogo numeris

Žr. naudojimo instrukcijas Tyrimų skaičius

Skirta naudoti su Serijos numeris

Naudoti tik pagal receptą Sudėtyje yra latekso
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CE ženklas – Reglamentas (ES)
2017/746 IVDR

Vertimai
Produkto dokumentai elektroninėse laikmenose gali būti pateikiami papildomomis kalbomis.
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Atitiktis saugos ir teisės aktų reikalavimams
Jei norite, kad sistema „CFX96 Dx“ arba sistema „CFX96 Deep Well Dx“ su „CFX Manager Dx“ 
programine įranga, šiame dokumente vadinama Sistema CFX Dx, veiktų tinkamai, „Bio-Rad“ primygtinai
rekomenduoja laikytis šioje dalyje ir visoje instrukcijoje pateiktų saugos specifikacijų.

Svarbu. Sistemos „CFX96 Dx“ ir „CFX96 Deep Well Dx“ patvirtintos naudoti kaip „in vitro“ 
diagnostikos (IVD) medicinos prietaisai.

Saugos įspėjamieji ženklai
Ant prietaiso pritvirtinti įspėjamieji ženklai perspėja apie potencialius sužeidimo arba pakenkimo
šaltinius. 1 lentelė paaiškinti visi saugos įspėjamieji ženklai.

Piktograma Reikšmė

Įspėjimas apie žalos sveikatai ar įrangai pavojų
Jei CFX Dx sistema pradedama eksploatuoti neperskaičius šios instrukcijos, gali
kilti kūno sužalojimo pavojus. Tam, kad būtų užtikrintas saugus naudojimas,
nenaudokite šio prietaiso būdu, nenurodytu šioje instrukcijoje. Šį prietaisą turi
naudoti tik kvalifikuoti laboratorijos darbuotojai, išmokyti saugiai dirbti su elektros
įranga. Visada su visais sistemos komponentais elkitės atsargiai ir lieskite
švariomis, sausomis rankomis.

Įspėjimas apie darbą su biologinį pavojų keliančiomis medžiagomis
Jeigu dirbama su biologinį pavojų keliančiais mėginiais, laikykitės
rekomenduojamų atsargumo priemonių ir gairių bei visų laboratorijoje ir vietovėje
taikomų vietinių nurodymų.

Įspėjimas apie nudegimų pavojų
Termocikleris išskiria tiek šilumos, kad gali sukelti sunkių nudegimų. Jo
eksploatavimo metu visada dėvėkite apsauginius akinius arba kitą akių apsaugos
priemonę. Prieš atidarydami dangtį ir išimdami mėginius, visada palaukite, kol
mėginių blokas atvės iki priimtinos temperatūros. Tam, kad išvengtumėte
atsitiktinių odos nudegimų, visada laikykitės didžiausio saugaus atstumo.

1 lentelė. Saugos įspėjamųjų ženklų reikšmė
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Atitiktis saugos ir teisės aktų reikalavimams

Piktograma Reikšmė

Įspėjimas apie sprogimo pavojų
Mėginių blokai įprastos eksploatacijos metu gali įkaisti tiek, kad skysčiai užvirtų ir
sprogtų.

1 lentelė. Saugos įspėjamųjų ženklų reikšmė (tęsinys)

Saugaus naudojimo techniniai duomenys ir atitiktis
2 lentelė išvardytos „Bio-Rad“ CFX Dx tikralaikių PGR aptikimo sistemų saugaus naudojimo techninės
sąlygos. Su šiais instrumentais turi būti naudojami ekranuoti kabeliai, kad būtų užtikrintas A klasės
prietaisams FCC nustatytų ribinių verčių laikymasis.

Naudojimo aspektas Saugaus naudojimo sąlygos

Nominalioji įvesties galia 100–240 V kintamoji srovė, 50–60 Hz, maks. 850 W

Viršįtampio kategorija II

Saugikliai 10 A, 250 V, 5 x 20 mm, greitas smūgis (2 vnt.)

Aplinka Naudoti tik patalpoje

Eksploatavimo temperatūra 15–31 °C

Laikymo temperatūra –20–60 °C

Santykinė drėgmė Iki 80 % (nesikondensuoja)

Aukštis virš jūros lygio Iki 2 000 metrų virš jūros lygio

Taršos laipsnis 2

2 lentelė. Saugaus naudojimo sąlygos
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Pavojai

Atitiktis teisės aktų reikalavimams
„CFX Dx“ tikralaikė PGR aptikimo sistema buvo išbandyta ir nustatyta, kad ji atitinka visus taikytinus
šių saugos ir elektromagnetinio suderinamumo standartų reikalavimus:

n IEC 61010-1:2010 (3 leidimas), EN 61010-1:2010 (3 leidimas). Elektrinė matavimo, valdymo ir
laboratorinė įranga. 1 dalis. Bendrieji reikalavimai

n IEC 61010-2-010:2014, EN 61010-2-010:2014. Saugos reikalavimai, keliami elektrinei matavimo,
valdymo ir laboratorinei įrangai. 2-010 dalis. Ypatingieji reikalavimai, keliami laboratorinei
medžiagų kaitinimo įrangai

n IEC 61010-2-081:2015, EN 61010-2-081:2015. Saugos reikalavimai, keliami elektrinei matavimo,
valdymo ir laboratorinei įrangai. 2-081 dalis. Ypatingieji reikalavimai, keliami automatinei ir pusiau
automatinei laboratorijų įrangai, naudojamai analizės ir kitokiems tikslams (įskaitant 1 pakeitimą)

n IEC 61010-2-101:2015 (2 leidimas). Saugos reikalavimai, keliami elektrinei matavimo, valdymo ir
laboratorinei įrangai. Ypatingieji reikalavimai, keliami „in vitro“ diagnostikos medicinos įrangai

n IEC 61326-1:2012 (A klasė), EN 61326-1:2013 (A klasė). Elektrinė matavimo, valdymo ir
laboratorinė įranga. EMS reikalavimai. 1 dalis. Bendrieji reikalavimai

n IEC 61326-2-6:2012, EN 61326-2-6:2013 (A klasė). Elektrinė matavimo, valdymo ir laboratorinė
įranga. EMS reikalavimai. Ypatingieji reikalavimai, keliami „in vitro“ diagnostikos medicinos
įrangai

Svarbu. Ši įranga generuoja, naudoja ir gali spinduliuoti radijo dažnio energiją, be to, jeigu ji nėra
įrengta ir naudojama pagal instrukcijų dokumentus, gali trikdyti radijo ryšius. Eksploatuojant
sistemas gyvenamuosiuose rajonuose veikiausiai atsiras žalingųjų trukdžių; tokiu atveju
naudotojai turės pašalinti trukdžius savo sąskaita.

Pavojai
CFX Dx tikralaikė PGR aptikimo sistema skirta saugiai veikti, kai naudojama gamintojo numatytu
būdu. Jeigu CFX Dx tikralaikė PGR aptikimo sistema arba bet kuri jos susijusi sudedamoji dalis
naudojamos ne pagal gamintojo nurodytą paskirtį, gali prasčiau veikti arba visai neveikti instrumento
vidinės apsaugos sistemos. „Bio-Rad Laboratories, Inc.“ neatsako už bet kokį sužalojimą ar žalą,
sukeltą naudojant šią įrangą ne tam skirtu būdu, arba dėl instrumento pakeitimų, kurie buvo atlikti ne
„Bio-Rad“ ar įgaliotojo atstovo. „CFX Dx“ realiojo laiko PGR sistemos priežiūrą turėtų atlikti tik
kvalifikuoti „Bio-Rad“ darbuotojai.
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Atitiktis saugos ir teisės aktų reikalavimams

Biologiniai pavojai
CFX Dx tikralaikė PGR aptikimo sistema yra laboratorinis gaminys. Jeigu yra biologiškai pavojingų
mėginių, laikykitės toliau pateiktų rekomendacijų ir visų laboratorijoje ir vietovėje taikomų vietos
rekomendacijų.

Pastaba. Jokios biologiškai pavojingos medžiagos nėra išleidžiamos įprasto šio instrumento
naudojimo metu.

Bendrosios atsargumo priemonės

n Būtinai vilkėkite laboratorinį chalatą, mūvėkite laboratorines pirštines, naudokite apsauginius
akinius (uždarus arba su šoniniais skydeliais).

n Rankomis nelieskite burnos, nosies ir akių.

n Prieš dirbdami su galimai užkrečiamosiomis medžiagomis visiškai apsaugokite kūno vietas, kur
įsipjovėte arba nusibrozdinote.

n Baigę darbą su bet kokiomis galimai užkrečiamosiomis medžiagomis, prieš išeidami iš
laboratorijos kruopščiai nusiplaukite rankas vandeniu ir muilu.

n Prieš dirbdami prie laboratorinio stalo nusisekite laikrodį ir nusiimkite papuošalus.

n Visas galimai užkrečiamąsias medžiagas laikykite nedūžtančiose ir sandariose talpyklėse.

n Prieš išeidami iš laboratorijos, nusivilkite apsauginius drabužius.

n Pirštinėtomis rankomis nerašykite, neatsiliepkite į telefono skambučius, nejunginėkite šviesų ir
nelieskite jokių kitų daiktų, kuriuos galėtų paliesti kiti, pirštinių nemūvintys asmenys.

n Dažnai keiskite pirštines. Regimai užterštas pirštines tuojau pat nusimaukite.

n Medžiagas, kurių neįmanoma tinkamai nukenksminti, saugokite nuo galimai užkrečiamųjų
medžiagų poveikio.

n Baigę dirbti su biologiškai pavojingomis medžiagomis, tinkamu dezinfekantu (pavyzdžiui, 1:10
buitinių chlorkalkių tirpalu) nukenksminkite darbo vietą.

Konkrečios IVD apsaugos priemonės

n Visi pacientų mėginiai gali būti biologiškai pavojingi ir turi būti atitinkamai tvarkomi laikantis
bendrųjų atsargumo priemonių.

n Jokios biologiškai pavojingos medžiagos nėra išleidžiamos įprasto šio prietaiso naudojimo metu.
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Pavojai

Paviršiaus nukenksminimas

ĮSPĖJIMAS! Norėdami išvengti elektros smūgio, prieš atlikdami nukenksminimo
procedūras instrumentą visuomet išjunkite ir ištraukite kištuką iš elektros lizdo.

Šias sritis galima valyti bet kuriuo ligoninės laipsnio baktericidiniu, virucidiniu ar fungicidiniu
dezinfekantu:

n Išorinis dangtelis ir ašis

n Vidinis reakcijos bloko paviršius ir reakcijos bloko šulinėliai

n Valdymo skydas ir ekranas

Kaip paruošti ir naudoti dezinfekantą, žr. gaminio gamintojo pateiktose instrukcijose. Panaudoję
dezinfekantą reakcijos bloką ir reakcijos bloko šulinėlius visuomet skalaukite kelis kartus vandeniu. Po
skalavimo vandeniu reakcijos bloką ir reakcijos bloko šulinėlius visuomet kruopščiai išdžiovinkite.

Svarbu. Nenaudokite šveičiamųjų valiklių, korozinių ploviklių ar stiprių šarminių tirpalų. Šios
priemonės gali subraižyti paviršius ar pažeisti reakcijos bloką, todėl gali sumažėti temperatūros
kontrolės tikslumas.

Biologiškai pavojingų medžiagų šalinimas

Visas toliau išvardytas galimai užterštas medžiagas šalinkite laikydamiesi taikomų vietinių
laboratorijos, regioninių ir nacionalinių taisyklių:

n klinikinius mėginius,

n reagentus,

n panaudotus reakcijos indus ar kitas sąnaudines priemones, kurios gali būti užterštos

Cheminiai pavojai
„CFX Dx“ realiojo laiko PGR aptikimo sistemoje nėra potencialiai pavojingų cheminių medžiagų.

Sprogimo arba užsiliepsnojimo pavojai
„CFX Dx“ realiojo laiko PGR aptikimo sistema nekelia jokio neįprasto su užsiliepsnojimu ar sprogimu
susijusio pavojaus, jei naudojama laboratorijose tinkamu būdu pagal „Bio-Rad“ nurodymus.
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Atitiktis saugos ir teisės aktų reikalavimams

Elektros pavojai
„CFX Dx“ realiojo laiko PGR aptikimo sistema nekelia operatoriams jokio neįprasto su elektros srove
susijusio pavojaus, jei yra tinkamai įrengta bei eksploatuojama be fizinių modifikacijų ir yra prijungta
prie reikiamos specifikacijos maitinimo šaltinio.

Transportavimas
Prieš perkeliant ar transportuojant CFX Dx tikralaikę PGR aptikimo sistemą, jos optinės reakcijos
modulį arba termociklerio pagrindinį bloką, būtina atlikti nukenksminimo procedūras. Visada perkelkite
ar transportuokite CFX Dx tikralaikę PGR aptikimo sistemą ir optinės reakcijos modulius atskirose
pakuotėse, naudodami pakavimo medžiagas, su kuriomis jie buvo pristatyti ir kurios apsaugos
prietaisus nuo pažeidimų. Jei negalite rasti tinkamų pakuočių, kreipkitės į savo vietinį „Bio-Rad“ 
padalinį.

Baterija
Sistema CFX Dx termocikleris naudoja 3 V ličio metalo diskinę bateriją ir 4,8 V nikelio metalo hidrido
įkraunamąjį akumuliatoriaus bloką, kad palaikytų laiko nuostatas ir paleistų duomenis patyrus
kintamosios srovės galios nuostolių. Jei laikas ir (arba) duomenų paleistis nelieka nustatyti išjungus
įrenginį, gali būti, kad senka baterijos. Jei taip atsitinka, kreipkitės į „Bio-Rad“ techninės pagalbos.

Nebandykite keisti baterijų. Susisiekite su „Bio-Rad“ technine pagalba.

Šalinimas
CFX Dx tikralaikėje PGR aptikimo sistemoje yra elektrinių medžiagų; jos negali būti šalinamos kaip
nerūšiuotos atliekos ir turi būti surenkamos atskirai pagal Europos Sąjungos direktyvą 2012/19/ES dėl
elektros ir elektroninės įrangos atliekų (EEĮA direktyva). Prieš šalinimą, susisiekite su vietos „Bio-Rad“ 
atstovu, kuris pateiks jūsų šaliai skirtus nurodymus.

Garantija
CFX Dx tikralaikei PGR aptikimo sistemai ir su ja susijusiems priedams taikoma standartinė „Bio-Rad“ 
garantija. Dėl išsamesnės informacijos apie garantiją susisiekite su vietos „Bio-Rad“ atstovybe.
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1 skyrius. Įvadas
„Bio-Rad“ CFX Dx tikralaikės PCR (PGR) amplifikavimo sistemos, skirtos „in vitro“ diagnostikai (IVD),
turi naujausias technologijas, kurios leidžia atlikti PCR (PGR) kiekybinį įvertinimą, naudojant
standartinę kreivę, geno ekspresijos analizę, alelinę diskriminaciją ir galutinio taško analizę.

„CFX Dx“ sistemos sudarytos iš dviejų aparatūros modulių ir programinės įrangos:

n „CFX96 Dx“ arba „CFX96 Deep Well Dx“ optinės reakcijos modulio (ORM)

n „C1000 Dx“ termociklerio

n „CFX Manager Dx“ programinės įrangos

Naudodami su CFX Manager Dx programine įranga, galite atlikti šiuos veiksmus:

n Iš karto gauti rezultatus lange „Startup Wizard“ (paleisties vedlys)

n Įvesti ar redaguoti šulinėlių informaciją prieš paleidimą, jo metu arba po jo

n Aiškinti kompleksinius duomenis ir vykdyti genų ekspresijos tyrimą, naudodamiesi tokiais
įrankiais kaip „PrimePCR“ (PGR pradmenys) kontrolinių medžiagų analizė ir etaloninio geno
parinkiklio įrankis

n Paruošti išsamias PCR (PGR) realiuoju laiku duomenų ataskaitas
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1 skyrius. Įvadas

CFX Dx PGR aptikimo sistemos
3 lentelė išvardyti „Bio-Rad“ IVD PCR (IVD PGR) produktai, kurie siunčiami su Sistema CFX Dxׅ‏.

Pastaba. Sistema CFX Dx siunčiama su CFX Manager Dx programine įranga, „C1000 Dx“ 
termocikleriu ir (arba) „CFX96 Dx“ arba „CFX96 Deep Well Dx“ optinės reakcijos moduliu.

Katalogo Nr. Aprašymas

1845097-IVD „CFX96 Dx ORM“*

1844095-IVD „CFX96 Deep Well Dx ORM“

1841000-IVD „C1000 Dx“ termocikleris

12007917 CFX Manager Dx programinė įranga, v3.1

3 lentelė. CFX IVD PGR aptikimo sistemos

* Optinės reakcijos modulis

Sužinokite daugiau
Šiame dokumente paaiškinama, kaip saugiai įdiegti ir naudoti „CFX96 Dx“ ir „CFX96 Deep Well Dx“ 
tikralaikes PGR aptikimo sistemas, turinčias „CE-IVD“ ženklą. Šiame dokumente šios sistemos
vadinamos Sistema CFX Dx. Šiame dokumente taip pat aiškinama, kaip naudoti CFX Manager Dx
programinė įranga su Sistema CFX Dx.

Patarimas. Spustelėkite „Bio-Rad“ logotipą, esantį bet kurio CFX Manager Dx programinė įranga
lango viršutiniame dešiniajame kampe, kad atidarytumėte „Bio-Rad“ interneto svetainę. Šioje
interneto svetainėje pateikiamos nuorodos į technines pastabas, instrukcijas, produkto
informaciją ir techninę pagalbą. Šioje interneto svetainėje taip pat pateikiama daug techninių
išteklių apie įvairius metodus ir programas, susijusias su PCR (PGR), realiojo laiko PCR (PGR) ir
geno ekspresija.
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2 skyrius. „C1000 Dx“ termociklerio nustatymas
Šiame skyriuje aiškinama, kaip nustatyti Sistema CFX Dx „C1000 Dx“ termociklerį jūsų vietoje.

Patarimas. Prieš nustatydami termociklerį, susipažinkite su termocikleriu ir jo optinės reakcijos
moduliu, prievadais ir priedais.

Vietos reikalavimai
Šioje dalyje pateikiami patalpos, aplinkos ir galios reikalavimai, kurių reikia laikytis norint sėkmingai
sumontuoti ir naudoti Sistema CFX Dx termociklerį.

Pastaba. Sistema CFX Dx termociklerį montuokite ant lygaus, sauso paviršiaus su pakankamu
šalto oro srautu, kad jis tinkamai veiktų.

Techniniai ir erdvės reikalavimai

Elementas Specifikacija

Įvesties galia Daugiausia iki 850 W

Dažnis 50–60 Hz, vienfazis

USB lizdai 5 A, 1 B

Matmenys Plotis: 13 in; 33 cm

Ilgis: 18 in; 46 cm

Aukštis: 14 in; 36 cm

Svoris 47 lb; 21 kg

4 lentelė. Sistema CFX Dx termociklerio techniniai ir erdvės reikalavimai
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2 skyrius. „C1000 Dx“ termociklerio nustatymas

Aplinkos reikalavimai

Parametras Intervalas Drėgnio intervalas

Darbinės sąlygos 15–31 °C

59–87,8 °F

0–80 % santykinė drėgmė, be
kondensacijos

Laikymo sąlygos 15–31 °C

59–87,8 °F

0–80 % santykinė drėgmė, be
kondensacijos

5 lentelė. Sistema CFX Dx termociklerio aplinkos reikalavimai

Galios reikalavimai
Į Sistema CFX Dx termociklerį tiekiama galia turi būti stabili ir atitikti specifikacijas, kad būtų užtikrintas
tinkamas veikimas. Maitinimo kabelis, prijungtas prie maitinimo įvado, turi būti įvertintas 7 ar daugiau
amperų.

Elementas Specifikacija

Maitinimo įvesties įtampa 100–240 V kintamoji srovė, 50–60 Hz, vienfazis

Maksimalus energijos suvartojimas < 850 vatų

Maitinimo lizdų skaičius Mažiausiai 2 maitinimo lizdai:

n 1 lizdas termocikleriui

n 1 lizdas kompiuterio „CFX Manager Dx“ programinei įrangai

6 lentelė. Sistema CFX Dx galios reikalavimai
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Sistemos apžvalga

Sistemos apžvalga
Šios dalies paveikslėliuose parodytos pagrindinės „C1000 Dx“ termociklerio pagrindo dalys.

Vaizdas iš priekio

1. Optinės reakcijos modulis – apima optinę sistemą fluorescenciniams duomenims rinkti ir
termociklerio bloką. „CFX Dx“ tikralaikės PGR aptikimo sistemos suderinamos su „CFX96
Dx“ arba „CFX96 Deep Well Dx“ moduliu.

2. Būsenos LED – nurodo, kada naudojamas blokas.

3. Dangtelio mygtukas – atveria arba uždaro optinės reakcijos modulio dangtelį ir
užsandarina reakcijos kamerą.

4. „C1000 Dx“ termociklerio pagrindas – teikia sistemai maitinimą ir ryšį; į jį statomi „CFX96
Dx“ ir CFX96 giliųjų šulinėlių optinės reakcijos moduliai.

5. Priekinio skydelio ekranas ir mygtukai – leidžia valdyti sistemą autonominiu režimu.

Svarbu. Siekiant užtikrinti IVD genų tyrimo duomenų vientisumą, „CFX Manager Dx“ 
programinė įranga nesuderinama su termociklerio, veikiančio autonominiu režimu,
sukurtais duomenimis.

6. Šildomas vidinis dangtelis – palaiko dangtelio temperatūrą, kad būtų išvengta
kondensacijos ir garavimo.

7. Mėginio (reakcijos) blokas – į jį statomas reakcijos indas, įskaitant vamzdžius ir
mikroplokšteles.

LEGENDA
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2 skyrius. „C1000 Dx“ termociklerio nustatymas

Vaizdas iš galo

1. Eterneto prievadas – „C1000 Dx“ termociklerį prijungia prie jūsų tinklo.

2. USB B tipo prievadas – „C1000 Dx“ termociklerį prijungia prie kompiuterio, kuriame veikia
CFX Manager Dx programinė įranga.

3. USB A tipo prievadai – perduoda duomenis iš USB atmintinės ar į ją.

Svarbu. Siekiant užtikrinti IVD genų tyrimo duomenų vientisumą, CFX Manager Dx
programinė įranga nesuderinama su termociklerio, veikiančio autonominiu režimu,
sukurtais duomenimis.

4. Nuoseklusis bandymo prievadas – tik bandyti techninės priežiūros metu.

5. Aušinimo angos – aušina termociklerį.

Svarbu. Neuždenkite aušinimo angų. Kad veiktų optimaliai, užtikrinkite, kad oras
galėtų cirkuliuoti už termociklerio pagrindo.

6. Maitinimo įvestis – kintamosios srovės maitinimas; naudojamas pridedamas maitinimo
kabelis.

7. Maitinimo jungiklis – jungiklis termocikleriui įjungti ir išjungti.

8. Saugikliai – saugiklių techninius duomenis žr. Saugaus naudojimo techniniai duomenys ir
atitiktis, p. 14.

LEGENDA
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Optinės reakcijos moduliai

Optinės reakcijos moduliai
„C1000 Dx“ termocikleris suderinamas su šiais „Bio-Rad“ tikralaikės PGR optinės reakcijos moduliais.

n „CFX96 Dx“ optinės reakcijos modulis

n „CFX96 Deep Well Dx“ optinės reakcijos modulis

Pasirinktas „CFX Dx“ optinės reakcijos modulis ir termocikleris tiekiami atskirose dėžėse. CFX
Manager Dx programinė įranga siunčiama su optinės reakcijos moduliu.

Svarbu. Optinės reakcijos modulis kalibruojamas su pakuotėje pridėtu termociklerio pagrindu.
Todėl nenaudokite optinės reakcijos modulio su jokiu kitu termociklerio pagrindu ar termociklerio
pagrindo su jokiu kitu optinės reakcijos moduliu.

Abiejuose optinės reakcijos moduliuose yra visiškai reguliuojamas šildomas dangtelis, kuris patikimai
veikia su daugybe reakcijos indų. Kiekviename optiniame reakcijos modulyje yra aušinimo
ventiliatoriai, skirti greitai pašildyti ir atvėsinti.

Kiekvieną „CFX Dx“ optinės reakcijos modulį sudaro šie komponentai:

n Šildomas vidinis dangtelis – palaiko dangtelio temperatūrą, kad būtų išvengta kondensacijos ir
garavimo.

n Mėginio (reakcijos) blokas – į jį statomi reakcijos indai, įskaitant mėgintuvėlius ir
mikroplokšteles.

n Dangtelio mygtukas – naudojamas dangteliui atidaryti, uždaryti ir reakcijos vietai užsandarinti.

n Būsenos LED – kai įjungtas, rodo, kad blokas naudojamas.

Rekomenduojami mėginio tūriai
Naudojant „C1000 Dx“ termociklerį, didžiausias mėginio tūris nustatomas pagal naudojamo reakcijos
modulio tipą. 7 lentelė išvardyti rekomenduojami tūriai, kurie naudotini su kiekvienu reakcijos moduliu.

Šulinėlių skaičius Blokų skaičius
Rekomenduojami mėginio tūriai, µl

(Viršutinė riba)

96 šulinėliai 1 10–50

96 gilūs šulinėliai 1 10–125

7 lentelė. Reakcijos modulių dydžio ir tūrio apribojimai
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2 skyrius. „C1000 Dx“ termociklerio nustatymas

„C1000 Dx“ termociklerio įrengimas
„C1000 Dx“ termociklerio pagrindinis blokas siunčiamas atskiroje dėžėje nuo optinės reakcijos
modulio. Pakuotėje yra:

n „C1000 Dx“ termociklerio pagrindinis blokas

n Maitinimo laidas

n 1 USB kabelis

Kaip įrengti „C1000 Dx“ termociklerį:

1. Išpakuokite ir paruoškite „C1000 Dx“ termociklerio pagrindą.

2. Prie pagrindinio bloko prijunkite reakcijos modulį.

3. Išsukite transportavimo varžtą.

Šiame skyriuje išsamiai paaiškintos šios užduotys.

„C1000 Dx“ termociklerio išpakavimas ir įrengimas
Svarbu. Prieš pradėdami naudoti termociklerį, perskaitykite informaciją, pateiktą skirsniuose
Atitiktis saugos ir teisės aktų reikalavimams, p. 13 ir Saugos įspėjamieji ženklai, p. 13.

Patarimas. Įrengdami pasirūpinkite, kad šalia termociklerio būtų pakankamai vietos kompiuteriui,
kuriame veiks CFX Manager Dx programinė įranga.

Kaip išpakuoti ir pastatyti termociklerio pagrindą

1. Suraskite paketą, kuriame yra termociklerio pagrindas.

2. Nuimkite nuo pagrindo pakavimo medžiagas.

Patarimas. Pakuotę išsaugokite, kad galėtumėte panaudoti ateityje. Jeigu trūksta kokios
nors dalies arba gavote sugadintą dalį, kreipkitės į savo vietinį „Bio-Rad“ padalinį.

3. Termociklerio pagrindą padėkite ant lygaus, sauso paviršiaus, kad būtų užtikrintas pakankamas
aušinimas oro srautu, kad prietaisas galėtų tinkamai veikti.

4. Suraskite pristatytoje pakuotėje maitinimo laidą ir prijunkite vieną jo galą prie maitinimo prievado,
esančio galinėje termociklerio pusėje.

Svarbu. Šiuo momentu prietaiso dar nejunkite.

5. Prie pagrindo prijunkite IVD reakcijos modulį. Tęskite, kaip nurodyta skirsnyje Optinės reakcijos
modulio prijungimas, p. 27.

26 | Sistemos CFX96 Dx ir CFX96 Deep Well Dx



„C1000 Dx“ termociklerio įrengimas

Optinės reakcijos modulio prijungimas
„Bio-Rad“ siunčia „CFX96 Dx“ arba „CFX96 Deep Well“ optinės reakcijos modulį su „C1000 Dx“ 
termociklerio pagrindu (bet atskiroje dėžėje). Atsargiai išpakuokite optinės reakcijos modulį ir
patikrinkite, ar maitinimo ir USB kabeliai yra pristatytoje pakuotėje.

Svarbu. Kiekvienas optinės reakcijos modulis kalibruojamas su pakuotėje pridėtu termociklerio
pagrindu. Todėl nenaudokite optinės reakcijos modulio su jokiu kitu termociklerio pagrindu.

Norėdami, kad „C1000 Dx“ termociklerio pagrindas veiktų tinkamai, pastatykite jį ant plokščio, sauso
paviršiaus, kur pakanka vėsaus oro.

Kaip prijungti reakcijos modulį prie termociklerio pagrindo

1. Pastatykite „C1000 Dx“ termociklerį tinkamoje vietoje taip, kad užrakto skląstis būtų nukreiptas į
apačią.

2. Pakėlę optinės reakcijos modulį už įdubimų, esančių virš šoninių oro angų, įstatykite modulį į
„C1000 Dx“ reakcijos modulio skyrių, palikdami apie 2 cm erdvės priekyje. Įstatytas į skyrių,
optinis modulis turi uždengti „Bio-Rad“ logotipą, esantį skyriaus priekyje.

3. Traukite užrakto skląstį į viršų, kol jis susilygins su modulio skyriaus šonais. Po šio veiksmo
modulis pasistumia į priekį ir užsifiksuoja.
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2 skyrius. „C1000 Dx“ termociklerio nustatymas

4. Patikrinkite, ar modulis iki galo ir lygiai įstatytas į „C1000 Dx“ termociklerio pagrindą. Tarp modulio
ir pagrindo neturi būti papildomo tarpo.

5. Įkiškite vieną maitinimo laido galą į „C1000 Dx“ termociklerio pagrindo nugarinę dalį, o kitą – į
atitinkamą elektros lizdą, tada paspauskite maitinimo jungiklį, esantį „C1000 Dx“ termociklerio
galiniame skydelyje, kad paleistumėte sistemą.
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„C1000 Dx“ termociklerio įrengimas

Transportavimo varžto ištraukimas
Svarbu. „Bio-Rad“ optinės reakcijos moduliai gabenami su raudonu į vidaus dangtelį įsuktu
transportavimo varžtu, kuris stabiliai laiko optinės reakcijos modulį gabenant. Prieš naudodami
optinės reakcijos modulį, turite išsukti transportavimo varžtą.

Kaip išsukti transportavimo varžtą

1. „C1000 Dx“ termocikleris atpažįsta į optinės reakcijos modulį įsuktą transportavimo varžtą ir rodo
pranešimą, kuriame nurodoma išsukti varžtą.

2. Vadovaudamiesi nurodymais, išsukite transportavimo varžtą. Toliau pateiktoje schemoje
parodyta transportavimo varžto vieta.

Pastaba. Jei dėl kokios nors priežasties turite grąžinti reakcijos modulį, turite vėl įsukti
transportavimo varžtą. Laikykite varžtą saugioje ir prieinamoje vietoje.
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2 skyrius. „C1000 Dx“ termociklerio nustatymas

Mėginių plokštelių įdėjimas
Kad mėginiai būtų vienodai kaitinami ir aušinami, plokštelės turi būti visiškai susilietusios su reakcijos
bloku. Jei norite užtikrinti tinkamą sąlytį, atlikite šiuos veiksmus:

n Prieš imdami mėginius, patikrinkite, ar blokas švarus.

n Tvirtai įspauskite atskirus mėgintuvėlius, mėgintuvėlių juosteles ar mikroplokšteles į bloko
šulinėlius.

n Kai naudojate vieną ar kelis mėgintuvėlius, naudokite mėgintuvėlio rėmą (katalogo Nr. 1849000
arba 1849001) arba įstatykite bent po vieną tuščią mėgintuvėlį kiekviename bloko kampe, kad
dangtelis tolygiai prispaustų atskirus mėgintuvėlius.
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„C1000 Dx“ termociklerio įrengimas

Plokštelių įdėjimas į optinės reakcijos modulį

Svarbu. Kai paleista Sistema CFX Dx, visuomet subalansuokite mėgintuvėlių juosteles arba
uždėkite mėgintuvėlių dangtelius ant kampinių šulinėlių, kad būtų užtikrinta, jog šildomas dangtis
spaudžiasi per visą bloką.

Kaip plokšteles įdėti į optinės reakcijos modulį

1. Norėdami atverti motorizuotą dangtelį, atlikite vieną iš šių veiksmų:

n CFX Manager Dx programinės įrangos aptikto instrumento skyriuje spustelėkite „Open Lid“ 
(atidaryti dangtelį).

n Programinės įrangos kortelėje „Start Run“ (paleidimo pradžia) spustelėkite „Open Lid“ 
(atidaryti dangtelį).

n Instrumento priekyje paspauskite dangtelio mygtuką.

2. Į bloką įdėkite mikroplokštelę, atskirus mėgintuvėlius ar mėgintuvėlių juostas su užsandarintais
dangteliais.

Svarbu. Patikrinkite, ar mėgintuvėliai yra visiškai užsandarinti, kad iš jų niekas nepratekėtų.

Patarimas. Kad gautumėte optimalius rezultatus, įdėjimo mėginio tūriai yra 10–25 µl
Sistema CFX Dx.

3. Kad duomenų analizė būtų tiksli, patikrinkite, ar reakcijos orientavimas bloke yra tiksliai toks pat,
kaip šulinėlių turinio orientavimas plokštelės kortelėje CFX Manager Dx programinėje įrangoje.

Patarimas. Šulinėlių turinį galite koreguoti CFX Manager Dx programine įranga prieš
paleidimą, jo metu ar po to.

4. Norėdami uždaryti motorizuotą dangtelį, atlikite vieną iš šių veiksmų:

n Paspauskite instrumento dangtelio mygtuką.

n Programinės įrangos aptiktų instrumentų srityje spustelėkite „Close Lid“ (uždaryti dangtelį).

n Programinės įrangos kortelėje „Start Run“ (paleidimo pradžia) spustelėkite „Close Lid“ 
(uždaryti dangtelį).

Svarbu. Užtikrinkite, kad niekas nekliudytų uždaromam dangteliui. Nors yra apsauginis
mechanizmas, skirtas neleisti dangteliui užsidaryti, jeigu aptinkamas pasipriešinimas, nieko
nedėkite po dangteliu prieš jį uždarydami.
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2 skyrius. „C1000 Dx“ termociklerio nustatymas

PGR plastikiniai ir reagentų reikmenys

Norėdami rasti ir užsakyti rekomenduojamų plastiko reikmenų CFX Dx sistemai, eikite į „Bio-Rad“ 
svetainę. Šią tinklavietę galite pasiekti per „Help > PCR Plastic Consumables Web Site“ (žinynas >
PGR plastikinių reikmenų tinklapis) meniu elementą, esantį CFX Manager Dx programinėje įrangoje.
Be to, žr. plastiko rinkiklių ir reagentų rinkiklių išteklius, kurie padės lengviau rasti ir užsakyti plastikinių
reikmenų ir reagentų jūsų konkrečiai aparatinei įrangai ir PGR reikmėms.

Prijungtų instrumentų aptikimas
Diegimo metu CFX Manager Dx programinė įranga diegimo programa į kompiuterį, kuriame veikia
CFX Manager Dx programinė įranga, automatiškai įdiegia instrumentų tvarkykles. Jums paleidus
programinę įrangą, CFX Manager Dx aptinka prijungtus instrumentus.

Svarbu. Prieš įdiegdami ar atnaujindami programinę įrangą, nuo CFX Manager Dx kompiuterio
turite atjungti „C1000 Dx“ termociklerį. Programinės įrangos diegimo metu termociklerio išjungti
nereikia.

Kaip aptinkami prijungti instrumentai

1. Jei to dar nepadarėte, prijunkite USB tipo B tipo kabelio kvadratinį (įstatomąjį) galą prie USB tipo
B prievado, esančio pagrindo galinėje pusėje.

2. Kitą (jungties) galą prijunkite prie CFX Manager Dx kompiuterio USB prievado.

3. Jei termocikleris dar neveikia, paspauskite maitinimo jungiklį prietaiso galinėje pusėje, kad jį
įjungtumėte.

4. Paleiskite CFX Manager Dx programinė įranga.

Programinė įranga automatiškai aptinka prijungtą instrumentą ir parodo jo pavadinimą lango „Home“ 
(pagrindinis) srityje „Detected Instruments“ (aptikti instrumentai).

Pastaba. Jei instrumentas srityje „Detected Instruments“ (aptikti instrumentai) neparodomas,
patikrinkite, ar tinkamai prijungtas USB kabelis. Jei norite iš naujo įdiegti tvarkykles, „CFX
Manager Dx programinė įranga“ lange „Home“ (pagrindinis) pasirinkite „Tools > Reinstall
Instrument Drivers“ (įrankiai > iš naujo įdiegti instrumentų tvarkykles).
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„C1000 Dx“ termociklerio įrengimas

Reakcijos modulio
Svarbu. Prieš atjungdami reakcijos modulį, išjunkite „C1000 Dx“ termaciklerio maitinimą (žr.
skirsnį „C1000 Dx“ termociklerio išjungimas, p. 33). Reakcijos modulio viduje esančios aušinimo
plokštės iškart po protokolo vykdymo arba inkubavimo gali būti įkaitusios. Prieš atjungdami
reakcijos modelį patikrinkite, ar plokštės yra atvėsusios.

Optinės reakcijos modulio atjungimas nuo termociklerio pagrindo

1. Termociklerio pagrindo galinėje pusėje esantį skląstį pastumkite žemyn, kad atfiksuotumėte ir
galėtumėte nuimti optinės reakcijos modulį.

2. Paėmę už rankenų abiejose pusėse, atsargiai iškelkite optinės reakcijos modulį iš jo skyriaus.

3. Padėkite optinės reakcijos modulį ant švaraus, lygaus paviršiaus vietoje, kurioje jis būtų
apsaugotas nuo sutrenkimų, pažeidimų ir nenukristų.

„C1000 Dx“ termociklerio išjungimas
Kaip išjungti termociklerį

1. Po paleidimo paspauskite dangtelio atidarymo mygtuką CFX optinės reakcijos modulio priekyje ir
pereikite prie į bloką įdėtų mėginių.

2. Iš bloko išimkite mėginius, paspauskite dangtelio uždarymo mygtuką ir uždarykite dangtelį.

3. Paspauskite maitinimo jungiklį, esantį „C1000 Dx“ termociklerio galiniame skydelyje ir išjunkite
sistemą.
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2 skyrius. „C1000 Dx“ termociklerio nustatymas
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3 skyrius. CFX Manager Dx programinės įrangos
diegimas

Šiame skyriuje paaiškinama, kaip įdiegti „CFX Manager Dx“ programinę įrangą.

CFX Manager Dx programinė įranga reikia PGR duomenims iš sistemų „CFX96 Dx“ ir „CFX96 Deep
Well analizuoti tikruoju laiku. Šią programinę įrangą galite naudoti šioms sistemoms kontroliuoti
programinės įrangos valdomu režimu.

Daugiau informacijos apie „Sistema CFX Dx“ termociklerio ir optinio reakcijos modulio įdiegimą žr.
„C1000 Dx“ termociklerio nustatymas, p. 21.
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3 skyrius. CFX Manager Dx programinės įrangos diegimas

Sistemos reikalavimai
8 lentelė išvardyti minimalūs ir rekomenduojami sistemos reikalavimai, keliami kompiuteriui, kuriame
veikia CFX Manager Dx programinė įranga (vadinamas CFX Manager Dx kompiuteriu).

Sistema Mažiausiai Rekomenduojama

Operacinė
sistema

„Microsoft Windows 7 SP1
Pro“

Bet kuri iš šių:

n „Microsoft Windows 7 SP2 Pro“ (32 ir 64 bitų)

n „Microsoft Windows 10 Pro“ (tik 64 bitų)

n „Microsoft Windows 10 Enterprise“ (tik 64 bitų)

Svarbu. „Microsoft Windows 10 Pro“ ir „Enterprise“ turi būti išjungtas saugusis paleidimas.

Prievadai 2 USB 2.0 didelės spartos
prievadai

2 USB 2.0 didelės spartos prievadai

Standžiojo disko
talpa

128 GB 128 GB

Procesoriaus
greitis

2,4 GHz, dviejų branduolių 2,4 GHz, keturių branduolių

RAM 4 GB RAM 8 GB RAM

Ekrano skiriamoji
geba

1024 x 768 tikrų spalvų
režimu

1280 x 1024 tikrų spalvų režimu

PDF skaitytuvas „Adobe PDF Reader“ arba „Windows PDF
Reader“ iš vienos iš atpažįstamų „Microsoft
Office Suite“ programų:

n 2007

n 2010

n 2013

8 lentelė. Reikalavimai CFX Manager Dx programinė įranga kompiuteriui
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CFX Manager Dx programinės įrangos diegimas

CFX Manager Dx programinės įrangos diegimas
Svarbu. Prieš įdiegdami ar atnaujindami programinę įrangą, nuo CFX Manager Dx kompiuterio
turite atjungti visus prijungtus prietaisus. Programinės įrangos diegimo metu termociklerio išjungti
nereikia. Įsitikinkite, kad įrašėte visas analizes ir kad nevyksta jokie eksperimentai.

Pastaba. Jei diegiate CFX Manager Dx programinė įranga „Windows 10“ versijoje, prieš
pradėdami diegimo procedūrą patikrinkite, ar išjungta saugioji paleistis.

CFX Manager Dx programinė įranga įdiegimas

1. Jei reikia, atjunkite nuo kompiuterio visus prijungtus prietaisus.

Raskite ir atjunkite nuo CFX Manager Dx kompiuterio prietaiso USB kabelį. Prie prietaiso
prijungtas kabelio galas gali likti neatjungtas.

2. Prisijunkite prie CFX Manager Dx kompiuterio administratoriaus teisėmis.

3. CFX Manager Dx programinės įrangos CD įdėkite į kompiuterio CD įrenginį.

4. Programinės įrangos paleidimo puslapis turėtų pasirodyti automatiškai. Programinės įrangos
paleidimo puslapyje du kartus spustelėkite „Install Software“ (įdiegti programinę įrangą).

Pastaba. Jeigu paleidimo puslapis neparodomas automatiškai, eikite į CD įrenginį ir atverkite
aplanką „CFX_Manager“, tada dukart spustelėkite setup.exe, kad paleistumėte programinės
įrangos diegimo vedlį.

Patarimas. Diegimo vedlyje spustelėkite mygtuką „Documentation“ (dokumentai) ir raskite
ieškomų laidos pastabų, instrumento vadovų ir kitų dokumentų kopijų.

5. Vadovaukitės instrukcijomis ekrane ir atlikite diegimą. Baigus kompiuterio darbalaukyje
parodoma „CFX Manager“ programinės įrangos piktograma.

6. Diegimui pasibaigus, galite saugiai išimti CD.

Prijungtų instrumentų aptikimas
Diegimo metu CFX Manager Dx programinės įrangos diegimo programa į kompiuterį, kuriame veikia
CFX Manager Dx, automatiškai įdiegia instrumentų tvarkykles. Jums paleidus programinę įrangą,
CFX Manager Dx aptinka prijungtus instrumentus.

Kaip aptinkami prijungti instrumentai

1. Jei to dar nepadarėte, prijunkite USB tipo B tipo kabelio kvadratinį (įstatomąjį) galą prie USB tipo
B prievado, esančio prietaiso pagrindo galinėje pusėje.

2. Kitą (jungties) galą prijunkite prie CFX Manager Dx kompiuterio USB prievado.
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3 skyrius. CFX Manager Dx programinės įrangos diegimas

3. Jei instrumentas dar neveikia, paspauskite maitinimo jungiklį instrumento galinėje pusėje, kad jį
įjungtumėte.

4. Paleiskite CFX Manager Dx.

Programinė įranga automatiškai aptinka prijungtą instrumentą ir parodo jo pavadinimą srityje
„Detected Instruments“ (aptikti instrumentai) lange „Home“ (pagrindinis).

Pastaba. Jei instrumentas srityje „Detected Instruments“ (aptikti instrumentai) neparodomas,
patikrinkite, ar tinkamai prijungtas USB kabelis. Jei norite iš naujo įdiegti tvarkykles, „CFX
Manager Dx“ pagrindiniame lange pasirinkite „Tools > Reinstall Instrument Drivers“ (įrankiai > iš
naujo įdiegti instrumentų tvarkykles).

Programinės įrangos failai
9 lentelė išvardyti CFX Manager Dx programinė įranga failų tipai.

Failo tipas Plėtinys Išsami informacija

Protokolas .prcl Yra protokolo sąrankos išsami informacija, skirta paleisti
PCR (PGR).

Plokštelė .pltd Yra plokštelės sąrankos išsami informacija, skirta paleisti
PCR (PGR).

Duomenys .pcrd Yra eksperimento paleidimo ir PCR (PGR) analizės
rezultatai.

„PrimePCR“ (PGR
pradmenys) paleidimas

.csv Yra protokolai ir plokštelės schema „PrimePCR“ (PGR
pradmenys) plokštelei.

Geno tyrimas .mgxd Yra kelių PCR (PGR) paleidimų ir geno ekspresijos
analizių rezultatai.

LIMS .plrn Yra plokštelės sąrankos ir protokolo informacija, kurios
reikia atlikti su LIMS suderinamą paleidimą.

9 lentelė. CFX Manager Dx programinė įranga failų tipai
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Rekomenduojamos kibernetinio saugumo priemonės

Rekomenduojamos kibernetinio saugumo priemonės
„Bio-Rad“ rekomenduoja jums bendradarbiauti su jūsų IT skyriumi, kad būtų įdiegtos kibernetinio
saugumo priemonės, skirtos apsaugoti kompiuteriui, naudojamam su CFX96 Dx sistema. Pavyzdžiui:

n Įdiekite ir sukonfigūruokite tinkamas apsaugos nuo virusų ir užkardos programas.

Svarbu. Konfigūruokite virusų paieškos sistemą, kad būtų skenuojama ne darbo metu arba
kai prietaisas neveikia aktyviai. Jei virusų paieška pradedama „CFX Manager Dx“ vykdant
eksperimentą, gali būti atšauktas paleidimas ir prarasti duomenys.

n CFX Manager Dx programinė įranga neturi neaktyvumo skirtojo laiko funkcijos vartotojo sesijoms.
Įdiekite „Windows“ naudojimo ar tretiesiems vartotojams taikomas prieigos saugos priemones
(pvz., įdiekite reikiamą ekrano užsklandą su prisijungimo funkcija).

n Keičiamųjų laikmenų sauga:

o Savo USB įrenginyje naudokite slaptažodžius ir šifravimą, kad apsaugotumėte duomenis.

o Išjunkite visų keičiamųjų laikmenų įrenginių automatinio paleidimo ir automatinio atkūrimo
funkcijas.

o Įjunkite USB nuskaitymo funkciją kiekvieną kartą, kai prijungiama USB atmintinė.

n Naudokite atsarginių kopijų kūrimo paslaugų programą, kad būtų paprasčiau atkurti duomenis.
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4 skyrius. Darbo erdvė
„CFX Manager Dx“ programinė įranga suteikia sąsają plokštelėms nuskaityti, PGR protokolams
rengti, jiems vykdyti „CFX Dx“ prietaisais ir PGR analizių duomenims vertinti.

CFX Manager Dx programinėje įrangoje yra penkios pagrindinės darbo erdvės:

n Langas „Home“ (pagrindinis)

n Langas „Startup Wizard“ (paleisties vedlys)

n Langas „Protocol Editor“ (protokolų redaktorius)

n Langas „Plate Editor“ (plokštelės redaktorius)

n Langas „Data Analysis“ (duomenų analizė)

Šiame skyriuje parodyta ir trumpai aprašyta kiekviena darbo erdvė.

Naudojimo vadovas | 41



4 skyrius. Darbo erdvė

Langas „Home“ (pagrindinis)
CFX Manager Dx programinė įranga atveria langą „Home“ (pagrindinis) ir parodo „Startup Wizard“ 
(paleisties vedlys), kuriame galite nustatyti eksperimentą, atlikti arba pakartoti paleidimą ar
išanalizuoti esamą paleidimą. Lange „Home“ (pagrindinis) taip pat galite peržiūrėti programos ir
instrumentų žurnalą, sukurti ir valdyti vartotojus bei pasiekti daug naudingų įrankių. Daugiau
informacijos žr. 5 skyrius, Langas „Home“ (pagrindinis).
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Langas „Startup Wizard“ (paleisties vedlys)

Langas „Startup Wizard“ (paleisties vedlys)
Lange „Startup Wizard“ (sąrankos vedlys) galite greitai parengti ir paleisti vartotojo nustatytus
eksperimentus arba pasirinkti ir paleisti „PrimePCR“ (PGR pradmenys) eksperimentą. Šiame vedlyje
taip pat galite pakartoti paleidimą arba analizuoti paleidimo duomenis.
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4 skyrius. Darbo erdvė

Langas „Protocol Editor“ (protokolų redaktorius)
Lange „Protocol Editor“ (protokolų redaktorius) galite kurti, atidaryti, peržiūrėti ir redaguoti protokolą.
Taip pat galite keisti atvirojo protokolo dangtelio temperatūrą. Lango „Protocol Editor“ (protokolų
redaktorius) funkcijos išsamiai aprašytos 6 skyrius, Protokolų kūrimas.
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Langas „Plate Editor“ (plokštelės redaktorius)

Langas „Plate Editor“ (plokštelės redaktorius)
Lange „Plate Editor“ (plokštelės redaktorius) galite kurti, atidaryti, peržiūrėti ir redaguoti plokštelę.
Lango „Plate Editor“ (plokštelės redaktorius) funkcijos išsamiai aprašytos 7 skyrius, Plokštelių
paruošimas.
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4 skyrius. Darbo erdvė

Langas „Data Analysis“ (duomenų analizė)
Lange „Data Analysis“ (duomenų analizė) galite peržiūrėti ir palyginti paleidimų duomenis, atlikti
statistinę analizę, eksportuoti duomenis ir kurti publikuoti parengtas ataskaitas. Lango „Data Analysis“ 
(duomenų analizė) funkcijos išsamiai aprašytos čia: 9 skyrius, Duomenų analizės apžvalga. Taip pat
žr. 10 skyrius, Išsami duomenų analizės informacija.
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5 skyrius. Langas „Home“ (pagrindinis)
„CFX Manager Dx“ programinė įranga suteikia sąsają PCR (PGR) protokolams rengti, jiems vykdyti
„CFX Dx“ sistemose ir PCR (PGR) analizių duomenims vertinti.

Šiame skyriuje supažindinama su „CFX Manager Dx programinė įranga“ ir aprašomos funkcijos,
kurias galima pasiekti iš lango „Home“ (pagrindinis).
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Langas „Home“ (pagrindinis)
CFX Manager Dx atveria langą „Home“ (pagrindinis) ir parodo „Startup Wizard“ (paleisties vedlys),
kuriame galite nustatyti paleidimą, atlikti arba pakartoti paleidimą ar išanalizuoti esamą paleidimą.
Lange „Home“ (pagrindinis) taip pat galite peržiūrėti programos ir instrumentų žurnalą, sukurti ir valdyti
vartotojus bei pasiekti daug naudingų įrankių.

1. Programinės įrangos antraštės juostoje rodomas programinės įrangos pavadinimas ir
prisijungęs vartotojas.

2. Meniu juosta suteikia greitą prieigą prie „File“ (failas), „View“ (rodinys), „Users“ (vartotojai),
„Run“ (paleidimas), „Tools“ (įrankiai), „Window“ (langas) ir „Help“ (žinynas) meniu komandų.

3. Įrankių juostos komandos suteikia sparčią prieigą prie meniu parinkčių.

4. Kairėje srityje rodomi instrumentai, prijungti prie CFX Manager Dx kompiuterio ir pateikti
mygtukai, kuriais galite valdyti dangtelį ir peržiūrėti instrumentų būsenas.

5. Pagrindinėje srityje rodomas darbinis langas. Numatytasis darbinis langas ekrane „Home“ 
(pagrindinis) yra „Startup Wizard“ (paleisties vedlys).

6. Būsenos juostoje rodomi prijungtų instrumentų pavadinimai ir prisijungęs vartotojas.

LEGENDA
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Meniu „File“ (failas) komandos
„New“ (naujas) – atveriamas dialogo langas, kuriame galite: pasirinkti sukurti naują protokolą, plokštelę
ar geno tyrimą.

„Open“ (atverti) – atveriamas dialogo langas, kuriame galite pasirinkti naršyti ir atverti esamą
protokolą, plokštelę, duomenų failą, geno tyrimą, LIMS failą, arba „PrimePCR“ (PGR pradmenys)
paleidimo failą.

„Recent Data Files“ (naujausi duomenų failai) – rodomas šuo metu atvertų PCR (PGR) failų
sąrašas.

„Repeat a Run“ (pakartoti paleidimą) – įrašytų PCR (PGR) failų vietoje atveriamas „Windows
Explorer“, kur galite rasti kartojamą paleidimą.

„Exit“ (išeiti) – užveriama „CFX Manager Dx“.

Meniu „View“ (rodymas) komandos
„Application Log“ (programos žurnalas) – rodomi programinės įrangos naudojimo duomenys nuo
įdiegimo iki einamosios dienos.

„Run Reports“ (paleidimo ataskaitos) – rodomas paleidimo ataskaitų sąrašas.

„Startup Wizard“ (paleisties vedlys) – pagrindinėje srityje rodomas „Startup Wizard“ (paleisties
vedlys).

„Run Setup“ (paleidimo sąranka) – pagrindinėje srityje rodomas langas „Run Setup“ (paleidimo
sąranka).

„Instrument Summary“ (instrumento santrauka) – pagrindinėje srityje rodomas langas
„Instrument Summary“ (instrumento santrauka).

„Detected Instruments“ (aptikti instrumentai) – perjungiamas prijungtų prietaisų rodymas ir
nerodymas kairėje srityje. Pagal numatytąsias nuostatas programinė įranga rodo prijungtus prietaisus
kairėje srityje.

„Toolbar“ (įrankių juosta) – perjungiamas įrankių juostos rodymas ir nerodymas ekrano viršuje.
Pagal numatytąsias nuostatas programinė įranga rodo įrankių juostą.

„Status Bar“ (būsenos juosta) – perjungiamas būsenos juostos rodymas ir nerodymas ekrano
viršuje. Pagal numatytąsias nuostatas programinė įranga rodo būsenos juostą.

„Show“ (rodyti) – atveriamas dialogo langas, iš kurio galite:

n peržiūrėti arba blokuoti žurnalą „Status“ (būsena);

n atverti ir peržiūrėti CFX Manager Dx duomenų aplanką;
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5 skyrius. Langas „Home“ (pagrindinis)

n atverti ir peržiūrėti vartotojo duomenų aplanką;

n atverti ir peržiūrėti LIMS failų aplanką;

n atverti ir peržiūrėti „PrimePCR“ (PGR pradmenys) aplanką;

n peržiūrėti paleidimų istoriją;

n Peržiūrėti visų prijungtų instrumentų ypatybes.

Meniu „User“ (vartotojas) komandos
„Select User“ (pasirinkti vartotoją) – atveriamas ekranas „Login“ (prisijungimas), kuriame iš
išplečiamojo sąrašo „User Name“ (vartotojo vardas) galite pasirinkti vartotoją ir prisijungti prie
programos.

„Change Password“ (keisti slaptažodį) – atveriamas dialogo langas „Change Password“ (keisti
slaptažodį), kuriame vartotojai gali keisti savo CFX Manager Dx programinė įranga slaptažodį.

„Change Password“ (keisti slaptažodį) – atveriamas dialogo langas „User Preferences“ (vartotojo
nuostatos), kuriame vartotojai gali keisti tokias numatytąsias nuostatas:

n Pranešimo el. paštu siuntimas ir gavimas pasibaigus analizės ciklui

n Duomenų failo įrašymas

n Protokolų kūrimas lange „Protocol Editor“ (protokolų redaktorius) arba naudojantis „Protocol
AutoWriter“ (protokolų automatinio kūrimo priemonė)

n Plokštelių kūrimas

n Duomenų analizavimas

n Geno ekspresijos analizės vykdymas

n Duomenų kokybės nustatymas

n CFX Dx instrumentų duomenų eksportavimas

„User Administrationׅ‏“ (vartotojų administravimas) – atveriamas dialogo langas „User
Administration“ (vartotojų administravimas), kuriame administratoriai gali kurti vartotojus, keisti
vaidmens teises ir priskirti vartotojams vaidmenis.

„Bio-Rad Service Login“ („Bio-Rad“ techninės priežiūros personalo prisijungimas) – skirta tik
„Bio-Rad“ techninės priežiūros personalui. Nesirinkite šios komandos.
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Meniu „Run“ (paleidimas) komandos
„User-defined Run“ (vartotojo nustatytas paleidimas) – atveriamas langas „Run Setup“ 
(paleidimo sąranka), kuriame galite nustatyti vartotojo nustatytą protokolą ir plokštelę ir tada
pasirinktame instrumente paleisti PGR eksperimentą.

„PrimePCR Run“ (PGR pradmenų paleidimas) – atveriama kortelė „Start Run“ (paleidimo pradžia),
esančią lange „Run Setup“ (paleidimo sąranka), su numatytaisiais įkeltais „PrimePCR“ (PGR
pradmenys) protokolu ir plokštelės schema, remiantis pasirinktu instrumentu.

„End-Point Only Run“ (tik galinio taško paleidimas) – atveriama kortelė „Start Run“ (paleidimo
pradžia), esančią lange „Run Setup“ (paleidimo sąranka), su numatytuoju pabaigos taško protokolu ir
plokštelės schema, remiantis pasirinktu instrumentu.

„Qualification Run“ (kvalifikacinis paleidimas) – atveriama kortelė „Start Run“ (paleidimo pradžia),
esančią lange „Run Setup“ (paleidimo sąranka), su numatytuoju „Bio-Rad“ kvalifikaciniu protokolu ir
plokštelės schema, įkelta pasirinktam instrumentui.

Meniu „Tools“ (įrankiai) komandos
„Master Mix Calculator“ (pagrindinio mišinio skaičiuotuvas) – atveria „Master Mix Calculator“ 
(pagrindinio mišinio skaičiuotuvas), kuriame galite sukurti reakcijos mišinį ir atspausdinti skaičiavimus.

„Protocol AutoWriter“ (protokolų automatinio kūrimo priemonė) – atveria dialogo langą
„Protocol AutoWriter“ (protokolų automatinio kūrimo priemonė), kur galite lengvai sukurti naują
protokolą.

„Ta Calculator“ (Ta skaičiuotuvas) – atveria „Ta Calculator“ (Ta skaičiuotuvas), kur galite lengvai
apskaičiuoti pradmenų atkaitinimo temperatūrą.

„Dye Calibration Wizard“ (dažų kalibravimo vedlys) – atveria „Dye Calibration“ (dažų
kalibravimas) vedlį, kuriuo galite sukalibruoti instrumentą naujam fluoroforui.

„Reinstall Instrument Drivers“ (iš naujo įdiegti instrumento tvarkykles) – iš naujo įdiegia
tvarkykles, kurios valdo ryšį su „Bio-Rad“ tikralaikėmis PGR sistemomis.

„Zip Data and Log Files“ (suarchyvuoti duomenys ir žurnalo failai) – atveria dialogo langą,
kuriame galite pasirinkti failus, suglaudinti ir įrašyti suglaudintą failą saugoti ar išsiųsti el. paštu.

„Batch Analysis“ (paketo analizė) – atveria dialogo langą „Batch Analysis“ (paketo analizė),
kuriame galite nustatyti parametrus kelių duomenų failų analizei vienu metu.

„Options“ (parinktys) – atveriamas dialogo langas, kuriame galite

n konfigūruoti savo el. pašto serverio nuostatas;

n Konfigūruoti eksporto LIMS ir kitų duomenų failų nuostatas.

Naudojimo vadovas | 51



5 skyrius. Langas „Home“ (pagrindinis)

Meniu „Help“ (žinynas) komandos
Patarimas. Meniu „Help“ (žinynas) yra visų CFX Manager Dx programinė įrangalangų meniu
juostose.

„Open Operation Manual“ (atverti naudojimo vadovą) – atveriamas vadovas PDF formatu.

„Gene Expression Gateway Web Site“ (geno ekspresijos sietuvo svetainė) – atveriamas „Bio-
Rad“ Sistema CFX Dx pagrindinis puslapis.

„PCR Reagents Web Site“ (PGR reagentų svetainė) – atveriama „Bio-Rad“ PCR (PGR) reagentų
svetainė, kurioje galite užsisakyti PCR (PGR) reagentų, supermišinių, dažų ir rinkinių.

„PCR Plastic Consumables Web Site“ (PGR plastikinių reikmenų svetainė) – atveriama „Bio-
Rad“ PCR (PGR) plastikinių medžiagų ir reikmenų svetainė, kurioje galite užsisakyti PCR (PGR)
plokštelių, plokštelių tarpiklių, mėgintuvėlių ir dangtelių bei kitų plastikinių priedų.

„Software Web Site“ (programinės įrangos svetainė) – atveriama „Bio-Rad“ PCR (PGR) analizės
programinės įrangos svetainė, kurioje galite užsisakyti atnaujintas „Bio-Rad“ CFX Manager Dx
programinė įranga versijas.

„About“ (apie) – rodoma informacija apie „CFX Manager Dx“ autoriaus teises ir versiją.

Įrankių komandos

– atveriamas „Windows Explorer“, kuriame galite naršyti ir atverti duomenų failą arba geno
tyrimo failą.

– atveria „Master Mix Calculator“ (pagrindinio mišinio skaičiuotuvas).

– atveria langą „Run Setup“ (paleidimo sąranka).

– atveria langą „Run Setup“ (paleidimo sąranka) su numatytuoju „PrimePCR“ (PGR
pradmenys) protokolu ir plokštelės schema, įkelta pagal pasirinktą instrumentą.

– atveria „Startup Wizard“ (paleisties vedlys).
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„Startup Wizard“ (paleisties vedlys)
Kai paleidžiama CFX Manager Dx, darbinėje srityje rodomas „Startup Wizard“ (paleisties vedlys). Per
„Startup Wizard“ (paleisties vedlys) galima atlikti šiuos veiksmus:

n Iš aptiktų instrumentų pasirinkti instrumentą ir nustatyti vartotojo apibrėžtą arba „PrimePCR“ 
(PGR pradmenys) paleidimą

n Atverti ir pakartoti paleidimą

n Atverti paleidimo ar geno tyrimo failo rezultatams iš kelių geno ekspresijos paleidimų

Šios užduotys yra išsamiai paaiškintos tolesniuose skyriuose.

Būsenos juosta
Pagrindinio programinės įrangos lango apačioje esančios būsenos juostos kairėje pusėje rodoma
esama aptiktų instrumentų būsena. Kairėje būsenos juostos pusėje rodomas esamo vartotojo vardas
ir data bei laikas.
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Sritis „Detected Instruments“ (aptikti instrumentai)
Srityje „Detected Instruments“ (aptikti instrumentai) rodomas kiekvienas prie CFX Manager Dx kompiuterio
prijungtas instrumentas. Pagal numatytąsias nuostatas, kiekvienas instrumentas rodomas kaip piktograma,
kurios pavadinimas – instrumento serijos numeris.

Pavyzdžiui, toliau pateiktame paveikslėlyje rodomi keturi aptikti instrumentai:

n Du C1000 termocikleriai su „CFX96 Deep Well“ reakcijos moduliais (CFX96DW1 ir CFX96DW2)

n Du C1000 termocikleriai su CFX96 reakcijos moduliais (CFX96l01 ir CFX96l02)

Šioje srityje galima atlikti šiuos veiksmus:

n Peržiūrėti pasirinkto instrumento savybes ir sukalibruotus dažus

Daugiau informacijos apie instrumento savybes žr. Instrumento savybių peržiūra, p. 58

n Peržiūrėti prijungto instrumento būseną

n Atidaryti pasirinkto instrumento motorizuotą dangtelį

n Uždaryti pasirinkto instrumento motorizuotą dangtelį

n Peržiūrėti visų prijungtų instrumentų būseną
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Kaip peržiūrėti prijungto instrumento būseną

u Srityje „Detected Instruments“ (aptikti instrumentai) pasirinkite norimą instrumentą ir atlikite šiuos
veiksmus:

n Spustelėkite „View Status“ (rodyti būseną) dalyje „Selected Instrument“ (pasirinktas
instrumentas).

n Paspauskite dešinįjį pelės mygtuką ir atsidariusiame meniu pasirinkite „View Status“ (rodyti
būseną).

Pasirodo dialogo langas „Run Details“ (paleidimo išsami informacija), kuriame yra kortelė „Run
Status“ (paleidimo būsena). Pasirinkto instrumento būsena rodoma po paleisties būsenos sritimi,
pavyzdžiui:

Kaip atidaryti arba uždaryti instrumento dangtelį

u Srityje „Detected Instruments“ (aptikti instrumentai) pasirinkite norimą instrumentą ir atlikite šiuos
veiksmus:

n Spustelėkite „Open Lid“ (atidaryti dangtelį) arba „Close Lid“ (uždaryti dangtelį) dalyje
„Selected Instrument“ (pasirinktas instrumentas).

n Paspauskite dešinįjį pelės mygtuką ir atsidariusiame meniu pasirinkite atitinkamą veiksmą.

n Atidarykite dialogo langą „Run Details“ (paleidimo išsami informacija), pasirinkite kortelę
„Run Status“ (paleidimo būsena) ir spustelėkite „Open Lid“ (atidaryti dangtelį) arba „Close
Lid“ (uždaryti dangtelį).

Naudojimo vadovas | 55



5 skyrius. Langas „Home“ (pagrindinis)

Kaip peržiūrėti visų aptiktų instrumentų būseną

u Atlikite vieną iš toliau nurodytų veiksmų:

n Srities „Detected Instruments“ (aptikti instrumentai) dalyje „All Instruments“ (visi
instrumentai) spustelėkite „View Summary“ (rodyti santrauką).

n Meniu juostoje pasirinkite „View > Instrument Summary“ (rodinys > instrumento santrauka).

Pasirodo dialogo langas „Instrument Summary“ (instrumento santrauka):

Patarimas. Jei sistema aptinka tik vieną prijungtą instrumentą, dalis „All Instruments“ (visi
instrumentai) srityje „Detected Instruments“ (aptikti instrumentai) nėra rodoma. Norėdami
peržiūrėti atskiro dokumento prietaiso santrauką, pasirinkite „View > Instrument Summary“ 
(rodinys > instrumento santrauka).

56 | Sistemos CFX96 Dx ir CFX96 Deep Well Dx



Langas „Home“ (pagrindinis)

Įrankių juostos „Instrument Summary“ (instrumento santrauka) valdikliai

10 lentelė pateikiami įrankių juostoje „Instrument Summary“ (instrumento santrauka) esantys valdikliai
ir funkcijos.

Mygtukas Mygtuko pavadinimas Funkcija

Sukurti naują paleidimą Sukuria naują paleidimą pasirinktame
bloke atidarius langą „Run Setup“ 
(paleidimo sąranka).

Stabdyti Sustabdo esamą paleidimą
pasirinktuose blokuose.

Pristabdyti Laikinai pristabdo esamą paleidimą
pasirinktuose blokuose.

Tęsti Tęsia paleidimą pasirinktuose
blokuose.

Mirksėti bloko
indikatoriumi

Blyksteli indikatoriaus šviesos diodu,
esančiu ant pasirinktų blokų dangtelio.

Atidaryti dangtelį Atidaro pasirinkto bloko motorizuotą
dangtelį.

Uždaryti dangtelį Uždaro pasirinkto bloko motorizuotą
dangtelį.

Paslėpti pasirinktus blokus Paslepia pasirinktus blokus sąraše
„Instrument Summary“ (instrumento
santrauka)

Rodyti visus blokus Rodo pasirinktus blokus sąraše
„Instrument Summary“ (instrumento
santrauka)

Rodyti Leidžia pasirinkti, kuriuos blokus rodyti
sąraše. Pasirinkite vieną iš parinkčių,
kad būtų rodomi visi aptikti blokai, visi
neveikiantys blokai, visi blokai,
veikiantys su dabartiniu vartotoju, arba
visi veikiantys blokai

10 lentelė. Įrankių juostos „Instrument Summary“ (instrumento santrauka) valdikliai
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Instrumento savybių peržiūra
Srityje „Detected Instruments“ (aptikti instrumentai) galite peržiūrėti išsamią informaciją apie pasirinktą
instrumentą, įskaitant jo savybes, transportavimo varžto būseną ir jo kalibruotų dažų (fluoroforų)
sąrašą.

Kaip peržiūrėti instrumento savybes

u Srityje „Detected Instruments“ (aptikti instrumentai) galite dešiniuoju pelės mygtuku spustelėti
tikslinį instrumentą ir rodomame meniu pasirinkti kortelę „Properties“ (savybės).
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Kortelė „Properties“ (savybės)

Kortelėje „Properties“ (savybės) pateikiama techninė informacija apie pasirinktą instrumentą, įskaitant
modelį, jo komponentų serijos numerius ir programinės įrangos versiją. Numatytasis instrumento
pavadinimas (serijos numeris) rodomas daugelyje vietų, įskaitant sritį „Detected Instruments“ (aptikti
instrumentai) ir dialogo lango „Instrument Properties“ (instrumento savybės) antraštės juostą. Jūs
galite pervadinti prietaisą, kad būtų lengviau jį identifikuoti.

Kaip pervadinti instrumentą

u Kortelėje „Instrument Properties“ (instrumento savybės) įveskite pavadinimą lauke „Rename“ 
(pervadinti), esančiame kortelės „Properties“ (savybės) viršuje, ir spustelėkite „Rename“ 
(pervadinti).

Naujas pavadinimas rodomas eilutėje „Nickname“ (slapyvardis), esančioje kortelėje „Properties“ 
(savybės), taip pat antraštės juostoje „Instrument Properties“ (instrumento savybės) ir srityje
„Detected Instruments“ (aptikti instrumentai).

Kortelė „Shipping Screw“ (transportavimo varžtas)

Kortelėje „Shipping Screw“ (transportavimo varžtas) rodoma esama pasirinkto prietaiso
transportavimo varžto būsena (pašalintas arba sumontuotas). Kortelėje taip pat pateikti nurodymai,
kaip sumontuoti arba pašalinti raudoną transportavimo varžtą.

Patarimas. Jei programinė įranga aptinka transportavimo varžtą, dialogo lange „Instrument
Properties“ (instrumento savybės) automatiškai rodoma kortelė „Shipping Screw“ (transportavimo
varžtas). Vadovaudamiesi nurodymais, išsukite varžtą.

Pastaba. Prieš naudodami prietaisą, turite išsukti transportavimo varžtą. Daugiau informacijos žr.
skirsnyje Transportavimo varžto ištraukimas, p. 29.
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Kortelė „Calibrated Dyes“ (kalibruoti dažai)

Kortelėje „Calibrated Dyes“ (kalibruoti dažai) rodomi kalibruoti pasirinkto prietaiso fluoroforai ir
plokštelės.

Norėdami peržiūrėti išsamią informaciją apie kalibravimą, stulpelyje „Detail“ (išsami informacija)
spustelėkite mygtuką „Info“ (informacija).
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Prieš pradedant

Vartotojo nuostatų nustatymas
Patarimas. Šių užduočių neprivaloma atlikti, norint naudoti CFX Manager Dx programinė įranga.
Galite saugiai praleisti šią dalį arba atlikti šias užduotis bet kurį kitą kartą.

CFX Manager Dx galite pritaikyti darbo aplinką sau. Jei jūsų administratorius sukūrė programinės
įrangos vartotojus, kiekvienas iš jų gali pritaikyti darbo aplinką sau. Jei jūsų administratorius nesukūrė
vartotojų, nuostatų pakeitimai taikomi visiems vartotojams, prisijungusiems prie CFX Manager Dx.
(Informacijos apie tai, kaip kurti CFX Manager Dx vartotojus, žr. B priedas, CFX Manager Dx vartotojų
ir vaidmenų valdymas.)

Pavyzdžiui, meniu „Users > User Preferences“ (vartotojai > vartotojo nuostatos) galima atlikti šiuos
veiksmus:

n Nustatyti, kad būtų siunčiamas pranešimas el. paštu apie baigtą paleidimą

n Keisti šias numatytąsias nuostatas:

o Vietą, kurioje įrašomi failai

o Paleidimo sąrankos failus

o Failo pavadinimo prefiksą

n Nustatyti numatytuosius parametrus, kurie bus naudojami kuriant naują protokolą ir plokštelę

n Nustatyti numatytuosius duomenų analizės ir geno ekspresijos parametrus

n Tinkinti numatytuosius kokybės kontrolės parametrus

n Tinkinti duomenų eksporto duomenų parametrus

Meniu „Tools“ (įrankiai) galima atlikti šiuos veiksmus:

n Sukurti pagrindinį mišinį

n Sukalibruoti dažus konkrečiam prietaisui

Pastaba. Pagrindinis mišinys ir dažų kalibravimas prieinami visiems, kurie prisijungia prie CFX
Manager Dx.

Šioje dalyje išsamiai paaiškinta, kaip atlikti šias užduotis.
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El. pašto pranešimų nustatymas

CFX Manager Dx galite prijungti prie siunčiamo el. pašto serverio ir, baigus paleidimą, sąraše
esantiems vartotojams išsiųsti pranešimus el. paštu. Taip pat galite pasirinkti prisegti duomenų failą ir
analizės ataskaitą sąraše esantiems vartotojams. Norėdami užmegzti ryšį tarp CFX Manager Dx ir
jūsų SMPT serverio, žr. CFX Manager Dx prijungimas prie SMTP serverio, p. 63.

Pastaba. Vartotojo galimybė pereiti prie el. pašto nuostatų funkcijų priklauso nuo vartotojų grupės
ir administratoriaus suteiktų leidimų. Išsamios informacijos apie vartotojų ir jų vaidmenų valdymą
žr. Vartotojų valdymas, p. 275.

Kaip nustatyti el. pašto pranešimus

1. Pasirinkite „Users > User Preferences“ (vartotojai > vartotojo nuostatos) ir atverkite dialogo langą
„User Preferences“ (vartotojo nuostatos).

Parodomas dialogo langas „User Preferences“ (vartotojo nuostatos), kuriame rodoma kortelė
„Email“ (el. paštas).

Pastaba. Jus informuos, jeigu sistema nustatys, kad nenustatėte galiojančio SMTP serverio,
skirto CFX Manager Dx. Spustelėkite „Configure Outgoing Email“ (konfigūruoti siunčiamą el.
paštą), atverkite dialogo langą „Options“ (parinktys) ir sukonfigūruokite el. pašto SMTP
serverį. Daugiau informacijos žr. CFX Manager Dx prijungimas prie SMTP serverio, p. 63.

2. Tekstiniame langelyje „To“ (į) įrašykite kiekvieno asmens, kurį planuojate informuoti apie
paleidimo baigimą, el. pašto adresą. Visi gavėjai gaus el. laišką, kai bus baigtas paleidimas.

Pastaba. Turite kiekvieną el. pašto adresą įvesti atskiroje eilutėje. Paspauskite „Enter“ 
(įvesti) arba „Return“ (grįžti) po kiekvieno adreso.

3. (Neprivaloma) Tekstiniame langelyje „cc“ įrašykite kiekvieno gavėjo, kuriam planuojate išsiųsti
kiekvieno pranešimo kopiją, el. pašto adresą.
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4. (Neprivaloma) Pagal numatytuosius parametrus visi gavėjai gauna duomenų failo kopiją kaip
priedą. Panaikinkite žymės langelio žymėjimą, jeigu nenorite prisegti duomenų failo kopijos.

5. (Neprivaloma) Pasirinkite „Attach Analysis Report“ (prisegti analizės ataskaitą) ir prie el. laiško
prisekite analizės ataskaitos PDF failą.

6. Spustelėkite OK (gerai), įrašykite pakeitimus ir uždarykite dialogo langą „User Preferences“ 
(vartotojo nuostatos).

Kaip redaguoti gavėjo el. pašto adresą

u Jeigu reikia, pakeiskite el. pašto adresą ir spustelėkite OK (gerai).

Kaip pašalinti gavėjo el. pašto adresą

1. Pasirinkite gavėjo el. pašto adresą ir paspauskite klavišą „Delete“ (šalinti).

2. Spustelėkite OK (gerai), įrašykite pakeitimus ir uždarykite dialogo langą.

Svarbu. Dialogo lange „User Preferences“ (vartotojo nuostatos) spustelėjus „Restore Defaults“ 
(atkurti numatytuosius parametrus) visose kortelėse iš naujo nustatomos visos nuostatos į
pradines gamyklines nuostatas. Būkite atsargūs, kai spaudžiate šį mygtuką.

CFX Manager Dx prijungimas prie SMTP serverio

Svarbu. Kai kurie komercinio tinklo paslaugų teikėjai (pvz., „Yahoo!“ ir „Gmail“) padidino el. pašto
saugą. Jeigu naudojate šias paskyras, jų paskyros nuostatose turite įjungti nuostatą „Allow less
secure apps“ (leisti mažiau saugias programas) ir įjunkite CFX Manager Dx, kad siųstų el.
laiškus. Daugiau žr. savo interneto paslaugų teikėjo saugos informacijoje.

Turite nustatyti ryšį su CFX Manager Dx ir savo el. pašto serveriu prieš programinei įrangai išsiunčiant
pranešimą el. paštu.

CFX Manager Dx prijungimas prie el. pašto serverio

1. Atlikite vieną iš šių veiksmų:

n Pasirinkite „User > User Preferences“ (vartotojas > vartotojo nuostatos) ir spustelėkite
„Configure Outgoing Email“ (konfigūruoti siunčiamus el. laiškus) kortelėje „Email“ (el.
paštas).

n Pasirinkite „Tools > Options“ (įrankiai > parinktys).
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Atveriamas dialogo langas „Options“ (parinktys), kuriame rodoma kortelė „Email“ (el. paštas).

2. Pateikite šią savo kompanijos informaciją:

n „SMTP Server Name“ (SMTP serverio pavadinimas) – išsiunčiamų el. laiškų serverio jūsų
kompanijoje pavadinimas.

n „Port“ (prievadas) – jūsų SMTP serverio prievado numeris. Paprastai tai yra 25.

n „Use SSL“ (naudoti SSL) – saugiųjų jungčių lygmens (SSL) parinktis. Kai kuriems SMTP
serveriams reikia šios nuostatos. Jeigu jūsų kompanijai to nereikia, panaikinkite šio žymės
langelio žymėjimą.

n „Use Default “From” Address“ (naudoti numatytąjį išsiuntimo „iš“ adresą) – jūsų
kompanijos el. pašto serverio pavadinimas. Kai kuriems SMTP serveriams reikia, kad visi
išsiųsti el. laiškai turėtų adresą „iš“, tai yra iš tam tikro domeno, pavyzdžiui,
name@YourCompany.com. Jeigu tai galioja, panaikinkite šio žymės langelio žymėjimą ir
pateikite galiojantį el. pašto adresą.

n „Authentication Required“ (būtina autentifikuoti) – jeigu jūsų vietoje reikia autentifikuoti
paskyrą, patikrinkite, ar pažymėtas žymės langelis.

n „User Name“ (vartotojo vardas) – autentifikuotos paskyros pavadinimas. To reikalaujama
tik tada, jeigu pasirinkta „Authentication Required“ (būtina autentifikuoti).

n „Password“ (slaptažodis) – autentifikuotos paskyros slaptažodis. To reikalaujama tik tada,
jeigu pasirinkta „Authentication Required“ (būtina autentifikuoti).
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3. Norėdami patikrinti, ar teisingos SMTP serverio nuostatos, į tekstinį langelį „Test Email Address“ 
(patikrinti el. pašto adresą) įveskite galiojantį el. pašto adresą ir pasirinkite „Test Email“ (patikrinti
el. paštą).

Pastaba. Kai kurie SMTP serveriai neleidžia siųsti priedų, o kiti leidžia siųsti tik tam tikro
didžiausio dydžio priedus. Jeigu planuojate el. paštu siųsti duomenų failus ir (arba)
ataskaitas naudodami CFX Manager Dx, pasirinkite „Test Attachment“ (patikrinti priedą) ir
nustatykite 5 megabaitų (MB) ar didesnį „Attachment Size in MB“ (priedo dydis megabaitais).

4. Spustelėkite OK (gerai), įrašykite pakeitimus ir uždarykite dialogo langelį.

Numatytųjų failų nuostatų keitimas

Dialogo lango failo kortelėje „User Preference“ (vartotojo nuostatos) galite pakeisti šias nuostatas:

n Numatytąją vietą CFX Manager Dx failams įrašyti

n Numatytuosius failus paleidimo sąrankai

n Numatytuosius failo pavadinimo parametrus

Kaip pakeisti numatytųjų failų nuostatas

1. Pasirinkite „Users > User Preferences“ (vartotojai > vartotojo nuostatos) ir atverkite dialogo langą
„User Preferences“ (vartotojo nuostatos).

2. Dialogo lange „User Preferences“ (vartotojo nuostatos) pasirinkite kortelę „Files“ (failai).

Naudojimo vadovas | 65



5 skyrius. Langas „Home“ (pagrindinis)

3. Pereikite į skyrių „Default Folder for File Creation“ (numatytasis aplankas failui sukurti) ir
pasirinkite numatytąjį aplanką, kuriame norite įrašyti naujus failus. Kiekvienam failų tipui galite
pasirinkti skirtingą vietą:

n Protokolas

n Plokštelė

n Duomenų failas

n Geno tyrimas

4. Eikite į skyrių „File Selection for Run Setup“ (failo pasirinkimas paleidimo sąrankai) ir pasirinkite
rodomus tikslinio protokolo ir plokštelės failus, kai atversite langą „Experiment Setup“ 
(eksperimento sąranka).

5. Skyriuje „Data File“ (duomenų failas) nustatykite duomenų failų prievardį ir (arba) povardį.
Bet kuriai daliai išplečiamajame sąraše pasirinkite naują vertę. Prievardžio ir povardžio
tekstiniuose langeliuose taip pat galite pateikti tinkintą prievardį ir povardį.

CFX Manager Dx po pasirinkimo langeliais parodo failo pavadinimo apžvalgą.

6. Spustelėkite OK (gerai), įrašykite pakeitimus ir uždarykite dialogo langą.

Svarbu. Dialogo lange „User Preferences“ (vartotojo nuostatos) spustelėjus „Restore Defaults“ 
(atkurti numatytuosius parametrus) visose kortelėse iš naujo nustatomos visos nuostatos į
pradines gamyklines nuostatas. Būkite atsargūs, kai spustelite šį mygtuką.
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Numatytųjų protokolo parametrų nustatymas

Numatytųjų protokolų parametrų „Protocol Editor“ (protokolų redaktorius) ir „Protocol
AutoWriter“ (protokolų automatinio kūrimo priemonė) nustatymas

1. Pasirinkite „Users > User Preferences“ (vartotojai > vartotojo nuostatos) ir atverkite dialogo langą
„User Preferences“ (vartotojo nuostatos).

2. Dialogo lange „User Preferences“ (vartotojo nuostatos) pasirinkite kortelę „Protocol“ (protokolas).

3. Skyriuje „Protocol Editor“ (protokolų redaktorius) nurodykite šių nuostatų vertes, kurios rodomos
„Protocol Editor“ (protokolų redaktorius):

n „Sample volume“ (mėginio tūris) – kiekvieno mėginio šulinėlyje tūris (µl).

n „Lid Shutoff temperature“ (dangtelio išjungimo temperatūra) – temperatūra ºC, kuriai
esant paleidimo metu dangtelio kaitinimas išjungiamas.

4. Skyriuje „Protocol AutoWriter“ (protokolo automatinio kūrimo priemonė) nurodykite šių nuostatų
vertes, kurios rodomos „Protocol AutoWriter“ (protokolo automatinio kūrimo priemonė):

n „Annealing temperature“ (atkaitinimo temperatūra) – temperatūra º C eksperimentams,
kuriuose naudojama „iProof“ DNR polimerazė, „iTaq“ DNR polimerazė ar kitos polimerazės.

n „Amplicon length“ (amplikono ilgis) – amplikono ilgis bp.

5. Spustelėkite OK (gerai), įrašykite pakeitimus ir uždarykite dialogo langą.

Svarbu. Dialogo lange „User Preferences“ (vartotojo nuostatos) spustelėjus „Restore Defaults“ 
(atkurti numatytuosius parametrus) visose kortelėse iš naujo nustatomos visos nuostatos į
pradines gamyklines nuostatas. Būkite atsargūs, kai spaudžiate šį mygtuką.
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Numatytųjų plokštelės parametrų nustatymas

Kortelėje „Plate“ (plokštelė) padaryti pakeitimai galioja visiems programinės įrangos vartotojams. Per
plokštelės sąranką atlikti pakeitimai pritaikomi vartotojams tada, kai juos įrašote ir uždarote.

Dialogo lange „User Preferences“ (vartotojo nuostatos) galima atlikti šiuos veiksmus:

n Nustatyti numatytuosius plokštelės parametrus

n Pridėti naują tikslo ir mėginio pavadinimą į atitinkamą biblioteką

n Pašalinti tikslo ir mėginio pavadinimą iš atitinkamos bibliotekos

Kaip nustatyti numatytuosius plokštelės parametrus

1. Pasirinkite „Users > User Preferences“ (vartotojai > vartotojo nuostatos) ir atverkite dialogo langą
„User Preferences“ (vartotojo nuostatos).

2. Dialogo lange „User Preferences“ (vartotojo nuostatos) pasirinkite kortelę „Plate“ (plokštelė).
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3. Nurodykite šių naujo plokštelės failo nuostatų reikšmes. Šios reikšmės pateikiamos lange „Plate
Editor“ (plokštelės redaktorius):

n „Plate type“ (plokštelės rūšis)

n „Plate size“ (plokštelės dydis)

n „Units“ (vienetai) – pradinio šablono koncentracija šulinėliuose, kuriuose yra standartų.

CFX Manager Dx šie vienetai naudojami standartinei kreivei sukurti kortelėje „Data Analysis
Quantification“ (duomenų analizės kiekybinis įvertinimas).

n „Scientific notation“ (standartinė skaičiaus išraiška) – pasirinkus šią parinktį CFX
Manager Dx standartinėje skaičiaus išraiškoje rodomi koncentracijos vienetai.

n „Scan mode“ (nuskaitymo režimas) – kanalų, kuriuos norite nuskaityti per paleidimą,
skaičius ar tipas.

n „Fluorophores“ (fluoroforai) – numatytieji fluoroforai, pateikiami „Plate Editor“ (plokštelės
redaktorius) šulinėlių apkrovimo valdikliuose.

n „Libraries“ (bibliotekos) – tikslo ir mėginio pavadinimai, kuriuos paprastai naudojate
eksperimentuose:

o „Target names“ (tikslų pavadinimai) – tikslo genų ir sekų pavadinimai.

o „Sample names“ (mėginių pavadinimai) – eksperimentinių mėginių pavadinimai arba
identifikavimo charakteristika (pavyzdžiui, „Mouse1“ (1 pelė), „Mouse2“ (2 pelė),
„Mouse3“ (3 pelė)).

4. Spustelėkite OK (gerai), įrašykite pakeitimus ir uždarykite dialogo langą.

Kaip pridėti naują tikslo ar mėginio pavadinimą

u Atitinkamame bibliotekos laukelyje įrašykite tikslo ar mėginio pavadinimą ir spustelėkite OK
(gerai).

Kaip pašalinti tikslo ar mėginio pavadinimą

u Atitinkamame bibliotekos laukelyje pasirinkite pavadinimą ir spauskite mygtuką „Delete“ (šalinti) ir
OK (gerai).
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Svarbu. Pavadinimai, kuriuos pašalinate iš bibliotekos, pašalinami iš programinės įrangos ir
vartotojas daugiau negali jų naudoti. Norėdami atkurti numatytuosius CFX Manager Dx
pavadinimus, spauskite „Restore Defaults“ (atkurti numatytuosius parametrus). Dialogo lange
„User Preferences“ (vartotojo nuostatos) spustelėjus „Restore Defaults“ (atkurti numatytuosius
parametrus) visose kortelėse iš naujo nustatomos visos nuostatos į pradines gamyklines
nuostatas. Būkite atsargūs, kai šalinate numatytuosius „CFX Manager Dx“ pavadinimus ir
spaudžiate šį mygtuką.
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Numatytųjų duomenų analizės parametrų nustatymas

Kaip nustatyti numatytuosius duomenų analizės parametrus

1. Pasirinkite „Users > User Preferences“ (vartotojai > vartotojo nuostatos) ir atverkite dialogo langą
„User Preferences“ (vartotojo nuostatos).

2. Dialogo lange „User Preferences“ (vartotojo nuostatos) pasirinkite kortelę „Data Analysis“ 
(duomenų analizė).

3. Dalyje „Analysis Mode“ (analizės režimas) pasirinkite režimą, kuriame analizuoti duomenis
(„Fluorophore“ (fluoroforas) arba „Target“ (tikslas)).

4. Dalyje „PCR Quantitation“ (PGR kiekybinis įvertinimas) nustatykite šių parinkčių numatytuosius
parametrus:

n „Baseline Setting“ (pagrindinė nuostata) – pagrindinis analizės režimo metodas.

n „Cq Determination Mode“ (Cq nustatymo režimas) – režimas, kuriame Cq reikšmės
apskaičiuojamos kiekvienam fluorescencijos pėdsakui (regresijos arba atskiros ribinės
reikšmės).
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n „Threshold Calc. Mode“ (ribinės reikšmės skaičiavimo režimas) – galutinio taško tikslo
kiekis.

Numatytoji nuostata – „Auto“ (automatinė). Tai reiškia, kad programinė įranga automatiškai
apskaičiuoja galutinio taško tikslą. Norėdami nustatyti konkrečią ribinę reikšmę, išvalykite
žymės langelį „Auto“ (automatinė) ir įveskite galutinio taško kiekį, apskaičiuotą santykiniais
fluorescencijos vienetais (arba RFU). Didžiausia reikšmė – 65 000,00 RFU. Duomenų
failuose, skirtuose vėlesniems paleidimams, bus naudojama ši ribinės reikšmės nuostata.

n „Baseline Calc. Mode“ (pagrindinės reikšmės skaičiavimo režimas) – visų pėdsakų
pagrindinė reikšmė.

Numatytoji nuostata – „Auto“ (automatinė). Tai reiškia, kad programinė įranga automatiškai
apskaičiuoja visų pėdsakų pagrindinę reikšmę. Norėdami nustatyti konkrečią pagrindinę
reikšmę, išvalykite žymės langelį „Auto“ (automatinė) ir įveskite mažiausią ir didžiausią ciklo
intervalo reikšmes (nuo 1 iki 9999). Duomenų failuose, skirtuose vėlesniems paleidimams,
bus naudojamas šis ciklo intervalas.

n „Log View“ (žurnalo rodinys) – nustato, kaip programinėje įrangoje atvaizduojami
amplifikavimo duomenys:

o „On“ (įjungta) – amplifikavimo duomenys rodomi pusiau logaritminiame grafike.

o „Off“ (išjungta) – (numatytieji) amplifikavimo duomenys rodomi linijiniame grafike.

5. Dalyje „End Point“ (galutinis taškas) pasirinkite galutinių ciklų skaičių, kuris bus naudojamas
atliekant galutinio taško skaičiavimus:

n „PCR“ – galutinių ciklų skaičius, kuris bus naudojamas kiekybinio įvertinimo duomenims
(numatytasis – 5).

n „End Point Only run“ (paleidimas tik galutiniame taške) – galutinių ciklų skaičius, kuris
bus naudojamas galutinio taško duomenims (numatytasis – 2).

6. Dalyje „Melt Curve“ (lydymosi kreivė) pasirinkite, kokio tipo didžiausią temperatūrą norite aptikti
(teigiamą arba neigiamą).

7. Dalyje „Well Selector“ (šulinėlių parinkiklis) pasirinkite, kaip rodyti šulinėlių etiketes (pagal
mėginio rūšį, tikslo pavadinimą arba mėginio pavadinimą).

8. Spustelėkite OK (gerai), įrašykite pakeitimus ir uždarykite dialogo langą.

Svarbu. Dialogo lange „User Preferences“ (vartotojo nuostatos) spustelėjus „Restore Defaults“ 
(atkurti numatytuosius parametrus) visose kortelėse iš naujo nustatomos visos nuostatos į
pradines gamyklines nuostatas. Būkite atsargūs, kai spaudžiate šį mygtuką.
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Numatytųjų geno ekspresijos duomenų failo parametrų nustatymas

Kaip nustatyti numatytuosius naujo geno ekspresijos duomenų failo parametrus

1. Pasirinkite „Users > User Preferences“ (vartotojai > vartotojo nuostatos) ir atverkite dialogo langą
„User Preferences“ (vartotojo nuostatos).

2. Dialogo lange „User Preferences“ (vartotojo nuostatos) pasirinkite kortelę „Gene Expression“ 
(geno ekspresija).

3. Nurodykite šių nuostatų reikšmes:

n „Relative to“ (lyginant su) – grafike parodomi geno ekspresijos duomenys, lyginant su
kontroliniu mėginiu (prasidedančiu nuo 1) arba nuliu:

o „Zero“ (nulis) – programinė įranga ignoruoja kontrolinį mėginį. Ši nuostata yra
numatytoji, kai lange „Experiment Settings“ (eksperimento nuostatos) nėra priskirto
kontrolinio mėginio.

o „Control“ (kontrolė) – programinė įranga apskaičiuoja duomenis, lygindama su
kontroliniu mėginiu, priskirtu lange „Experiment Setup“ (eksperimento sąranka).

n „X-axis“ (x ašis) – mėginys arba tikslas grafiškai atvaizduojamas ant x ašies.

n „Y-axis“ (y ašis) – linijinė, log2 arba log10 skalė grafiškai atvaizduojama ant y ašies.
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n „Scaling“ (mastelio keitimas) – grafiko mastelio keitimo parinktis (numatytoji parinktis –
neapdorota):

o „Highest“ (didžiausias) – programinė įranga pakeičia grafiko dydį į didžiausią
duomenų tašką.

o „Lowest“ (mažiausias) – programinė įranga pakeičia grafiko dydį į mažiausią duomenų
tašką.

o „Unscaled“ (neapdorotas) – programinė įranga pateikia neapdorotus duomenis
grafike.

n „Mode“ (režimas) – analizės režimas: santykinis kiekis (∆Cq) arba normalizuota ekspresija
(∆∆Cq).

n „Error Bar“ (paklaidos juosta) – duomenų kintamumas, pateikiamas kaip standartinis
nuokrypis („Std. Dev.“) arba vidurkio standartinė paklaida („Std. Error Mean“).

n „Error Bar Multiplier“ (paklaidos juostos daugiklis) – standartinio nuokrypio daugiklis,
naudojamas grafiškai atvaizduoti paklaidų juostoms (numatytasis – 1).

Daugiklį galite padidinti iki 2 arba 3.

n „Sample Types to Exclude“ (neįtrauktini mėginių tipai) – mėginių tipai, kurių nenorite
įtraukti į analizę.

Galite pasirinkti vieną ar kelis mėginius, kurių nenorite įtraukti į analizę. Jei nenorite įtraukti
nė vieno mėginio tipo, išvalykite pasirinktų tipų žymės langelius.

4. Spustelėkite OK (gerai), įrašykite pakeitimus ir uždarykite dialogo langą.

Svarbu. Dialogo lange „User Preferences“ (vartotojo nuostatos) spustelėjus „Restore Defaults“ 
(atkurti numatytuosius parametrus) visose kortelėse iš naujo nustatomos visos nuostatos į
pradines gamyklines nuostatas. Būkite atsargūs, kai spaudžiate šį mygtuką.

Kaip tinkinti kokybės kontrolės taisykles

CFX Manager Dx galite nustatyti kokybės kontrolės taisykles, kurios galiotų duomenims lange „Data
Analysis“ (duomenų analizė). Programinė įranga patvirtina duomenis pagal jūsų nustatytas taisykles.

Pastaba. Pagal numatytąsias nuostatas visos kokybės kontrolės taisyklės yra įjungtos.

Patarimas. Galite lengvai pašalinti šulinėlius, kurie neatitinka KK parametro, iš analizės lango
„Data Analysis“ (duomenų analizė) KK modulyje.
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Kaip tinkinti kokybės kontrolės taisykles

1. Pasirinkite „Users > User Preferences“ (vartotojai > vartotojo nuostatos) ir atverkite dialogo langą
„User Preferences“ (vartotojo nuostatos).

2. Dialogo lange „User Preferences“ (vartotojo nuostatos) pasirinkite kortelę QC (KK).

kur:

n NTC – nėra šablono kontrolės

n NRT – nėra atvirkštinės transkriptazės kontrolės

n „Efficiency“ (veiksmingumas) – reakcijos veiksmingumas

n „Std Curve R^2“ (standartinės kreivės R^2) – R kvadratinė vertė standartinei kreivei

n „Replicate group Cq Std Dev“ (kopijų grupės apskaičiuotas standartinis nuokrypis) –
standartinis nuokrypis, apskaičiuotas kiekvienai kopijų grupei

3. Kiekvienai QC (KK) taisyklei atlikite vieną iš šių veiksmų:

n Norėdami naudoti numatytąją vertę, nieko nedarykite.

n Norėdami pakeisti jos vertę, spustelėkite tekstinį langelį „Value“ (vertė), įrašykite naują vertę
ir paspauskite klavišą „Enter“ (įvesti).

n Norėdami išjungti taisyklę, panaikinkite žymės langelio „Use“ (taikyti) žymėjimą.

4. Spustelėkite OK (gerai), įrašykite pakeitimus ir uždarykite dialogo langą.
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Svarbu. Dialogo lange „User Preferences“ (vartotojo nuostatos) spustelėjus „Restore Defaults“ 
(atkurti numatytuosius parametrus) visose kortelėse iš naujo nustatomos visos nuostatos į
pradines gamyklines nuostatas. Būkite atsargūs, kai spaudžiate šį mygtuką.

Duomenų eksporto parametrų tinkinimas

CFX Manager Dx duomenis galite eksportuoti šiais formatais:

n Tekstinis (.txt)

n CSV (.csv)

n „Excel 2007“ (.xlsx)

n „Excel 2003“ (.xls)

n XML (.xml)

n HTML (.html)

Galite nurodyti, kokio tipo duomenis eksportuoti, ir tinkinti eksportuojamų duomenų išvestį.
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Kaip tinkinti duomenų eksporto parametrus

1. Pasirinkite „Users > User Preferences“ (vartotojai > vartotojo nuostatos) ir atverkite dialogo langą
„User Preferences“ (vartotojo nuostatos).

2. Dialogo lange „User Preferences“ (vartotojo nuostatos) pasirinkite kortelę „Custom Export“ 
(pasirinktinis eksportas).

3. Išplečiamajame sąraše „Export Format“ (eksporto formatas) pasirinkite, kokiu formatu eksportuoti
duomenis.

4. Dalyje „Data to Export“ (eksportuojami duomenys) pasirinkite arba išvalykite eksportuojamų
duomenų tipo žymės langelius. Pasirinkti elementai pasirodo sąrašo lauke „Exported Columns“ 
(eksportuoti stulpeliai).

Pastaba. Pagal numatytąsias nuostatas paleisties informacija įtraukta į antraštę. Jei nenorite
įtraukti paleisties informacijos, išvalykite šį žymės langelį.

5. Galite keisti pasirinktų elementų išvesties rodymo tvarką.

Sąrašo lauke „Exported Columns“ (eksportuoti stulpeliai) pažymėkite elementą ir spausdami
sąrašo kairėje esančias rodykles perkelkite jį aukštyn arba žemyn.
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6. Pasirinktinai galite keisti pasirinktų elementų išvesties stulpelių pavadinimus:

a. Spustelėkite „Customize Column Names“ (tinkinti stulpelių pavadinimus).

Pasirodo dialogo langas „Column Name Customizer“ (stulpelių pavadinimų pasirinkimo
priemonė).

b. Kiekvieno numatytojo stulpelio pavadinimo, kurį norite pakeisti, naują pavadinimą įveskite
laukelyje „Custom Name“ (pasirinktinis pavadinimas).

c. Atlikite vieną iš toliau nurodytų veiksmų:

n Spustelėkite OK (gerai), įrašykite keitimus ir grįžkite į kortelę „Custom Export“ 
(pasirinktinis eksportas). Naujasis pavadinimas pasirodo skliausteliuose, šalia
numatytojo stulpelio pavadinimo sąrašo lauke „Exported Columns“ (eksportuoti
stulpeliai).

n Spustelėkite „Cancel“ (atšaukti), išvalykite pakeitimus ir grįžkite į kortelę „Custom
Export“ (pasirinktinis eksportas).

7. Spustelėkite OK (gerai), įrašykite pakeitimus ir uždarykite dialogo langą.

Svarbu. Dialogo lange „User Preferences“ (vartotojo nuostatos) spustelėjus „Restore Defaults“ 
(atkurti numatytuosius parametrus) visose kortelėse iš naujo nustatomos visos nuostatos į
pradines gamyklines nuostatas. Būkite atsargūs, kai spaudžiate šį mygtuką.
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Reakcijos pagrindinio mišinio sukūrimas
Naudodamiesi CFX Manager Dx „Master Mix Calculator“ (pagrindinio mišinio skaičiuotuvas) galite
lengvai apskaičiuoti kiekvieno komponento savo pagrindiniame mišinyje reikiamą tūrį. Galite
atspausdinti pagrindinio mišinio skaičiavimų lentelę savo numatytuoju spausdintuvu ir įrašyti kiekvieno
tikslo skaičiavimus ateičiai.

Reakcijos mišinio sukūrimas naudojant „Master Mix Calculator“ (pagrindinio mišinio
skaičiuotuvas)

1. Norėdami atverti „Master Mix Calculator“ (pagrindinio mišinio skaičiuotuvas), atlikite vieną iš šių
veiksmų:

n Pasirinkite „Tools > Master Mix Calculator“ (įrankiai > pagrindinio mišinio skaičiuotuvas).

n Įrankių juostoje spustelėkite „Master Mix Calculator“ (pagrindinio mišinio skaičiuotuvas).

Parodomas „Master Mix Calculator“ (pagrindinio mišinio skaičiuotuvas).
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2. Skyriuje „Reaction“ (reakcija) pasirinkite aptikimo metodą:

n „SYBR® Green“ / „EvaGreen“

n „Probes“ (zondai)

3. Norėdami sukurti naują tikslą, tikslo skyriuje spustelėkite„Create New“ (sukurti naują). Tikslo
išplečiamajame sąraše parodomas naujo tikslo pavadinimas.

4. (Neprivaloma) Norėdami pakeisti numatytąjį tikslo pavadinimą:

a. Išplečiamajame tikslų sąraše paryškinkite tikslo pavadinimą.

b. Langelyje „Target“ (tikslas) įrašykite naują tikslo pavadinimą.

c. Paspauskite klavišą „Enter“ (įvesti).

5. Koreguokite tiesioginių ir atvirkštinių pradmenų ir visų zondų pradžios ir pabaigos koncentracijas.

6. Skyriuje „Master Mix Setup“ (pagrindinio mišinio sąranka) pakoreguokite vertes:

n Paleidžiamų reakcijų skaičių

n Reakcijos tūrį šulinėliui

n Šablono tūrį šulinėliui

n Supermišinio koncentraciją šulinėliui

n Perteklinės reakcijos tūrį šulinėliui

7. (Neprivaloma) Atlikite 2–6 veiksmus su tiek tikslų, kiek reikia.

8. Skyriuje „Choose Target to Calculate“ (pasirinkite skaičiuotiną tikslą) pasirinkite skaičiuotiną
tikslą.

Patarimas. Vienu metu galite apskaičiuoti tik vieną, kelis arba visus tikslus.

Kiekvieno pasirinkto tikslo reikiamų komponentų apskaičiuoti tūriai rodomi pagrindinio mišinio
lentelėje.

9. Spustelėkite „Set as Default“ (nustatyti kaip numatytąjį) ir skyriuose „Target“ (tikslas) ir „Master
Mix Setup“ (pagrindinio mišinio sąranka) nustatykite įvedamus kiekius kaip naujus
numatytuosius.

10. Spustelėkite OK (gerai) ir įrašykite dialogo lango „Master Mix Calculator“ (pagrindinio mišinio
skaičiuotuvas) turinį.
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Pagrindinio mišinio skaičiavimų lentelės spausdinimas

u Norėdami atspausdinti pagrindinio mišinio skaičiavimų lentelę, spustelėkite „Print“ (spausdinti).

Skaičiavimų lentelė atspausdinama jūsų numatytajame spausdintuve.

Pagrindinio mišinio skaičiavimų lentelės įrašymas PDF formatu

u Savo numatytąjį spausdintuvą pakeiskite į PDF tvarkyklę ir „Master Mix Calculator“ (pagrindinio
mišinio skaičiuotuvas) spustelėkite „Print“ (spausdinti).

Tikslų naikinimas

u Išplečiamajame tikslų sąraše pasirinkite tikslą ir spustelėkite „Remove“ (pašalinti).

Svarbu. Tikslą šalinant iš tikslų sąrašo, jis taip pat pašalinamas iš visų pagrindinių mišinių
skaičiavimų, kuriuose buvo naudojamas. Būkite atsargūs, kai šalinate tikslą.
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Naujų dažų kalibravimas
Sistemos „CFX96 Dx“ yra gamykloje sukalibruotos dažniausiai naudojamiems fluoroforams baltų ir
skaidrių šulinėlių plokštelėse. 11 lentelė išvardyti fluoroforai ir kanalai, kuriems sukalibruotas kiekvienas
instrumentas.

Pastaba. Sistemos „CFX96 taip pat apima kanalą, skirtą FRET chemijai. Šio kanalo nereikia
kalibruoti konkrečiam dažui.

Fluoroforai Kanalas Sužadinimas, nm Aptikimas, nm

FAM, „SYBR® Green I“ 1 450–490 515–530

VIC, HEX, „CAL Fluor Gold 540“,
„Cal Fluor Orange 560“

2 515–535 560–580

ROX, „Texas Red“, „CAL Fluor Red
610“, TEX 615

3 560–590 610–650

CY5, „Quasar 670“ 4 620–650 675–690

„Quasar 705“, „Cy5.5“ 5 672–684 705–730

11 lentelė. Gamykloje kalibruoti fluoroforai ir kanalai

Naujų dažų kalibravimas CFX sistemoms

1. Lango „Home“ (pagrindinis) srityje „Detected Instruments“ (aptikti instrumentai) pasirinkite tikslinį
instrumentą.

2. Pasirinkite „Tools > Calibration Wizard“ (įrankiai > kalibravimo vedlys) ir atverkite vedlį „Dye
Calibration“ (dažų kalibravimas).
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Fluoroforas, jau kalibruotas tiksliniam instrumentui, rodomas lentelėje „Calibrated Fluorophores“ 
(kalibruoti fluoroforai).

3. Skyriuje „Calibrate New or Existing Fluorophores“ (kalibruoti naujus ir esamus fluoroforus) iš
išplečiamojo sąrašo pasirinkite kalibruojamą fluoroforą.

Jeigu fluoroforo pavadinimas į sąrašą neįtrauktas, jo pavadinimą įrašykite į tekstinį langelį ir
įtraukite jį į sąrašą.

4. Pasirinkite fluoroforo plokštelės tipą.

Jeigu fluoroforo tipas į sąrašą neįtrauktas, pavadinimą įrašykite į tekstinį langelį ir įtraukite jį į
sąrašą.

5. Pasirinkite fluoroforo kanalą.

6. Pasirinkite fluoroforo plokštelės stulpelį.

7. (Neprivaloma) Įrašykite su fluoroforu siejamą spalvą.

8. Spustelėkite „Add to Plate“ (pridėti plokštelėje) ir pridėkite fluoroforą.

9. (Neprivaloma) Pakartokite 3–8 veiksmus ir pridėkite kiekvieną fluoroforą, kurį planuojate
kalibruoti plokštelei.

10. Kai pridedate fluoroforus, spustelėkite „View Plate“ (peržiūrėti prokštelę) ir atverkite langą „Pure
Dye Plate Display“ (grynų dažų plokštelės rodmuo).

Šiuo langu naudokitės kaip rekomendacija dažams įdėti į plokštelę.

11. Paruoškite 96 šulinėlių plokštelę dažams kalibruoti:

a. Pagal „Pure Dye Plate Display“ (grynų dažų plokštelės rodmuo) rodomą schemą į kiekvieną
šulinėlį pipetuokite dažų tirpalą.

b. Kiekvienam fluoroforui keturis šulinėlius pripildykite 50 µl (96 šulinėlių plokštelė) 300 nM dažo
tirpalo. Atkreipkite dėmesį, kad mažiausiai pusėje plokštelių yra tuščių šulinėlių.

c. Plokštelę užsandarinkite sandarinimo metodu, kurį naudosite savo eksperimente.

12. Kalibravimo plokštelę padėkite į bloką ir uždarykite dangtelį.

13. Vedlyje „Dye Calibration“ (dažų kalibravimas) spustelėkite „Calibrate“ (kalibruoti), OK (gerai) ir
patvirtinkite, kad plokštelė yra bloke.

14. Kai CFX Manager Dx programinė įranga baigia kalibravimą, parodomas dialogo langas.
Spustelėkite „Yes“ (taip), baikite kalibravimą ir atverkite „Dye Calibration Viewer“ (dažų
kalibravimo žiūryklė).

15. Spustelėkite OK (gerai) ir užverkite langą.

Naudojimo vadovas | 83



5 skyrius. Langas „Home“ (pagrindinis)

84 | Sistemos CFX96 Dx ir CFX96 Deep Well Dx



6 skyrius. Protokolų kūrimas
Protokolas yra veiksmų, kurie atliekami nurodyta seka, rinkinys. „CFX Manager Dx“ programinėje
įrangoje visi šie veiksmai susiję su instrumento parinktimis. Pavyzdžiui, veiksmu instrumentui
nurodoma kontroliuoti bloko ir dangtelio temperatūrą, taikyti temperatūros skirtumą bloke, nuskaityti
plokštelę arba atlikti lydymosi kreivės analizę. Kiekviena parinktis nurodoma skirtingoms plokštelėms
ir paleidimų tipams.

CFX Manager Dx teikia dvi protokolų kūrimo parinktis: „Protocol Editor“ (protokolų redaktorius) ir
„Protocol AutoWriter“ (protokolų automatinio kūrimo priemonė).

„Protocol Editor“ (protokolo redaktorius) funkcijos:

n Standartiniai protokolo valdikliai sparčiam protokolų kūrimui

n Galimybė greitai apskaičiuoti gradientą pasirinktam eilučių skaičiui

n Galimybė greitai apskaičiuoti gradientą pasirinkto tipo plokštelei

n Galimybė redaguoti protokolo veiksmus

n Galimybė įrašyti protokolą, kad būtų galima naudoti pakartotinai

n Galimybė atspausdinti protokolą numatytuoju spausdintuvu

„Protocol AutoWriter“ (protokolų automatinio kūrimo priemonė) automatiškai sukuria tinkintą PGR
protokolą su karšta pradžia, pradine denatūracija, atkaitinimu ir pratęsimo veiksmais taikydama jūsų
pateiktus parametrus. Tada jūs galite peržiūrėti siūlomo protokolo grafinį pavaizdavimą ir redaguoti,
paleisti ar įrašyti protokolą.
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Langas „Protocol Editor“ (protokolų redaktorius)
Lange „Protocol Editor“ (protokolų redaktorius) galite kurti, atverti, peržiūrėti ir redaguoti protokolą.
Pagal numatytąsias nuostatas atvėrus langą „Protocol Editor“ (protokolų redaktorius) rodomas
bendras tikralaikis 2 veiksmų protokolas 96 šulinėlių plokštelei.

1. Meniu juosta suteikia sparčią prieigą prie meniu „File“ (failas), „Settings“ (nuostatos) ir
„Tools“ (įrankiai) komandų.

2. Įrankių juosta suteikia sparčią prieigą prie protokolo įrašymo ir spausdinimo, naujo veiksmo
įterpimo vietos nustatymo, mėginio tūrio nustatymo ir protokolo numatomo veikimo laiko
rodymo parinkčių.

3. Pagrindinėje srityje rodomas protokolo grafinis vaizdas.

4. Toliau esančioje srityje rodoma protokolo schema.

5. Kairėje srityje rodomi protokolo valdymo elementai, kuriuos galite pridėti pritaikydami
protokolą.

LEGENDA
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Meniu „File“ (failas) komandos
„Save“ (įrašyti) – įrašomas esamas protokolas.

„Save As“ (įrašyti kaip) – esamas protokolas įrašomas nauju pavadinimu arba naujoje vietoje.

„Close“ (užverti) – užveriamas „Protocol Editor“ (protokolų redaktorius).

Meniu „Settings“ (nuostatos) komanda
„Lid Settings“ (dangtelio nuostatos) – atveriamas dialogo langas „Lid Setting“ (dangtelio nuostata),
kuriame galite pakeisti arba nustatyti dangtelio temperatūrą.

Meniu „Tools“ (įrankiai) komandos
„Gradient Calculator“ (gradiento skaičiuotuvas) – atveriamas dialogo langas, kuriame galite
pasirinkti gradiento veiksmo bloko tipą. Numatytoji nuostata yra 96 šulinėliai.

„Run time Calculator“ (paleidimo trukmės skaičiuotuvas) – atveria dialogo langą, kuriame galite
pasirinkti plokštelės tipą ir nuskaitymo režimą, kad būtų galima apskaičiuoti paleidimo trukmę lange
„Run Setup“ (paleidimo sąranka). Numatyti 96 šulinėliai visuose kanaluose.

Įrankių juostos komandos

– įrašo esamą protokolo failą.

– atspausdina pasirinktą langą.

– naudokite šią komandą pasirinkti, kur įterpti veiksmus, palyginus su esamu
pasirinktu veiksmu.
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– naudokite šią komandą ir įveskite mėginio tūrį µl. Mėginio tūris skiriasi
priklausomai nuo bloko tipo:

n 96 gilių šulinėlių bloko intervalas yra 0–125 µl.

n 96 šulinėlių bloko intervalas yra 0–50 µl.

– rodo apskaičiuotą paleidimo trukmę, remiantis protokolo veiksmais, kitimo
greičiu ir pasirinkto bloko tipu.

– rodo žinyno informacija apie protokolus.

Protokolų redagavimo valdikliai
Lango „Protocol Editor“ (protokolų redaktorius) kairę sritį sudaro valdikliai, kuriais galite sukurti
protokolus.

Kiekvieną valdiklį sudaro keli parametrai, reiškiantys veiksmą protokole. Kiekvieną parametrą galite
keisti ir pridėti arba pašalinti, kad tinkintumėte savo protokolą. Šiame skyriuje apibūdintos kiekvieno
valdiklio parinktys.

n „Insert Step“ (įterpti veiksmą) – įterpia veiksmą prieš pasirinktą
veiksmą arba po jo. Galite redaguoti temperatūros arba užlaikymo
trukmės vertes arba protokolo grafiniame rodinyje, arba protokolo
schemoje.

n „Insert Gradient“ (įterpti gradientą) – įterpiamas gradiento
veiksmas, remiantis gradiento skaičiuotuve pasirinkto šulinėlių bloko
tipu. Gradiento intervalą galite redaguoti srityje „Gradient“ 
(gradientas), kuris parodomas, kai įterpiamas gradiento veiksmas.

n „Insert GOTO“ (įterpti GOTO) – įterpiamas ciklinis (kilpos)
veiksmas, kuris programinei įrangai nurodo pakartoti veiksmus
sekoje nurodytą ciklų skaičių. Kartojimas pradedamas, kai baigiamas

pirmasis ciklas. Pavyzdžiui, jūs galite programinei įrangai nurodyti 2–4 veiksmus pakartoti 39
kartus. Po paskutinio pakartojimo programinė įranga 2–4 veiksmus bus atlikusi 40 kartų. Galite
koreguoti sugrįžimo į (GOTO) veiksmą ir ciklų skaičių arba grafiniame rodinyje, arba protokolo
schemoje.

n „Insert Melt Curve“ (įterpti lydymosi kreivę) – įterpiamas lydymosi kreivės nuskaitymo
veiksmas.
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n „Insert Plate Read to Step“ (įterpti plokštelės nuskaitymą į veiksmą) – į pasirinktą veiksmą
įtraukiama plokštelės nuskaitymo komanda. Plokštelės nuskaitymo funkcija ciklo pabaigoje
išmatuoja fluorescencijos kiekį. Plokštelės nuskaitymo veiksmas paprastai yra paskutinis
veiksmas GOTO cikle.

Patarimas. Kai prie veiksmo pridedate plokštelės nuskaitymo komandą, pasirinkus veiksmą
mygtukas pasikeičia į „Remove Plate Read“ (pašalinti plokštelės nuskaitymą).

n „Remove Plate Read“ (pašalinti plokštelės nuskaitymą) – iš pasirinkto veiksmo pašalinama
plokštelės nuskaitymo komanda.

Patarimas. Kai iš veiksmo pašalinate plokštelės nuskaitymo komandą, pasirinkus veiksmą
mygtukas pasikeičia į „Add Plate Read to Step“ (į veiksmą įtraukti plokštelės nuskaitymą).

n „Step Options“ (veiksmų parinktys) – atveriamas dialogo langas „Step Options“ (veiksmų
parinktys) ir rodomos pasirinkto veiksmo galimos parinktys. Išsamią informaciją apie veiksmų
parinktis žr. Veiksmų parinktys, p. 89.

Patarimas. „Step Options“ (veiksmų parinktys) galite pasiekti grafiniame rodinyje veiksmą
spustelėję pelės dešiniuoju klavišu.

n „Delete Step“ (pašalinti veiksmą) – iš protokolo pašalina pasirinktą veiksmą.

Veiksmų parinktys

Atverkite dialogo langą „Step Options“ (veiksmų parinktys) ir peržiūrėkite parinktis, kurias galite pridėti,
pakeisti ar pašalinti iš veiksmo.

n „Plate Read“ (plokštelės nuskaitymas) – pasirinkus į veiksmą įtraukiamas plokštelės
nuskaitymas.

n „Temperature“ (temperatūra) – nustatoma pasirinkto veiksmo tikslinė temperatūra.
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n „Gradient“ (gradientas) – veiksmui nustatomas gradiento intervalas; intervalas yra 1–24 °C.

Pastaba. Gradientas paleidžiamas mažiausia temperatūra bloko priekyje (šiame
paveikslėlyje – H eilė) ir didžiausia temperatūra bloko gale (šiame paveikslėlyje – A eilė).

n „Increment“ (kitimas) – temperatūros didinimo (ar mažinimo) dydis pasirinktam veiksmui; šis
vertės dydis pridedamas tikslinei temperatūrai kiekvienam ciklui. Diapazonas – ±0,1–10 °C.

Pastaba. Norėdami sumažinti temperatūrą, prieš skaitinę vertę parašykite minuso ženklą
(pavyzdžiui, –5 °C).

n „Ramp Rate“ (kitimo greitis) – pasirinkto veiksmo kitimo greitis; intervalas priklauso nuo bloko
dydžio.

n „Time“ (laikas) – pasirinkto veiksmo užlaikymo laikas.

n „Extend“ (pratęsimas) – laikas (sek.), kuriuo pratęsimas ar sutrumpinamas pasirinktas
veiksmas; ši parinktis pridedama prie užlaikymo laiko kiekviename cikle; intervalas yra 1–60 sek.

n „Beep“ (pypsėjimas) – pasirinkus kiekvieno veiksmo pabaigoje pasigirsta pypsėjimas.

Patarimas. Įvedus skaičių, kuris nepatenka į parinkties intervalą, programinė įranga jį
pakeičia artimiausia įvestimi intervale.
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Protokolo kūrimas lange „Protocol Editor“ (protokolų
redaktorius)

Lange „Protocol Editor“ (protokolų redaktorius) galite kurti pasirinktinius protokolų failus. Taip pat
galite redaguoti ir įrašyti anksčiau įrašytus protokolo failus arba pavyzdinius protokolų failus, pridėtus
prie CFX Manager Dx programinė įranga.

Kaip sukurti naują protokolo failą:

n Lange „Protocol Editor“ (protokolų redaktorius) atverkite protokolo failą.

Patarimas. Lange „Protocol Editor“ (protokolų redaktorius) galite atverti naują arba esamą
protokolą.

n Sukurkite naują protokolą.

n Pridėkite prie protokolo veiksmus iš protokolų valdymo srities.

n Redaguokite veiksmų ypatybes.

n Įrašykite protokolą.

Patarimas. Apie tai, kaip sukurti naują protokolą iš anksčiau įrašytų arba pavyzdinių protokolų
failų, žr. Esamo protokolo atvėrimas lange „Protocol Editor“ (protokolų redaktorius), p. 93.

Naujo protokolo failo atvėrimas lange „Protocol Editor“ 
(protokolo redaktorius)
CFX Manager Dx turi kelias galimybes naujo protokolo failui atverti:

n Lange „Home“ (pagrindinis)

n Dialogo lange „Startup Wizard“ (paleisties vedlys)

n Dialogo lange „Run Setup“ (paleidimo sąranka)

Kaip atverti naujo protokolo failą lange „Home“ (pagrindinis)

u Pasirinkite „File > New > Protocol“ (failas > naujas > protokolas).

Atveriamas langas „Protocol Editor“ (protokolo redaktorius), kuriame rodomas numatytasis
protokolo failas.

Patarimas. Daugiau informacijos apie numatytojo protokolo nustatymą žr. Numatytųjų failų
nuostatų keitimas, p. 65.
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Kaip atverti naujo protokolo failą per „Startup Wizard“ (paleisties vedlys)

1. Lange „Home“ (pagrindinis) atlikite vieną iš šių veiksmų ir atverkite „Startup Wizard“ (paleisties
vedlys), jeigu jis dar nerodomas:

n Pasirinkite „View > Startup Wizard“ (peržiūrėti > paleisties vedlys).

n Įrankių juostoje spustelėkite „Startup Wizard“ (paleisties vedlys).

Pagal numatytąsias nuostatas „Startup Wizard“ (paleisties vedlys) parodo kortelę „Run setup“ 
(paleidimo sąranka) su pasirinktu CFX96 instrumento tipu.

2. Jeigu reikia, išplečiamajame sąraše pasirinkite instrumento tipą.

3. Spustelėkite „User-defined“ (vartotojo nustatytas) kaip paleidimo tipą.

Dialogo langas „Run Setup“ (paleidimo sąranka) atveria kortelę „Protocol“ (protokolas) ir rodo
numatytąjį protokolo failą.

4. Spustelėkite „Create New“ (kurti naują).

Atveriamas langas „Protocol Editor“ (protokolų redaktorius), kuriame rodomas tikralaikis
protokolas.

Kaip atverti naują protokolą dialogo lange „Run Setup“ (paleidimo sąranka)

1. Lange „Home“ (pagrindinis) atlikite vieną iš šių veiksmų ir atverkite dialogo langą „Run Setup“ 
(paleidimo sąranka):

n Pasirinkite „Run > User-defined Run“ (paleidimas > vartotojo nustatytas paleidimas).

n Įrankių juostoje spustelėkite „User-defined Run Setup“ (vartotojo nustatyto paleidimo
sąranka).

Dialogo langas „Run Setup“ (paleidimo sąranka) atveria kortelę „Protocol“ (protokolas) ir rodo
jūsų numatytąjį protokolo failą.

2. Spustelėkite „Create New“ (kurti naują).

Atveriamas langas „Protocol Editor“ (protokolų redaktorius), kuriame rodomas realiojo laiko
protokolas.

92 | Sistemos CFX96 Dx ir CFX96 Deep Well Dx



Protokolo kūrimas lange „Protocol Editor“ (protokolų redaktorius)

Esamo protokolo atvėrimas lange „Protocol Editor“ (protokolų
redaktorius)
CFX Manager Dx pateikia mėginių protokolų failus, kuriuos galite redaguoti ir įrašyti kaip tinkintus
naujus protokolus. Taip pat galite sukurti naujus protokolus pagal esamą tinkintą protokolą.

Kaip atidaryti mėginio protokolo failą

1. Lange „Home“ (pagrindinis) pasirinkite „File > Open > Protocol“ (failas > atverti > protokolas).

Pagal numatytuosius parametrus „Windows Explorer“ atveriamas CFX Manager Dx mėginių failų
aplanko vietoje.

2. Atverkite mėginių failų aplanką. Galite matyti šiuos aplankus:

n „ConventionalProtocols“ (įprasti protokolai) – protokolų pavyzdžių failai tradicinei PGR
analizei.

n „DataFiles“ (duomenų failai) – duomenų pavyzdžių failai, kuriuos galite naudoti CFX
Manager Dx funkcijoms tyrinėti.

n „MeltCalibration“ (lydymosi kalibravimas) – protokolų pavyzdžių failai, skirti naudoti su
„Bio-Rad“ rezultatų lydymosi analizės programine įranga.

n „Plates“ (plokštelės) – plokštelės pavyzdžių failai.

n „RealTimeProtocols“ (tikralaikiai protokolai) – protokolų pavyzdžių failai PGR analizei
tikruoju laiku.

3. Atverkite protokolų aplanką planuojamam atlikti paleidimo tipui („ConventionalProtocols“ (įprasti
protokolai) arba „RealTimeProtocols“ (tikralaikiai protokolai)).

4. Pasirinkite reikiamą protokolą ir spustelėkite „Open“ (atverti).

Lange „Protocol Editor“ (protokolų redaktorius) atveriamas mėginių protokolas.

5. Pasirinkite „File > Save As“ (failas > įrašyti kaip) ir įrašykite protokolą nauju pavadinimu ar
naujame aplanke.
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Kaip atverti esamą protokolą

1. Lange „Home“ (pagrindinis) atlikite vieną iš šių veiksmų:

n Pasirinkite „File > Open > Protocol“ (failas > atverti > protokolas), suraskite tikslinį protokolą,
jį atverkite ir spustelėkite „Open“ (atverti).

n Atverkite „Startup Wizard“ (paleisties vedlys) ir atlikite vieną iš šių veiksmų:

o Norėdami redaguoti rodomą protokolą, spustelėkite „Edit Selected“ (redaguoti
pasirinktą).

o Norėdami redaguoti kitą esamą protokolą, spustelėkite „Select Existing“ (pasirinkti
esamą) ir raskite tikslinį failą.

Lange „Protocol Editor“ (protokolų redaktorius) atveriamas protokolas.

2. Pasirinkite „File > Save As“ (failas > įrašyti kaip) ir įrašykite protokolą nauju pavadinimu ar
naujame aplanke.

Naujo protokolo nustatymas
Patarimas. Jei jūsų protokolo faile yra reikalingi parametrai (pvz., jei redaguojate esamą
plokštelės failą), galite šį skyrių praleisti. Tęskite, kaip nurodyta skirsnyje Protokolo veiksmų
pridėjimas, p. 96.

Naujiems protokolo failams reikalingi šie parametrai:

n Bloko tipas

n Pasirinkto bloko tipo nuskaitymo režimas

n Dangtelio temperatūra

n Mėginio tūris

Bloko tipo nustatymas

CFX Manager Dx automatiškai apskaičiuoja gradiento veiksmų temperatūros kitimus, remiantis bloko
tipu.

Pastaba. Plokštelės tipas, nustatytas „Protocol Editor“ (protokolo redaktorius), turi būti toks pat,
kaip ir plokštelė reakcijos modulyje.

Kaip nustatyti bloko tipą

u Lange „Protocol Editor“ (protokolo redaktorius) pasirinkite „Tools > Gradient Calculator“ (įrankiai >
gradiento skaičiuotuvas) ir rodomame išplečiamajame sąraše pasirinkite atitinkamo tipo
plokštelę.
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Nuskaitymo režimo pasirinkimas pasirinkto tipo blokui

Norėdami nustatyti protokolo paleidimo laiką, pasirinkite tikslo bloko tipą ir nuskaitymo režimą.

Kaip pasirinkti bloko tipą ir nuskaitymo režimą

u Lange „Protocol Editor“ (protokolo redaktorius) pasirinkite „Tools > Run time Calculator“ (įrankiai
> paleidimo laiko skaičiuotuvas) ir rodomame išplečiamajame sąraše pasirinkite atitinkamo tipo
plokštelę.

Dangtelio temperatūros koregavimas

CFX Manager Dx nustato numatytąją dangtelio temperatūrą iki 105,0 °C.

Galite pakeisti numatytąsias nuostatas arba dangtelio kaitintuvą išjungti, kai reikia, pagal protokolo
reikalavimus.

Patarimas. Numatytąją dangtelio temperatūrą galite pakeisti dialogo lange „User Preferences“ 
(vartotojo nuostatos). Žr. Numatytųjų protokolo parametrų nustatymas, p. 67.

Kaip koreguoti dangtelio temperatūrą

1. Lange „Plate Editor“ (plokštelės redaktorius) pasirinkite „Settings > Lid Settings“ (nuostatos >
dangtelio nuostatos).

Parodomas dialogo langas „Lid Settings“ (dangtelio nuostatos).

2. Atlikite vieną iš toliau nurodytų veiksmų:

n Pasirinkite „User Defined“ (vartotojo nustatyta) ir teksto langelyje įrašykite temperatūros
vertę.

n Pasirinkite „Turn Off Lid Heater“ (išjungti dangtelio kaitintuvą).

3. Spustelėkite OK (gerai) ir patvirtinkite pakeitimus bei uždarykite dialogo langą

Mėginio tūrio nustatymas

Pagal numatytąsias nuostatas CFX Manager Dx kiekvienam šulinėliui nustato 25 µl mėginio tūrį. Vis
dėlto Sistema CFX Dx diapazonas yra 0–125 µl.

Prietaisas naudoja vieną iš dviejų temperatūros reguliavimo režimų, kad nustatytų, kada mėginys
pasiekia tikslinę temperatūrą protokole:

n „Calculated mode“ (apskaičiuotas režimas) – kai mėginio tūris yra nustatomas pagal blokui
tinkamą tūrį, prietaisas apskaičiuoja mėginio temperatūrą pagal mėginio tūrį. Tai standartinis
režimas.
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n „Block mode“ (bloko režimas) – kai nustatytas mėginio tūris yra nulis (0) µl, prietaisas
užfiksuoja tokią pačią mėginio temperatūrą, kaip išmatuota bloko temperatūra.

Mėginio tūrio konkrečiam blokui nustatymas

u Lange „Plate Editor“ (plokštelės redaktorius) įveskite reikiamą reikšmę įrankių juostoje esančiame
tekstiniame langelyje „Sample Volume“ (mėginio tūris).

Patarimas. Numatytąjį mėginio tūrį galite pakeisti dialogo lange „User Preferences“ (vartotojo
nuostatos). Daugiau informacijos žr. skirsnyje Numatytųjų failų nuostatų keitimas, p. 65.

Protokolo veiksmų pridėjimas
Kaip pridėti protokolo veiksmą

1. Atidarykite protokolą lange „Protocol Editor“ (protokolų redaktorius).

2. Nustatykite, kur įterpti naują veiksmą. Įrankių juostoje esančiame išplečiamajame sąraše „Step“ 
(veiksmas) pasirinkite „Before“ (prieš) arba „After“ (po).

3. Diagramoje pasirinkite veiksmą, prieš kurį arba po kurio planuojate įterpti naują veiksmą.

4. Kairėje srityje pasirinkite „Insert Step“ (įterpti veiksmą).

5. Norėdami pakeisti temperatūrą ar sulaikymo laiką, spustelėkite numatytąją reikšmę diagramoje
arba protokolo kontūre ir įveskite naują reikšmę.

6. (Neprivaloma) Kairėje srityje spustelėkite „Step Options“ (veiksmų parinktys), kad atidarytumėte
dialogo langą „Step Options“ (veiksmų parinktys) ir pakeistumėte pasirinkto veiksmo parinktis.

Patarimas. Dialogo langą „Step Options“ (veiksmų parinktys) galite rasti dešiniuoju pelės
klavišu paspaudę diagramos arba protokolo kontūro sritį ir atidarę meniu.

7. Spustelėkite OK (gerai) ir „Yes“ (taip), kad įrašytumėte protokolo pakeitimus.

Pasirodo dialogo langas „Save As“ (įrašyti kaip)

8. Lange „Save As“ (įrašyti kaip) įveskite naujo protokolo failo pavadinimą ir spustelėkite „Save“ 
(įrašyti).
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Gradiento veiksmo įterpimas
Kaip įterpti gradiento veiksmą

1. Patikrinkite, ar gradiento plokštelės dydis yra toks pat, kaip ir instrumento bloko tipo, 96.

2. Jeigu to dar neatlikote, pasirinkite plokštelės dydį gradientui:

Pasirinkite „Tools > Gradient Calculator“ (įrankiai > gradiento skaičiuotuvas) ir išplečiamajame
sąraše pasirinkite šulinėlių tipą.

3. Įrankių juostoje esančiame išplečiamajame sąraše „Insert Step“ (įterpti veiksmą) pasirinkite arba
„Before“ (prieš), arba „After“ (po).

4. Diagramoje arba paryškintoje srityje pasirinkite veiksmą, prieš kurį arba po kurio planuojate įterpti
gradiento veiksmą.

5. Kairėje srityje spustelėkite „Insert Gradient“ (įterpti gradientą). Naujas gradiento veiksmas
paryškinamas diagramoje ir apibrėžtoje srityje, pavyzdžiui:

Kiekvienos eilutės temperatūra gradiente parodoma lentelėje „Gradient“ (gradientas) dešinėje
srityje.
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6. Norėdami koreguoti gradiento temperatūros intervalą, atlikite šiuos veiksmus:

n Spustelėkite numatytąją temperatūrą diagramoje ar apibrėžtoje srityje ir įveskite naują
temperatūrą.

n Spustelėkite „Step Options“ (veiksmų parinktys) ir lange „Step Options“ (veiksmų parinktys)
įveskite gradiento intervalą.

n Pakeiskite lentelėje „Gradient“ (gradientas) esančią vertę „Range“ (intervalas).

7. Norėdami koreguoti užlaikymo laiką, grafike ar tekstiniame vaizde spustelėkite numatytąjį laiką ir
įveskite naują laiką.

8. Kad įrašytumėte pakeitimus, spustelėkite mygtuką OK (gerai), o tada „Yes“ (taip).

Veiksmo GOTO įterpimas
Pastaba. Veiksmo GOTO negalite įterpti į GOTO rinkinį; negalite sukurti rinkinio GOTO
pasikartojančių veiksmų.

Kaip įterpti veiksmą GOTO

1. Įrankių juostoje esančiame išplečiamajame sąraše „Insert Step“ (įterpti veiksmą) pasirinkite
„Before“ (prieš) arba „After“ (po).

2. Diagramoje pasirinkite veiksmą, prieš kurį arba po kurio planuojate įterpti GOTO veiksmą.

3. Kairėje srityje spustelėkite „Insert GOTO“ (įterpti GOTO).

4. Norėdami koreguoti GOTO veiksmo numerį ar GOTO pasikartojimų numerį, diagramoje
pasirinkite numatytąjį numerį arba pažymėkite sritį ir įveskite naują vertę.

5. Kad įrašytumėte pakeitimus, spustelėkite mygtuką OK (gerai), o tada „Yes“ (taip).

Lydymosi kreivės veiksmo įterpimas
Patarimas. Lydymosi kreivės veiksmo negalite įterpti į GOTO ciklą.

Pastaba. Lydymosi kreivės veiksmas apima 30 sek. užlaikymą veiksmo, kuris neparodytas
protokole, pradžioje.

Kaip įterpti lydymosi kreivės veiksmą

1. Įrankių juostoje esančiame išplečiamajame sąraše „Insert Step“ (įterpti veiksmą) pasirinkite
„Before“ (prieš) arba „After“ (po).

2. Diagramoje pasirinkite veiksmą, prieš kurį arba po kurio planuojate įterpti lydymosi kreivės
veiksmą.
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3. Kairėje srityje spustelėkite „Insert Melt Curve“ (įterpti lydymosi kreivę). Naujas lydymosi kreivės
veiksmas paryškinamas diagramoje ir apibrėžtoje srityje, pavyzdžiui:

4. Norėdami koreguoti lydymosi temperatūros intervalą arba padidinimo laiką, diagramoje
pasirinkite numatytąjį numerį arba apibraukite sritį ir įveskite naują vertę.

5. Kad įrašytumėte pakeitimus, spustelėkite mygtuką OK (gerai), o tada „Yes“ (taip).
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Plokštelės nuskaitymo veiksmo pridėjimas arba pašalinimas
Patarimas. Kai prie veiksmo pridedate plokštelės nuskaitymo komandą, pasirinkus veiksmą
mygtukas pasikeičia į „Remove Plate Read“ (pašalinti plokštelės nuskaitymą).

Plokštelės nuskaitymo pridėjimas prie veiksmo

1. Įrankių juostoje esančiame išplečiamajame sąraše „Insert Step“ (įterpti veiksmą) pasirinkite
„Before“ (prieš) arba „After“ (po).

2. Diagramoje pasirinkite veiksmą, prieš kurį arba po kurio planuojate įterpti plokštelės nuskaitymo
veiksmą.

3. Norėdami prie pasirinkto veiksmo pridėti plokštelės nuskaitymą, kairėje srityje spustelėkite „Add
Plate Read to Step“ (plokštelės nuskaitymą pridėti prie veiksmo).

4. Kad įrašytumėte pakeitimus, spustelėkite mygtuką OK (gerai), o tada – „Yes“ (taip).

Plokštelės nuskaitymo pašalinimas iš veiksmo

u Diagramoje pasirinkite veiksmą, į kurį įtrauktas plokštelės nuskaitymas, ir kairiojoje srityje
spustelėkite „Remove Plate Read“ (pašalinti plokštelės nuskaitymą).

Veiksmų parinkčių keitimas
Pasirinkto veiksmo parinkčių keitimas

1. Diagramoje ar kontūro srityje pasirinkite tikslinį veiksmą.

2. Kairėje srityje spustelėkite „Step Options“ (veiksmų parinktys) ir atverkite dialogo langą „Step
Options“ (veiksmų parinktys).

Taip pat galite dešiniuoju pelės mygtuku bet kurioje srityje spustelėti tikslinį veiksmą ir rodomame
meniu pasirinkti „Step Options“ (veiksmų parinktys).

3. Norėdami pridėti, keisti ar pašalinti parinktis, atlikite šiuos veiksmus:

n Atitinkamame tekstiniame langelyje įrašykite vertę.

n Konkrečiame tekstiniame langelyje koreguokite vertę.

n Pasirinkite arba išvalykite žymės langelį.

4. Spustelėkite OK (gerai) ir įrašykite pakeitimus bei uždarykite dialogo langą „Step Options“ 
(veiksmų parinktys).

5. Spustelėkite OK (gerai), paskui „Yes“ (taip) ir įrašykite protokolą.
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Veiksmo šalinimas
Veiksmo protokole šalinimas

1. Diagramoje ar kontūro srityje pasirinkite veiksmą.

2. Kairiame skydelyje spustelėkite „Delete Step“ (šalinti veiksmą) ir pašalinkite pasirinktą veiksmą.

3. Spustelėkite OK (gerai), paskui „Yes“ (taip) ir įrašykite protokolą.

Protokolo kopijavimas, eksportavimas arba spausdinimas
Protokolo kopijavimas

u Pelės dešiniuoju mygtuku spustelėkite protokolo schemą ir pasirinkite „Copy Protocol“ (kopijuoti
protokolą).

Galite įklijuoti schemą į .txt, .xls, .doc arba .ppt failą.

Protokolo eksportavimas

1. Pelės dešiniuoju mygtuku spustelėkite protokolo schemą ir pasirinkite „Export Protocol“ 
(eksportuoti protokolą).

Parodomas dialogo langas „Save As“ (įrašyti kaip).

2. (Neprivaloma) Per naršyklę „Windows Explorer“ pasiekite aplanką, kuriame norite įrašyti
protokolo failą.

3. Lauke „File Name“ (failo pavadinimas) įrašykite eksportuoto protokolo failo pavadinimą.

4. Spustelėkite „Save“ (įrašyti).

Protokolo spausdinimas

u Pelės dešiniuoju mygtuku spustelėkite protokolo schemą ir pasirinkite „Print“ (spausdinti).

Galite atspausdinti protokolo schemą jūsų numatuoju spausdintuvu.
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Protokolų kūrimas su „Protocol AutoWriter“ (protokolų
automatinio kūrimo priemonė)

Svarbu. „Bio-Rad“ negarantuoja, kad paleidžiant su „Protocol AutoWriter“ (protokolų automatinio
kūrimo priemonė) sukurtą protokolą bus gaunamas tikralaikis PGR produktas.

CFX Manager Dx „Protocol AutoWriter“ (protokolų automatinio kūrimo priemonė) automatiškai sukuria
ciklinius protokolus pagal šiuos įvesties parametrus:

n „Amplicon length“ (amplikono ilgis) – PGR produkto tikėtinas ilgis.

n „Annealing temperature“ (atkaitinimo temperatūra) – reakcija Ta naudojamiems
pradmenims.

Jeigu Ta yra nežinoma, galite naudoti „Ta Calculator“ (Ta skaičiuotuvas) ir automatiškai
apskaičiuoti pagal jūsų pradmens sekas.

Pastaba. Ta yra koreguota iš pradmens lydymosi temperatūros (Tm) informacijos, kuri
pagrįsta pažymėtu fermentu ir protokolo greičiu.

n „Enzyme type“ (fermento tipas) – DNA (DNR) polimerazės fermentas („iTaq, iProof DNA“ 
(„iTaq“, „iProof DNR“) polimerazė arba „Other“ (kt.))

Jeigu jūs naudojate kitą fermentą, ne „iTaq“ ar „iProof DNA“ („iProof DNR“) polimerazę, galite
įvesti papildomą informaciją, įskaitant gradiento intervalą, karšto paleidimo aktyvinimo laiką (sek.)
ir galutinį pratęsimo laiką (sek.).

n „Run speed“ (paleidimo greitis) – reakcijos greitis (standartinis, greitas arba itin greitas)

„Protocol AutoWriter“ (protokolų automatinio kūrimo priemonė) optimizuoja protokolą,
priklausomai nuo pasirinktos greičio nuostatos. Bendras paleidimo laikas nustatomas pagal
veiksmų ir ciklų skaičių, inkubavimo laiką kiekvienu etapu ir laiką, kiek užtruko pasiekti vienodą
tikslinę temperatūrą.

Pagal jūsų įvestus parametrą ir standartines PGR rekomendacijas „Protocol AutoWriter“ (protokolų
automatinio kūrimo priemonė) automatiškai sukuria tinkintą PGR protokolą su karšta pradžia, pradine
denatūracija, atkaitinimu ir pratęsimo veiksmais. Tada jūs galite peržiūrėti siūlomo protokolo grafinį
vaizdą ir redaguoti, paleisti ar įrašyti protokolą.
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Protokolų kūrimas su „Protocol AutoWriter“ (protokolų automatinio kūrimo priemonė)

Naujo protokolo sukūrimas naudojant CFX Manager Dx „Protocol AutoWriter“ 
(protokolų automatinio kūrimo priemonė)

1. Lange „Home“ (pagrindinis) pasirinkite „Tools > Protocol AutoWriter“ (įrankiai > protokolų
automatinio kūrimo priemonė).

Parodomas dialogo langas „Protocol AutoWriter“ (protokolų automatinio kūrimo priemonė).

2. Skyriuje „Enter Target Values/Enzyme“ (įvesti tikslines vertes / fermentą) atlikite šiuos veiksmus:

n Įveskite pradmens atkaitinimo temperatūrą (Ta), jeigu žinoma.

Patarimas. Daugiau informacijos žr. „Ta Calculator“ (Ta skaičiuotuvas) naudojimas, p.
105.

Pastaba. Informacijos apie skaičiavimus, atliekamus „Ta Calculator“ (Ta skaičiuotuvas),
žr. Breslauer et al., 1986.

n Įveskite amplikono ilgį bazių porose (bp).

n Iš parinkčių („iTaq DNA“ („iTaq DNR“) polimerazė, „iProof DNA“ („iProof DNR“) polimerazė ar
„Other“ (kt.)) sąrašo pasirinkite fermento tipą.

Patarimas. Jeigu pasirenkate fermento tipą „Other“ (kt.), parametras skyriuje
„Additional Parameters (Optional)“ (papildomi parametrai (neprivaloma) tampa aktyvus.

Naudojimo vadovas | 103



6 skyrius. Protokolų kūrimas

3. Jeigu pasirinkote fermento tipą „Other“ (kt.), galite pridėti bet kurį iš pateikiamų arba visus
protokolo parametrus:

n Gradiento intervalas

n Karštos pradžios aktyvinimo temperatūra

n Galutinis pratęsimo laikas

4. Skyriuje „Type“ (tipas) slinkite slankiąją juostą ir pasirinkite protokolo greitį („Standard“ 
(standartinis), „Fast“ (greitas) arba „Ultrafast“ (itin greitas)). CFX Manager Dx koreguoja bendrą
paleidimo laiką.

5. Pasirinkite atliekamos PGR tipą („Real-time PCR“ (tikralaikė PGR) yra numatytasis).

Su tikralaike PGR CFX Manager Dx prideda plokštelės nuskaitymo veiksmą fluorescencijos
duomenims surinkti.

6. Skyriuje „Preview“ (apžvalga) peržiūrėkite protokolą. Jeigu reikia, galite atlikti pakeitimus.

7. Atlikite vieną iš šių veiksmų:

n Spustelėkite OK (gerai) ir įrašykite naują protokolą. Jį įrašius, protokolas atveriamas lange
„Startup Wizard“ (paleisties vedlys). Spustelėkite „Edit Selected“ (redaguoti pasirinktą) ir
keiskite protokolą. Pavyzdžiui, jums gali reikėti pakeisti dangtelio temperatūrą ir mėginio tūrį.

n Spustelėkite „Cancel“ (atšaukti) ir užverkite langą neįrašę protokolo.
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„Ta Calculator“ (Ta skaičiuotuvas) naudojimas
Kai nežinoma pradmens atkaitinimo temperatūra, galite pasinaudoti „Ta Calculator“ (Ta skaičiuotuvas)
ir apskaičiuoti vertę. Vertę galite naudoti priemonėje „Protocol AutoWriter“ (protokolo automatinio
kūrimo priemonė) arba „Protocol Editor“ (protokolų redaktorius) ir sukurti savo protokolą.

Apie „Ta Calculator“ (Ta skaičiuotuvas)
„Ta Calculator“ (Ta skaičiuotuvas) skaičiuoja kiekvieno pradmens Tm vertę, taip pat Ta vertę
standartinio greičio protokolui.

Ta protokolas grindžiamas vidutinėmis pradmens Tm vertėmis taikant šias galiojančias taisykles:

n Jeigu skirtumas tarp pradmens Tm verčių yra >4 °C, Ta = (mažesnė iš dviejų pradmenų Tm verčių
+ 2) – 4 °C

n Jeigu skirtumas tarp Tm verčių yra ≤4 °C, Ta = (pradmens Tm verčių vidurkis) – 4 °C

Bazių porų skaičiavimo metodas

Kiekvienam pradmeniui „Ta Calculator“ (Ta skaičiuotuvas) taiko bazių porų skaičiavimo metodą
sekoms su 14 ar mažiau bazių porų (bp).

Tm = ((w*A + x*T) * 2) + ((y*G + z*C) * 4)

kur atitinkamai w, x, y ir z yra bazių A, T, G ir C skaičius sekoje.

Artimiausių kaimynų metodas

Sekoms su daugiau nei 14 bp naudojamas artimiausių kaimynų metodas. Artimiausių kaimynų
metode lydymosi temperatūros skaičiavimai grindžiami termodinaminiu ryšiu tarp entropijos
(oligonukleotido sekos ar matmenų atsitiktinumo), entalpijos (oligonukleotido išskiriamos arba
absorbuotos šilumos), laisvosios energijos ir temperatūros.

∆H = ∆G + T* ∆S

kur:

n ∆H = entalpijos reikšmė, cal/mol*K

n T = temperatūra pagal Kelvino skalę

n ∆S = entropijos reikšmė, cal/mol*K

n ∆G = Gibso laisvoji energija, cal/mol*K

Entropijos ir entalpijos pokyčiai yra tiesiogiai apskaičiuojami sumuojant nukleotidų porų reikšmes,
pateiktas 12 lentelė (Breslauer et al., 1986).
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Laisvosios energijos ir reaktantų bei produktų koncentracijos pusiausvyrai reikalingas santykis
apskaičiuojamas pagal:

∆G = R*T*ln ((DNR * pradmuo)/(DNR + pradmuo))

kur R yra dujų konstanta (1,986 cal/mol*K).

Pakeitus G dviejose lygtyse ir apskaičiavus T gaunama

T = ∆H/(∆S + R*Ln((DNR * pradmuo)/(DNR + pradmuo)))

darant prielaidą, kad DNR ir DNR pradmenų komplekso koncentracija yra vienoda.

Empiriškai nustatyta, kad perėjimo nuo vienos grandinės DNR prie B formos DNR metu atsiranda 5
kcal (3,4 kcal) (Sugimoto et al., 1996) laisvosios energijos pokytis. Tai tikriausiai spiralės inicijavimo
energija. Galiausiai, pridėjus druskos paklaidą, gaunama lygtis, kurią naudoja Ta skaičiuotuvas:

T = (∆H – 5(KCal/K*mol))/(∆S + (R * ln(1/(pradmuo)))) + 16,6 log10 (druskos molinė koncentracija)

Nereikia taikyti jokios paklaidos druskos koncentracijos konstantai, nes įvairūs parametrai buvo
nustatyti esant 1 M NaCl, o log10 1 lygus nuliui.

Termodinaminiais skaičiavimais daroma prielaida, kad atkaitinimas vyksta esant pH 7,0. Tm
skaičiavimo metu daroma prielaida, kad sekos nėra simetriškos ir turi bent vieną G ar C.

Tam, kad būtų gautos pagrįstos Tm reikšmės, oligonukleotido seka turi būti mažiausiai 14 bazių ilgio.
Mažiau nei 14 bazių atveju naudojamas bazių porų skaičiavimo metodas (žr. toliau pateiktą 12
lentelė).

Sąveika ∆H ∆S ∆G

AA TT 9,1 24 1,5

AT TA 8,6 23,9 1,5

AC TG 6,5 17,3 1,3

AG TC 7,8 20,8 1,6

TA AT 6 16,9 0,9

TT AA 9,1 24 1,9

TC AG 5,6 13,5 1,6

TG AC 5,8 12,9 1,9

12 lentelė. Breslauer sąveikos konstantos
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Sąveika ∆H ∆S ∆G

CA GT 5,8 12,9 1,9

CT GA 7,8 20,8 1,6

CC GG 11 26,6 3,1

CG GC 11,9 27,8 3,6

GA CT 5,6 13,5 1,6

GT CA 6,5 17,3 1,3

GC CG 11,1 26,7 3,1

GG CC 11 26,6 3,1

12 lentelė. Breslauer sąveikos konstantos (tęsinys)
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„Ta Calculator“ (Ta skaičiuotuvas) naudojimas

Kaip naudoti „Ta Calculator“ (Ta skaičiuotuvas)

1. Tam, kad atvertumėte langą „Ta Calculator“ (Ta skaičiuotuvas), atlikite vieną iš toliau nurodytų
veiksmų:

n Jei šiuo metu esate atvėrę „Protocol AutoWriter“ (protokolų automatinio kūrimo priemonė),
spustelėkite „Ta Calculator“ (Ta skaičiuotuvas).

n Lange „Home“ (pagrindinis) pasirinkite „Tools > Ta Calculator“ (įrankiai > Ta skaičiuotuvas).

Atveriamas dialogo langas „Ta Calculator“ (Ta skaičiuotuvas).

2. Tekstiniame langelyje „Forward Primer“ (tiesioginis pradmuo) įrašykite arba įklijuokite tiesioginio
pradmens seką.

Patarimas. Seką įvesti taip pat galite mygtukais A, T, G, C dialogo lango kairėje pusėje.

3. Tekstiniame langelyje „Reverse Primer“ (atvirkštinis pradmuo) įrašykite arba įklijuokite atvirkštinio
pradmens seką.
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4. Spustelėkite mygtuką „Calculate“ (skaičiuoti).

„Ta Calculator“ (Ta skaičiuotuvas) skaičiuoja ir parodo kiekvieno pradmens Tm reikšmę bei
vidutines Tm ir Ta reikšmes, pavyzdžiui:

Jei pradmens Tm reikšmės skiriasi daugiau nei 4 °C, „Protocol AutoWriter“ (protokolų automatinio
kūrimo priemonė) remiasi žemesne pradmens Tm reikšme + 2 °C kaip pagrindu apskaičiuodama
Ta reikšmę, kurią galite toliau koreguoti, keisdami fermentą ir reakcijos greitį.

„Ta Calculator“ (Ta skaičiuotuvas) su „iTaq DNR“ polimeraze generuoja atkaitinimo temperatūrą
standartiniam greičiui. Naudojant kitą fermentą, greičio nuostatos automatiškai koreguoja Ta.

5. Atlikite vieną iš toliau nurodytų veiksmų:

n Jei atvėrėte langą „Ta Calculator“ (Ta skaičiuotuvas) iš „Protocol AutoWriter“ (protokolų
automatinio kūrimo priemonė), spustelėkite OK (gerai). Tada grįšite į „Protocol AutoWriter“ 
(protokolų automatinio kūrimo priemonė). Atkaitinimo temperatūra keičiama automatiškai.

n Jei atvėrėte langą „Ta Calculator“ (Ta skaičiuotuvas) iš meniu „Tools“ (įrankiai), įrašykite
skaičiavimus ir spustelėkite „Cancel“ (atšaukti), kad užvertumėte skaičiuotuvą.
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7 skyrius. Plokštelių paruošimas
Plokštelės faile yra informacijos apie paleidimo parametrus, pvz., nuskaitymo režimą, fluoroforus ir
šulinėlių turinį. Po paleidimo „CFX Manager Dx“ programinė įranga susieja šulinėlio turinį su
fluorescencijos duomenimis, surinktais paleidimo metu, ir lange „Data Analysis“ (duomenų analizė)
atliekama atitinkama analizė. Pavyzdžiui, šulinėliai, į kuriuos įdėtas standartinio tipo mėginys,
naudojami sukurti standartinei kreivei.

CFX Manager Dx programinė įranga teikia dvi parinktis plokštelėms kurti: „Plate Editor“ (plokštelės
redaktorius) tikralaikių PGR paleidimams ir „Setup Wizard“ (sąrankos vedlys) normalizuotos geno
ekspresijos analizei.

„Plate Editor“ (plokštelės redaktorius) apima šias funkcijas:

n Standartinių fluoroforų ir mėginių tipų priskyrimas plokštelių šulinėliams

n Galimybė nustatyti etaloninį tikslą ir kontrolinį mėginį geno ekspresijos analizei

n Galimybė redaguoti plokštelių sąranką prieš paleidimą, jo metu arba po jo

n Galimybė įrašyti failus, kad būtų galima naudoti pakartotinai

n Galimybė atspausdinti plokštelės failą numatytuoju spausdintuvu

„Setup Wizard“ (sąrankos vedlys) padės jums sukurti plokštelės schemą normalizuotai geno
ekspresijos analizei. Parinktį „Setup Wizard“ (sąrankos vedlys) galite naudoti prieš paleidimą, jo metu
arba po jo.
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Langas „Plate Editor“ (plokštelės redaktorius)
Naudodami „Plate Editor“ (plokštelės redaktorius) sukurkite tinkintas plokšteles ar keiskite esamas
plokšteles.

1. Meniu juosta suteikia sparčią prieigą prie meniu „File“ (failas) ir „Settings“ (nuostatos)
komandų bei plokštelės redagavimo įrankių parinkčių.

2. Įrankių juosta leidžia greitai pasiekti svarbias plokštelės įdėjimo funkcijas.

3. Pagrindinėje srityje rodoma plokštelės schema ir plokštelės parinktys, kurias joms taikysite.

4. Dešinėje srityje rodomos parinktys, kurias naudojate savo plokštelei tinkinti.

5. Apatinėje srityje rodomas plokštelės tipas ir suteikiama greita prieiga prie peržiūros
parinkčių.

LEGENDA
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Langas „Plate Editor“ (plokštelės redaktorius)

Meniu „File“ (failas) komandos
„Save“ (įrašyti) – plokštelės duomenų failas įrašomas dialogo lango „User Preferences“ (vartotojo
nuostatos) kortelėje „File“ (failas) nurodytoje vietoje. Daugiau informacijos žr. Numatytųjų failų
nuostatų keitimas, p. 65. Šis meniu elementas prieinamas tik kuriant naują plokštelės failą.

„Save As“ (įrašyti kaip) – atvertos plokštelės duomenų failas įrašomas nauju, jūsų nurodytu
pavadinimu. Šis meniu elementas prieinamas tik kuriant naują plokštelės failą.

„Extract Plate“ (išskleisti plokštelę) – atveriamas dialogo langas, kuriame galite išskleisti (įrašyti)
plokštelės failą (.pltd). Šis meniu elementas prieinamas tik peržiūrint arba redaguojant esamą
plokštelės failą.

„Print“ (spausdinti) – atspausdina atvertos plokštelės duomenų failą.

„Close“ (uždaryti) – užveria langą „Plate Editor“ (plokštelės redaktorius).

Meniu „Settings“ (nuostatos) komandos
„Plate Size“ (plokštelės dydis) – pateikia parinktis, kuriomis galite pasirinkti paleidimo plokštelės
dydį.

Pastaba. Sistema CFX Dx gali naudoti tik 96 šulinėlių plokštelę.

„Plate Type“ (plokštelės tipas) – leidžia jums pasirinkti šulinėlių tipą plokštelėje, kurioje laikomi jūsų
mėginiai, arba „BR White“ (BR balta), arba „BR Clear“ (BR skaidri). Kad gautumėte tikslią duomenų
analizę, pasirinktas plokštelės tipas turi būti toks pat, kaip paleidimo metu naudojamos plokštelės
tipas.

„Number Convention“ (sutartinis skaičių žymėjimas) – leidžia jums pasirinkti ar panaikinti
parinkties žymėjimą, kad standartinėje skaičiaus išraiškoje būtų rodomi matavimo vienetai. Pagal
numatytąsias nuostatas standartinėje skaičiaus išraiškoje rodomi matavimo vienetai.

„Units“ (matavimo vienetai) – leidžia pasirinkti matavimo vienetus, kurie bus rodomi skaičiuoklėse,
kai atliekamas nežinomų mėginių kiekybinis vertinimas, palyginus su standartine kreive.
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Meniu „Editing Tools“ (redagavimo įrankiai) komandos
„Setup Wizard“ (sąrankos vedlys) – atidaroma parinktis „Setup Wizard“ (sąrankos vedlys), kuria
galite nustatyti dabartinės plokštelės schemos ir analizės parametrus. Parinktį „Setup Wizard“ 
(sąrankos vedlys) galite naudoti prieš paleidimą, jo metu arba po jo.

„Spreadsheet View/Importer“ (skaičiuoklės peržiūra / importavimo įrankis) – atveriamas
dialogo langas „View“ (peržiūrėti), kuriame plokštelės schema rodoma kaip šablonas skaičiuoklės
formatu. Galite naudoti šį dialogo langą, jei norite eksportuoti arba importuoti plokštelės šablono
duomenis .csv formatu.

„Flip Plate“ (plokštelės apvertimas) – plokštelės turinys apverčiamas 180 o kampu.

Įrankių juostos komandos

Įrašomas esamas plokštelės failas.

Rodomas išplečiamasis sąrašas, kuriame galite padidinti arba sumažinti
plokštelės vaizdą.

Rodomas išplečiamasis sąrašas, kuriame galite pasirinkti skenavimo
režimą, kuriuo instrumentui nurodoma, kuriuose kanaluose rinkti
fluorescencijos duomenis paleidimo metu.

Atidaro „Well Groups Manager“ (šulinėlių grupių tvarkyklė), kurioje galima
sukurti naudojamos plokštelės šulinėlių grupes.

Rodomas dialogo langas, kuriame galite pasirinkti amplifikavimo pėdsakų
spalvas ir simbolius.

Atveriamas dialogo langas „View“ (peržiūrėti), kuriame plokštelės
schema rodoma kaip šablonas skaičiuoklės formatu. Galite naudoti šį
dialogo langą, jei norite eksportuoti arba importuoti plokštelės šablono
duomenis .csv formatu.

Rodomi būtini veiksmai plokštelei nustatyti ir šulinėliams įkelti.
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Plokštelės failo sukūrimas naudojant „Plate Editor“ 
(plokštelės redaktorius)

Naudodami „Protocol Editor“ (plokštelės redaktorius) galite kurti pasirinktinius plokštelių failus. Taip
pat galite redaguoti ir įrašyti anksčiau įrašytus plokštelių failus arba pavyzdinius plokštelių failus,
pridėtus prie CFX Manager Dx programinė įranga.

Norėdami sukurti naują plokštelės failą, atlikite šiuos veiksmus:

n Atidarykite plokštelės failą per „Plate Editor“ (plokštelės redaktorius).

n Pasirinkite plokštelės tipą.

Pastaba. Plokštelės faile nurodytas plokštelės tipas turi būti toks pats kaip reakcijos
modulyje.

n Pasirinkite, kokį nuskaitymo režimą naudoti protokole.

n Pasirinkite, kokius fluoroforus naudoti plokštelėje.

n Pasirinkite mėginio tipą, tikslus ir mėginius.

n Jei reikia, pasirinkite kopijas.

n Įrašykite plokštelės išdėstymą.

Patarimas. Norėdami sukurti naują plokštelę iš anksčiau įrašytų arba pavyzdinių plokštelių failų,
žr. Esamo plokštelės failo atvėrimas lange „Plate Editor“ (plokštelės redaktorius), p. 118.

Naujos plokštelės failo atvėrimas lange „Plate Editor“ 
(plokštelės redaktorius)
CFX Manager Dx programinė įranga turi kelias galimybes naujos plokštelės failui atverti:

n Lange „Home“ (pagrindinis)

n Dialogo lange „Startup Wizard“ (paleisties vedlys)

n Dialogo lange „Run Setup“ (paleidimo sąranka)
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Naujos plokštelės failo atvėrimas lange „Home“ (pagrindinis)

u Pasirinkite „File > New > Plate“ (failas > naujas > plokštelė).

Atveriamas langas „Plate Editor“ (plokštelės redaktorius), kuriame rodomas numatytasis
plokštelės failas pasirinktam instrumentui.

Patarimas. Daugiau informacijos apie numatytojo plokštelės failo nustatymą žr. Numatytųjų
failų nuostatų keitimas, p. 65.

Kaip atverti naujos plokštelės failą lange „Startup Wizard“ (paleisties vedlys)

1. Lange „Home“ (pagrindinis) atlikite vieną iš šių veiksmų ir atverkite „Startup Wizard“ (paleisties
vedlys), jeigu jis dar nerodomas:

n Pasirinkite „View > Startup Wizard“ (peržiūrėti > paleisties vedlys).

n Įrankių juostoje spustelėkite „Startup Wizard“ (paleisties vedlys).

Pagal numatytąsias nuostatas „Startup Wizard“ (paleisties vedlys) parodo kortelę „Run Setup“ 
(paleidimo sąranka) su pasirinktu CFX96 instrumentu.

2. Jeigu reikia, išplečiamajame sąraše pasirinkite instrumento tipą.

3. Norėdami sukurti naują plokštelę, spustelėkite „User-defined“ (vartotojo nustatytas) kaip
paleidimo tipą.

Atveriamas dialogo langas „Run Setup“ (paleidimo sąranka), kuriame rodoma kortelė „Protocol“ 
(protokolas).

4. Spustelėkite kortelę „Plate“ (plokštelė) ir „Create New“ (kurti naują).

Atveriamas langas „Plate Editor“ (plokštelės redaktorius), kuriame rodoma numatytoji plokštelės
schema pasirinktam instrumentui.
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Kaip atverti naujos plokštelės failą dialogo lange „Run Setup“ (paleidimo sąranka)

1. Lange „Home“ (pagrindinis) atlikite vieną iš šių veiksmų ir atverkite dialogo langą „Run Setup“ 
(paleidimo sąranka):

n Pasirinkite „Run > User-defined Run“ (paleidimas > vartotojo nustatytas paleidimas).

n Įrankių juostoje spustelėkite „User-defined Run Setup“ (vartotojo nustatyto paleidimo
sąranka).

Dialogo langas „Run Setup“ (paleidimo sąranka) atveria kortelę „Protocol“ (protokolas).

2. Norėdami sukurti naują plokštelę, spustelėkite kortelę „Plate“ (plokštelė) ir „Create New“ (kurti
naują).

Atveriamas langas „Plate Editor“ (plokštelės redaktorius), kuriame rodoma numatytoji plokštelės
schema pasirinktam instrumentui.
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Esamo plokštelės failo atvėrimas lange „Plate Editor“ 
(plokštelės redaktorius)
CFX Manager Dx programinė įranga pateikia mėginių plokštelės failus, kuriuos galite redaguoti ir
įrašyti kaip naują plokštelę. Taip pat galite sukurti naują failą iš anksčiau įrašyto plokštelės failo.

Kaip atidaryti mėginio plokštelės failą

1. Lange „Home“ (pagrindinis) pasirinkite „File > Open > Plate“ (failas > atverti > plokštelė).

„Windows Explorer“ atveriamas CFX Manager Dx aplanko „Sample files“ (mėginių failai) vietoje.

2. Atverkite aplanką „Sample files“ (mėginių failai), o tada – aplanką „Plates“ (plokštelės).

3. Pasirinkite reikiamą plokštelę ir spustelėkite „Open“ (atverti).

Lange „Plate Editor“ (plokštelės redaktorius) atveriamas mėginių plokštelės failas.

4. Pasirinkite „File > Save As“ (failas > įrašyti kaip) ir įrašykite plokštelės failą nauju pavadinimu ar
naujame aplanke.

Kaip atidaryti anksčiau įrašytą plokštelės failą

1. Lange „Home“ (pagrindinis) pasirinkite „File > Open > Plate“ (failas > atverti > plokštelė), raskite ir
pasirinkite tikslinę plokštelę, tada spustelėkite „Open“ (atverti).

Lange „Plate Editor“ (plokštelės redaktorius) atveriama tikslinė plokštelė.

2. Pasirinkite „File > Save As“ (failas > įrašyti kaip) ir įrašykite plokštelės failą nauju pavadinimu ar
naujame aplanke.
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Naujo plokštelės failo nustatymas
Patarimas. Jei jūsų plokštelės faile yra reikalingų parametrų (pvz., jei redaguojate mėginį ar
esamą plokštelės failą), galite šį skyrių praleisti. Tęskite, kaip nurodyta skirsnyje Pasirenkamųjų
parametrų priskyrimas plokštelės failui, p. 126.

Naujiems plokštelės failams reikalingi šie parametrai:

n Plokštelės dydis

n Plokštelės tipas

n Nuskaitymo režimas

n Vienas fluoroforas (dažas)

n Vienas mėginio tipas

Plokštelės dydžio ir tipo pasirinkimas

Svarbu. Plokštelės dydį turite pasirinkti per plokštelės sąranką. Negalite keisti plokštelės dydžio
paleidimo metu arba po jo.

Programinėje įrangoje plokštelės dydis ir tipas pritaikomi visiems šulinėliams. Įsitikinkite, kad
pasirinktas plokštelės dydis yra toks pat, kaip plokštelės, kurią naudosite per paleidimą.

„Bio-Rad“ CFX96 ir „CFX96 Deep Well“ priemonės sukalibruotos gamykloje daugeliui fluorescencinių
dažų ir plokštelių derinių. Kalibravimas priklauso nuo prietaiso, dažų ir plokštelės tipo. Įsitikinkite, kad
fluoroforas, kurį ketinate naudoti, sukalibruotas pagal pasirinktą plokštelės tipą.

Nuskaitymo režimo pasirinkimas

„CFX96 ir „CFX96 Deep Well“ sistemos sužadina ir aptinka fluoroforus penkiuose kanaluose. Visos
sistemos taiko kelis duomenų gavimo nuskaitymo režimus fluorescencijos duomenims paleidimo metu
gauti.

CFX Manager Dx programinė įranga teikia tris skenavimo režimus:

n Visi kanalai

o Skenuojami „CFX96 ir „CFX96 Deep Well“ sistemų 1–5 kanalai
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n SYBR® /FAM

o Skenuojamas tik 1 kanalas

o Galimas greitasis skenavimas

n FRET

o Skenuojamas tik FRET kanalas

o Galimas greitasis skenavimas

Fluoroforų pasirinkimas

Svarbu. Prieš pradedant paleidimą, CFX Manager Dx programinė įranga plokštelė patikrina, ar
jūsų plokštelėje nurodyti fluoroforai yra kalibruoti su jūsų instrumentu. Negalite paleisti plokštelės,
jeigu joje yra fluoroforų, kurie nebuvo kalibruoti instrumente.

Prieš paleisdami į plokštelę turite įkelti bent vieną fluoroforą. Šiuo momentu galite pridėti tiek
fluoroforų, kiek reikia, bet plokštelėje turi būti bent vienas fluoroforas. Pasirinkti fluoroforai „Target
Names“ (tikslų pavadinimai) parodomi kaip tikslų parinktys.

Dialogo lange „Select Fluorophores“ (pasirinkti fluoroforus) įkeliate fluoroforus (arba plokštelės dažus)
„Plate Editor“ (plokštelės redaktorius) šulinėlių įkėlimo valdikliuose. Fluoroforai, parodomi dialogo
lange „Select Fluorophores“ (pasirinkti fluoroforus), priklauso nuo jūsų pasirinkto nuskaitymo režimo.

n Visi kanalai

Parodomi visi galimi fluoroforai.

Patarimas. Galite pridėti tiek fluoroforų, kiek reikia, tačiau į kiekvieną šulinėlį galite įdėti tik
vieną fluoroforą kanalui.

n SYBR®/FAM

Parodomi tik 1 kanalo fluoroforai.

n FRET

Parodomas tik 6 kanalo fluoroforas.

Patarimas. 6 kanalo FRET fluoroforas rodomas tik tada, kai FRET yra pasirinktas
nuskaitymo režimas. Jis negalimas „All Channels“ (visi kanalai) nuskaitymo režimu.

Pastaba. Jūs negalite fluoroforų pridėti tiesiogiai į dialogo langą „Select Fluorophore“ (pasirinkti
fluoroforą) arba iš jo pašalinti. Privalote naujus fluoroforus kalibruoti naujame instrumente
naudodami „Calibration Wizard“ (kalibravimo vedlys). Po kalibravimo naujas fluoroforas
automatiškai įtraukiamas į sąrašą.
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Mėginių tipų pasirinkimas

Svarbu. Prieš paleisdami turite pasirinkti bent vieną mėginio tipą, kurį priskirti plokštelių
šulinėliams.

CFX Manager Dx programinė įranga galimi penki mėginių tipai:

n „Unknown“ (nežinoma)

n „Standard“ (standartinis)

n NTC (nėra šablono kontrolės)

n „Positive Control“ (teigiama kontrolė)

n „Negative Control“ (neigiama kontrolė)

n NRT (nėra atvirkštinės transkriptazės)

Priskiriate mėginių tipus plokštelių šulinėliams.

Naujos plokštelės nustatymas

Kaip nustatyti naują plokštelę

1. Lange „Plate Editor“ (plokštelės redaktorius) atverkite naują plokštelę.

2. Norėdami nustatyti plokštelės dydį, pasirinkite „Settings > Plate Size“ (nuostatos > plokštelės
dydis) ir išplečiamajame meniu pasirinkite tinkamą plokštelės dydį.

3. Norėdami nustatyti plokštelės tipą, pasirinkite „Settings > Plate Type“ (nuostatos > plokštelės
tipas), o tada išplečiamajame meniu pasirinkite „BR White“ (BR baltas) arba „BR Clear“ (BR
skaidrus).

4. Arba galite meniu „Settings“ (nuostatos) keisti skaičių rašymo išraišką ir rodomus matavimo
vienetus:

n Norėdami pakeisti numeravimo tvarką, pasirinkite „Settings > Number Convention“ 
(nuostatos > skaičių rašymo išraiška), o tada pasirinkite „Scientific Notation“ (standartinė
skaičiaus išraiška).

Patarimas. Pagal numatytąsias nuostatas pasirinkta „Scientific Notation“ (standartinė
skaičiaus išraiška). Tokiu atveju pasirinkus „Scientific Notation“ (standartinė skaičiaus
išraiška), numatytoji nuostata pašalinama ir nustatoma standartinės formos skaičių
rašymo išraiška.

n Norėdami pakeisti rodomus vienetus, pasirinkite „Settings > Units“ (nuostatos > matavimo
vienetai) ir pasirinkite naują matavimo vieneto reikšmę.
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5. Norėdami nustatyti nuskaitymo režimą, pasirinkite tinkamą nuskaitymo režimą išplečiamajame
sąraše „Scan Mode“ (nuskaitymo režimas), esančiame lango „Plate Editor“ (plokštelės
redaktorius) įrankių juostoje.

6. Pasirinkite reikiamus plokštelės flouroforus:

a. Dešinėje srityje spustelėkite „Select Fluorophores“ (pasirinkti flouroforus).

Pasirodo dialogo langas „Select Fluorophores“ (pasirinkti flouroforus). Pamatysite
fluoroforus, skirtus nuskaitymo režimo tipui, kurį pasirinkote atlikdami 5 veiksmas,
pavyzdžiui:

b. Norėdami pasirinkti fluoroforą, spustelėkite jo žymės langelį.

Patarimas. Norėdami pašalinti iš sąrašo fluoroforą, pašalinkite jo žymės langelio
„Selected“ (pasirinkta) žymėjimą.

c. Norėdami pakeisti fluoroforo rodmens spalvą, spustelėkite jo spalvą stulpelyje „Color“ 
(spalvos).

Pastaba. Jūsų pasirinkta spalva fluoroforas rodomas lange „Plate Editor“ (plokštelės
redaktorius) ir lango „Data Analysis“ (duomenų analizė) diagramose.
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d. Dialogo lange „Color“ (spalva) pasirinkite norimą spalvą arba spustelėkite „Define Custom
Colors“ (nustatyti pasirinktines spalvas) ir sukurkite naują spalvą, kuria turi būti rodomas
fluoroforas.

e. Spustelėkite OK (gerai), įrašykite pakeitimus ir išeikite iš dialogo lango „Select Fluorophores“ 
(pasirinkti flouroforus).

7. Turite pasirinkti bent vieną šulinėlį, į kurį turi būti įkeliamas mėginio tipas. Pagal numatytąsias
nuostatas pasirinktas šulinėlis A1.

Plokštelių srityje atlikite vieną iš toliau nurodytų veiksmų:

n Tam, kad įkeltumėte kelis gretimus šulinėlius, spustelėkite šulinėlį ir vilkite iki tikslinio
šulinėlio.

n Tam, kad įkeltumėte kelis negretimus šulinėlius, laikykite nuspaustą klavišą „Control“ 
(valdymas) ir spustelėkite kiekvieną šulinėlį.

n Tam, kad įkeltumėte visą stulpelį su tokio paties tipo mėginiais, spustelėkite stulpelio numerį.

n Tam, kad įkeltumėte visą eilutę, spustelėkite eilutės numerį.

n Tam, kad įkeltumėte visą plokštelę, spustelėkite viršutinį kairįjį plokštelės kampą.

Pavyzdžiui:
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8. Išplečiamajame meniu „Sample Type“ (mėginio tipas) priskirkite mėginio tipą pasirinktam
šulinėliui arba šulinėliams.

9. Visiems šulinėliams, turintiems mėginio tipą, priskirkite bent vieną fluoroforą. Galite šulinėliui ar
šulinėlių grupei priskirti daugiau nei vieną fluoroforą.

Pastaba. Vienam kanalui galite priskirti tik vieną fluoroforą. Jūs negalite priskirti daugiau nei
vieno fluoroforo iš to paties kanalo į tą patį šulinėlį.

Patarimas. Galite susieti tikslą su fluoroforu arba galite dabar tik priskirti fluoroforą, o tikslą
su fluoroforu susieti paskui, kai atliksite eksperimentą.

n Jei norite tik priskirti fluoroforą pasirinktiems šulinėliams, dešinės srities dalyje „Target
Names“ (tikslų pavadinimai) pažymėkite konkretaus fluoroforo žymės langelį „Load“ 
(įkėlimas).

n Jei norite susieti tikslą su fluoroforu, dalyje „Target Names“ (tikslų pavadinimai)
išplečiamajame sąraše pasirinkite tikslo pavadinimą konkrečiam fluoroforui. Programinė
įranga automatiškai pažymi žymės langelį „Load“ (įkėlimas).

10. Jei šulinėliams priskirtas mėginio tipas yra „Standard“ (standartinis), turite įkelti koncentracijos
reikšmę. Kiekvieno šulinėlio koncentracijos reikšmė gali būti skirtinga. Pagal numatytąsias
nuostatas CFX Manager Dx programinė įranga įkelia 1.00E+06 koncentracijos reikšmę visiems
šulinėliams, kuriems priskirtas mėginio tipas yra „Standard“ (standartinis). Jei reikia, galite
pakeisti reikšmę.

a. Plokštelių srityje pasirinkite šulinėlį ar šulinėlių grupę „Standard“ (standartinis).

b. Dalyje „Concentration“ (koncentracija) spustelėkite „Load“ (įkėlimas), kad įkeltumėte
pasirinkto šulinėlio arba šulinėlių reikšmę.
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c. (Neprivaloma) Norėdami įkelti kitą koncentracijos reikšmę, tekstiniame langelyje
„Concentration“ (koncentracija) įrašykite naują reikšmę ir paspauskite „Enter“ (įvesti).

d. Atlikite šį veiksmą visiems šulinėliams, kurių mėginio tipas yra „Standard“ (standartinis).

Patarimas. Tam, kad įkeltumėte tą pačią koncentracijos reikšmę visiems šulinėliams,
kurie yra „Standard“ (standartinis), įsitikinkite, kad išplečiamajame sąraše po
„Concentration“ (koncentracija) reikšme rodoma „<All>“ (visi). Tam, kad įkeltumėte tą
pačią koncentracijos reikšmę visiems šulinėliams, kuriems priskirtas konkretus
fluoroforas, spustelėkite išplečiamąjį sąrašą ir pasirinkite fluoroforą.

11. Spustelėkite mygtuką OK (gerai), kad įrašytumėte naują plokštelę.
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Pasirenkamųjų parametrų priskyrimas plokštelės failui
Plokštelės faile yra informacijos apie kiekvieno šulinėlio, į kurį įdėta mėginio paleisti, turinį.
Po paleidimo CFX Manager Dx programinė įranga susieja šulinėlio turinį su fluorescencijos
duomenimis, gautais įgyvendinus protokolą, ir lange „Data Analysis“ (duomenų analizė) atliekama
atitinkama analizė.

Prieš eksperimento paleidimą, paleidimo metu ar net po paleidimo CFX Manager Dx kiekvienam
plokštelės šulinėliui galite priskirti parametrus. Galite priskirti parametrus esančiame plokštelės faile
arba naujame plokštelės faile. Tai šie parametrai:

n „Target names“ (tikslo pavadinimas) – kiekvieno įdėto šulinėlio objekto tikslas ar tikslai (genai
ar sekos).

n „Sample names“ (mėginių pavadinimai) – identifikatorius ar būsena, kuri atitinka mėginį
kiekviename šulinėlyje, pvz., 0Hr, 1Hr arba 2Hr.

Patarimas. Tikslų ir mėginių pavadinimai turi būti tokie patys tarp šulinėlių, kad būtų galima
palyginti duomenis kortelėje „Gene Expression“ (geno ekspresija) lange „Data Analysis“ 
(duomenų analizė). Kiekvienas pavadinimas turi būti tokiomis pačiomis didžiosiomis
raidėmis, skyryba ir tarpais. Pavyzdžiui, „Actin“ nėra tas pats, kaip „actin“, „2Hr“ nėra tas
pats, kaip „2 hr“ ir „Mouse 1“ nėra tas pats, kaip „mouse1“. Norėdami užtikrinti pavadinimų
vientisumą, pavadinimus įveskite į bibliotekų skyrių, esantį „User > User Preferences > Plate“ 
(vartotojas > vartotojo nuostatos > plokštelė) lange „Home“ (pagrindinis).

n „Biological sets“ (biologiniai rinkiniai) – identifikatorius arba būsena, kuri atitinka šulinėlių
rinkinį.

n „Replicates“ (kopijos) – kiekvienas šulinėlis, kuris naudojamas analizuojant tokį patį mėginių
ir tikslų derinį, tai yra pakartojant qPGR reakcijas.

n Skiedimo serijos – kiekis, skirtas pakeisti „Standard“ (standartinis) mėginio tipo koncentraciją
kopijų grupėje, kad būtų sukurta standartinė duomenų kreivė analizei.

Tikslo priskyrimas šulinėliams
Patarimas. Tokio paties pavadinimo tikslą galite priskirti vienam ar keliems šulinėliams. Taip pat
galite kelis tikslus priskirti tam pačiam šulinėliui.

Tikslo priskyrimas šulinėliui ar šulinėlių grupei

1. Lange „Plate Editor“ (plokštelės redaktorius) įsitikinkite, kad šulinėliui ar šulinėlių grupei buvo
priskirtas mėginio tipas.

Informacijos apie mėginių tipų priskyrimą šulinėliams žr. Mėginių tipų pasirinkimas, p. 121.
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2. Plokštelių srityje pasirinkite šulinėlį ar šulinėlių grupę:

n Norėdami pasirinkti atskirą šulinėlį, jį spustelėkite.

n Norėdami pasirinkti kelis gretimus šulinėlius, spustelėkite šulinėlį ir nutempkite jį į norimą
šulinėlį.

n Norėdami pasirinkti kelis negretimus šulinėlius, laikykite nuspaustą klavišą „Control“ 
(valdymas) ir spustelėkite kiekvieną šulinėlį.

n Norėdami pasirinkti visą stulpelį su tokio paties tipo mėginiais, spustelėkite stulpelio numerį.

n Norėdami pasirinkti visą eilutę, spustelėkite eilutės numerį.

3. Dešiniajame lange iš išplečiamojo sąrašo „Target Name“ (tikslo pavadinimas) pasirinkite
kiekvieno pasirinkto fluoroforo pavadinimą.

4. 3 veiksmas pakartokite kiekvienam šulinėliui ir šulinėlių grupei, kuriai turite priskirti tikslą.

Patarimas. Kiekvienam pasirinktam fluoroforui galite priskirti tokį patį ar skirtingą tikslo
pavadinimą.

5. Spustelėkite OK (gerai) ir patvirtinkite pakeitimus bei įrašykite plokštelę.

Tikslo pavadinimo šalinimas

u Norėdami pašalinti tikslo pavadinimą iš pasirinkto šulinėlio ar šulinėlių grupės, pašalinkite jo
žymės langelio „Load“ (įkėlimas) žymėjimą.

Svarbu. Pašalinus šulinėlio tikslo pavadinimą, taip pat pašalinamas jo susijęs fluoroforas. Būkite
atsargūs šalindami šulinėlio tikslo pavadinimą.

Tikslo pavadinimo įtraukimas į sąrašą

u Norėdami tikslo pavadinimą įtraukti į išplečiamąjį sąrašą, atlikite šiuos veiksmus:

n Išplečiamajame sąraše „Target Name“ (tikslo pavadinimas) įrašykite pavadinimą ir
paspauskite „Enter“ (įvesti).

Patarimas. Viename sąraše įrašyti tikslo pavadinimai rodomi visuose kituose tikslo
sąrašuose.
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n Išplečiamojo sąrašo dešinėje spustelėkite žalią + simbolį, įrašykite tikslo pavadinimą ir
paspauskite „Enter“ (įvesti).

n Įrankių juostoje spustelėkite „User Preferences“ (vartotojo nuostatos) ir bibliotekoje „Target
Names“ (tikslo pavadinimas), esančioje kortelėje „Plate“ (plokštelė), įrašykite pavadinimą.

Svarbu. Jūsų į išplečiamąjį sąrašą įrašyti tikslų pavadinimai taikomi tik naudojamai plokštelei
ir tik jeigu pavadinimą priskiriate šulinėliui ir įrašote plokštelės schemą. Jeigu šulinėliui
nepriskiriate pavadinimo ir įrašote plokštelės schemą, pavadinimas neįrašomas ir jo
negalima naudoti ateityje. Norėdami tikslo pavadinimą įrašyti visam laikui, jį taip pat įrašykite į
biblioteką „Target Names“ (tikslų pavadinimai) naudodami dialogo langą „User Preferences“ 
(vartotojo nuostatos). Jūsų į biblioteką įtrauktus pavadinimus bus galima naudoti jums vėl
atvėrus langą „Plate Editor“ (plokštelės redaktorius). Daugiau informacijos žr. Numatytųjų
plokštelės parametrų nustatymas, p. 68.

Tikslo pavadinimo šalinimas iš sąrašo

1. Įrankių juostoje spustelėkite „User Preferences“ (vartotojo nuostatos).

Parodomas dialogo langas „User Preferences“ (vartotojo nuostatos), kuriame rodoma kortelė
„Plate“ (plokštelė).

2. Bibliotekoje „Target Names“ (tikslų pavadinimai), esančioje kortelėje „Plate“ (plokštelė),
pasirinkite šalinamą pavadinimą ir paspauskite klavišą „Delete“ (šalinti).

3. Spustelėkite OK (gerai) ir įrašykite pakeitimus bei išeikite iš dialogo lango „User Preferences“ 
(vartotojo nuostatos).

Svarbu. Negalite pašalinti tikslų pavadinimų, kuriuos įrašėte su plokštelės failu. Pasirinktiniai
pavadinimai, kuriuos įrašėte į išplečiamąjį sąrašą „Target Names“ (tikslų pavadinimai),
nenaudojote ir įrašėte su plokštele, yra automatiškai pašalinami iš sąrašo. Pavadinimai,
kuriuos pašalinate iš bibliotekos „Target Names“ (tikslų pavadinimai), yra visam laikui
pašalinami iš programinės įrangos ir vartotojas daugiau jų naudoti negali. Būkite atsargūs,
kai šalinate tikslo pavadinimus.

Mėginio pavadinimo priskyrimas šulinėliams
Pastaba. Tam, kad priskirtumėte mėginio pavadinimą, turite pasirinktiems šulinėliams priskirti
bent vieną fluoroforą. Jei pasirinktiems šulinėliams nepriskirtas fluoroforas, išplečiamasis sąrašas
„Sample Names“ (mėginių pavadinimai) išjungtas. Informaciją apie fluoroforų priskyrimą žr.
skirsnyje Tikslo priskyrimas šulinėliams, p. 126.

Patarimas. Galite priskirti tik vieną mėginio pavadinimą kiekvienam šulinėliui arba šulinėlių
grupei.

128 | Sistemos CFX96 Dx ir CFX96 Deep Well Dx



Pasirenkamųjų parametrų priskyrimas plokštelės failui

Mėginio pavadinimo priskyrimas šulinėliui ar šulinėlių grupei

1. Lange „Plate Editor“ (plokštelės redaktorius) įsitikinkite, ar šulinėliui arba šulinėlių grupei buvo
priskirtas fluoroforas.

2. Plokštelių srityje pasirinkite šulinėlį ar šulinėlių grupę.

3. Dešinėje srityje iš išplečiamojo sąrašo „Sample Names“ (mėginių pavadinimai) pasirinkite
pavadinimą.

4. 3 veiksmas pakartokite kiekvienam šulinėliui ir šulinėlių grupei, kuriai turite priskirti mėginio
pavadinimą.

5. Spustelėkite OK (gerai) ir patvirtinkite pakeitimus bei įrašykite plokštelę.

Mėginio pavadinimo šalinimas

u Norėdami pašalinti mėginio pavadinimą iš pasirinkto šulinėlio ar šulinėlių grupės, pašalinkite jo
žymės langelio „Load“ (įkėlimas) žymėjimą.

Mėginio pavadinimo įtraukimas į sąrašą

u Norėdami mėginio pavadinimą įtraukti į išplečiamąjį sąrašą, atlikite vieną iš toliau nurodytų
veiksmų:

n Išplečiamajame sąraše „Sample Names“ (mėginių pavadinimai) įrašykite pavadinimą ir
paspauskite „Enter“ (įvesti).

n Išplečiamojo sąrašo dešinėje spustelėkite žalią + simbolį ir įrašykite mėginio pavadinimą.

n Įrankių juostoje spustelėkite „User Preferences“ (vartotojo nuostatos) ir bibliotekoje „Sample
Names“ (mėginių pavadinimai), esančioje kortelėje „Plate“ (plokštelė), įrašykite pavadinimą.
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Svarbu. Jūsų į išplečiamąjį sąrašą įrašyti mėginių pavadinimai taikomi tik naudojamai
plokštelei ir tik jeigu pavadinimą priskiriate šulinėliui ir įrašote plokštelės schemą. Jeigu
šulinėliui nepriskiriate pavadinimo ir įrašote plokštelės schemą, pavadinimas neįrašomas ir jo
negalima naudoti ateityje. Norėdami mėginio pavadinimą įrašyti visam laikui, jį taip pat
įrašykite į biblioteką „Sample Names“ (mėginių pavadinimai), naudodami dialogo langą „User
Preferences“ (vartotojo nuostatos). Jūsų į biblioteką įtrauktus pavadinimus bus galima
naudoti jums vėl atvėrus langą „Plate Editor“ (plokštelės redaktorius). Daugiau informacijos
žr. Numatytųjų plokštelės parametrų nustatymas, p. 68.

Mėginio pavadinimo šalinimas iš sąrašo

1. Įrankių juostoje spustelėkite „User Preferences“ (vartotojo nuostatos).

Parodomas dialogo langas „User Preferences“ (vartotojo nuostatos), kuriame rodoma kortelė
„Plate“ (plokštelė).

2. Bibliotekoje „Sample Names“ (mėginių pavadinimai), esančioje kortelėje „Plate“ (plokštelė),
pasirinkite šalinamą pavadinimą ir paspauskite klavišą „Delete“ (šalinti).

3. Spustelėkite OK (gerai) ir įrašykite pakeitimus bei išeikite iš dialogo lango „User Preferences“ 
(vartotojo nuostatos).

Svarbu. Negalite pašalinti mėginių pavadinimų, kuriuos įrašėte su plokštelės failu.
Pasirinktiniai pavadinimai, kuriuos įrašėte į sąrašą „Sample Names“ (mėginių pavadinimai),
nenaudojote ir įrašėte su plokštele, yra automatiškai pašalinami iš išplečiamojo sąrašo.
Pavadinimai, kuriuos pašalinate iš bibliotekos „Sample Names“ (mėginių pavadinimai), yra
visam laikui pašalinami iš programinės įrangos ir vartotojas daugiau negali jų naudoti.
Šalindami mėginių pavadinimus, būkite atidūs.

Biologinių rinkinių priskyrimas šulinėliams
Pastaba. Tam, kad priskirtumėte biologinį rinkinį, turite pasirinktiems šulinėliams priskirti bent
vieną fluoroforą. Priskiriant fluoroforą, įjungiamas išplečiamasis sąrašas „Biological Set Name“ 
(biologinio rinkinio pavadinimas). Informacijos apie fluoroforų priskyrimą žr. Tikslo priskyrimas
šulinėliams, p. 126.

Patarimas. Galite priskirti vieną biologinį rinkinį kiekvienam šulinėliui arba šulinėlių grupei.

Biologinio rinkinio priskyrimas šulinėliui arba šulinėlių grupei

1. Parinkčių srityje „View“ (rodymas), esančioje lange „Plate Editor“ (plokštelės redaktorius), pasirinkite
žymės langelį „Biological Set“ (biologinis rinkinys).

2. Lange „Plate Editor“ (plokštelės redaktorius) įsitikinkite, ar šulinėliui arba šulinėlių grupei buvo
priskirtas fluoroforas.

3. Plokštelių srityje pasirinkite šulinėlį ar šulinėlių grupę.
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4. Dešinėje srityje pasirinkite elementą iš išplečiamojo sąrašo „Biological Set Name“ (biologinio
rinkinio pavadinimas) .

CFX Manager Dx programinė įrangaautomatiškai pažymi žymės langelį „Load“ (įkėlimas).

5. 4 veiksmas pakartokite kiekvienam šulinėliui ir šulinėlių grupei, kuriai turite priskirti biologinį
rinkinį.

6. Spustelėkite OK (gerai) ir patvirtinkite pakeitimus bei įrašykite plokštelę.

Patarimas. Priskiriant biologinių rinkinių pavadinimus šulinėliams, įjungiamas rodinys
„Biological Set Analysis Options“ (biologinio rinkinio analizės parinktys) dialogo lange
„Experiment Settings“ (eksperimento nuostatos), kuriame galite atlikti mėginių analizę,
pasirinkę vieną iš keturių konfigūracijų. Daugiau informacijos žr. Eksperimento nuostatų
keitimas, p. 137.

Biologinio rinkinio šalinimas

u Tam, kad pašalintumėte biologinį rinkinį iš pasirinkto šulinėlio ar šulinėlių grupės, pašalinkite
žymės langelio „Load“ (įkėlimas) žymėjimą.

Biologinio rinkinio įtraukimas į sąrašą

u Tam, kad biologinį rinkinį įtrauktumėte į išplečiamąjį sąrašą, įrašykite pavadinimą į išplečiamąjį
laukelį „Biological Set Name“ (biologinio rinkinio pavadinimas) ir paspauskite „Enter“ (įvesti).

Svarbu. Jūsų į išplečiamąjį sąrašą įrašyti biologinių rinkinių pavadinimai taikomi tik
naudojamai plokštelei ir tik jeigu pavadinimą priskiriate šulinėliui ir įrašote plokštelės schemą.
Jeigu šulinėliui nepriskiriate pavadinimo ir įrašote plokštelės schemą, pavadinimas
neįrašomas ir jo negalima naudoti ateityje.

Visų biologinių rinkinių plokštelėje peržiūrėjimas

u Pasirinkite žymės langelį „Biological Set“ (biologinis rinkinys) parinkčių srityje „View“ (rodymas),
esančioje lango „Editor“ (redaktorius) apačioje.
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Parodomi visų šulinėlių atitinkami biologinių rinkinių pavadinimai, jei priskirti. Valdymo elementas
„Biological Set Name“ (biologinio rinkinio pavadinimas) rodomas dešinėje srityje.

Norėdami paslėpti biologinius rinkinius, pašalinkite žymės langelio „Biological Set“ (biologinis
rinkinys) žymėjimą parinkčių srityje „View“ (rodymas) .

Kopijų skaičiaus priskyrimas šulinėliams
Svarbu. Kad būtų galima priskirti kopijų skaičių, pasirinkti šulinėliai turi būti su identišku šulinėlių
turiniu. Tai yra pasirinkti šulinėliai turi būti tokio paties mėginio tipo ir fluoroforo. Jeigu taikoma,
jiems taip pat turi būti priskirtas toks pats tikslo ir mėginio pavadinimas bei toks pats biologinis
rinkinys. Jeigu jie ne tokie patys, CFX Manager Dx programinė įranga šios parinkties neįjungia.

Kopijų skaičiaus priskyrimas šulinėlių grupei

1. Lange „Plate Editor“ (plokštelės redaktorius) įsitikinkite, ar šulinėlių grupės turinys yra vienodas.

2. Plokštelių lange pasirinkite šulinėlių grupės tikslą.

3. Norėdami tokį patį kopijos numerį priskirti visiems pasirinktiems šulinėliams, dešinėje srityje
skyriuje „Replicate #“ (kopijos Nr.) į langelį įrašykite kopijos numerį ir pasirinkite „Load“ (įkėlimas).

4. (Neprivaloma) Norėdami kopijų serijas taikyti pasirinktų šulinėlių rinkiniui, atlikite šiuos veiksmus:

a. Spustelėkite „Technical Replicates“ (techninės kopijos), „Replicate Series“ (kopijų serijos).
Pasikeičia skyrius „Replicate #“ (kopijos Nr.), kad būtų parodytos šios parinktys:

n „Replicate size“ (kopijos dydis) – skaičius, kuris reiškia šulinėlių kiekvienoje kopijų
grupėje, skaičių

n „Starting replicate #“ (pradinės kopijos Nr.) – pasirinktos kopijų grupės pirmasis
numeris kopijų serijoje
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Pastaba. Pagal numatytuosius parametrus CFX Manager Dx programinė įranga rodo
pradinės kopijos numerį kaip didesnį skaičių nei paskutinį kopijos skaičių, priskirtą
plokštelei. Pavyzdžiui, jeigu paskutinis kopijos numeris plokštelėje yra penki, kitas
pradinis skaičius yra šeši. Pradinį numerį galite pakeisti į bet kurį dar nepriskirtą numerį.

n Įkėlimo kryptis (horizontali ar vertikali)

b. Spustelėkite „Apply“ (taikyti) ir pritaikykite parametrus serijai bei grįžkite į rodmenį „Replicate
#“ (kopijos Nr.).

5. Spustelėkite OK (gerai) ir patvirtinkite pakeitimus bei įrašykite plokštelę.

Šulinėlio pašalinimas iš kopijų serijos

u Pasirinkite šalinamą šulinėlį ar šulinėlių grupę ir panaikinkite žymės langelio „Replicate # Load“ 
(kopijos numerio įkėlimas) žymėjimą.

Taip pat galite spustelėti „Clear Replicate #“ (išvalyti kopijos Nr.) ir iš pasirinkto šulinėlio ar
šulinėlių grupės pašalinti kopijos numerį.

Skiedimo serijų priskyrimas standartinių tipų mėginiams
Kaip jau minėta, visiems šulinėliams su standartinio tipo mėginiais turi būti priskirta koncentracijos
reikšmė. Skiedimo serijas galite priskirti keliems šulinėliams su standartinio tipo mėginiais.

Pastaba. Norint skiedimo serijas priskirti šulinėlių grupei, šulinėliai turi būti įtraukti į kopijų serijas.
Informacijos apie šulinėlių įtraukimą į kopijų serijas žr. skirsnyje Kopijų skaičiaus priskyrimas
šulinėliams, p. 132.

Skiedimo serijų priskyrimas grupei šulinėlių su standartiniais mėginiais

1. Lange „Plate Editor“ (plokštelės redaktorius) įsitikinkite, kad įvykdyti šie reikalavimai:

n Šulinėlių grupės mėginių tipas yra „Standard“ (standartinis).

n Visiems grupės šulinėliams yra priskirtas bent vienas fluoroforas ir jie visi turi tuos pačius
fluoroforus.

n Visi grupės šulinėliai yra įtraukti į tą pačią kopijų seriją.

Pastaba. CFX Manager Dx programinė įranga įjungia parinktį „Dilution Series“ 
(skiedimo serijos) tik tuo atveju, jei visi pasirinkti šulinėliai atitinka šiuos kriterijus.

2. Plokštelių lange pasirinkite šulinėlių grupės tikslą.
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3. Dešinėje srityje esančioje dalyje „Concentration“ (koncentracija) spustelėkite „Dilution series“ 
(skiedimo serijos). Dalis „Concentration“ (koncentracija) pasikeičia, kad būtų parodytos šios
parinktys:

n „Starting concentration“ (pradinė koncentracija) – koncentracijos reikšmė, nuo kurios
prasideda serijos

n „Replicates from and to“ (kopijos nuo ir iki) – kopijos serijoje, kuriai bus taikomas
skiedimo koeficientas

n „Dilution factor“ (skiedimo koeficientas) – kiekis, kuriuo siekiama pakeisti koncentraciją
kiekvienoje kopijų grupėje

4. Nustatykite parinkčių reikšmes arba patvirtinkite numatytąsias.

5. Pagal numatytąsias nuostatas skiedimo serijos sumažinamos skiedimo koeficientu. Norėdami
padidinti skiedimo seriją, pasirinkite „Increasing“ (didinti).

6. (Neprivaloma) Pagal numatytąsias nuostatas skiedimo koeficientas taikomas visiems
fluoroforams kopijų serijose. Jei jūsų serijoje yra daugiau nei vienas fluoroforas ir norite taikyti
skiedimą vienam fluoroforui, pasirinkite jį iš išplečiamojo sąrašo.

7. Spustelėkite „Apply“ (taikyti), kad skiedimo serijos būtų taikomos šulinėlių grupei, ir grįžkite į
rodmenį „Concentration“ (koncentracija).

8. Spustelėkite OK (gerai) ir patvirtinkite pakeitimus bei įrašykite plokštelę.
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Šulinėlio turinio kopijavimas į kitą šulinėlį
Galite nukopijuoti šulinėlio turinį ir įklijuoti jį į vieną ar kelis šulinėlius. Tačiau galite kopijuoti tik vieno
šulinėlio turinį. Negalite pasirinkti kelių šulinėlių ir kopijuoti jų turinio.

Kaip nukopijuoti šulinėlio turinį į kitą šulinėlį

1. Plokštelės srityje pasirinkite šulinėlį, kurio turinį norite kopijuoti.

2. Pelės dešiniuoju mygtuku spustelėkite šulinėlį ir pasirinkite „Copy Well“ (kopijuoti šulinėlį).

3. Pasirinkite šulinėlį ar šulinėlius, į kuriuos norite įklijuoti turinį:

n Norėdami pasirinkti vieną šulinėlį, spustelėkite jį.

n Norėdami pasirinkti kelis gretimus šulinėlius, spustelėkite šulinėlį ir nutempkite jį į norimą
šulinėlį.

n Norėdami pasirinkti kelis negretimus šulinėlius, laikykite nuspaustą klavišą „Control“ 
(valdymas) ir spustelėkite kiekvieną šulinėlį.

4. Pasirinkę norimus šulinėlius, spustelėkite dešinįjį pelės mygtuką ir pasirinkite „Paste Well“ 
(įklijuoti šulinėlį).

„CFX Manager Dx programinė įranga“ įklijuoja pirmojo šulinėlio turinį į pasirinktus šulinėlius.

Pastabos pridėjimas prie šulinėlio
Prie šulinėlio galite pridėti aiškinamąją pastabą. Galite peržiūrėti šulinėliui skirtas pastabas lango
„Data Analysis“ (duomenų analizė) kortelėje „Quantification“ (kiekybinis įvertinimas).

Kaip pridėti pastabą prie šulinėlio

1. Plokštelių srityje pasirinkite šulinėlį ar šulinėlių grupę, prie kurios planuojate pridėti pastabą.

2. Apatinėje srityje esančioje dalyje „View“ (rodymas) pasirinkite „Well Note“ (šulinėliui skirta
pastaba).

Dešinėje srityje parodomas laukas „Well Note“ (šulinėliui skirta pastaba).

3. Teksto laukelyje įrašykite pastabos turinį ir paspauskite „Enter“ (įvesti).

Tekstas rodomas pasirinktų šulinėlių apačioje.

Patarimas. Jei sukūrėte ankstesnę šulinėliui skirtą pastabą, galite ją pasirinkti
išplečiamajame sąraše ir taikyti pasirinktiems šulinėliams.
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Viso šulinėlių turinio išvalymas
Galite išvalyti visą atskiro šulinėlio, šulinėlių grupės arba visos plokštelės turinį. Išvalius šulinėlius,
fluorescencijos duomenys, surinkti skaitant plokštelę, nėra pašalinami.

Išvalius šulinėlį, jo turinys pašalinamas visam laikui. Būkite atsargūs valydami šulinėlius.

Kaip išvalyti visus šulinėlių nuostatas

1. Lange „Plate Editor“ (plokštelių redaktorius) pasirinkite šulinėlį ar jų grupę plokštelių srityje:

n Norėdami pasirinkti vieną šulinėlį, spustelėkite jį.

n Norėdami pasirinkti kelis gretimus šulinėlius, spustelėkite šulinėlį ir nutempkite jį į norimą
šulinėlį.

n Norėdami pasirinkti kelis negretimus šulinėlius, laikykite nuspaustą klavišą „Control“ 
(valdymas) ir spustelėkite kiekvieną šulinėlį.

n Norėdami pasirinkti visą stulpelį su tokio paties tipo mėginiais, spustelėkite stulpelio numerį.

n Norėdami pasirinkti visą eilutę, spustelėkite eilutės numerį.

2. Dešinėje srityje spustelėkite „Clear Wells“ (išvalyti šulinėlius).

CFX Manager Dx programinė įranga išvalo visas pasirinktų šulinėlių nuostatas.

3. Spustelėkite OK (gerai) ir patvirtinkite keitimus bei įrašykite plokštelę.
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Eksperimento nuostatų keitimas
Dialogo lange „Experiment Settings“ (eksperimento nuostatos) peržiūrėkite arba pakeiskite tikslų ar
mėginių sąrašą arba pasirinkite geno ekspresijos analizės grupę ir analizės parinktį, jeigu šulinėliams
plokštelėje priskyrėte biologinių rinkinių.

Dialogo lango „Experiment Settings“ (eksperimento nuostatos) kortelėje „Targets“ (tikslai) rodomas
tikslinių pavadinimų kiekvienai PGR reakcijai sąrašas, pvz., tikslinio geno ar dominančių genų sekų.

Kortelėje „Samples“ (mėginiai) rodomas mėginių pavadinimų, kuriuo nurodomas tikslo šaltinis, pvz.,
mėginių, paimtų „1 hour (1Hr)“ (1 val.) ar nuo konkretaus atskiro („mouse1“ (1 pelė)), sąrašas.

Plokštelės nuostatų keitimas eksperimento nuostatų dialogo lange

1. Norėdami atverti dialogo langą „Experiment Settings“ (eksperimento nuostatos) atlikite šiuos
veiksmus:

n „Plate Editor“ (plokštelės redaktorius) dešinėje srityje spustelėkite „Experiment Settings“ 
(eksperimento nuostatos).

n Kortelės „Gene Expression“ (geno ekspresija) lange „Data Analysis“ (duomenų analizė)
spustelėkite „Experiment Settings“ (eksperimento nuostatos).

Atveriamas dialogo langas „Experiment Settings“ (eksperimento nuostatos), kuriame rodomas
kortelės „Targets“ (tikslai) turinys.
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2. Norėdami pridėti tikslo ar mėginio pavadinimą, atitinkamos kortelės tekstiniame langelyje „New“ 
(naujas) įrašykite pavadinimą ir spustelėkite „Add“ (pridėti).

3. Norėdami pašalinti vieną ar kelis tikslo ar mėginio pavadinimus iš sąrašo, atitinkamoje kortelėje
pasirinkite elemento žymės langelį stulpelyje „Select to Remove“ (pasirinkti ir pašalinti) ir
spustelėkite „Remove checked item(s)“ (pašalinti pažymėtą (-us) elementą (-us)).

4. CFX Manager Dx programinė įranga neįtraukia mėginio tipo NTC (nėra šablono kontrolės) iš
geno ekspresijos analizės.

Norėdami įtraukti NTC mėginių tipų, skyriuje „Exclude the following sample types“ (pašalinti šiuos
mėginių tipus) panaikinkite žymės langelio žymėjimą. Galite pašalinti šiuos mėginių tipus
pasirinkę atitinkamą žymės langelį:

n NRT (nėra atvirkštinės transkriptazės)

n „Negative Control“ (neigiama kontrolė)

n „Positive Control“ (teigiama kontrolė)

n „Standard“ (standartinis)
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5. Kortelėje „Targets“ (tikslai):

a. Norėdami tikslą pasirinkti kaip etaloną geno ekspresijos duomenų analizei, jį pasirinkite
stulpelyje „Reference“ (etalonas).

b. Norėdami paslėpti analizės nuostatas, kurios bus taikomos lango „Analysis Settings“ 
(analizės nuostatos) kortelėje „Gene Expression“ (geno ekspresija), panaikinkite „Show
Analysis Settings“ (rodyti analizės nuostatas) žymėjimą.

Programinė įranga paslepia šiuos stulpelius:

n „Color“ (spalva)

n „Show Chart“ (rodyti diagramą)

n „Auto Efficiency“ (automatinis veiksmingumas)

n „Efficiency“ (veiksmingumas) (%)

c. Norėdami pakeisti tikslo, pateikto diagramoje „Gene Expression“ (geno ekspresija), spalvą,
stulpelio „Color“ (spalva) iškylančiajame dialogo lange „Color“ (spalva), spustelėkite jos
langelį ir spustelėkite OK (gerai).

d. Norėdami tikslą diagramoje „Gene Expression“ (geno ekspresija) parodyti pasirinkta spalva,
stulpelyje „Show Chart“ (rodyti diagramą) pasirinkite jos žymės langelį.

e. Pagal numatytuosius parametrus CFX Manager Dx automatiškai apskaičiuoja tikslo santykinį
veiksmingumą, jeigu jo duomenys apima standartinę kreivę.

Norėdami panaudoti anksčiau nustatytą veiksmingumo vertę, stulpelio „Efficiency“ 
(veiksmingumas) (%) langelyje įrašykite vertę ir paspauskite klavišą „Enter“ (įvesti). CFX
Manager Dx panaikina žymės langelio „Auto Efficiency“ (automatinis veiksmingumas)
žymėjimą.

6. Kortelėje „Samples“ (mėginiai) ir atlikite šiuos veiksmus:

a. Norėdami mėginį pasirinkti kaip kontrolinį mėginį geno ekspresijos duomenų analizei,
stulpelyje „Control“ (kontrolė) pasirinkite žymės langelį.

b. Norėdami paleidimo mėginiui priskirti kontrolinę būseną, stulpelyje „Control“ (kontrolė)
spustelėkite žymės langelį.

c. Jeigu jis dar nepasirinktas, spustelėkite „Show Analysis Settings“ (rodyti analizės nuostatas)
ir peržiūrėkite arba pakeiskite analizės parametrus, kurie bus taikomi kortelėje „Gene
Expression“ (geno ekspresija). Programinė įranga paslepia stulpelius „Color“ (spalva) ir
„Show Chart“ (rodyti diagramą).
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7. Jei šulinėliams plokštelėje priskyrėte vieną ar kelis biologinius rinkinius (žr. Biologinių rinkinių
priskyrimas šulinėliams, p. 130), sąraše „Biological Set Analysis Options“ (biologinio rinkinio
analizės parinktys) pasirinkite vieną iš šių parinkčių:

n „Target vs. Sample“ (tikslo palyginimas su mėginiu) – geno ekspresijos skaičiavimuose
naudojamas tik šulinėlio mėginio pavadinimas.

n „Target vs. Biological Set“ (tikslo palyginimas su biologiniu rinkiniu) – skaičiavimuose
naudojamas tik biologinio rinkinio pavadinimas.

n „Target vs. Sample_Biological Set“ (tikslo palyginimas su mėginio biologiniu
rinkiniu) – mėginio pavadinimas ir biologinio rinkinio pavadinimas derinami, sukuriant
bendrą pavadinimą, kuris naudojamas skaičiavimuose.

n „Target vs. Biological Set_Sample“ (tikslo palyginimas su biologinio rinkinio
mėginiu – biologinio rinkinio pavadinimas derinamas su mėginio pavadinimu, sukuriant
bendrą pavadinimą, kuris naudojamas skaičiavimuose.

8. Spustelėkite OK (gerai), dialogo laukelyje „Experiment Settings“ (eksperimento nuostatos)
įrašykite parametrus ir grįžkite į langą Plate Editor (plokštelės redaktorius).

Šulinėlių grupių kūrimas
Šulinėlių grupės dalija atskirą plokštelę į šulinėlių poaibius, kuriuos galima analizuoti nepriklausomai
lange „Data Analysis“ (duomenų analizė). Kai nustatomos šulinėlių grupės, lange „Data Analysis“ 
(duomenų analizė) pasirinkite vieną duomenims, kaip nepriklausomai grupei, analizuoti. Pavyzdžiui,
nustatykite šulinėlių grupes, kad būtų analizuojami keli eksperimentai, paleisti vienoje plokštelėje,
arba kiekviena šulinėlių grupė būtų analizuojama su skirtingomis standartinėmis kreivėmis.

Pastaba. Numatytoji šulinėlių grupė yra „All Wells“ (visi šulinėliai).

Kaip kurti šulinėlių grupes

1. Norėdami atidaryti „Well Groups Manager“ (šulinėlių grupių tvarkyklė), atlikite vieną iš šių
veiksmų:

n Įrankių juostoje „Plate Editor“ (plokštelės redaktorius) spustelėkite „Well Groups“ (šulinėlių
grupės).

n Lange „Data Analysis“ (duomenų analizė) spustelėkite „Manage Well Groups“ (tvarkyti
šulinėlių grupes).
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Parodomas dialogo langas „Well Groups Manager“ (šulinėlių grupių tvarkytuvė).

2. Spustelėkite „Add“ (pridėti) ir sukurkite naują grupę. Išplečiamajame meniu rodomas pirmosios
grupės pavadinimas „Group 1“ (1 grupė).

3. Spustelėdami ir vilkdami žymeklį per šulinėlių grupę, pasirinkite šulinėlių iš šulinėlių grupės
plokštelės vaizde. Pasirinkti šulinėliai „Manager“ (tvarkytuvė) rodomi mėlynai.

4. (Neprivaloma) Norėdami pakeisti grupės pavadinimą, išplečiamajame meniu pasirinkite jos
pavadinimą ir įrašykite naują pavadinimą.

5. (Neprivaloma) Norėdami šalinti šulinėlių grupę, išplečiamajame sąraše pasirinkite jos pavadinimą
ir spustelėkite „Delete“ (šalinti).

6. Spustelėkite OK (gerai) norėdami baigti ir uždaryti langą arba spustelėkite „Cancel“ (atšaukti) ir
užverkite langą neatlikę pakeitimų.

Svarbu. Norėdami rodyti šulinėlių grupes, lango „Plate Editor“ (plokštelės redaktorius) apačioje
parinktyse „View“ (peržiūrėti) pasirinkite „Well Groups“ (šulinėlių grupės).

Naudojimo vadovas | 141



7 skyrius. Plokštelių paruošimas

Dialogo lango „Well Groups Manager“ (šulinėlių grupių tvarkytuvė) pelės
dešiniojo mygtuko meniu elementai

13 lentelė pateikti meniu elementai, esantys dialogo lange „Well Groups Manager“ (šulinėlių grupių
tvarkytuvė), kai pelės dešiniuoju mygtuku spustelite šulinėlį.

Elementas Funkcija

„Copy“ (kopijuoti) Kopijuojamas šulinėlio turinys, kurį galima įklijuoti į kitą
šulinėlį ar šulinėlius.

„Copy as Image“ (kopijuoti kaip
paveikslėlį)

Šulinėlio parinkiklio rodinys kopijuojamas kaip paveikslėlis.

„Print“ (spausdinti) Atspausdinamas šulinėlio parinkiklio rodinys.

„Print Selection“ (spausdinti
pasirinkimą)

Atspausdinami tik pasirinkti langeliai.

„Export to Excel“ (eksportuoti į
„Excel“)

Duomenys eksportuojami į „Excel“ skaičiuoklę.

„Export to Csv“ (eksportuoti į
Csv)

Duomenys eksportuojami kaip kableliais atskirų duomenų
dokumentas.

„Export to Xml“ (eksportuoti į
Xml)

Duomenys eksportuojami kaip .xml dokumentas.

„Export to Html“ (eksportuoti į
Html)

Duomenys eksportuojami kaip .html dokumentas.

13 lentelė. Pelės dešiniojo mygtuko meniu elementai dialogo lange „Plate Editor Well
Selector“ (plokštelės redaktoriaus šulinėlių parinkiklis)
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Pėdsakų stiliaus keitimas
Atlikdami plokštelės sąranką per bandymą, galite keisti amplifikavimo pėdsakų spalvą ir stilių. Tada
galite lengvai peržiūrėti pėdsakus tikralaikės būsenos lange, kai duomenys renkami.

Kaip pakeisti pėdsakų stilių

1. Spustelėkite „Trace Styles“ (pėdsakų stiliai) įrankių juostoje „Plate Editor“ (plokštelės
redaktorius).

Pasirodo atidarytos plokštelės dialogo langas „Trace Styles“ (pėdsakų stiliai), pavyzdžiui:

2. Kad pėdsakų stilius būtų rodomas pagal konkretų fluoroforą, pasirinkite jį išplečiamajame meniu
„Fluorophores“ (fluoroforai).

3. Kaip pakeisti pėdsakų rodymą:

a. Pasirinkite pėdsako rūšį išplečiamajame sąraše „Wells“ (šulinėliai).

b. Spustelėkite spalvą stulpelyje „Color“ (spalva).

c. Pasirodžiusiame dialogo lange „Color“ (spalva) pasirinkite kitą pėdsako spalvą ir spustelėkite
OK (gerai).

Pakeistas šulinėlio tipas pasirodo žemiau esančiame tinklelyje.

d. (Neprivaloma) Pasirinkite pėdsako simbolį išplečiamajame sąraše „Symbols“ (simboliai).
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4. Norėdami greitai pakeisti spalvų rinkinį, spustelėkite atitinkamą pasirinktį dalyje „Color Quick Set“ 
(greitas spalvos nustatymas).

5. Norėdami peržiūrėti šulinėlių etiketes tinklelyje, pasirinkite etiketės rūšį dalyje „Well Labels“ 
(šulinėlių etiketės).

6. Spustelėkite OK (gerai), kad įrašytumėte pakeitimus, arba „Cancel“ (atšaukti), norėdami juos
atšaukti.
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Plokštelės peržiūrėjimas skaičiuoklės formatu
Įrankis „Spreadsheet View/Importer“ (skaičiuoklės peržiūra / importavimo įrankis) rodo plokštelės
turinį skaičiuoklės formatu. Įrankiu „Spreadsheet View/Importer“ (skaičiuoklės peržiūra / importavimo
įrankis) galite eksportuoti šulinėlių turinį tabuliacijos žymėmis atskirtu formatu į programas, pvz.,
„Microsof Excel“. Taip pat galite importuoti šulinėlių turinį iš tabuliacijos žymes taikančių programų.

Kaip naudoti įrankį „Spreadsheet View/Importer“ (skaičiuoklės peržiūra / importavimo
įrankis)

1. Įrankių juostoje „Plate Editor“ (plokštelės redaktorius) spustelėkite „Spreadsheet View/Importer“ 
(skaičiuoklės peržiūra / importavimo įrankis) ir atverkite dialogo langą „Plate Spreadsheet View“ 
(plokštelės skaičiuoklės peržiūra).

2. Dialogo lange „Spreadsheet View“ (skaičiuoklės peržiūra) rodomas atskiro fluoroforo turinys
plokštelėje. Norėdami peržiūrėti kito fluoroforo plokštelės turinį, jį pasirinkite išplečiamajame
sąraše „Fluors List“ (fluoroforų sąrašas).

3. Spustelėkite „Export Template“ (eksportuoti šabloną) ir eksportuokite plokštelės skaičiuoklės
šabloną į „Excel“ failą (.csv formatu). Šį šabloną galite redaguoti ir importuoti šulinėlio turinio
informaciją.

4. (Neprivaloma) Spustelėkite „Import“ (importuoti) ir importuokite šulinėlių turinį iš kableliais atskirtų
reikšmių failo.
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5. Norėdami skaičiuoklės duomenis rūšiuoti pagal duomenis konkrečiame stulpelyje, spustelėkite
trikampį šalia stulpelio pavadinimo.

Patarimas. Galite redaguoti bet kurio langelio stulpelyje, šalia kurio pavadinimas pažymėtas
žvaigždute (*), turinį (pavyzdžiui, *tikslo pavadinimas).

Pastaba. Atvėrę „Plate Editor“ (plokštelės redaktorius) ir meniu juostoje pasirinkę „Settings >
Units“ (nuostatos > matavimo vienetai) stulpelyje „Quantity“ (kiekis) pasirinkite standartinės
kreivės duomenų matavimo vienetus. Kai baigtas plokštelės paleidimas, duomenys iš šių
standartų parodomi su pasirinktais matavimo vienetais lango „Data Analysis“ (duomenų analizė)
kortelės „Quantification“ (kiekybinis įvertinimas) diagramoje „Standard Curve“ (standartinė
kreivė).

Įrankio „Plate Spreadsheet View/Importer“ (plokštelės skaičiuoklės peržiūra /
importavimo įrankis) pelės dešiniojo mygtuko meniu elementai

14 lentelė pateikiami meniu elementai, matomi įrankyje „Spreadsheet View/Importer“ (skaičiuoklės
peržiūra / importavimo įrankis) dešiniuoju pelės mygtuku paspaudus bet kurį įrankyje esantį šulinėlį.

Elementas Funkcija

„Copy“ (kopijuoti) Nukopijuoja visą skaičiuoklę.

„Copy as Image“ 
(kopijuoti kaip
paveikslėlį)

Nukopijuoja skaičiuoklę kaip vaizdo failą.

„Print“ (spausdinti) Atspausdina skaičiuoklę.

„Print Selection“ 
(spausdinti pasirinkimą)

Atspausdina tik pasirinktus langelius.

„Export to Excel“ 
(eksportuoti į „Excel“)

Eksportuoja failą į „Excel“ skaičiuoklę.

„Export to Csv“ 
(eksportuoti į Csv)

Eksportuoja failą .csv formatu.

„Export to Xml“ 
(eksportuoti į Xml)

Eksportuoja failą .xml formatu.

14 lentelė. Įrankio „Plate Spreadsheet View/Importer“ (plokštelės skaičiuoklės
peržiūra / importavimo įrankis) pelės dešiniojo mygtuko meniu elementai
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Elementas Funkcija

„Export to Html“ 
(eksportuoti į Html)

Eksportuoja failą .html formatu.

„Find“ (ieškoti) Ieško konkretaus teksto.

„Sort“ (rūšiuoti) Rūšiuoja skaičiuoklę pasirinkus iki trijų duomenų stulpelių lange
„Sort“ (rūšiuoti).

14 lentelė. Įrankio „Plate Spreadsheet View/Importer“ (plokštelės skaičiuoklės
peržiūra / importavimo įrankis) pelės dešiniojo mygtuko meniu elementai (tęsinys)
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Plokštelės schemos kūrimas, naudojant parinktį „Plate
Setup Wizard“ (plokštelės sąrankos vedlys)

Galite pasinaudoti parinktimi „Setup Wizard“ (sąrankos vedlys) ir įvesti normalizuoto geno ekspresijos
analizei reikalingą plokštelės schemos informaciją, į kurią būtų įtraukti šie elementai:

n Tikslų pavadinimai

n Mėginių pavadinimai

n Tikslų ir mėginių vieta ant plokštelės

n Etaloninis (-iai) genas (-ai)

n Kontrolinis mėginys

Parinktį „Setup Wizard“ (sąrankos vedlys) galite naudoti prieš paleidimą, jo metu arba po jo.

Plokštelės „Setup Wizard“ (sąrankos vedlys) naudojimas
Šioje dalyje aiškinama, kaip kurti plokštelės išdėstymą naudojant plokštelės „Setup Wizard“ (sąrankos
vedlys). Norėdami lengviau peržiūrėti kiekvieno plokštelės šulinio turinį, spustelėkite „Zoom plate“ 
(keisti plokštelės mastelį) lango „Setup Wizard“ (sąrankos vedlys) viršuje.

Svarbu. Esant bet kurioje lango „Setup Wizard“ (sąrankos vedlys) kortelėje ir grįžus į kortelę
„Auto layout“ (automatinis išdėstymas), atstatomas plokštelės išdėstymas. Būkite atsargūs, kai
renkatės šią kortelę.

Patarimas. Išdėstymą galite atstatyti pasirinkdami „Tools > Clear Plate“ (įrankiai > išvalyti
plokštelę) lange „Setup Wizard“ (sąrankos vedlys).

Kaip naudoti „Setup Wizard“ (sąrankos vedlys)

1. Atidarykite langą „Plate Editor“ (plokštelės redaktorius).

2. Norėdami atidaryti langą „Setup Wizard“, pasirinkite „Editing Tools > Setup Wizard“ (redagavimo
įrankiai > sąrankos vedlys).

Pasirodo „Setup Wizard“ (sąrankos vedlys), kuriame yra kortelė „Auto layout“ (automatinis
išdėstymas).
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3. Kortelėje „Auto layout“ (automatinis išdėstymas) atlikite šiuos veiksmus:

a. Spustelėkite šulinėlį tinklelyje, vilkite skersai ir žemyn, kad nurodytumėte plokštelės sritį,
kurioje planuojate įkelti mėginį.

b. Įveskite tikslų ir mėginių, kuriuos norite įkelti, skaičių.

Patarimas. Tikslų ir mėginių skaičius turi atitikti pasirinktų langelių skaičių. Jei įvesti
skaičiai netelpa į pasirinktą sritį, pakeiskite skaičius arba plokštelių pasirinkimo sritį.
Galite nurodyti plokštelės elementų padėtį ir grupavimą.

c. (Neprivaloma) Pakeiskite plokštelės padėtį. Pavyzdžiui, galite stulpeliuose nustatyti tikslus, o
eilutėse – mėginius, arba grupuoti pagal mėginius.

d. Spustelėkite „Next“ (toliau), kad pereitumėte į kortelę „Target names“ (tikslo pavadinimai).

Pastaba. Jei jūsų plokštelės išdėstymas neturi dėsningo modelio, naudokite kortelę „Target
names“ (tikslų pavadinimai), kad rankiniu būdu nustatytumėte tikslų padėtį, arba kortelę
„Sample Names“ (mėginių pavadinimai), kad rankiniu būdu nustatytumėte mėginių padėtį ant
plokštelės. Spustelėkite ir vilkite, kad pasirinktumėte keletą šulinėlių.
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7 skyrius. Plokštelių paruošimas

4. Kortelėje „Target Names“ (tikslų pavadinimai) nurodykite tikslų grupių tikslų pavadinimus:

a. Atlikite vieną iš toliau nurodytų veiksmų:

n Norėdami pervadinti tikslus pagal grupę, nustatykite „Select by“ (pasirinkti pagal) į
„Target“ (tikslas).

n Norėdami pervadinti tikslus pagal šulinėlį, nustatykite „Select by“ (pasirinkti pagal) į
„Well“ (šulinėlis).

b. Pasirinkite tikslų grupę arba šulinėlį tinklelyje ir išplečiamajame sąraše „Target Name“ (tikslo
pavadinimas) įrašykite pavadinimą.

Patarimas. Spustelėkite tabuliavimo klavišą, kad pasirinktumėte kitą grupę arba
dešinėje esantį šulinėlį, arba „Enter“ (įvesti), kad pasirinktumėte kitą grupę arba žemiau
esantį šulinėlį. Taip pat galite kortelėse „Target Name“ (tikslo pavadinimas) ir „Sample
Name“ (mėginio pavadinimas) laikyti „Control“ (valdymas) mygtuką ir spustelėti šulinėlį,
kad pasirinktumėte kelis ne greta esančius šulinėlius.

c. Spustelėkite „Next“ (toliau), kad pereitumėte į kortelę „Sample Names“ (mėginių
pavadinimai).

5. Kortelėje „Sample Names“ (mėginių pavadinimai) nurodykite mėginių grupių mėginių
pavadinimus.

6. Spustelėkite „Next“ (toliau), kad pereitumėte į kortelę „Reference Targets“ (etaloniniai tikslai).

7. Kortelėje „Reference Targets“ (etaloniniai tikslai) pasirinkite vieną ar kelis tikslus, kuriuos
naudosite kaip etalonus normalizuotoje geno ekspresijoje, ir spustelėkite „Next“ (toliau),
kad pereitumėte į kortelę „Control Sample“ (kontrolinis mėginys).

8. Kortelėje „Control Sample“ (kontrolinis mėginys) pasirinkite vieną mėginį, kurį naudosite kaip
kontrolinį santykinės geno ekspresijos skaičiavimams.

9. Spustelėkite OK (gerai), kad įrašytumėte plokštelės išdėstymą ir grįžtumėte į langą „Plate Editor“ 
(plokštelės redaktorius), kuriame galėsite nustatyti kitus plokštelės parametrus. Daugiau
informacijos rasite dalyje Pasirenkamųjų parametrų priskyrimas plokštelės failui, p. 126.

Arba galite spausti „Previous“ (atgal), kad grįžtumėte į prieš tai buvusią kortelę ir atliktumėte
pakeitimus.

Pastaba. Grįžus į kortelę „Auto layout“ (automatinis išdėstymas), plokštelė automatiškai
atstatoma. Būkite atsargūs, kai spaudžiate „Previous“ (atgal).
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8 skyrius. Eksperimentų paleidimas
Šiame skyriuje paaiškinama, kaip naudojant „CFX Manager Dx“ programinę įrangą pradėti vykdyti
tinkintus (vartotojo apibrėžtus) arba „PrimePCR“ (PGR pradmenys) analizės eksperimentus.

Paleidimo duomenų faile pateikiama paleisti reikalinga protokolo ir plokštelės informacija. Taip pat
faile pateikiami analizių, kurias CFX Manager Dx atlieka pasibaigus paleidimo veiksmui, duomenys.

CFX Manager Dx programinė įranga suteikia galimybę paprastai pradėti ir vykdyti vartotojo apibrėžtus
arba „PrimePCR“ (PGR pradmenys) eksperimentus. Lange „Run Setup“ (paleidimo sąranka)
nuosekliai jums nurodomi bendrieji eksperimento nustatymo veiksmai, kuriuos atlikę pateksite į
dialogo langą „Start Run“ (paleidimo pradžia), iš kurio pradėsite paleidimą.

Lango „Run Setup“ (paleidimo sąranka) įjungimas
Kaip įjungti langą „Run Setup“ (paleidimo sąranka)

u Atlikite vieną iš toliau nurodytų veiksmų:

n Kortelėje „Run Setup“ (paleidimo sąranka), kurią rasite lange „Startup Wizard“ (paleisties
vedlys), spustelėkite „User-defined“ (vartotojo apibrėžta) arba „PrimePCR“ (PGR
pradmenys).

n Lange „Home“ (pagrindinis) įrankių juostoje spustelėkite „User-defined Run Setup“ (vartotojo
apibrėžta paleidimo sąranka) arba „PrimePCR Run Setup“ (PGR pradmenų paleidimo
sąranka).

n Lange „Home“ (pagrindinis) pasirinkite „Run > User-defined Run“ (paleidimas > vartotojo
apibrėžtas paleidimas) arba „Run > PrimePCR Run“ (paleidimas > PGR pradmenų
paleidimas).
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8 skyrius. Eksperimentų paleidimas

Langas „Run Setup“ (paleidimo sąranka)
Langas „Run Setup“ (paleidimo sąranka) suteikia sparčią prieigą prie failų ir nuostatų, kurių reikia
norint parengti ir paleisti eksperimentą. Kai pasirenkate paleisti vartotojo apibrėžtą eksperimentą,
atveriamas dialogo langas „Run Setup“ (paleidimo sąranka), kuriame rodoma kortelė „Protocol“ 
(protokolas). Kai pasirenkate paleisti „PrimePCR“ (PGR pradmenys) eksperimentą, atveriamas
dialogo langas „Run Setup“ (paleidimo sąranka), kuriame rodoma kortelė „Start run“ (paleidimo
pradžia).

Patarimas. Informacijos apie „PrimePCR“ (PGR pradmenys) žr. „PrimePCR“ (PGR pradmenys)
eksperimentų atlikimas, p. 170; informacijos apie kortelę „Start Run“ (paleidimo pradžia) žr.
Kortelė „Start Run“ (paleidimo pradžia), p. 160.
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Langas „Run Setup“ (paleidimo sąranka)

1. Kortelėse būsite nukreipti į eksperimento nuostatas ir paleidimą:

n Kortelė „Protocol“ (protokolas) – pasirinkite esamą paleidžiamą ar
redaguojamą protokolą arba „Protocol Editor“ (protokolų redaktorius) ir
sukurkite naują protokolą.

n Kortelė „Plate“ (plokštelė) – pasirinkite esamą paleidžiamą ar redaguojamą
plokštelę arba „Plate Editor“ (plokštelės redaktorius) ir sukurkite naują
plokštelę.

n Kortelė „Start Run“ (paleidimo pradžia) – peržiūrėkite eksperimento nuostatas,
pasirinktie vieną ar kelis instrumentų blokus ir pradėkite paleidimą.

2. Pagrindiniame lange rodomos kiekvienos kortelės parinktys, kokias jūs taikote.

3. Naršymo mygtukas nukreips jus į kortelę „Start Run“ (paleidimo pradžia).

LEGENDA
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8 skyrius. Eksperimentų paleidimas

Kortelė „Protocol“ (protokolas)
Kortelėje „Protocol“ (protokolas) rodoma jūsų planuojamo paleidimo protokolo failo apžvalga.
Protokolo faile yra instrukcijos dėl instrumento temperatūros etapų ir instrumento parinkčių, kuriomis
valdomas kitimo greitis, mėginio tūris ir dangtelio temperatūra.

Pagal numatytąsias nuostatas programinė įranga rodo protokolą, apibūdintą skyriuje „File Selection
for Run Setup“ (failo pasirinkimas paleidimo sąrankai) kortelėje „Files“ (failai), kuri yra dialogo lange
„User > User Preferences“ (vartotojas > vartotojo nuostatos). Numatytąjį protokolą galite pakeisti
dialogo lange „User Preferences“ (vartotojo nuostatos). Daugiau informacijos žr. Numatytųjų failų
nuostatų keitimas, p. 65.

Kortelėje „Protocol“ (protokolas) galite atlikti šiuos veiksmus:

n Sukurti naują paleidimo protokolą

n Pasirinkti esamą paleidžiamą ar redaguojamą protokolą

Daugiau informacijos apie protokolų sukūrimą ir keitimą žr. 6 skyrius, Protokolų kūrimas.
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Kortelė „Protocol“ (protokolas)

Kaip sukurti naują protokolą

1. Kortelėje „Protocol“ (protokolas) spustelėkite „Create New“ (kurti naują).

Parodomas „Protocol Editor“ (protokolo redaktorius).

2. Naudodami „Protocol Editor“ (protokolo redaktorius) sukurkite naują protokolą.

3. Spustelėkite OK (gerai), įrašykite protokolą ir grįžkite į kortelę „Protocol“ (protokolas), esančią
„Run Setup“ (paleidimo sąranka).

4. Peržiūrėkite protokolo išsamią informaciją ir atlikite vieną iš šių veiksmų:

n Jeigu jūsų informacija teisinga, spustelėkite „Next“ (toliau) ir pereikite į kortelę „Plate“ 
(plokštelė).

n Jeigu jūsų informacija neteisinga, spustelėkite „Edit Selected“ (redaguoti pasirinktą) ir grįžkite
į langą „Protocol Editor“ (protokolų redaktorius). Peržiūrėkite protokolą, įrašykite pakeitimus,
tada kortelėje „Protocol“ (protokolas) spustelėkite „Next“ (toliau) ir pereikite prie kortelės
„Plate“ (plokštelė).

Kaip pasirinkti esamą protokolą

1. Kortelėje „Protocol“ (protokolas) atlikite vieną iš šių veiksmų:

n Spustelėkite „Select Existing“ (pasirinkti esamą) ir raskite esamą protokolą.

n Spustelėkite „Express Load“ (specialioji apkrova) ir protokolų išplečiamajame sąraše
pasirinkite protokolą.

Patarimas. Į išplečiamąjį sąrašą „Express Load“ (specialioji apkrova) galite įtraukti
protokolus arba iš jo pašalinti. Daugiau informacijos žr. Specialiosios apkrovos protokolų
pridėjimas ir šalinimas.

2. Peržiūrėkite protokolo išsamią informaciją ir atlikite vieną iš šių veiksmų:

n Jeigu jūsų informacija teisinga, spustelėkite „Next“ (toliau) ir pereikite į kortelę „Plate“ 
(plokštelė).

n Jeigu jūsų informacija neteisinga, spustelėkite „Edit Selected“ (redaguoti pasirinktą) ir
atverkite „Protocol Editor“ (protokolų redaktorius). Peržiūrėkite protokolą, įrašykite
pakeitimus, tada kortelėje „Protocol“ (protokolas) spustelėkite „Next“ (toliau) ir pereikite prie
kortelės „Plate“ (plokštelė).
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8 skyrius. Eksperimentų paleidimas

Specialiosios apkrovos protokolų pridėjimas ir šalinimas

Galite keisti išplečiamojo sąrašo „Express Load“ (specialioji apkrova), kuris parodomas lange
„Protocol Editor“ (protokolų redaktorius), turinį. Šio sąrašo protokolai įrašomi šiame aplanke:

c:\Users\Public\Documents\Bio-Rad\CFX\Users\<user_name>\ExpressLoad\

Kaip keisti protokolų sąrašą „Express Load“ (specialioji apkrova):

1. Suraskite ir atidarykite aplanką „Express Load“ (specialioji apkrova).

2. Aplanke peržiūrėkite protokolo failus (.pcrl).

3. Atlikite bet kurį iš šių veiksmų:

n Pašalinkite protokolus iš aplanko, kad pašalintumėte juos iš išplečiamojo sąrašo.

n Kopijuokite protokolus į aplanką, kad pridėtumėte juos į išplečiamąjį sąrašą.
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Kortelė „Plate“ (plokštelė)

Kortelė „Plate“ (plokštelė)
Pastaba. Jeigu kortelėje „Protocol“ (protokolas) pasirinktame protokole nėra plokštelės
nuskaitymo veiksmo tikralaikės PCR (PGR) analizei, kortelė „Plate“ (plokštelė) paslepiama.
Norėdami peržiūrėti kortelę „Plate“ (plokštelė), į protokolą įtraukite bent vieną plokštelės
nuskaitymą.

Kortelėje „Plate“ (plokštelė) rodoma jūsų planuojamo plokštelės failo apžvalga. Tikralaikės PCR
(PGR) paleidimo metu plokštelės faile yra kiekvieno šulinėlio turinio aprašymas, įskaitant jo
fluoroforus, nuskaitymo režimą ir plokštelės tipą. CFX Manager Dx programinė įranga šiuos
apibūdinimus naudoja duomenims rinkti ir analizuoti.

Pagal numatytąsias nuostatas programinė įranga rodo plokštelę, apibūdintą failo pasirinkimo veiksme
paleidimo sąrankos skyriuje kortelėje „Files“ (failai), kuri yra dialogo lange „User > User Preferences“ 
(vartotojas > vartotojo nuostatos). Numatytąją plokštelę galite pakeisti dialogo lange „User
Preferences“ (vartotojo nuostatos). Daugiau informacijos žr. Numatytųjų failų nuostatų keitimas, p. 65.

Kortelėje „Plate“ (plokštelė) galite atlikti šiuos veiksmus:

n Sukurti naują įdedamą plokštelę

n Pasirinkti esamą įdedamą ar redaguojamą plokštelę

Daugiau informacijos apie plokštelių kūrimą ir keitimą žr. 7 skyrius, Plokštelių paruošimas.
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8 skyrius. Eksperimentų paleidimas

Naujos plokštelės kūrimas

1. Kortelėje „Plate“ (plokštelė) spustelėkite „Create New“ (kurti naują).

Parodomas „Plate Editor“ (plokštelės redaktorius).

2. Naują plokštelę kurkite naudodami „Plate Editor“ (plokštelės redaktorius).

3. Spustelėkite OK (gerai), norėdami įrašyti plokštelę ir grįžti į kortelę „Plate“ (plokštelė), esančią
„Run Setup“ (paleidimo sąranka).

4. Peržiūrėkite plokštelės išsamią informaciją ir atlikite vieną iš šių veiksmų:

n Jeigu jūsų informacija teisinga, spustelėkite „Next“ (toliau) ir pereikite į kortelę „Start Run“ 
(paleidimo pradžia).

n Jeigu jūsų informacija neteisinga, spustelėkite „Edit Selected“ (redaguoti pasirinktą) ir grįžkite
į „Plate Editor“ (plokštelės redaktorius). Peržiūrėkite plokštelės failą, įrašykite pakeitimus,
tada kortelėje „Plate“ (plokštelė) spustelėkite „Next“ (toliau) ir pereikite prie kortelės „Start
Run“ (paleidimo pradžia).

Kaip pasirinkti esamos plokštelės failą

1. Kortelėje „Plate“ (plokštelė) atlikite vieną iš šių veiksmų:

n Spustelėkite „Select Existing“ (pasirinkti esamą) ir raskite tikslinį plokštelės failą.

n Spustelėkite „Express Load“ (specialioji apkrova) ir išplečiamajame sąraše pasirinkite
plokštelės failą.

Patarimas. Į išplečiamąjį sąrašą „Express Load“ (specialioji apkrova) galite įtraukti
plokšteles arba iš jo pašalinti. Daugiau informacijos žr. Specialiosios apkrovos plokštelių
failų pridėjimas ir šalinimas.

2. Peržiūrėkite plokštelės išsamią informaciją ir atlikite vieną iš šių veiksmų:

n Jeigu jūsų informacija teisinga, spustelėkite „Next“ (toliau) ir pereikite į kortelę „Start Run“ 
(paleidimo pradžia).

n Jeigu jūsų informacija neteisinga, spustelėkite „Edit Selected“ (redaguoti pasirinktą) ir atverkite
langą „Plate Editor“ (plokštelės redaktorius). Peržiūrėkite plokštelės failą, įrašykite pakeitimus,
tada spustelėkite „Next“ (toliau) ir pereikite prie kortelės „Start Run“ (paleidimo pradžia).

Specialiosios apkrovos plokštelių failų pridėjimas ir šalinimas

Galite keisti išplečiamojo sąrašo „Express Load“ (specialioji apkrova), kuris pasirodo lange „Plate
Editor“ (plokštelės redaktorius), turinį. Šiame sąraše pateiktos plokštelės įrašomos aplanke:

c:\Users\Public\Documents\Bio-Rad\CFX\Users\<user_name>\ExpressLoad\
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Kortelė „Plate“ (plokštelė)

Kaip keisti plokštelių failų „Express Load“ (specialioji apkrova) sąrašą

1. Suraskite ir atidarykite aplanką „Express Load“ (specialioji apkrova).

2. Peržiūrėkite aplanke esančius plokštelių failus (.pltd).

3. Atlikite vieną iš toliau nurodytų veiksmų:

n Pašalinkite plokštelių failus iš aplanko, kad pašalintumėte juos iš išplečiamojo sąrašo.

n Kopijuokite plokštelių failus į aplanką, kad pridėtumėte juos į išplečiamąjį sąrašą.
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8 skyrius. Eksperimentų paleidimas

Kortelė „Start Run“ (paleidimo pradžia)
Kortelėje „Start Run“ (paleidimo pradžia) rodoma informacija apie norimą vykdyti eksperimentą. Joje
taip pat rodomas prijungtas prietaisų blokas arba blokai, kuriuose galite paleisti eksperimentą.

Kortelėje „Start Run“ (paleidimo pradžia) galite atlikti šiuos veiksmus:

n Peržiūrėti išsamią paleidimo informaciją, įskaitant pasirinktą protokolo failą, plokštelės failą ir
nuskaitymo režimą

n Pridėti pastabų apie paleidimą

n Peržiūrėti išsamią informaciją apie visus prijungtus instrumentus, įskaitant jų paleidimo būseną
(paleistas ar neveikia), mėginio tūrį µl, dangtelio temperatūrą, emuliacijos režimą ir ID ar turimą
brūkšninį kodą

Pastaba. Galite keisti lentelėje „Start Run on Selected Blocks“ (pradėti paleidimą
pasirinktuose blokuose) rodomus stulpelius. Kaip tai daryti, žr. Išsamios informacijos
lentelėje „Selected Blocks“ (pasirinkti blokai) keitimas, p. 161.

n Pasirinkti bloką ar blokus, kuriuose vykdomas paleidimas

n Nuotoliniu būdu atidaryti arba uždaryti kiekvieno pasirinkto instrumento dangtelį

n Pradėkite paleidimą.
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Kortelė „Start Run“ (paleidimo pradžia)

Išsamios informacijos lentelėje „Selected Blocks“ (pasirinkti blokai) keitimas

Galite keisti lentelėje „Start Run on Selected Block(s)“ (pradėti paleidimą pasirinktame (-uose) bloke (-
uose)) rodomus stulpelius. Lentelėje taip pat galite keisti numatytąjį mėginio tūrį ir dangtelio
temperatūros vertes. Nuostatų pakeitimai taikomi paleidimui, kuris bus atliekamas.

Kaip pridėti stulpelius lentelėje „Start Run on Selected Blocks“ (pradėti paleidimą
pasirinktuose blokuose)

u Pelės dešiniuoju mygtuku spustelėkite lentelėje ir pateiktame meniu pasirinkite parinktį.

Kaip panaikinti stulpelius lentelėje „Start Run on Selected Blocks“ (pradėti paleidimą
pasirinktuose blokuose)

u Pelės dešiniuoju mygtuku spustelėkite lentelėje ir pateiktame meniu panaikinkite parinkties
žymėjimą.

Kaip koreguoti mėginio tūrio ar bloko dangtelio temperatūros vertes

u Pasirinkite tikslinio bloko mėginio tūrį ar dangtelio temperatūros langelį ir į jį įrašykite naują vertę.

Kaip pridėti paleidimo ID ar bloko brūkšninį kodą

u Pasirinkite tikslinio bloko langelį „ID/Bar Code“ (ID / brūkšninis kodas) ir įrašykite ID arba
nuskenuokite bloką brūkšninių kodų skaitytuvu.

Eksperimento paleidimas
Svarbu. Prieš paleisdami eksperimentą, turite užtikrinti, kad paleidimo metu jūsų kompiuterio
antivirusinė programa nepradės skenuoti.

Kaip paleisti eksperimentą

1. Kortelėje „Start Run“ (paleidimo pradžia) paleidimo informacijos skyriuje patikrinkite plokštelės ir
protokolo išsamią informaciją.

2. (Neprivaloma) Į pastabų tekstinį laukelį įrašykite pastabas apie paleidimą ar eksperimentą.

3. Pasirinkite vieno ar kelių blokų, kuriuose vykdomas paleidimas, žymės langelį.

Patarimas. Norėdami eksperimentą paleisti visuose blokuose, pasirinkite „Select All Blocks“ 
(pasirinkti visus blokus) parinktį, esančią po pasirinktų blokų lentele.

4. (Neprivaloma) Spustelėkite „Flash Block Indicator“ (mirksintis bloko indikatorius), kad sumirksėtų LED
indikatorius, esantis pasirinkto instrumento blokuose.
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8 skyrius. Eksperimentų paleidimas

5. Į bloką įdėkite eksperimento plokšteles:

a. Spustelėkite „Open Lid“ (atidaryti dangtelį). Atsidaro kiekvieno pasirinkto bloko motorizuotas
dangtelis.

b. Į kiekvieną pasirinktą bloką įdėkite eksperimento bloką.

c. Spustelėkite „Close Lid“ (uždaryti dangtelį).

Patarimas. Taip pat galite instrumento priekyje paspausti dangtelio mygtuką ir atidaryti arba
uždaryti dangtelį.

6. Spustelėkite „Open Lid“ (atidaryti dangtelį) ir „Close Lid“ (uždaryti dangtelį), kad atidarytumėte
arba uždarytumėte kiekvieno pasirinkto instrumento bloko motorizuotą dangtelį.

7. Peržiūrėkite paleidimo išsamią informaciją ir atlikite vieną iš šių veiksmų:

n Jeigu išsami informacija teisinga, spustelėkite „Start Run“ (paleidimo pradžia).

n Jeigu išsami informacija neteisinga:

o Lentelėje „Selected Blocks“ (pasirinkti blokai) pakoreguokite informaciją ir spustelėkite
„Start Run“ (paleidimo pradžia).

o Grįžkite į tinkamą kortelę ir atlikite reikiamus pakeitimus, juos įrašykite, tada spustelėkite
„Next“ (toliau) ir grįžkite į kortelę „Start Run“ (paleidimo pradžia) ir pradėkite paleidimą.

Kaip pradėti naują paleidimą iš ankstesnio paleidimo

u Atlikite vieną iš šių veiksmų:

n Pagrindinio programinės įrangos meniu juostoje pasirinkite „File > Repeat a Run“ (failas >
pakartoti paleidimą); raskite ir du kartus spustelėkite paleidimo, kurį norite pakartoti,
duomenų failą.

n Pasirinkite kortelę „Repeat Run“ (pakartoti paleidimą), esančią „Startup Wizard“ (paleisties
vedlys), ir du kartus spustelėkite paleidimo, kurį norite pakartoti, duomenų failą.

Be to, kortelėje „Repeat Run“ (pakartoti paleidimą) galite spustelėti „Browse“ (naršyti) ir
raskite bei du kartus spustelėkite paleidimo duomenų failą, kuri norite pakartoti.
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Dialogo langas „Run Details“ (paleidimo išsami informacija)

Dialogo langas „Run Details“ (paleidimo išsami informacija)
Spustelėjus „Start Run“ (paleidimo pradžia), CFX Manager Dx programinė įranga paragina įrašyti
duomenų failą (.pcrd), pradeda analizę ir atidaro dialogo langą „Run Details“ (paleidimo išsami
informacija). Dialogo langą „Run Details“ (paleidimo išsami informacija) sudaro trys būsenos kortelės:

n „Run Status“ (paleidimo būsena) – naudokite šią kortelę, jei norite peržiūrėti dabartinę
protokolo būseną, atidaryti arba uždaryti dangtį, pristabdyti analizę, pridėti pakartojimų, praleisti
veiksmus arba sustabdyti paleidimą.

n „Real-time Status“ (tikralaikė būsena) – naudokite šią kortelę, jei norite peržiūrėti PCR (PGR)
fluorescencijos duomenis tikruoju laiku, kai jie renkami.

n „Time Status“ (laiko būsena) – naudokite šią kortelę, jei norite matyti per visą ekraną protokolo
atgalinės atskaitos laikmatį.

Šios kortelės išsamiai paaiškintos tolesniuose skyriuose.
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8 skyrius. Eksperimentų paleidimas

Kortelė „Run Status“ (paleidimo būsena)
Kortelėje „Run Status“ (paleidimo būsena) rodoma dabartinė vykstančio paleidimo būsena. Šiame
rodinyje taip pat galite valdyti dangtelį ir keisti paleidimą.

1. Sritis „Run Status“ (paleidimo būsena) – rodoma dabartinė protokolo eiga.

2. „Run Status“ (paleidimo būsena) valdikliai – leidžia valdyti prietaisą arba
nutraukti dabartinį protokolą.

3. Sritis „Run Information“ (paleidimo išsami informacija) – rodoma išsami
paleidimo informacija.

LEGENDA
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Dialogo langas „Run Details“ (paleidimo išsami informacija)

Komandos kortelėje „Run Status“ (paleidimo būsena)

Naudokite komandas kortelėje „Run Status“ (paleidimo būsena), jei norite valdyti prietaisą iš
programinės įrangos arba keisti vykdomą paleidimą.

Pastaba. Padarius pakeitimų protokole paleidimo metu, pvz., pridėjus pakartojimų,
nepakeičiamas protokolo failas, susijęs su paleidimu. Šie veiksmai registruojami žurnale „Run
Log“ (paleidimo žurnalas).

– atidaromas pasirinktų instrumentų motorizuotas dangtelis.

Svarbu. Atidarius dangtelį paleidimo metu, paleidimas esamo veiksmo metu pristabdomas,
todėl gali būti iškreipti duomenys.

– uždaromas pasirinktų instrumentų motorizuotas dangtelis.

– įtraukiama daugiau pakartojimų į GOTO veiksmą protokole. Ši parinktis galima tik tada, kai
vyksta GOTO veiksmas.

– praleidžiamas esamas protokolo veiksmas.

Pastaba. Jei praleidžiate GOTO veiksmą, programinė įranga paragina patvirtinti, kad norite
praleisti visą GOTO ciklą ir pereiti prie kito protokolo veiksmo.

– įjungiamas mirksintis pasirinkto instrumento šviesos diodas, kad būtų galima nustatyti
pasirinktus blokus.

– pristabdomas protokolas.

Pastaba. Šis veiksmas registruojamas žurnale „Run Log“ (paleidimo žurnalas).

– atnaujinamas pristabdytas protokolas.

– paleidimas sustabdomas prieš pasibaigiant protokolams.

Pastaba. Sustabdžius paleidimą prieš pasibaigiant protokolui, gali būti iškreipti duomenys.
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8 skyrius. Eksperimentų paleidimas

Kortelė „Real-time Status“ (tikralaikė būsena)
Kortelėje „Real-time Status“ (tikralaikė būsena) rodomi PCR (PGR) tikralaikiai duomenys, surinkti per
kiekvieną paleidimo ciklą po pirmų dviejų plokštelių nuskaitymų.

1. „Amplification trace pane“ (amplifikavimo pėdsako sritis) – per paleidimą rodomi
tikralaikiai amplifikavimo duomenys.

2. „Well group identifier“ (šulinėlių grupės identifikatorius) – jei šulinėlių grupės
identifikuotos plokštelės sąrankoje, naudotojai gali pasirinkti konkrečią šulinėlių
grupę ir peržiūrėti jos pėdsakus, šulinėlius ir informaciją lentelėse.

„Step number identifier“ (veiksmo numerio identifikatorius) – jei protokole
renkami duomenys iš daugiau nei vieno veiksmo (pavyzdžiui, per amplifikavimą
ir lydymosi kreivę), naudotojai gali pasirinkti konkretų veiksmą ir peržiūrėti tame
veiksme surinktus pėdsakus.

3. „Well selector pane“ (šulinėlių parinkiklio sritis) – rodo aktyvius, neaktyvius ir
tuščius plokštelės šulinėlius.

4. „Plate setup table pane“ (plokštelės sąrankos lentelės sritis) – rodo plokštelės
sąranką lentelėje.

LEGENDA
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Dialogo langas „Run Details“ (paleidimo išsami informacija)

5. „Run details pane“ (paleidimo išsamios informacijos sritis) – rodo paleidimo
tikralaikę būseną, įskaitant:

n Dabartinį veiksmą

n Dabartinį kartojimą

n Dabartinę temperatūrą

n Likusį laiką

n Mėginio temperatūrą

n Dangtelio temperatūrą

6. „Plate Setup“ (plokštelės sąranka) – atveria dialogo langą „Plate Setup“ 
(plokštelės sąranka), kuriame naudotojai gali keisti dabartinės plokštelės
sąranką vykstant paleidimo veiksmui.

Kortelėje „Real-time Status“ (tikralaikė būsena) galite atlikti šiuos veiksmus:

n Rodyti arba slėpti tikralaikius pėdsakus pasirinkdami juos šulinėlių parinkiklio srityje arba
plokštelės sąrankos lentelėje

n Peržiūrėti vieną pėdsaką ar jų grupes, pasirinkdami juos šulinėlių grupių išplečiamajame meniu

n Redaguoti plokštelę arba pakeisti plokštelės failą

n Paleisčiai taikykite „PrimePCR“ (PGR pradmenys) failą.

Tikralaikių pėdsakų rodymas arba paslėpimas

Pagal numatytuosius parametrus visi pripildyti šulinėliai yra aktyvūs ir rodomi plokštelės sąrankos
lentelėje. Aktyvūs šulinėliai šulinėlių parinkiklio srityje rodomi mėlynai. Paslėpti šulinėliai šulinėlių
parinkiklio srityje rodomi šviesiai pilka spalva, o nenaudojami šulinėliai – tamsiai pilka spalva.

Paleidimo metu galite paslėpti pėdsakus iš aktyvių šulinėlių. CFX Manager Dx toliau renka duomenis
iš visų šulinėlių; kai paslepiate šulinėlius, jų duomenys nerodomi plokštelės sąrankos lentelėje.

Kaip paslėpti tikralaikius pėdsakus

u Šulinėlių parinkiklio srityje spustelėkite aktyvius (mėlynus) šulinėlius, kuriuos norite paslėpti.

Kaip rodyti tikralaikius laiko pėdsakus

u Šulinėlių parinkiklio srityje spustelėkite paslėptus (šviesiai pilkus) šulinėlius, kuriuos norite rodyti.

Daugiau informacijos apie šulinėlių parinkiklį žr. Šulinėlių parinkiklis, p. 184.
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8 skyrius. Eksperimentų paleidimas

Plokštelės sąrankos redagavimas

Kaip redaguoti plokštelės sąranką

u Spustelėkite „Plate Setup“ (plokštelės sąranka), o tada pasirinkite „View/Edit Plate“ (peržiūrėti /
redaguoti plokštelę).

Parodomas langas „Plate Editor“ (plokštelės redaktorius), kuriame galite redaguoti plokštelę, kol
vykdomas paleidimas. Daugiau informacijos apie plokštelių redagavimą žr. 7 skyrius, Plokštelių
paruošimas.

Pastaba. Lange „Plate Editor“ (plokštelės redaktorius) taip pat galite redaguoti pėdsakų
stilius. Kortelėje „Real-time Status“ (būsena realiuoju laiku) parodomi pakeitimai
amplifikavimo pėdsakų diagramoje.

Plokštelės failo pakeitimas

Patarimas. Plokštelės failo pakeitimas yra itin naudingas, jeigu paleidimą pradedate „Quick
Plate“ (sparčioji plokštelė) failu aplanke „ExpressLoad“ (specialioji apkrova).

Kaip pakeisti plokštelės failą

u Spustelėkite „Plate Setup“ (plokštelės sąranka) ir pasirinkite vieną iš šių parinkčių:

n Pakeiskite plokštelės failą – naršyklės lango sąraše pasirinkite naują plokštelės failą

n Taikyti „PrimePCR“ (PGR pradmenys) failą – ieškokite paleidimo failo, kuriame bus gauta
plokštelės schema naudojant išmanią paiešką, arba spustelėkite „Browse“ (naršyti) ir raskite
failą, kurį įkėlėte iš „Bio-Rad“ svetainės ir kurio nėra aplanke „PrimePCR“ (PGR pradmenys)

Pastaba. CFX Manager Dx patikrina nuskaitymo režimą ir plokštelės failo plokštelės dydį. Jie
turi būti tokie patys, kaip ir paleidimo nuostatos, su kuriomis buvo pradėtas paleidimas.
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Kortelė „Time Status“ (laiko būsena)
Kortelėje „Time Status“ (laiko būsena) rodomas laikas, likęs iki esamo paleidimo baigimo.
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8 skyrius. Eksperimentų paleidimas

„PrimePCR“ (PGR pradmenys) eksperimentų atlikimas
„PrimePCR“ (PGR pradmenys) eksperimentų metu naudojami trakto arba konkrečios ligos analizių
duomenys, kuriuos „Bio-Rad“ patvirtino ir optimizavo tradicinėje laboratorijoje ir kurie yra prieinami
šiais formatais:

n Iš anksto apdorotos plokštelės – plokštelės, kuriose yra analizių, būdingų biologiniam traktui arba
konkrečiai ligai; jos apima „PrimePCR“ (PGR pradmenys) kontrolines medžiagas ir etaloninius
genus

n Pagal užsakymą sukonfigūruotos plokštelės – plokštelės, kurias galima pritaikyti pagal vartotojo
nustatytą konfigūraciją, sudarančią galimybę pasirinkti analizes, susijusias su dominančiais
objektais, kontrolinėmis medžiagomis ir etalonais

n Individualūs tyrimai – mėgintuvėliai, kuriuose yra atskiri pradmenų rinkiniai, naudojami
tikralaikėms reakcijoms

Jei norite sumažinti bendrą paleidimo laiką, galite protokole pašalinti lydymo veiksmą. „Bio-Rad“ 
primygtinai rekomenduoja „PrimePCR“ (PGR pradmenys) paleidimo protokole nedaryti jokių kitų
pakeitimų. Numatytasis protokolas yra tas, kuris naudojamas analizei patvirtinti. Bet koks nukrypimas
nuo jo gali turėti įtakos rezultatams. Protokolo pakeitimai pažymimi gauto duomenų failo kortelėje
„Run Information“ (paleidimo išsami informacija) ir visose sukurtose ataskaitose.

„PrimePCR“ (PGR pradmenys) paleidimo pradžia

u Kad paleistumėte „PrimePCR“ (PGR pradmenys) procesą, atlikite toliau nurodytus veiksmus:

n Meniu „Startup Wizard“ (paleisties vedlys) pasirinkite „PrimePCR“ (PGR pradmenys)
kortelėje „Run Setup“ (paleidimo sąranka), o tada pasirinkite tinkamą cheminę sudėtį
(SYBER arba zondas).

n Pasirinkite „PrimePCR“ (PGR pradmenys) paleidimo parinktį iš sąrašo „Recent Runs“ 
(naujausi paleidimai), esančio meniu „Startup Wizard“ (paleisties vedlys) kortelėje „Repeat
Run“ (pakartotinis paleidimas).

n Pasirinkite „File > New > PrimePCR Run“ (failas > naujas > PGR pradmenų paleidimas)
pagrindiniame lange.

n Lange „Home“ (pagrindinis) pasirinkite „File > New > PrimePCR Run File“ (failas > atidaryti >
PGR pradmenų paleidimo failas).

n Nutempkite „PrimePC“ (PGR pradmenys) paleidimo failą pagrindiniame lange.

Pasirinkus „PrimePCR“ (PGR pradmenys) paleidimą, atsidaro kortelėje „Start Run“ (paleidimo
pradžia) esantis „Run Setup“ (paleidimo sąranka) langas su numatytąja „PrimePCR“ (PGR
pradmenys) plokštelės schema, kuri įkeliama pagal pasirinktą instrumentą.
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„PrimePCR“ (PGR pradmenys) eksperimentų atlikimas

Kaip pašalinti lydymo veiksmą iš protokolo

u Kortelėje „Protocol“ (protokolas) panaikinkite žymą žymės langelyje „Include Melt Step“ (įtraukti
lydymo veiksmą).

Kaip importuoti informaciją apie tikslą, skirtą „PrimePCR“ (PGR pradmenys)
plokštelėms, į plokštelės schemą

1. Atlikite vieną iš toliau nurodytų veiksmų:

n Kortelėje „Real-time Status“ (tikralaikė būsena), esančioje dialogo lange „Run Details“ 
(paleidimo išsami informacija), pasirinkite „Plate Setup > Apply PrimePCR File“ (plokštelės
sąranka > taikyti PGR pradmenų failą).

n Lange „Data Analysis“ (duomenų analizė) pasirinkite „Plate Setup > Apply PrimePCR File“ 
(plokštelės sąranka > taikyti PGR pradmenų failą).

2. Paleidimo failo dialogo lange „PrimePCR“ (PGR pradmenys) spustelėkite mygtuką „Browse“ 
(naršyti), kad pasiektumėte atitinkamą „PrimePCR“ (PGR pradmenys) failą (.csv).

3. Pasirinkite tikslo „PrimePCR“ (PGR pradmenys) failą ir spustelėkite „Open“ (atidaryti).

„CFX Manager Dx“ importuoja tikslo informaciją į jūsų plokštelės schemą.
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9 skyrius. Duomenų analizės apžvalga
„CFX Manager Dx“ siūlo kelis metodus duomenų failams atverti ir peržiūrėti. Veiksmai, kuriuos galite
atlikti:

n Lange „Home“ (pagrindinis) pasirinkite „File > Open > Data File“ (failas > atverti > duomenų
failas) ir pereikite prie tikslo .pcrd failo.

n Lange „Home“ (pagrindinis) pasirinkite „File > Recent Data Files“ (failas > naujausi duomenų
failai) ir sąraše pasirinkite naujausius atidarytus duomenų failus.

Langas „Data Analysis“ (duomenų analizė)
Lange „Data Analysis“ (duomenų analizė) yra kelios kortelės; kiekviena kortelė rodo išanalizuotus su
konkrečiu analizės metodu susijusius duomenis arba su tam tikru paleidimu susijusią informaciją.
Kortelės rodomos tik tuo atveju, jei duomenys, surinkti paleidimo metu, gali būti naudojami to tipo
analizei.

Patarimas. Norėdami išsirinkti rodytinas korteles, pasirinkite jas iš išplečiamojo sąrašo „View“ 
(rodymas) lange „Data Analysis“ (duomenų analizė). Norėdami grįžti prie pirminio skirtukų
išdėstymo, pasirinkite „Settings > Restore Default Window Layout“ (nuostatos > atkurti numatytąjį
langų išdėstymą).
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9 skyrius. Duomenų analizės apžvalga

Duomenų analizės įrankių juosta
Įrankių juosta lange „Data Analysis“ (duomenų analizė) leidžia greitai pasiekti svarbias duomenų
analizės funkcijas.

15 lentelė išvardytos įrankių juostoje esančių mygtukų funkcijos.

Mygtukas Pavadinimas Funkcija

Plokštelės sąranka „View/Edit“ (žiūrėti / redaguoti) plokštelę:
atidaro „Plate Editor“ (plokštelės
redaktorius), kuriame galima peržiūrėti ir
redaguoti šulinėlių turinį.

Failas „Replace Plate“ (pakeisti plokštelę):
pasirenka plokštelės failą, kuriuo keičiamas
plokštelės išdėstymas.

Taikyti „PrimePCR“ (PGR pradmenys) failą:
pasirenka paleidimo failą, kuriuo keičiamas
„PrimePCR“ (PGR pradmenys) paleidimo
plokštelės išdėstymas.

Tvarkyti šulinėlių
grupes

Atidaro langą „Well Groups Manager“ 
(šulinėlių grupių tvarkyklė), kuriame galima
kurti, redaguoti ir šalinti šulinėlių grupes.

Šulinėlių grupė Pasirenka esamą šulinėlių grupės
pavadinimą iš išplečiamojo meniu.
Numatytoji parinktis yra „All Wells“ (visi
šulinėliai). Šis mygtukas pasirodo tik tada,
kai sukuriamos šulinėlių grupės.

Analizės režimas Analizuoja duomenis režimu „Fluorophore“ 
(fluoroforas) arba „Target“ (tikslas).

Pagalba Atidaro elektroninę šių instrukcijų kopiją
„Acrobat PDF“ formatu.

15 lentelė. Įrankių juosta lange „Data Analysis“ (duomenų analizė)

174 | Sistemos CFX96 Dx ir CFX96 Deep Well Dx



Langas „Data Analysis“ (duomenų analizė)

Duomenų analizės meniu juosta
16 lentelė pateikiami meniu juostos elementai, esantys lange „Data Analysis“ (duomenų analizė).

Meniu
elementas Komanda Funkcija

„File“ (failas) „Save“ (įrašyti) Įrašo failą.

„Save As“ (įrašyti kaip) Įrašo failą nauju pavadinimu.

„Repeat Run“ (pakartoti
paleidimą)

Ištraukia protokolą ir plokštelės failą iš esamos
paleisties ir paleidžia juos iš naujo.

„Close“ (uždaryti) Uždaro langą „Data Analysis“ (duomenų
analizė).

„View“ (rodinys) „Run Log“ (paleidimų žurnalas) Atidaro langą „Run Log“ (paleidimų žurnalas),
kuriame galite peržiūrėti esamo duomenų failo
paleidimų žurnalą.

„Quantification“ (kiekybinis
įvertinimas), „Melt Curve“ 
(lydymosi kreivė), „Gene
Expression“ (geno ekspresija),
„End Point“ (pabaigos taškas),
„Custom Data View“ 
(pasirinktinių duomenų
rodinys), QC (KK), „Run
Information“ (paleidimo išsami
informacija)

Rodo analizuojamus duomenis pasirinktose
lango „Data Analysis“ (duomenų analizė)
kortelėse. Reikia pasirinkti bent vieną kortelę.

„Settings“ 
(nuostatos)

„Cq Determination Mode“ (Cq
nustatymo režimas)

Pasirinkite režimą „Regression“ (regresija)
arba „Single Threshold“ (atskira ribinė
reikšmė), norėdami nustatyti, kaip
skaičiuojamos kiekvieno pėdsako Cq reikšmės.

„Baseline Setting“ (pradinis
nustatymas)

Pasirinkite metodą „Baseline Subtraction“ 
(pradinė atimtis) pasirinktoms šulinėlių
grupėms.

16 lentelė. Lango „Data Analysis“ (duomenų analizė) meniu juostos elementai
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9 skyrius. Duomenų analizės apžvalga

Meniu
elementas Komanda Funkcija

„Analysis Mode“ (analizės
režimas)

Pasirinkite, ar duomenis analizuoti pagal
„Fluorophore“ (fluoroforas), ar „Target“ 
(tikslas).

„Cycles to Analyze“ 
(analizuotini ciklai)

Pasirinkite analizuotinus ciklus.

„Baseline Thresholds“ 
(pagrindinės ribinės reikšmės)

Atidaro „Baseline Thresholds“ (pagrindinės
ribinės reikšmės) langą, kuriame galima keisti
pradinę arba ribinę reikšmę.

„Trace Styles“ (pėdsakų stiliai) Atidaro langą „Trace Styles“ (pėdsakų stiliai).

„Plate Setup“ (plokštelės
sąranka)

Atidaro „Plate Editor“ (plokštelės redaktorius),
kuriame galima peržiūrėti ir redaguoti plokštelę;
pakeiskite esamą plokštelę ta, kuri yra vartotojo
apibrėžtos plokštelės faile arba „PrimePCR“ 
(PGR pradmenys) paleidimo faile.

„Include All Excluded Wells“ 
(įtraukti visus neįtrauktus
šulinėlius)

Įtraukia visus neįtrauktus šulinėlius į analizę.

„Mouse Highlighting“ 
(žymėjimas pele)

Įjungia arba išjungia funkciją, kuri leidžia tuo
pačiu metu paryškinti duomenis pelės rodykle.

Patarimas. Jei funkcija „Mouse
Highlighting“ (žymėjimas pele) išjungta,
spustelėkite mygtuką „Control“ (kontrolė),
kad laikinai ją įjungtumėte.

„Restore Default Window
Layout“ (atkurti numatytąjį
langų išdėstymą)

Atkuria langų išdėstymą pagal numatytąsias
nuostatas.

16 lentelė. Lango „Data Analysis“ (duomenų analizė) meniu juostos elementai (tęsinys)
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Langas „Data Analysis“ (duomenų analizė)

Meniu
elementas Komanda Funkcija

„Export“ 
(eksportuoti)

„Export All Data Sheets to
Excel“ (eksportuoti visus
duomenų lapus į „Excel“)

Eksportuoja visus skaičiuoklių rodinius iš visų
kortelių į atskirą „Excel“ failą.

„Custom Export“ (pasirinktinis
eksportas)

Atidaro langą „Custom Export“ (pasirinktinis
eksportas), kuriame galima nurodyti
eksportuotinus laukelius ir failo formatą.

„Export to LIMS Folder“ 
(eksportuoti į LIMS aplanką)

Atidaro langą, kuriame galima įrašyti duomenis
iš anksto nustatytu formatu LIMS aplanke.

„Seegene Export“ („Seegene“ 
eksportas)

Atidaro langą, kuriame galima pasirinkti vietą,
kurioje „Excel“ formatu, specialiai pritaikytu
„Seegene, Inc“, bus įrašyti duomenys iš visų
skaičiuoklių rodinių.

„Tools“ (įrankiai) „Reports“ (ataskaitos) Atidaro šio duomenų failo ataskaitą.

„Well Group Reports“ (šulinėlių
grupės ataskaitos)

Atidaro langą „Well Group Report“ (šulinėlių
grupės ataskaita), kuriame galima kurti
ataskaitas nurodytoms šulinėlių grupėms.

„Import Fluorophore
Calibration“ (importuoti
fluoroforo kalibravimą)

Pasirinkite kalibravimo failą, kurį norite taikyti
esamam duomenų failui.

„qbase+“ Paleidžia 2.5 versijos „qbase+“ tiesiai iš esamo
.pcrd failo (jei jis įdiegtas).

16 lentelė. Lango „Data Analysis“ (duomenų analizė) meniu juostos elementai (tęsinys)
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Kortelės išsami informacija
Kiekvienoje lango „Data Analysis“ (duomenų analizė) kortelėje rodomi diagramų ir skaičiuoklių
duomenys, skirti tam tikram analizės metodui, taip pat yra šulinėlių parinkiklis, kad galėtumėte
pasirinkti norimus rodyti duomenis. Atidarius langą „Data Analysis“ (duomenų analizė) pagal
numatytąsias nuostatas jame rodoma kortelė „Quantification“ (kiekybinis įvertinimas). Jei norite
nustatyti tinkamus analizės parametrus, galite naudoti diagramą „Amplification“ (amplifikavimas),
esančią kortelėje „Quantification“ (kiekybinis įvertinimas).

Pastaba. Programinė įranga susieja kiekvienos kortelės „Data Analysis“ (duomenų analizė) sričių
duomenis. Pavyzdžiui, jei šulinėlis yra paryškinamas, užvedus virš jo pelės rodyklę šulinėlių
parinkiklio rodinyje, taip pat paryškinami su juo susiję duomenys visose kitose srityse.

Parinkiklis „Step Number“ (veiksmo numeris)
Sistemos „CFX96“ ir „CFX96 Deep Well“ gali gauti fluorescencijos duomenis, surinktus atlikus įvairius
protokolo veiksmus; programinė įranga išsaugo kiekvieno veiksmo metu gautus duomenis atskirai
vienus nuo kitų. Programinė įranga rodo parinkiklį „Step Number“ (veiksmo numeris). Jei protokolas
apima bent vieną duomenų rinkimo veiksmą, CFX Manager Dx programinė įranga rodo pirmojo
rinkimo veiksmo metu gautus duomenis.

Jei protokolas apima daugiau nei vieną rinkimo veiksmą, išplečiamajame sąraše galite pasirinkti kitą
veiksmą, pavyzdžiui:

178 | Sistemos CFX96 Dx ir CFX96 Deep Well Dx



Langas „Data Analysis“ (duomenų analizė)

Kai pasirenkate veiksmą, programinė įranga taiko šią parinktį visiems duomenims, rodomiems lange
„Data Analysis“ (duomenų analizė).

Šulinėlių grupių lange „Data Analysis“ (duomenų analizė)
peržiūrėjimas
Plokštelės šulinėlius galima sugrupuoti į pogrupius nepriklausomai analizei, naudojant šulinėlių
grupes. Kai sukuriate šulinėlių grupes, jų pavadinimai pasirodo įrankių juostoje esančiame
išplečiamajame sąraše „Well Groups“ (šulinėlių grupės) lange „Data Analysis“ (duomenų analizė).

Jei sukūrėte šulinėlių grupių, programinėje įrangoje atidarius langą „Data Analysis“ (duomenų analizė)
rodoma numatytoji šulinėlių grupė „All Wells“ (visi šulinėliai). Joje diagramų ir skaičiuoklių forma
pateikiami visų šulinėlių duomenys. Šulinėlių parinkiklyje rodomi tik grupės šulinėliai su turiniu ir tik šių
šulinėlių duomenys įtraukiami į duomenų analizės skaičiavimus.

Pastaba. Jei nesate sukūrę šulinėlių grupių, išplečiamasis sąrašas „Well Groups“ (šulinėlių
grupės) įrankių juostoje nerodomas.

Šulinėlių turinio keitimas po paleidimo
Kai duomenų analizės metu keičiamas duomenų rodymo būdas, keičiant šulinėlių turinį „Plate Editor“ 
(plokštelės redaktorius), niekada nesikeičia fluorescencijos duomenys, kurie buvo surinkti iš kiekvieno
šulinėlio paleidimo metu. Kai modulis renka fluorescencinius duomenis, negalite šalinti šių duomenų,
tačiau galite pasirinkti pašalinti duomenis iš peržiūros ir analizės.

Šulinėlių turinio pakeitimas po paleidimo

u Lange „Data Analysis“ (duomenų analizė) spustelėkite „Plate Setup“ (plokštelės sąranka) ir
pasirinkite vieną iš šių parinkčių:

n „Edit/View Plate“ (redaguoti / peržiūrėti plokštelę) – atveriamas „Plate Editor“ 
(plokštelės redaktorius), kuriame rankiniu būdu galite atlikti schemos pakeitimus.
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n „Replace Plate file“ (pakeisti plokštelės failą) – atveriama plokštelių parinkčių naršyklė,
kuria naudodamiesi galite pasiekti anksčiau įrašytą plokštelės failą, kuriuo galite pakeisti
dabartinę plokštelės schemą.

n „Apply PrimePCR file“ (taikyti PGR pradmenų failą) – atveriamas failo dialogo langas
„Select PrimePCR“ (pasirinkti PGR pradmenis), iš kurio galite pasiekti „PrimePCR“ (PGR
pradmenys) analizės failą ir taikyti jį plokštelės schemai.

Patarimas. Jūs galite pridėti arba redaguoti informaciją apie šulinėlio turinį prieš paleidimą,
paleidimo metu arba tada, kai PCR (PGR) paleidimas baigtas. Nuskaitymo režimą ir plokštelės
dydį turite priskirti prieš pradėdami paleidimą. Šie parametrai pradėjus paleidimą negali būti
keičiami.
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Duomenų analizės nuostatos

Duomenų analizės nuostatos
Diagramos „Amplification“ (amplifikavimas) duomenys kortelėje „Quantification“ (kiekybinis
įvertinimas) rodo kiekvieno šulinėlio santykinę fluorscenciją (RFU) kiekvieno ciklo metu. Kiekvienas
pėdsakas diagramoje reiškia duomenis iš atskiro fluoroforo viename šulinėlyje. Šie duomenys
naudojami nustatyti Cq vertėms kiekvienam šulinėliui pagal fluoroforą. Programinė įranga taiko vieną
iš dviejų režimų Cq vertėms nustatyti:

n „Regression“ (regresija) – taiko daugialypį, netiesinės regresijos modelį atskirų šulinėlių
pėdsakams ir tada šį modelį naudoja apskaičiuoti optimaliai Cq vertei.

n „Single Threshold“ (atskira ribinė reikšmė) – naudoja atskirą ribinę reikšmę Cq vertei
apskaičiuoti pagal atskirų fluorescencijos pėdsakų ribinę reikšmę kertantį tašką.

Pasirinkite „Settings > Cq Determination Mode“ (nuostatos > Cq nustatymo režimas) ir pasirinkite Cq
nustatymo režimą.

Ribinės reikšmės koregavimas
Režimu „Single Threshold“ (atskira ribinė reikšmė) galite koreguoti fluoroforo ribinę reikšmę spustelėję
ribinės reikšmės liniją diagramoje „Amplification“ (amplifikavimas) ir pelės rodyklę perkėlę vertikaliai.
Taip pat galite nurodyti pasirinkto fluoroforo tikslią perėjimo ribinę reikšmę.

Pradinės nuostatos
Programinė įranga automatiškai nustato pradines nuostatas atskirai kiekvienam šulinėliui. Pradinė
nuostata apibrėžia pradinį atimties metodą, taikomą visiems fluorescencijos pėdsakams.
Programinėje įrangoje numatytos trys pradinės atimties parinktys:

n „No Baseline Subtraction“ (pradinės atimties nėra) – rodo duomenis kaip santykinius
fluorescencijos pėdsakus. Kai kuri analizė šiuo analizės režimu neįmanoma, todėl programinė
įranga nerodo kortelių „Gene Expression“ (geno ekspresija), „End Point“ (pabaigos taškas) ir
„Allelic Discrimination“ (alelių diskriminacija).

n „Baseline Subtracted“ (pradinė atimtis) – rodo duomenis kaip pėdsako pradinę atimtį,
susijusią su kiekvienu šulinėlio fluoroforu. Programinė įranga turi sukurti duomenų pradinę atimtį,
kad nustatytų kiekybinius ciklus, braižytų standartines kreives ir nustatytų nežinomų mėginių
koncentraciją. Kai norima sukurti pėdsako pradinę atmintį, programinė įranga nustato pradinio
ciklo metu kiekvienam šulinėliui įrašytą fluorescencijos geriausią tiesiąją liniją ir tada atrenka
tinkamiausius duomenis iš foninių kiekvieno ciklo metu atrinktų duomenų.

n „Baseline Subtracted Curve Fit“ (pradinės atimties kreivės atitiktis) – rodo duomenis kaip
pėdsako pradinę atimtį, o programinė įranga išlygina pradinės atimties kreivę, naudodama
centruotą vidurkio filtrą. Šis procesas atliekamas taip, kad kiekvienas Cq liktų nepakitęs.
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Be šių parinkčių, taip pat galite pasirinkti „Apply Fluorescent Drift Correction“ (taikyti fluorescencijos dreifo
korekciją). Šulinėlių, kuriuose per pradinius kelis analizės ciklus gaunamos neįprastai išsisklaidžiusios
RFU reikšmės, atveju programinė įranga apskaičiuoja numatytą pradinę liniją iš gretimų šulinėlių,
kuriems sėkmingai sukurta horizontali pradinė linija.

Pradinės atimties nuostatos keitimas

u Pasirinkite „Settings > Baseline Setting“ (nuostatos > pradinis nustatymas).

Analizės režimas
Duomenis galima sugrupuoti ir analizuoti arba pagal fluoroforą, arba tikslo pavadinimą. Sugrupavus
pagal fluoroforą, duomenų pėdsakai rodomi pagal fluoroforą, kaip nurodyta to paleidimo plokštelės
nuostatose. Atskiro fluoroforo duomenys parodomi amplifikavimo ir standartinės kreivės diagramoje
(jeigu yra), kai pažymimi atitinkami fluoroforo pasirinkimo priemonės žymės langeliai, esantys po
amplifikavimo diagrama.
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Sugrupavus pagal tikslą, duomenų pėdsakai parodomi pagal tikslo pavadinimą, koks jis buvo įvestas į
paleidimo plokštelės sąranką.

Duomenų analizės režimo pasirinkimas

u Atlikite vieną iš šių veiksmų:

n Pasirinkite „Settings > Analysis Mode“ (nuostatos > analizės režimas).

n Įrankių juostos išplečiamajame meniu „Analysis Mode“ (analizės režimas) pasirinkite režimą.

Analizuotini ciklai
Galite riboti analizuotinų ciklų skaičių. Taip pat galite analizuoti duomenis iš konkretaus ciklų rinkinio.
Didžiausias ciklų, kurį galite analizuoti, skaičius yra 50.

Pastaba. Pašalinus ciklus iš paleidimo pradžios galima padaryti didelę įtaką pradiniam lygiui.

Duomenų analizės apribojimas iki konkretaus ciklų intervalo

1. Pasirinkite „Settings > Cycles to Analyze“ (nuostatos > analizuotini ciklai).

Parodomas dialogo langas „Cycles to Analyze“ (analizuotini ciklai).

2. Įveskite pradžios ir pabaigos ciklo vertes ir spustelėkite OK (gerai).

Dialogo lange „Cycles to Analyze“ (analizuotini ciklai) spustelėkite „Restore Defaults“ (atkurti
numatytuosius parametrus) ir grįžkite į analizei pradžioje naudojamus ciklus.
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Šulinėlių parinkiklis
Pasinaudokite šulinėlių parinkikliu šulinėlio duomenims parodyti arba paslėpti diagramose arba
skaičiuoklėse lange „Data Analysis“ (duomenų analizė). Šulinėlių parinkiklyje galima pasirinkti tik su
mėginiais įdėtus šulinėlius. Programinė įranga šulinėlių parinkiklyje nuspalvina šulinėlius:

n „Blue“ (mėlyna) – reiškia pasirinktus šulinėlius. Duomenys iš pasirinktų šulinėlių rodomi lange
„Data Analysis“ (duomenų analizė).

n „Light gray“ (šviesiai pilka) – reiškia nepasirinktus šulinėlius. Duomenys iš nepasirinktų
šulinėlių nerodomi lange „Data Analysis“ (duomenų analizė).

n „Dark gray“ (tamsiai pilka) – reiškia tuščius šulinėlius.
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Šulinėlių parinkiklis

Šulinėlių duomenų rodymas arba paslėpimas

u Šulinėlių parinkiklyje atlikite toliau nurodytus veiksmus:

n Norėdami paslėpti vieną šulinėlį, spustelėkite atskirą šulinėlį. Norėdami rodyti tą šulinėlį, jį
spustelėkite dar kartą.

n Norėdami paslėpti kelis šulinėlius, vilkite per šulinėlius, kuriuos norite pasirinkti. Norėdami
šiuos šulinėlius rodyti, vėl vilkite per šiuos šulinėlius.

n Spustelėkite plokštelės viršutinį kairįjį kampą ir paslėpkite visus šulinėlius. Spustelėkite
viršutinį kairįjį kampą dar kartą ir rodykite visus šulinėlius.

n Spustelėkite stulpelio ar eilutės pradžią ir šiuos šulinėlius paslėpkite. Stulpelį ar eilutę
spustelėkite dar kartą ir parodykite šulinėlius.

Šulinėlių parinkiklio pelės dešiniojo mygtuko meniu elementai
17 lentelė pateikiamos pelės dešiniojo mygtuko parinktys, prieinamos šulinėlių parinkiklio rodinyje.

Elementas Funkcija

„Well XX“ (šulinėlis XX) Rodomas tik šis šulinėlis, šis šulinėlis pašalinamas iš rodinio,
nustatoma šio šulinėlio spalva arba šis šulinėlis pašalinamas iš
analizės.

„Selected Wells“ (pasirinkti
šulinėliai) (spustelėjus dešinįjį
pelės mygtuką ir tempiant)

Rodomi tik šie šulinėliai, šie šulinėliai pašalinami iš rodinio,
nustatoma šių šulinėlių spalva arba šie šulinėliai pašalinami iš
analizės.

„Copy“ (kopijuoti) Šulinėlio turinys, įskaitant mėginio tipą ir pasirinktines kopijas (Nr.),
kopijuojamas į iškarpinę.

„Copy as Image“ (kopijuoti kaip
paveikslėlį)

Šulinėlio parinkiklio rodinys kopijuojamas kaip paveikslėlis.

„Print“ (spausdinti) Atspausdinamas šulinėlio parinkiklio rodinys.

„Print Selection“ (spausdinti
pasirinkimą)

Atspausdinamas esamas pasirinkimas.

„Export to Excel“ (eksportuoti į
„Excel“)

Duomenys eksportuojami į „Excel“ skaičiuoklę.

17 lentelė. Pelės dešiniojo mygtuko meniu elementai, skirti šulinėlių parinkikliams
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Elementas Funkcija

„Export to Csv“ (eksportuoti į
Csv)

Duomenys eksportuojami kaip tekstinis dokumentas.

„Export to Xml“ (eksportuoti į
Xml)

Duomenys eksportuojami kaip .xml dokumentas.

„Well Labels“ (šulinėlių
etiketės)

Šulinėlių etiketės pakeičiamos į „Sample Type“ (mėginio tipas),
„Target Name“ (tikslo pavadinimas) arba „Sample Name“ (mėginio
pavadinimas).

17 lentelė. Pelės dešiniojo mygtuko meniu elementai, skirti šulinėlių parinkikliams (tęsinys)

Iš analizės laikinai pašalinami šulinėliai
Kaip laikinai pašalinti šulinėlius iš analizės

1. Spustelėkite šulinėlį dešiniuoju pelės mygtuku šulinėlių parinkiklyje. Jei norite pašalinti kelis
šulinėlius, spustelėkite dešinįjį pelės mygtuką ir vilkite pelės rodyklę, kad pažymėtumėte keletą
šulinėlių, pėdsakų ar taškų.

2. Dešiniojo pelės mygtuko meniu pasirinkite norimą parinktį:

n „Well > Exclude Well“ (šulinėlis > pašalinti šulinėlį)

n „Selected Wells > Exclude from Analysis“ (pasirinkti šulinėliai > pašalinti iš analizės)

n „Selected Traces > Exclude these wells from Analysis“ (pasirinkti pėdsakai > pašalinti šiuos
šulinėlius iš analizės)
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Norėdami visam laikui pašalinti šulinėlius iš analizės, taip pat galite išvalyti šulinėlių turinį lange
„Plate Editor“ (plokštelės redaktorius) paspausdami mygtuką „Clear Wells“ (valyti šulinėlius).

Svarbu. Turite iš naujo įvesti bet kokį pašalintą turinį.

Kaip grąžinti pašalintą šulinėlį

u Spustelėkite atitinkamą šulinėlį dešiniuoju pelės mygtuku šulinėlių parinkiklyje ir pasirinkite „Well
> Include Well in Analysis“ (šulinėlis > įtraukti šulinėlį į analizę).
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Diagramos
Kiekvienoje lange „Data Analysis“ (duomenų analizė) esančioje diagramoje duomenų rodymas skiriasi
grafiškai ir pateikiamos duomenų arba diagramų grafikos koregavimo ir eksportavimo parinktys.

Bendrieji pelės dešiniojo mygtuko meniu elementai, skirti
diagramoms
18 lentelė pateikiami pelės dešiniojo mygtuko meniu elementai, kurie gali būti naudojami diagramose.
Kai kurie galimi elementai yra skirti visoms diagramoms; šie elementai gali būti naudojami, norint keisti
duomenų rodymo būdą arba paprastai eksportuoti duomenis iš diagramos.

Elementas Funkcija

„Copy“ (kopijuoti) Diagrama nukopijuojama į iškarpinę.

„Save Image As“ (įrašyti
paveikslėlį kaip)

Įrašomas nustatyto dydžio, raiškos ir failo tipo vaizdas. Galimi vaizdo
formatai yra PNG (numatytasis), JPG ir BMP.

„Page Setup“ (puslapio
sąranka)

Peržiūrima ir parenkama puslapio sąranka spausdinti.

„Print“ (spausdinti) Atspausdinama diagrama.

„Set Scale to Default“ 
(nustatyti numatytąją skalę)

Padidinta diagrama grąžinama į numatytąjį rodinį.

„Chart Options“ (diagramos
parinktys)

Atveriamas langas „Chart Options“ (diagramos parinktys), kuriame
galima pakeisti diagramą, įskaitant pavadinimo keitimą, x ir y ašių ribų
pasirinkimą, tinklelio linijų rodymą ir mažųjų varnelių ašyse rodymą.

18 lentelė. Pelės dešiniojo mygtuko meniu elementai, skirti diagramoms

Pastaba. Meniu elementai, taikomi konkrečioms diagramoms, aprašyti 10 skyrius, Išsami
duomenų analizės informacija.
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Diagramos

Diagramos duomenų kopijavimas į iškarpinę
Galite nukopijuoti diagramos rodinio turinį ir įklijuoti jį į bet kurią programą, kuri priima taškinės grafikos
vaizdo failus.

Kaip kopijuoti diagramos duomenis į iškarpinę

1. Iš diagramos dešiniojo pelės mygtuko meniu pasirinkite „Copy“ (kopijuoti).

2. Atidarykite programą, kuri priima taškinės grafikos vaizdus, pvz., „Microsoft Word“.

3. Dešiniuoju pelės mygtuku spustelėkite ir pasirinkite „Paste“ (įklijuoti), kad įklijuotumėte taškinės
grafikos vaizdą iš iškarpinės į taikomąją programą.

Pradinės ribinės reikšmės nuostatų modifikavimas
Režimu „Single Threshold“ (atskira ribinė reikšmė) galite koreguoti fluoroforo ribinę reikšmę spustelėję
ribinės reikšmės liniją amplifikavimo diagramoje ir pelės rodyklę perkėlę vertikaliai. Taip pat galite
nurodyti pasirinkto fluoroforo tikslią perėjimo ribinę reikšmę.

Patarimas. Galite nurodyti ciklo intervalą, kad būtų galima nustatyti pradinį visų duomenų failų
lygį, kortelėje „Data Analysis“ (duomenų analizė), esančioje „User > User Preferences“ 
(vartotojas > vartotojo nuostatos).

Kiekvieno šulinėlio pradinio lygio pradžios ir pabaigos ciklo koregavimas

1. Kortelėje „Quantification“ (kiekybinis įvertinimas) pasirinkite atskirą fluoroforą diagramoje
„Amplification“ (amplifikavimas).

2. Diagramos dešiniojo pelės mygtuko meniu pasirinkite „Baseline Threshold“ (pradinė ribinė
reikšmė).
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Parodomas dialogo langas „Baseline Threshold“ (pradinė ribinė reikšmė).

3. Skyriuje „Baseline Cycles“ (pradiniai ciklai) atlikite šiuos veiksmus:

n Norėdami pasirinkti vieną šulinėlį, spustelėkite jo eilutės numerį.

n Norėdami pasirinkti kelis gretimus šulinėlius, spustelėkite pirmojo šulinėlio eilės numerį ir
vilkite stulpeliu žemyn iki galutinio šulinėlio.

n Norėdami pasirinkti kelis negretimus šulinėlius, paspauskite klavišą „Control“ (valdyti) ir
spustelėkite kiekvieną tikslinį šulinėlį.

n Norėdami pasirinkti visus šulinėlius, spustelėkite lentelės viršutinį kairįjį kampą.

4. Koreguokite visų pasirinktų šulinėlių pradinį pradžios ciklą ir pradinį pabaigos ciklą arba
skaičiuoklės apačioje pakeiskite pradžios ir pabaigos ciklo numerį.

Patarimas. Norėdami sugrąžinti nuostatų paskutines įrašytas vertes, spustelėkite „Reset All
User Defined Values“ (atstatyti visas vartotojo apibrėžtas vertes).

5. Spustelėkite „OK“ (gerai), įrašykite pakeitimus ir grįžkite į diagramą.
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Diagramos

Visų duomenų failų ciklo intervalo nurodymas

u Lange „Home“ (pagrindinis) arba „Plate Editor“ (plokštelės redaktorius) pasirinkite „User > User
Preferences“ (vartotojas > vartotojo nuostatos) ir pasirinkite kortelę „Data Analysis“ (duomenų
analizė).

Tikslo ir mėginių duomenų rūšiavimas
Pastaba. Ši parinktis galima tik geno ekspresijos diagramose.

Pagal numatytuosius parametrus tikslų ir mėginių sąrašai pateikiami abėcėline tvarka. Dialogo lange
„Sort“ (rūšiuoti) galite rūšiuoti rodmenis atvirkštine tvarka pagal abėcėlę arba rankiniu būdu perkelti
terminą į kitą padėtį sąraše.

Tikslo ir mėginio duomenų rūšiavimas

1. Diagramos dešiniojo pelės mygtuko meniu spustelėkite „Sort“ (rūšiuoti).

Parodomas dialogo langas „Gene Expression Chart Sorting“ (geno ekspresijos diagramų
rūšiavimas).

2. Dialogo lange spustelėkite Z–A ir surūšiuokite sąrašą atvirkštine abėcėline tvarka.

3. Norėdami rankiniu būdu perkelti terminą, jį pasirinkite ir spustelėkite atitinkamą mygtuką tarp
diagramų:

n Spustelėkite rodyklę aukštyn ar žemyn ir pasirinktą terminą perkelkite per vieną padėtį.

n Spustelėkite juostos rodyklę aukštyn ar žemyn ir pasirinktą terminą perkelkite į sąrašo viršų
ar apačią.

4. Spustelėkite OK (gerai), įrašykite pakeitimus ir grįžkite į „Gene Expression“ (geno ekspresija)
kortelę.
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Diagramos srities didinimas
Kaip didinti diagramos sritį

u Spustelėkite ir vilkite pele diagramoje, o tada spustelėkite „Zoom“ (keisti mastelį)*. Programinė
įranga pakeičia diagramos dydį ir ją centruoja pasirinktoje srityje.

Pastaba. * Stulpelinėje diagramoje nereikia spustelėti „Zoom“ (keisti mastelį) išplečiamosios
komandos.

Diagramos nustatymas į visą rodinį

u Diagramoje spustelėkite dešiniuoju klavišu ir pasirinkite „Set Scale to Default“ (nustatyti
numatytąją skalę).

Diagramų kopijavimas į „Microsoft“ failą
Duomenų diagramas galite kopijuoti į „Microsoft Word“, „Excel“ arba „PowerPoint“ dokumentus.
Vaizdo skiriamoji geba atitinka ekrano, iš kurio buvo gautas vaizdas, skiriamąją gebą

Kaip nukopijuoti diagramas į „Microsoft“ failą

1. Lange „Data Analysis“ (duomenų analizė) pasirinkite „Copy“ (kopijuoti) diagramos dešiniojo
mygtuko meniu.

2. Atidarykite tuščią „Microsoft“ failą ir įklijuokite turinį iš iškarpinės.

Taip pat galite: spustelėti ant „click-and-drag“ (spustelėti ir tempti) piktogramos ir nutempti
diagramą į „Microsoft“ failą.
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Skaičiuoklės

Skaičiuoklės
Lange „Data Analysis“ (duomenų analizė) pateiktos skaičiuoklės apima duomenų rūšiavimo ir
perdavimo galimybes. Rūšiuokite stulpelius vienu iš šių būdų:

n Spustelėkite ir vilkite stulpelį į naują vietą pasirinktoje lentelėje.

n Spustelėkite stulpelio antraštę, jei norite rūšiuoti duomenis didėjančia ar mažėjančia tvarka.

Kaip rūšiuoti iki trijų duomenų stulpelių lange „Sort“ (rūšiuoti)

1. Dešiniuoju pelės mygtuku spustelėkite skaičiuoklę ir pasirinkite „Sort“ (rūšiuoti).

2. Dialogo lange „Sort“ (rūšiuoti) pasirinkite pirmą stulpelio pavadinimą, kurį rūšiuosite. Rūšiuokite
duomenis didėjančia ar mažėjančia tvarka.

3. Pasirinkite antrą arba trečią stulpelį ir rūšiuokite jį „Ascending“ (didėjančia tvarka) arba
„Descending“ (mažėjančia tvarka).

4. Spustelėkite OK (gerai), kad išrūšiuotumėte duomenis, arba „Cancel“ (atšaukti), kad
sustabdytumėte rūšiavimą.

Paryškinkite duomenis susijusiose diagramose ir šulinėlių parinkiklyje laikydami pelės rodyklę virš
langelio. Spustelėkite langelį, jei norite kopijuoti ir įklijuoti jo turinį į kitą programinę įrangą.
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Skaičiuoklių bendrieji pelės dešiniojo mygtuko meniu elementai
19 lentelė pateikiami pelės dešiniojo mygtuko meniu elementai, kurie gali būti naudojami skaičiuoklės
rodinyje.

Elementas Funkcija

„Copy“ (kopijuoti) Pasirinkto šulinėlio turinį kopijuoja į iškarpinę, tada jį įkelia į
skaičiuoklę, pvz., „Excel“.

„Copy as Image“ (kopijuoti kaip
paveikslėlį)

Kopijuoja skaičiuoklės vaizdą kaip paveikslėlio failą ir įkelia į failą,
kuris priima vaizdinius failus, pvz., tekstinį, vaizdinį ar skaičiuoklės
failą.

„Print“ (spausdinti) Atspausdinamas esamas vaizdas.

„Print Selection“ (spausdinti
pasirinkimą)

Atspausdinamas esamas pasirinkimas.

„Export to Excel“ (eksportuoti į
„Excel“)

Duomenys eksportuojami į „Excel“ skaičiuoklę.

„Export to CSV“ (eksportuoti į
CSV)

Eksportuoja duomenis į kableliu atskirtų duomenų (.csv) failą.

„Export to Xml“ (eksportuoti į
Xml)

Duomenys eksportuojami į Xml failą.

„Export to Html“ (eksportuoti į
Html)

Duomenys eksportuojami į Html failą.

„Find“ (ieškoti) Ieškoma teksto.

„Sort“ (rūšiuoti) Rūšiuoja duomenis į iki trijų stulpelių.

„Select Columns“ (pasirinkti
stulpelius)

Pasirenkami stulpeliai, kurie bus rodomi skaičiuoklėje.

19 lentelė. Skaičiuoklių pelės dešiniojo mygtuko meniu elementai
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Eksportas

Eksportas
CFX Manager Dx programinė įranga eksporto išplečiamajame meniu jums suteikia keturias
eksportavimo parinktis:

n „Export All Data Sheets“ (eksportuoti visus duomenų lapus)

n „Custom Export“ (pasirinktinis eksportas)

n „Export to LIMS“ (eksportuoti į LIMS)

n „Seegene Export“ („Seegene“ eksportas)

Visų duomenų lapų eksportavimas
Visus skaičiuoklės rodinius iš kiekvienos „CFX Manager Dx programinė įranga“ kortelės galite
eksportuoti į atskirus failus.

Kaip eksportuoti visus duomenų lapus

u Pasirinkite „Export > Export All Data Sheets“ (eksportuoti > eksportuoti visus duomenų lapus) ir
tada pasirinkite pageidaujamą failo tipą:

n CSV (*.csv)

n „Text“ (tekstinis) (*.txt)

n „Excel 2007“ (*.xlsx)

n „Excel 2003“ (*.xls)

n XML (*.xml)
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Pasirinktinio eksporto failo sukūrimas
Kaip sukurti pasirinktinio eksporto failą

1. Pasirinkite „Export > Custom Export“ (eksportuoti > pasirinktinis eksportas). Pasirodo dialogo
langas „Custom Export“ (pasirinktinis eksportas).

2. Pasirinkite eksporto formatą iš pasirodžiusio išplečiamojo sąrašo.

3. Pažymėkite norimų eksportuoti elementų žymės langelius.

4. (Neprivaloma) Spustelėkite „Customize Column Names“ (tinkinti stulpelių pavadinimus),
norėdami pakeisti stulpelių pavadinimus.

5. Spustelėkite „Export“ (eksportuoti). Parodomas dialogo langas „Save As“ (įrašyti kaip).

6. Dialogo lange „Save As“ (įrašyti kaip) nurodykite failo pavadinimą ir vietą, kurioje norite įrašyti
eksportuojamą failą.

7. Kad įrašytumėte eksportuojamą failą, spustelėkite OK (gerai).
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Eksportas

Eksportavimas į LIMS aplanką
Duomenis galite eksportuoti su LIMS suderinamu failo formatu.

Kaip eksportuoti duomenis LIMS formatu

1. Pasirinkite „Export > Export to LIMS Folder“ (eksportuoti > eksportuoti į LIMS aplanką).

Parodomas dialogo langas „Save As“ (įrašyti kaip).

2. Dialogo lange „Save As“ (įrašyti kaip) nurodykite failo pavadinimą ir vietą, kurioje norite įrašyti
eksportuojamą failą.

3. Kad įrašytumėte eksportuojamą failą, spustelėkite OK (gerai).

Duomenų „Seegene“ formatu eksportavimas
Duomenis galite eksportuoti iš visų skaičiuoklių rodinių į „Excel“ failus, specialiai pritaikytus „Seegene,
Inc“.

Kaip eksportuoti duomenis „Seegene“ formatu

1. Pasirinkite „Export > Seegene Export“ (eksportuoti > „Seegene“ eksportas).

Parodomas dialogo langas „Save As“ (įrašyti kaip).

2. Dialogo lange „Save As“ (įrašyti kaip) nurodykite aplanko vietą, kurioje norite įrašyti
eksportuojamą „Excel“ (.xlsx) failą „Seegene“ formatu.

3. Kad įrašytumėte eksportuojamus failus, spustelėkite OK (gerai).
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10 skyrius. Išsami duomenų analizės informacija
„CFX Manager Dx“ programinės įrangos langą „Data Analysis“ (duomenų analizė) sudaro kelios
kortelės, kuriose galima peržiūrėti duomenis. Šiame skyriuje išsamiai paaiškinamos šios kortelės.

Patarimas. Galite pasirinkti, kurias korteles peržiūrėti lange „Data Analysis“ (duomenų analizė)
pasinaudoję meniu „View“ (rodymas) meniu. Pasirinktinis išdėstymas įrašomas su duomenų failu.
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Kortelė „Quantification“ (kiekybinis įvertinimas)
Pasinaudokite duomenimis kortelėje „Quantification“ (kiekybinis įvertinimas) ir nustatykite duomenų
analizės sąlygas, įskaitant atskirų šulinėlių pagrindines nuostatas ir ribinės reikšmės nuostatas.
Kortelėje „Quantification“ (kiekybinis įvertinimas) rodomi duomenys keturiuose šiuose rodiniuose:

n Diagrama „Amplification“ (amplifikavimas) – kiekvienam šulinėliui kiekviename cikle rodomi
santykiniai fluorescencijos vienetai (RFU). Kiekvienas pėdsakas diagramoje reiškia duomenis iš
atskiro fluoroforo viename šulinėlyje.

n „Standard curve“ (standartinė kreivė) – rodoma tik jeigu paleidimas apima šulinėlius, skirtus
mėginių tipo standartui („Std“ (standartinis)). Standartinėje kreivėje rodomas ribinės reikšmės
ciklas, pažymėtas grafike pradinio kiekio logaritmo atžvilgiu. Sutartiniame žymėjime rodomas
reakcijos veiksmingumas (E) kiekvienam fluoroforui šulinėliuose, kuriuose yra standartinio tipo
mėginiai.

n Šulinėlių parinkiklis – pasirenkami šulinėliai su fluorescenciniais duomenimis, kuriuos norite
parodyti.

n Skaičiuoklė – rodoma pasirinkto šulinėlio surinktų duomenų skaičiuoklė.

Fluoroforų parinktys
Norėdami kortelės „Quantification“ (kiekybinis įvertinimas) diagramose ir skaičiuoklėse pateikti
fluoroforo duomenis, pasirinkite tikslinį (-ius) fluoroforą (-us), esantį (-čius) po diagrama „Amplification“ 
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Kortelė „Quantification“ (kiekybinis įvertinimas)

(amplifikavimas). Norėdami paslėpti duomenų analizės lange esančius fluoroforo duomenis,
pašalinkite jo žymės langelio žymėjimą.

Dialogo langas „Trace Styles“ (pėdsakų stiliai)
Dialogo lange „Trace Styles“ (pėdsakų stiliai) galite koreguoti visų pėdsakų amplifikavimo ir lydymosi
kreivių diagramų išvaizdą kortelėse „Quantification“ (kiekybinis įvertinimas) ir „Melt Curve“ (lydymosi
kreivė). Tada jūs galite peržiūrėti šulinėlių parinkiklio pakeitimus, kurie rodomi dialogo lange „Trace
Styles“ (pėdsakų stiliai).

Kaip koreguoti pėdsakų stilių

1. Diagramoje „Amplification“ (amplifikavimas) pasirinkite tik vieną fluoroforą.

2. Norėdami atverti dialogo langą „Trace Styles“ (pėdsakų stiliai) atlikite vieną iš šių veiksmų:

n Diagramoje „Amplification“ (amplifikavimas) spustelėkite „Trace Styles“ (pėdsakų stiliai).

n Meniu juostoje „Data Analysis“ (duomenų analizė) pasirinkite „Settings > Trace Styles“ 
(nuostatos > pėdsakų stiliai).

n Pelės dešiniuoju klavišu spustelėkite pėdsaką ir pasirinkite „Trace Styles“ (pėdsakų stiliai).

Parodomas dialogo langas „Trace Styles“ (pėdsakų stiliai).

3. Dialogo lango „Trace Styles“ (pėdsakų stiliai) šulinėlių parinkiklyje apatinėje srityje pasirinkite
konkretų šulinėlių rinkinį. Taip pat galite pasirinkti šulinėlius, kurių išplečiamojo meniu stulpelyje
„Wells“ (šulinėliai) mėginiai yra vieno tipo.

4. Atlikite toliau nurodytus veiksmus:
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n Norėdami pasirinkti pasirinktų šulinėlių spalvą, stulpelyje „Color“ (spalva) spustelėkite
langelį.

n Norėdami pasirinktiems šulinėliams priskirti simbolį, išplečiamajame sąraše „Symbol“ 
(simbolis) pasirinkite simbolį.

n Norėdami gretai nuspalvinti šulinėlius pagal mygtuko ženklinimą, spustelėkite atitinkamą
spartųjį rinkinį:

o „Random by Well“ (atsitiktinai pagal šulinėlį)

o „Random by Replicate“ (atsitiktinai pagal kopiją)

o „Use Fluor Colors“ (naudoti fluoroforo spalvas)

o „Use Target Colors“ (naudoti tikslo spalvas)

o „Use Sample Colors“ (naudoti mėginio spalvas)

n Norėdami priskirti šulinėlių etiketes, pasirinkite arba „Sample Type“ (mėginio tipas), „Target
Name“ (tikslo pavadinimas), „Sample Name“ (mėginio pavadinimas), arba „Symbol“ 
(simbolis).

Parinktis „Log Scale“ (logaritminė skalė)
Pasirinkite „Log Scale“ (logaritminė skalė), esančią po diagrama „Amplification“ (amplifikavimas), kad
pamatytumėte fluorescencijos pėdsakus antrinio žurnalo skalėje:

Patarimas. Jei norite padidinti bet kurią diagramos sritį, vilkite pele per tikslinę sritį. Jei norite
grįžti į rodinį per visą ekraną, diagramoje spustelėkite dešiniuoju klavišu ir pasirinkite „Set Scale to
Default“ (nustatyti numatytąją skalę).
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Kortelė „Quantification“ (kiekybinis įvertinimas)

Diagrama „Standard Curve“ (standartinė kreivė)
Programinė įranga kortelėje „Quantification“ (kiekybinis įvertinimas) sukuria diagramą „Standard
Curve“ (standartinė kreivė), jei duomenys apima mėginių tipus, apibrėžtus kaip „Std“ (standartinis)
bent vienam fluoroforui analizėje.

Diagramoje „Standard Curve“ (standartinė kreivė) rodoma ši informacija:

n Kiekvienos kreivės (fluoroforo arba tikslo) pavadinimas

n Kiekvieno fluoroforo arba tikslo spalva

n Reakcijos veiksmingumas (E). Naudokite šiuos statistinius duomenis, kad optimizuotumėte
daugkartinę reakciją ir išlygintumėte standartinės kreivės duomenis.

Pastaba. Reakcijos veiksmingumas nusako, kokia jūsų tikslo dalis sukuriama kiekvieno
protokolo ciklo metu. 100 % veiksmingumas parodo, kad kiekvieno ciklo metu padvigubinate
savo tikslą.

n Nustatymo koeficientas R2 (rašoma R^2). Naudokite šiuos statistinius duomenis, kad
nustatytumėte, ar teisingai linija apibūdina duomenis (atitikties laipsnis).

n Statumas

n y ašinė atkarpa
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Diagramos „Amplification“ (amplifikavimas) meniu parinktys
Papildomai įprastoms dešiniuoju pelės mygtuku atidaromo meniu parinktims (žr. Bendrieji pelės
dešiniojo mygtuko meniu elementai, skirti diagramoms, p. 188), 20 lentelė išvardytos meniu parinktys,
galimos tik diagramoje „Amplification“ (amplifikavimas).

Pastaba. Diagramoje „Standard Curve“ (standartinė kreivė) pateikiamos tik įprastos dešiniojo
mygtuko paspaudimu atveriamo meniu parinktys.

Meniu parinktis Funkcija

„Show Threshold Values“ (rodyti
ribines reikšmes)

Rodoma kiekvienos diagramos amplifikavimo kreivės ribinė vertė.

„Trace Styles“ (pėdsakų stiliai) Atidaromas langas „Trace Styles“ (pėdsakų stiliai), kuriame galima
keisti pėdsakų, rodomų kortelėse „Quantification“ (kiekybinis
įvertinimas) ir „Melt Curve“ (lydymosi kreivė), stilių.

„Baseline Thresholds“ 
(pagrindinės ribinės reikšmės)

Atidaromas langas „Baseline Thresholds“ (pagrindinės ribinės
reikšmės), kuriame keičiama kiekvieno fluoroforo pagrindinė arba
ribinė reikšmės (pakeitimai rodomi diagramoje „Amplification“ 
(amplifikavimas), esančioje kortelėje „Quantification“ (kiekybinis
įvertinimas).

20 lentelė. Amplifikavimo diagramos dešiniojo ir kairiojo pelės mygtukų meniu elementai

Kiekybinio įvertinimo kortelės skaičiuoklė
21 lentelė apibūdinami duomenys, kurie rodomi kiekybinio įvertinimo kortelės skaičiuoklėje.

Informacija Aprašymas

Šulinėlis Šulinėlio padėtis plokštelėje

Fluoroforas Aptiktas fluoroforas

Tikslas Tikslo, įdėto į plokštelės redaktoriaus šulinėlius, pavadinimas

Turinys Mėginio tipo (privalomas) ir kopijų Nr. (pasirinktinai), įdėtų į
plokštelės redaktorių, derinys

Mėginys Į plokštelės redaktorių šulinėlius įdėto mėginio pavadinimas

Cq Kiekvienam pėdsako kiekybinio įvertinimo ciklas

21 lentelė. Kiekybinio įvertinimo kortelės skaičiuoklės turinys
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Kortelė „Quantification“ (kiekybinis įvertinimas)

Tikslo, turinio ar mėginio duomenų keitimas

Stulpeliuose „Target“ (tikslas), „Content“ (turinys) ir „Sample“ (mėginys) esančius duomenis galite
keisti redaguodami plokštelės failą su „Plate Editor“ (plokštelės redaktorius) net ir po eksperimento.

Kaip pakeisti duomenis stulpeliuose „Content“ (turinys), „Target“ (tikslas) ir „Sample“ 
(mėginys)

u Spustelėkite „Plate Setup“ (plokštelės sąranka) ir pasirinkite „View/Edit Plate“ (rodyti / redaguoti
plokštelę), kad atidarytumėte „Plate Editor“ (plokštelės redaktorius).
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Kortelė „Quantification Data“ (kiekybinio įvertinimo
duomenys)

Kortelėje „Quantification Data“ (kiekybinio įvertinimo duomenys) rodomi iš kiekvieno šulinėlio gauti
kiekybinio įvertinimo duomenys. CFX Manager Dx programinė įranga duomenis pateikia keturiuose
skirtinguose skaičiuoklės rodiniuose:

n „Results“ (rezultatai) – rodoma duomenų skaičiuoklė. Tai numatytasis rodinys.

n „Standard Curve Results“ (standartinės kreivės rezultatai) – rodoma standartinės kreivės
duomenų skaičiuoklė.

n „Plate“ (plokštelė) – rodomi duomenys kiekviename šulinėlyje kaip plokštelės schema.

n RFU – rodomi kiekvieno ciklo kiekvieno šulinėlio RFU kiekiai.

Pasirinkite kiekvieną skaičiuoklę iš išplečiamojo sąrašo, kuris rodomas po kortele „Quantification
Data“ (kiekybinio įvertinimo duomenys).

Skaičiuoklė „Results“ (rezultatai)
Skaičiuoklėje „Results“ (rezultatai) rodomi kiekvieno šulinėlio plokštelėje duomenys.

Pastaba. Visi „Std. Dev“ (standartinis nuokrypis) skaičiavimai galioja kopijų grupėms, priskirtoms
šulinėliams lange „Plate Editor“ (plokštelės redaktorius). Apskaičiuojamas kiekvieno šulinėlio
kopijų grupėje Cq vertės vidurkis.

22 lentelė apibrėžiami duomenys, pateikiami skaičiuoklėje „Results“ (rezultatai).
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Kortelė „Quantification Data“ (kiekybinio įvertinimo duomenys)

Informacija Aprašymas

„Well“ (šulinėlis) Šulinėlio padėtis plokštelėje

„Fluor“ (fluoroforas) Aptiktas fluoroforas

„Target“ (tikslas) Amplifikacijos tikslo pavadinimas (genas)

„Content“ (turinys) Mėginio tipas ir kopijos Nr.

„Sample“ (mėginys) Mėginio aprašymas

„Biological Set Name“ 
(biologinio rinkinio
pavadinimas)

Biologinio rinkinio pavadinimas

Cq Kiekybinio įvertinimo ciklas

„Cq Mean“ (Cq vidurkis) Kopijos grupės kiekybinio įvertinimo vidurkis

„Cq Std. Dev“ (Cq standartinis
nuokrypis)

Kopijos grupės kiekybinio įvertinimo standartinis nuokrypis

„Starting Quantity“ (pradinis
kiekis) (SQ)

Tikslo pradinio kiekio įvertis

„Log Starting Quantity“ 
(pradinio kiekio registravimas)

Pradinio kiekio registravimas

„SQ Mean“ (pradinio kiekio
vidurkis)

Pradinio kiekio vidurkis

„SQ Std. Dev“ (Cq standartinis
nuokrypis)

Kopijų pradinio kiekio standartinis nuokrypis

22 lentelė. Rezultatų skaičiuoklės turinys
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Skaičiuoklė „Standard Curve Results“ (standartinės kreivės
rezultatai)
Skaičiuoklėje „Standard Curve Results“ (standartinės kreivės rezultatai) rodomi apskaičiuoti
standartinės kreivės parametrai.

23 lentelė apibrėžiami duomenys, pateikiami skaičiuoklėje „Standard Curve Results“ (standartinės
kreivės rezultatai).

Informacija Aprašymas

„Fluor“ (fluoroforas) (arba
„Target“ (tikslas))

Aptiktas fluoroforas (arba tikslas)

„Efficiency“ (veiksmingumas)
(%)

Reakcijos veiksmingumas

„Slope“ (statumas) Standartinės kreivės statumas

„Y-intercept“ (y ašinė atkarpa) Taškas, kuriame kreivė kerta y ašį

R^2 Nustatymo koeficientas

23 lentelė. Skaičiuoklės „Standard Curve Results“ (standartinės kreivės rezultatai) turinys
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Kortelė „Quantification Data“ (kiekybinio įvertinimo duomenys)

Skaičiuoklė „Plate“ (plokštelė)
Skaičiuoklėje „Plate“ (plokštelė) vienu metu rodoma vieno fluoroforo duomenų plokštelės schema.

Kaip peržiūrėti konkretaus fluoroforo duomenis

u Skaičiuoklės apačioje spustelėkite jo kortelę.

Skaičiuoklė RFU
Skaičiuoklėje RFU rodomos kiekvieno šulinėlio santykinių fluorescencijos vienetų (RFU) reikšmės,
gautos paleidimo kiekvieno ciklo metu. Šulinėlio numeris rodomas kiekvieno stulpelio viršuje, o ciklo
numeris parodomas kiekvienos eilutės kairėje.
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Kortelė „Melt Curve“ (lydymosi kreivė)
Atsakomybės apribojimas: „Bio-Rad“ nesuteikia teisės naudoti lydymosi kreivės analizės didelės
skiriamosios gebos lydymosi analizėje žmonių ar veterinarijos „in vitro“ diagnostikos srityje. Be to,
pirkėjas atsakingas už bet kokių intelektinės nuosavybės teisių, kurios gali būti reikalingos
konkrečioms programoms, įsigijimą.

DNR jungiančių dažų ir neskaidrių hibridizacijos zondų atveju fluorescencija yra ryškiausia, kai dvi
DNR grandinės atkaitinamos. Todėl tada, kai temperatūra kyla iki lydymosi temperatūros (Tm),
fluorescencija mažėja pastoviu greičiu (pastovus statumas). Kai pasiekiama Tm, fluorescencija
smarkiai sumažėja ir pastebimai pasikeičia statumas. Šio pokyčio norma nustatoma pagal neigiamos
pirmosios fluorescencijos regresijos priklausomybę nuo temperatūros (-d(RFU)/dT). Dėl didžiausio
fluorescencijos pokyčio susidaro matomos smailės, kurios atitinka dvigubos DNR kompleksų Tm.

CFX Manager Dx programinė įranga parodo RFU duomenų, surinktų lydymosi kreivės analizės metu,
priklausomybę nuo temperatūros. Siekiant išanalizuoti didžiausios lydymosi temperatūros duomenis,
programinė įranga, perkeldama ribinės reikšmės juostą, kiekvienai smailei priskiria pradinę ir galutinę
temperatūrą. Smailės srities pagrindas nustatomas pagal ribinės reikšmės juostos padėtį. Galiojantis
smailės aukštis turi bent jau atitikti atstumą tarp ribinės reikšmės juostos ir aukščiausios smailės
viršūnės taško.

Kortelėje „Melt Curve“ (lydymosi kreivė) rodomi keturi amplifikuotų PCR (PGR) produktų Tm lydymosi
temperatūros rodiniai:

n „Melt Curve“ (lydymosi kreivė) – rodomi tikralaikiai kiekvieno fluoroforo duomenys, kaip su
temperatūra susietos RFU reikšmės kiekvienam šulinėliui.

n „Melt Peak“ (didžiausia lydymosi temperatūra) – rodomas neigiamas su temperatūra susietų
kiekvieno šulinėlio RFU duomenų sumažėjimas.

n „Well selector“ (šulinėlių parinkiklis) – rodomi šulinėliai, kurių atveju būtų rodomi arba paslėpti
duomenys.
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Kortelė „Melt Curve“ (lydymosi kreivė)

n „Peak spreadsheet“ (smailės skaičiuoklė) – rodomi pasirinkto šulinėlio surinkti duomenys.

Pastaba. Ši skaičiuoklė rodo iki dviejų kiekvieno pėdsako smailių. Jei norite pamatyti
daugiau smailių, spustelėkite kortelę „Melt Curve Data“ (lydymosi kreivės duomenys).

24 lentelė, p. 211 apibūdinami duomenys, pateikiami skaičiuoklėje „Melt Curve“ (lydymosi kreivė).

Informacija Aprašymas

„Well“ (šulinėlis) Šulinėlio padėtis plokštelėje

„Fluor“ (fluoroforas) Aptiktas fluoroforas

„Content“ (turinys) Mėginio tipo ir kopijų skaičiaus derinys

„Sample“ (mėginys) Mėginio, įkelto į plokštelės redaktorių, pavadinimas

„Melt Temp“ (lydymosi temperatūra) Didžiausia kiekvieno šulinėlio lydymosi temperatūra

Pastaba. Šioje skaičiuoklėje rodomos tik dvi
aukščiausios smailės.

24 lentelė. Lydymosi kreivės skaičiuoklės turinys
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„Melt Curve“ (lydymosi kreivė) duomenų koregavimas
Kaip koreguoti „Melt Curve“ (lydymosi kreivė) duomenis

u Atlikite toliau nurodytus veiksmus:

n Spustelėkite ir vilkite ribinės reikšmės juostas diagramoje „Melt Peak“ (didžiausia lydymosi
temperatūra) ir į duomenų analizę įtraukite didžiausią temperatūrą arba iš jos pašalinkite.

n Išplečiamajame meniu „Peaks“ (didžiausia temperatūra) pasirinkite „Positive“ (teigiama), kad
virš linijos „Melt Threshold“ (lydymosi ribinė reikšmė) būtų rodoma didžiausios temperatūros
skaičiuoklė, arba pasirinkite „Negative“ (neigiama), kad didžiausios temperatūros
skaičiuoklės duomenys būtų rodomi po lydymosi ribinės reikšmės linija.

n Atidarykite langą „Trace Styles“ (pėdsakų stiliai), kuriame galima keisti pėdsakų, rodomų
kortelėse „Melt Curve“ (lydymosi kreivė) ir „Melt Peak“ (didžiausia lydymosi temperatūra),
spalvą.

n Parinkiklyje „Step Number“ (veiksmo numeris) pasirinkite numerį ir peržiūrėkite „Melt Curve“ 
(lydymosi kreivė) duomenis kitame protokolo veiksme. Sąraše rodomi keli veiksmai, jeigu į
protokolą įtraukti plokštelių nuskaitymai keliuose lydymosi kreivės veiksmuose.

n Pasirinkite šulinėlius šulinėlių parinkiklyje, norėdami susikoncentruoti į duomenų pogrupius.

n Pasirinkite šulinėlių grupę, kurios šulinėlių pogrupį norite peržiūrėti ir analizuoti plokštelėje.
Pasirinkite kiekvieną šulinėlių grupę pagal pavadinimą įrankių juostoje esančiame
išskleidžiamajame meniu „Well Group“ (šulinėlių grupė).
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Kortelė „Melt Curve Data“ (lydymosi kreivės duomenys)

Kortelė „Melt Curve Data“ (lydymosi kreivės duomenys)
Kortelėje „Melt Curve Data“ (lydymosi kreivės duomenys) rodomi duomenys iš kortelės „Melt Curve“ 
(lydymosi kreivė), pateikiami keliose skaičiuoklėse, apimančiose visus kiekvienos kreivės didžiausios
lydymosi temperatūros duomenis. „CFX Manager Dx“ programinėje įrangoje yra keturios skaičiuoklių,
kuriose galima peržiūrėti lydymosi kreivės duomenis, parinktys:

n „Melt Peaks“ (didžiausia lydymosi temperatūra) – rodomi visi duomenys, įskaitant visus
kiekvienos kreivės didžiausios lydymosi temperatūros duomenis. Tai numatytasis rodinys.

n „Plate“ (plokštelė) – rodomas kiekvieno šulinėlio plokštelėje duomenų ir turinio rodinys.

n RFU – rodomi kiekvieno šulinėlio RFU kiekiai kiekvienoje temperatūroje.

n -d(RFU)/dT – rodomas neigiamas RFU pokyčio, keičiantis temperatūrai (T), rodiklis. Tai pirmasis
kiekvieno šulinėlio plokštelėje regresijos grafikas.

Pasirinkite kiekvieną skaičiuoklę iš išplečiamojo sąrašo, kuris rodomas po kortele „Melt Curve Data“ 
(lydymosi kreivės duomenys).

Skaičiuoklė „Melt Peaks“ (didžiausia lydymosi temperatūra)
Skaičiuoklėje „Melt Peaks“ (didžiausia lydymosi temperatūra) rodomi visi lydymosi kreivės duomenys.

25 lentelė, p. 214 apibūdinami duomenys, kurie pateikiami skaičiuoklėje „Melt Peaks“ (didžiausia
lydymosi temperatūra).
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Informacija Aprašymas

„Well“ (šulinėlis) Šulinėlio padėtis plokštelėje

„Fluor“ (fluoroforas) Aptiktas fluoroforas

„Content“ (turinys) Mėginio tipas, nurodytas lange „Plate Editor“ (plokštelės
redaktorius)

„Target“ (tikslas) Amplifikavimo tikslas (genas)

„Sample“ (mėginys) Mėginio pavadinimas, nurodytas lange „Plate Editor“ (plokštelės
redaktorius)

„Melt Temperature“ (lydymosi
temperatūra)

Kiekvieno produkto lydymosi temperatūra, nurodyta kaip viena
didžiausia skaičiuoklės eilutėje

„Peak Height“ (didžiausios
temperatūros viršūnės aukštis)

Didžiausios temperatūros viršūnės aukštis

„Begin Temperature“ (pradžios
temperatūra)

Temperatūra viršūnės pradžioje

„End Temperature“ (pabaigos
temperatūra)

Temperatūra viršūnės pabaigoje

25 lentelė. Skaičiuoklės „Melt Peaks“ (didžiausia lydymosi temperatūra) turinys

Skaičiuoklė „Plate“ (plokštelė)
Skaičiuoklėje „Plate“ (plokštelė) rodomi lydymosi kreivės duomenys plokštelės formatu.

Pastaba. Jei norite koreguoti programinės įrangos apibrėžiamą smailę, pakoreguokite kortelėje
„Melt Curve“ (lydymosi kreivė) esančios diagramos „Melt Peak“ (didžiausia lydymosi temperatūra)
linijos ribinę reikšmę.
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Kortelė „Melt Curve Data“ (lydymosi kreivės duomenys)

26 lentelė, p. 215 apibūdinti duomenys, kurie rodomi skaičiuoklėje „Plate“ (plokštelė).

Informacija Aprašymas

„Content“ (turinys) Mėginio tipo (privalomas) ir kopijų Nr. (pasirinktinai) derinys

„Sample“ (mėginys) Mėginio aprašymas

„Peak 1“ 
(1 didžiausia
temperatūra)

Pirmoji pagal didumą lydymosi temperatūra (aukščiausia)

„Peak 2“ 
(2 didžiausia
temperatūra)

Antroji pagal didumą lydymosi temperatūra (žemesnė)

26 lentelė. Skaičiuoklės „Plate“ (plokštelė) turinys

RFU skaičiuoklė
RFU skaičiuoklėje rodoma kiekvieno šulinėlio fluorescencija kiekvieno ciklo, kuris nustatomas
lydymosi kreivėje, metu.

27 lentelė apibūdinami duomenys, kurie rodomi RFU skaičiuoklėje.

Informacija Aprašymas

„Well number (A1, A2, A3, A4, A5)“ 
(šulinėlio numeris (A1, A2, A3, A4, A5))

Šulinėlio padėtis plokštelėje įkeltų šulinėlių
atveju

„Temperature“ (temperatūra) Amplifikuoto tikslo, pateikiamo kaip vienas
šulinėlis kiekvienai eilutei ir keli šulinėliai
keliems produktams tame pačiame šulinėlyje,
lydymosi temperatūra

27 lentelė. RFU skaičiuoklės turinys
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-d(RFU)/dT skaičiuoklė
d(RFU)/dT skaičiuoklėje rodomas neigiamas RFU pokyčio dydis keičiantis temperatūrai (T).

28 lentelė apibrėžiami duomenys, kurie pateikiami -d(RFU)/dT skaičiuoklėje.

Informacija Aprašymas

„Well number (A1, A2, A3, A4, A5)“ 
(šulinėlio numeris (A1, A2, A3, A4, A5))

Šulinėlio padėtis plokštelėje įkeltų šulinėlių atveju

„Temperature -d(RFU)/dT“ 
(temperatūros riba -d(RFU)/dT)

Neigiamas RFU pokyčio dydis keičiantis temperatūrai (T)

28 lentelė. Skaičiuoklės -d(RFU)/dT turinys
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Kortelė „End Point“ (pabaigos taškas)

Kortelė „End Point“ (pabaigos taškas)
Atverkite kortelę „End Point“ (pabaigos taškas) ir analizuokite mėginių šulinėlių galutinius santykinius
fluorescencijos vienetus (RFU). Programinė įranga šulinėlių su nežinomais mėginiais RFU lygius
palygina su neigiamos kontrolės šulinėlių RFU lygiais ir nežinomą „pavadina“ teigiamu arba neigiamu.
Teigiamų mėginių RFU vertė yra didesnė nei neigiamos kontrolės vidutinė RFU vertė plius ribinė
vertė.

Norint išanalizuoti galutinio taško duomenis, plokštelėje turi būti neigiamų kontrolių arba programinė
įranga negalės atlikti užklausos. Paleiskite vieną iš šių tipų protokolų:

n Paleiskite „Quantification“ (kiekybinis įvertinimas) protokolą – nustatykite standartinį protokolą.
Baigę paleidimą atverkite langą „Data Analysis“ (duomenų analizė), kortelėje „Quantification“ 
(kiekybinis įvertinimas) koreguokite duomenų analizės nuostatas, tada spustelėkite kortelę „End
Point“ (pabaigos taškas) ir pasirinkite pabaigos taško ciklą.

n Paleiskite protokolą „End Point Only“ (tik pabaigos taškas) – protokolą „End Point Only“ (tik
pabaigos taškas) įkelkite į lango „Run Setup“ (paleidimo sąranka) plokštelės kortelę ir pradėkite
paleidimą.

Kortelėje „End Point“ (pabaigos taškas) rodomos vidutinės RFU vertės, skirtos nustatyti, ar tikslas
buvo amplifikuotas paskutiniu (pabaigos) ciklu. Šiuos duomenis naudokite nustatyti, ar mėginyje yra
konkreti tikslo seka (teigiama). Teigiamų tikslų RFU vertės yra didesnės nei jūsų nustatyta ribinė vertė.
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Patarimas. Norėdami sukurti pabaigos taško protokolą, atverkite protokolo kortelę (langas „Run
Setup“ (paleidimo sąranka)) ir pasirinkite „Run“ > End Point Only Run“ (paleidimas > tik galutinio
taško paleidimas).

Kai paleidimas baigiamas, duomenų failas atveriamas kortelėje „End Point“ (pabaigos taškas), kurią
sudaro šie skyriai:

n „Settings“ (nuostatos) c koreguojamos duomenų analizės nuostatos.

n „Results“ (rezultatai) – rezultatai, rodomi iš karto jums pakoregavus nuostatas.

n „Well Selector“ (šulinėlių parinkiklis) – pasirenkami šulinėliai su pabaigos taško duomenimis,
kuriuos norite parodyti.

n „RFU spreadsheet“ (RFU skaičiuoklė) – rodomi pabaigos RFU, gauti pasirinktuose šulinėliuose.

Rezultatų duomenys
Skyriuje „Results“ (rezultatai) pateikiami šie duomenys:

n „Lowest RFU value“ (mažiausia RFU vertė) – mažiausia RFU vertė duomenyse

n „Highest RFU value“ (didžiausia RFU vertė) – didžiausia RFU vertė duomenyse

n „Negative Control Average“ (neigiamos kontrolės vidurkis) – vidutinis šulinėlių, kuriuose yra
neigiamos kontrolės, RFU

n „Cut Off Value“ (ribinė vertė) – apskaičiuojama sudedant leistiną nuokrypį (intervalo, pateikto
nuostatose, RFU arba „Percentage“ (procentas)) ir neigiamos kontrolės vidurkį. Mėginiai, kurių
RFU didesni nei ribinė vertė, bus laikomi teigiamais. Norėdami pakoreguoti ribinę vertę,
pakeiskite RFU arba „Percentage of Range“ (intervalo procentas).

„Cut Off Value“ (ribinė vertė) apskaičiuojama taikant šią formulę:

Ribinė vertė = neigiamos kontrolės vidurkis + leistinas nuokrypis

Leistiną nuokrypį pasirinkite vienu iš šių būdų:

n RFU (numatytoji nuostata) – pasirinkite šį metodą ir naudokite absoliučią leistinojo nuokrypio RFU
vertę. Mažiausia RFU leistinojo nuokrypio vertė yra 2. Didžiausia yra didžiausia RFU absoliuti
vertė minus mažiausia RFU absoliuti vertė. Numatytoji RFU leistinojo nuokrypio vertė yra 10 %
bendrojo RFU intervalo.

n „Percent of Range“ (intervalo procentas) – pasirinkite šį metodą ir leistinajam nuokrypiui taikykite
RFU intervalo procentą. Minimalus intervalo procentas yra 1 %. Maksimalus intervalo procentas
yra 99 %. Numatytasis intervalo procentas yra 10 %.
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Kortelė „End Point“ (pabaigos taškas)

Pabaigos taško duomenų analizės keitimas
Kaip keisti duomenis kortelėje „End Point“ (pabaigos taškas)

u Atlikite toliau nurodytus veiksmus:

n Išplečiamajame sąraše pasirinkite fluoroforą.

n Pasirinkite reikšmę „End Cycle to Average“ (pabaigos taško vidurkio ciklų skaičius),
norėdami nustatyti ciklų skaičių, pagal kurį skaičiuojamas vidutinis pabaigos taško RFU.

n Pasirinkite RFU, norėdami peržiūrėti duomenis santykiniais fluorescencijos vienetais.

n Pasirinkite „Percentage of Range“ (intervalo procentas), norėdami peržiūrėti duomenis kaip
RFU intervalo procentą.

n Pasirinkite šulinėlius šulinėlių parinkiklyje, norėdami susikoncentruoti į duomenų pogrupius.

n Pasirinkite šulinėlių grupę, kurios šulinėlių pogrupį norite peržiūrėti ir analizuoti plokštelėje.
Pasirinkite kiekvieną šulinėlių grupę pagal pavadinimą įrankių juostoje esančiame
išskleidžiamajame meniu „Well Group“ (šulinėlių grupė).

RFU skaičiuoklė, skirta pabaigos taško analizei
29 lentelė apibūdinami duomenys, kurie rodomi RFU skaičiuoklės kortelėje „End Point“ (pabaigos
taškas).

Informacija Aprašymas

„Well“ (šulinėlis) Šulinėlio padėtis plokštelėje

„Fluor“ (fluoroforas) Aptiktas fluoroforas

„Content“ (turinys) Mėginio tipo ir kopijų Nr. derinys

„End RFU“ (pabaigos
RFU)

RFU galiniame ciklo taške

„Call“ (paskyrimas) Teigiamas arba neigiamas, kai teigiamų mėginių RFU reikšmė yra
didesnė už vidutinės neigiamų kontrolinių elementų RFU reikšmės ir
ribinės reikšmės sumą

„Sample“ (mėginys) Mėginio pavadinimas, įkeltas į langą „Plate Editor“ (plokštelės redaktorius)

29 lentelė. „End Point“ (pabaigos taškas) skaičiuoklės turinys
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Kortelė „Allelic Discrimination“ (alelių diskriminacija)
Kortelėje „Allelic Discrimination“(alelių diskriminacija) šulinėliams su nežinomais mėginiais priskiriami
genotipai. Remdamiesi šiais duomenimis, galite nustatyti mėginius su įvairiais genotipais, įskaitant
„Allele 1“ (1-asis alelis), „Allele 2“ (2-asis alelis), „Heterozygote“ (heterozigota), „No Call“ (jokio
paskyrimo) arba „Undetermined“ (nenustatyta).

Pastaba. Alelių diskriminacijos duomenys turi būti gaunami iš daugkartinių paleidimų su
mažiausiai dviem fluoroforais. Kiekvienas fluoroforas identifikuoja vieną alelį visuose mėginiuose.

Alelių diskriminacijos analizei reikalingas minimalus šulinėlių turinys:

n Du fluoroforai kiekviename šulinėlyje

n NTC (nėra šablono kontrolės) mėginiai optimizuotai duomenų analizei
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Kortelė „Allelic Discrimination“ (alelių diskriminacija)

CFX Manager Dx programinė įranga siūlo keturis variantus alelių diskriminacijos duomenims
peržiūrėti:

n Diagramoje „Allelic Discrimination“ (alelių diskriminacija) RFU grafiko forma rodomi pirmojo ir
(arba) antrojo alelio duomenys. Kiekvienas grafiko taškas rodo abiejų viename šulinėlyje esančių
fluoroforų duomenis. Koordinates galite perjungti iš Dekarto į polines ir atvirkščiai, pasirinkdami ir
išvalydami žymės langelį „Polar Coordinates“ (polinės koordinatės). Dekarto koordinačių
sistemoje x ašyje pateikiamas pirmojo, o y – antrojo alelio RFU. Polinių koordinačių sistemoje x
ašyje pateikiamas kampas, o y – atstumas tarp atskaitos taško ir RFU (visų NTC mediana).

n „Well spreadsheet“ (šulinėlių skaičiuoklė) rodomi alelių diskriminacijos duomenys, surinkti
kiekviename plokštelės šulinėlyje.

n „Well selector“ (šulinėlių parinkiklis) leidžia pasirinkti šulinėlius su norimais rodyti alelių
duomenimis.

n „Selected Fluorophores panel“ (pasirinktų fluoroforų skydelis) keičiamos alelių diskriminacijos
diagramos x ir y ašių etiketės, analizuojamas ciklas ir nustatoma, ar rodyti paskyrimo schemą.

Alelių diskriminacijos duomenų koregavimas
Programinė įranga automatiškai priskiria genotipą šulinėliams su nežinomais mėginiais atsižvelgdama
į NTC padėtis ir nežinomų duomenų taškų padėtį bei kampą ir atstumą nuo NTC.

Kaip koreguoti alelių diskriminacijos duomenis

u Atlikite toliau nurodytus veiksmus:

n Kad būtų rodomos polinės koordinatės, diagramoje „Allelic Discrimination“ (alelių
diskriminacija) pažymėkite žymės langelį.

n Kad peržiūrėtumėte kitą fluoroforą, jį pasirinkite išplečiamajame sąraše skydelyje „Selected
Fluorophores“ (pasirinkti fluoroforai).

n Norėdami pakeisti paskyrimą, diagramoje „Allelic Discrimination“ (alelių diskriminacija) vilkite
žymeklį per duomenų elementą (-us) ir pasirinktų šulinėlių sąraše pasirinkite parinktį:

o „Allele 1“ (1-asis alelis)

o „Allele 2“ (2-asis alelis)

o „Heterozygote“ (heterozigota)
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o „Undetermined“ (nenustatyta)

o „No Call“ (nėra paskyrimo)

o „Auto Call“ (automatinis paskyrimas)

Patarimas. Pasirinkite „Auto Call“ (automatinis paskyrimas) ir pakeiskite į numatytąjį
paskyrimą.
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Kortelė „Allelic Discrimination“ (alelių diskriminacija)

Diagramos meniu parinktys
Papildomai įprastai dešiniuoju klavišu atidaromo diagramos meniu parinktims (žr. Bendrieji pelės
dešiniojo mygtuko meniu elementai, skirti diagramoms, p. 188), 30 lentelė išvardytos galimos diagramos
„Allelic Discrimination“ (alelių diskriminacija) meniu parinktys.

Meniu parinktis Funkcija

„Zoom“ (keisti mastelį) Diagramos vaizdą fokusuoja pasirinktoje srityje (spustelint žymeklį
ir jį patraukiant diagramoje).

Patarimas. Kad atkurtumėte mastelį ir būtų rodomi visi
duomenų taškai, spustelėkite dešinįjį klavišą ir pasirinkite „Set
Scale to Default“ (nustatyti mastelį į numatytąjį).

„Well“ (šulinėlis) Pasirinktų šulinėlių galimos funkcijos: rodyti tik šiuos šulinėlius,
pašalinti šį šulinėlį iš vaizdo, nustatyti šio pėdsako spalvą arba šį
šulinėlį pašalinti iš analizės.

„Selected Wells“ (pasirinkti
šulinėliai)

Pasirinktų šulinėlių (pasirenkami spustelint ir patraukiant žymeklį
diagramoje) parinktys yra: rodyti tik šiuos šulinėlius, šiuos šulinėlius
pašalinti iš vaizdo, nustatyti šių pėdsakų spalvas arba šiuos
šulinėlius pašalinti iš analizės.

30 lentelė. Diagramos „Allelic Discrimination“ (alelių diskriminacija) meniu dešinėje ir kairėje
parinktys

„Allelic Discrimination“ (alelių diskriminacija) skaičiuoklė
31 lentelė apibrėžiami duomenys, kurie pateikiami „Allelic Discrimination“ (alelių diskriminacija)
skaičiuoklėje.

Informacija Aprašymas

„Well“ (šulinėlis) Šulinėlio padėtis plokštelėje

„Sample“ (mėginys) Mėginio pavadinimo aprašymas

„Call“ (paskyrimas) Identifikuokite alelį, įskaitant automatinį „Allele 1“ (1-asis alelis),
„Allele 2“ (2-asis alelis), „Heterozygote“ (heterozigota), „No Call“ 
(jokio paskyrimo) arba „Undetermined“ (nenustatyta)

31 lentelė. „Allelic Discrimination“ (alelių diskriminacija) skaičiuoklės turinys
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Informacija Aprašymas

„Type“ (tipas) Automatinis arba rankinis – taip apibūdinama, kaip buvo atliktas
paskyrimas. Automatinis reiškia, kad programinė įranga pasirinko
paskyrimą. Rankinis reiškia, kad paskyrimą pasirinko naudotojas

RFU1 RFU 1-ajam aleliui

RFU2 RFU 2-ajam aleliui

31 lentelė. „Allelic Discrimination“ (alelių diskriminacija) skaičiuoklės turinys (tęsinys)
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Kortelė „Custom Data View“ (pasirinktinių duomenų rodymas)

Kortelė „Custom Data View“ (pasirinktinių duomenų
rodymas)

Kortelėje „Custom Data View“ (pasirinktinių duomenų rodymas) vienu metu rodomos kelios sritys
pritaikomu formatu.

Išplečiamajame sąraše „Load a Preset View“ (įkelti iš anksto nustatytą rodinį) pateikiama įvairių
rodinių formatų šablonų. Numatytasis rodinys parenkamas priklausomai nuo analizuojamo failo
rūšies. Pavyzdžiui, jei pateikiami kortelės „Melt Curve“ (lydymosi kreivė) duomenys, parodomas
numatytasis Amp+Melt rodinys.
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Pasirinktinių duomenų rodinio sukūrimas
Kaip sukurti pasirinktinių duomenų rodinį

u Atlikite toliau nurodytus veiksmus:

n Išplečiamajame sąraše pasirinkite kitą iš anksto nustatytą rodinį.

n Išplečiamajame sąraše, esančiame kiekvienos atskiros srities viršuje, pasirinkite kitą
diagramos rodinį.

n Pakeiskite eilučių ir stulpelių skaičių kortelėje.

n Pakeiskite atskiros srities matmenis. Vilkite juostas kiekvienos srities pakraštyje.

Spustelėkite „Save as Preset“ (įrašyti kaip išankstinę nuostatą), kad įrašytumėte pasirinktą rodinį kaip
iš anksto nustatytą šabloną. Jei norite pašalinti, pervardyti arba atkurti esamus iš anksto nustatytus
rodinius, spustelėkite „Manage Presets“ (valdyti išankstines nuostatas).
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Kortelė QC (KK)

Kortelė QC (KK)
Kortelėje QC (KK) galite greitai įvertinti paleidimo duomenų kokybę, remdamiesi taisyklėmis,
nustatytomis kortelėje QC (KK).

CFX Manager Dx programinė įranga siūlo keturis variantus QC (KK) duomenims peržiūrėti:

n „Amplification chart“ (amplifikavimo diagrama) – kiekvienam šulinėliui kiekviename cikle
rodomas RFU. Kiekvienas pėdsakas diagramoje reiškia duomenis iš atskiro fluoroforo viename
šulinėlyje.

n „QC rules table“ (KK taisyklių lentelė) – rodomos taikomos QC (KK) taisyklės ir nuostatos,
kuriomis apibrėžiama kiekviena taisyklė. Galiojančios QC (KK) taisyklės nurodomos varnele.

n „Well selector“ (šulinėlių parinkiklis) – pasirenkami šulinėliai su fluorescenciniais
duomenimis, kuriuos norite parodyti.

n „QC rule summary pane“ (KK taisyklių santraukos sritis) – rodoma pasirinkta QC (KK)
taisyklė ir paryškinami šulinėliai, kurie neatitinka taisyklės.

QC (KK) kriterijų keitimas
Kaip keisti QC (KK) kriterijus

u Pažymėkite arba išvalykite taisyklės, kurią norite įtraukti į QC (KK) arba pašalinti iš jo, žymės
langelį „Use“ (naudoti).
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Šulinėlių, kurie neatitinka QC (KK), pašalinimas
CFX Manager Dx programinė įranga rezultatų stulpelyje QC (KK) taisyklių lentelėje ir santraukos
srityje parodo šulinėlius, kurie neatitinka QC (KK) kriterijų.

Šulinėlių, kurie neatitinka QC (KK) kriterijų, pašalinimas

u Prie kiekvieno šalinamo šulinėlio pasirinkite „Exclude Wells“ (pašalinti šulinėlius).
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Kortelė „Run Information“ (paleidimo išsami informacija)

Kortelė „Run Information“ (paleidimo išsami informacija)
Kortelėje „Run Information“ (paleidimo išsami informacija) rodomas protokolas ir kita informacija apie
kiekvieną paleidimą. Veiksmai, kuriuos galima atlikti šioje kortelėje:

n Peržiūrėti protokolą

n Įvesti arba redaguoti paleidimo pastabas

n Įvesti arba redaguoti paleidimo ID arba brūkšninį kodą

n Peržiūrėti įvykius, kurie įvyko per paleidimą. Naudokite šiuos pranešimus paleidimo problemoms
spręsti.

Patarimas. Paspauskite protokolą dešiniuoju pelės mygtuku, norėdami jį kopijuoti, eksportuoti
arba spausdinti. Dešiniuoju pelės mygtuku spauskite sritis „Notes“ (pastabos), „ID/Bar Code“ (ID /
brūkšninis kodas) arba „Other“ (kita), kad iškirptumėte, kopijuotumėte, įklijuotumėte,
pašalintumėte arba pasirinktumėte tekstą.
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Duomenų analizės ataskaitos
Dialogo lange „Report“ (ataskaita) rodoma informacija apie esamą duomenų failą lange „Data
Analysis“ (duomenų analizė) . Norėdami atverti ataskaitą, pasirinkite „Tools > Reports“ (įrankiai >
ataskaitos).

Dialogą „Report“ (ataskaita) sudaro šie skyriai:

n Meniu ir įrankių juosta – pateikia ataskaitos ar šablono formato, įrašymo ir spausdinimo parinkčių.

n Parinkčių sąrašas (dialogo lango viršutinė kairė pusė) – pateikia ataskaitos pateikimo parinkčių.

n Parinkčių sritis (dialogo lango apatinė kairė pusė) – rodomi tekstiniai langeliai, kuriuose galite
įrašyti informaciją apie pasirinktą parinktį.

n Peržiūros sritis (dialogo lango dešinė pusė) – rodoma esamos ataskaitos peržiūra.
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Duomenų analizės ataskaitos

Duomenų analizės ataskaitų kategorijos
32 lentelė išvardytos visos parinktys, galimos duomenų analizės ataskaitoje, priklausomai nuo lange
„Data Analysis“ (duomenų analizė) esančių duomenų tipo.

Kategorija Parinktis Aprašymas

„Header“ (antraštė)

Ataskaitos antraštė, poantraštė ir
logotipas

„Report Information“ (ataskaitos
informacija)

Paleidimo data, vartotojo vardas,
duomenų failo pavadinimas, duomenų
failo kelias ir pasirinktų šulinėlių grupė

„Audit Information“ (audito
informacija)

Papildoma informacija, kurios reikia
auditui atlikti, įskaitant parašus

„Notes“ (pastabos) Pastabos apie duomenų ataskaitą

„Run Setup“ (paleidimo sąranka)

„Run Information“ (paleidimo
informacija)

Paleidimo data, vartotojo vardas,
duomenų failo pavadinimas, duomenų
failo kelias ir pasirinktų šulinėlių grupė

„Protocol“ (protokolas) Protokolo veiksmų ir parinkčių tekstinis
vaizdas

„Plate Display“ (plokštelės
rodmuo)

Informacijos plokštelės vaizdas
kiekviename plokštelės šulinėlyje

„Quantification“ (kiekybinis įvertinimas)

„Analysis Settings“ (analizės
nuostatos)

Duomenų rinkimo veiksmo numeris,
analizės režimas ir pradinio taško
atėmimo metodas

„Amplification Chart“ 
(amplifikavimo diagrama)

Amplifikavimo diagrama paleidimams,
kurie apima kiekybinio įvertinimo
duomenis

32 lentelė. Duomenų analizės ataskaitų kategorijos parinkčių sąraše
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Kategorija Parinktis Aprašymas

„Standard Curve Chart“ 
(standartinės kreivės diagrama)

Standartinės kreivės diagrama

„Data“ (duomenys) Skaičiuoklėje išvardyti kiekvieno
šulinėlio duomenys

Stulpelinė diagrama „Gene Expression“ (geno ekspresija)

„Analysis Settings“ (analizės
nuostatos)

Analizės režimas, diagramos
duomenys, mastelio parinktys ir
diagramos paklaida

„Chart“ (diagrama) Stulpelinės diagramos kopija

„Target Names“ (tikslų
pavadinimai)

Tikslų pavadinimų diagrama

„Sample Names“ (mėginių
pavadinimai)

Mėginių pavadinimų diagrama

„Data“ (duomenys) Skaičiuoklėje išvardyti kiekvieno
šulinėlio duomenys

„Target Stability“ (tikslo
stabilumas)

Tikslo stabilumo reikšmių diagrama

Grupinė diagrama ir taškinė diagrama „Gene Expression“ (geno ekspresija)

„Analysis Settings“ (analizės
nuostatos)

Kiekvieno diagramos tipo nuostatos

„Chart“ (diagrama) Diagramos kopija

„Data“ (duomenys) Skaičiuoklėje išvardyti kiekvieno tikslo
duomenys

„Melt Curve“ (lydymosi kreivė)

„Analysis Settings“ (analizės
nuostatos)

Lydymosi veiksmų skaičius ir ribinės
reikšmės juostos nuostata

32 lentelė. Duomenų analizės ataskaitų kategorijos parinkčių sąraše (tęsinys)
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Kategorija Parinktis Aprašymas

„Melt Curve“ (lydymosi kreivės)
diagrama

Lydymosi kreivės diagrama

„Melt Peak“ (didžiausia
lydymosi temperatūra)
diagrama

Didžiausia lydymosi temperatūra

„Data“ (duomenys) Skaičiuoklėje išvardyti kiekvieno
šulinėlio duomenys

„Allelic Discrimination“ (alelių diskriminacija)

„Analysis Settings“ (analizės
nuostatos)

Rodomi fluoroforai, ciklas ir vaizdo
paskyrimų schema

„Allelic Discrimination Chart“ 
(alelių diskriminacijos
diagrama)

Alelių diskriminacijos diagramos kopija

„Data“ (duomenys) Skaičiuoklėje išvardyti kiekvieno
šulinėlio duomenys

„End Point“ (pabaigos taškas)

„Analysis Settings“ (analizės
nuostatos)

Fluoroforas, pabaigos ciklai vidurkiui,
režimui, mažiausiai RFU vertei,
didžiausiai RFU vertei ir vertinimo
vertei

„Data“ (duomenys) Skaičiuoklėje išvardyti kiekvieno
šulinėlio duomenys

„QC Parameters“ 
(KK parametrai)

„Data“ (duomenys) Skaičiuoklėje išvardyti parametrai
kiekvienai QC (KK) taisyklei

32 lentelė. Duomenų analizės ataskaitų kategorijos parinkčių sąraše (tęsinys)
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Duomenų analizės ataskaitos kūrimas
Ataskaitos išdėstymą galite įrašyti kaip šabloną, kurį vėl galite naudoti panašioms ataskaitoms.

Kaip sukurti duomenų analizės ataskaitą

1. Prieš kurdami ataskaitą, atlikite paskutinius šulinėlių turinio, pasirinktų šulinėlių, diagramų ir
skaičiuoklių pakeitimus lange „Data Analysis“ (duomenų analizė).

2. Pasirinkite „Tools > Reports“ (įrankiai > ataskaitos) meniu juostoje „Data Analysis“ (duomenų
analizė), kad atidarytumėte dialogo langą „Report“ (ataskaita).

3. Pasirinkite parinktis, kurias norite įtraukti į ataskaitą. Ataskaita atidaroma pagal pasirinktas
numatytąsias parinktis. Pasirinkite arba išvalykite žymės langelius, kad pakeistumėte visas
kategorijas ar atskiras kategorijos parinktis.

Pastaba. Ataskaitoje pateikiami duomenys priklauso nuo esamų pasirinkimų kortelėse,
esančiose lange „Data Analysis“ (duomenų analizė) . Pavyzdžiui, kiekybinio įvertinimo
paleistyje gali nebūti standartinės kreivės, todėl šie duomenys nerodomi lange „Data
Analysis“ (duomenų analizė) arba duomenų ataskaitoje.

4. Pakeiskite kategorijų ir elementų tvarką ataskaitoje. Vilkite parinktis į santykinę padėtį. Elementus
pertvarkyti galima tik tose kategorijose, kurioms jie priklauso.

5. (Neprivaloma) Srityje „Report Options“ (ataskaitų parinktys) įveskite pasirinktai parinkčiai
reikalingą informaciją:

n Pasirinkite informacijos, kurią norite rodyti ataskaitoje, pogrupį.

n Pasirinkite konkrečias pasirinktos parinkties nuostatas.

n Pakeiskite tekstą, kuris bus rodomas pasirinktai parinkčiai.

6. Spauskite „Update Report“ (atnaujinti ataskaitą), kad atnaujintumėte „Report Preview“ (ataskaitos
peržiūra) su pakeitimais.

7. Spausdinkite arba įrašykite ataskaitą. Paspauskite įrankių juostos mygtuką „Print Report“ 
(spausdinti ataskaitą), norėdami atspausdinti esamą ataskaitą. Pasirinkite „File > Save“ (failas >
įrašyti), kad įrašytumėte ataskaitą PDF („Adobe Acrobat Reader“ failas) formatu, ir pasirinkite, kur
norite failą įrašyti. Pasirinkite „File > Save As“ (failas > įrašyti kaip), kad įrašytumėte ataskaitą
nauju pavadinimu arba naujoje vietoje.

8. (Neprivaloma) Sukurkite ataskaitos šabloną su norima informacija. Norėdami įrašyti esamas
ataskaitos nuostatas šablone, pasirinkite „Template > Save“ (šablonas > įrašyti) arba „Save As“ 
(įrašyti kaip). Tada įkelkite ataskaitos šabloną kitą kartą, kai norėsite sukurti naują ataskaitą.
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Šulinėlių grupės ataskaitų kūrimas
Kaip sukurti šulinėlių grupės ataskaitą

1. Lange „Data Analysis“ (duomenų analizė) pasirinkite „Tools > Well Group Reports“ (įrankiai >
šulinėlių grupės ataskaitos).

2. Dialogo lange „Well Groups Reports“ (šulinėlių grupių ataskaitos) pasirinkite šulinėlių grupes,
amplifikavimo veiksmus ir lydymosi veiksmus, kuriuos norite įtraukti į ataskaitą.

3. Įveskite kelią arba eikite į paskirties aplanką, kuriame norite įrašyti ataskaitą.

4. (Neprivaloma) Pasirinkite „Choose a Report Template“ (pasirinkti ataskaitos šabloną) ir eikite į
šablono failo aplanką.

5. (Neprivaloma) Pasirinkite „Open Destination Folder“ (atidaryti paskirties aplanką), norėdami
atidaryti aplanką ir peržiūrėti sugeneruotas ataskaitas.

6. Spauskite „Create Reports“ (sukurti ataskaitas).
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10 skyrius. Išsami duomenų analizės informacija
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11 skyrius. Geno ekspresijos analizė
Naudodamiesi griežtai atrinktomis kontrolės priemonėmis reakcijose, galite naudoti „CFX Manager
Dx“ programinę įrangą, kad paleistumėte geno ekspresiją, siekdami normalizuoti santykinius
skirtumus tarp tikslo koncentracijų mėginiuose. Paprastai norimo geno ekspresijos lygiams
normalizuoti naudojami vieno ar daugiau etaloninių genų ekspresijos lygiai. Etaloniniuose genuose
atsižvelgiama į apkrovos skirtumus arba kitus kiekviename mėginyje esančius skirtumus, o jų
ekspresijos lygiai neturi būti paveikti tiriamoje biologinėje sistemoje.

Pasirinkite kortelę „Gene Expression“ (geno ekspresija) lange „Data Analysis“ (duomenų analizė), kad
įvertintumėte santykinius skirtumus tarp PCR (PGR) reakcijų dviejuose ar daugiau šulinėlių.
Pavyzdžiui, galite įvertinti santykinį viruso genomų skaičių arba santykinį transfekuotų sekų skaičių
PCR (PGR) reakcijoje. Geno ekspresijos tyrime tai dažniausiai taikoma lyginant cDNA (cDNR)
koncentracijas daugiau nei vienoje reakcijoje, siekiant įvertinti pastovios būsenos informacinės RNA
(RNR) lygį.

Programinė įranga apskaičiuoja santykinį tikslo ekspresijos lygį pagal vieną iš šių scenarijų:

n Tikslo sekos santykinis ekspresijos lygis (1 tikslas), lyginant su kitu tikslu (2 tikslas); pavyzdžiui,
vieno geno kiekis, lyginant su kitu genu taip pat apdorojamame mėginyje.

n Santykinis vienos tikslo sekos ekspresijos lygis viename mėginyje, lyginant su tuo pačiu tikslu
kitaip apdorojamame mėginyje; pavyzdžiui, santykinis vieno geno kiekis, lyginant su tuo pačiu
genu skirtingomis laiko, geografinėmis ar vystymosi sąlygomis.

Plokštelės sąranka geno ekspresijos analizei
Elementai, kurie turi būti šulinėliuose norint atlikti geno ekspresijos analizę:

n Du ar daugiau tikslų – du tikslai, atitinkantys skirtingus amplifikuotus genus ar sekas jūsų
mėginiuose.

n Vienas ar daugiau etaloninių tikslų – bent vienas normalizuotos ekspresijos tikslas turi būti
etaloninis. Visus etaloninius tikslus priskirkite lange „Experiment Settings“ (eksperimento
nuostatos), kad išanalizuotumėte duomenis režimu „Normalized Expression“ (normalizuota
ekspresija) (ΔΔCq). Paleidimai, kuriuose nėra etalono, turi būti analizuojami režimu „Relative
Expression“ (santykinė ekspresija) (ΔCq).
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11 skyrius. Geno ekspresijos analizė

n Bendrieji mėginiai – jūsų reakcijose turi būti bendrų mėginių (mažiausiai du), kad galėtumėte
peržiūrėti duomenis kortelėje „Gene Expression“ (geno ekspresija). Šie mėginiai turi atspindėti
įvairius kiekvienos tikslo sekos apdorojimo būdus arba sąlygas. Lange „Experiment Settings“ 
(eksperimento nuostatos) priskirkite kontrolinį mėginį (neprivaloma). Nepasirinkus kontrolinės
imties, programinė įranga vietoj jos pasirenka Cq.

„Gene Expression“ (geno ekspresija) sąrankos reikalavimai „Plate Editor“ (plokštelės redaktorius)
priklauso nuo to, ar reakcijos turinį sudaro vienkartinė PCR (PGR), kurioje dalyvauja vienas
fluoroforas, ar daugkartinė PCR (PGR), kurioje dalyvauja daugiau nei vienas fluoroforas.

Interaktyvioji plokštelės sąranka
Jei duomenų failų plokštelės sąrankoje nėra analizei reikalingos informacijos ir pasirinkta kortelė
„Gene Expression“ (geno ekspresija), toje vietoje, kurioje paprastai pateikiama stulpelinė diagrama,
pateikiami nurodymai, kaip įvesti šią informaciją. Normalizuotai geno ekspresijai atlikite šiuos
veiksmus:

1. Nurodykite „Target“ (tikslas) ir „Sample“ (mėginys) pavadinimus naudodami vieną iš šių parinkčių:

n „Plate Setup“ (plokštelės sąranka) – atidaromas langas „Plate Editor“ (plokštelės
redaktorius).

n „Replace Plate file“ (pakeisti plokštelės failą) – atidaroma naršyklė „Select Plate“ (pasirinkti
plokštelę), kurioje galite pasirinkti anksčiau įrašytą plokštelės failą dabartiniam plokštelės
išdėstymui pakeisti.

n „Replace PrimePCR file“ (keisti PGR pradmenų failą) – atidaromas dialogo langas „Select
PrimePCR“ (pasirinkti PGR pradmenis), kuriame galite pasirinkti „PrimePCR“ (PGR
pradmenys) paleidimo failą ir taikyti jį plokštelės išdėstymui.

2. Pasirinkite vieną ar daugiau etaloninių tikslų ir kontrolinį mėginį dialogo lange „Experiment
Settings“ (eksperimento nuostatos).

Jei plokštelės išdėstymo vietoje jau yra tikslo ir mėginio informacija, reikia atlikti tik antrąjį
veiksmą, kuris pažymėtas oranžine spalva. Šį veiksmą reikia atlikti prieš normalizuotą geno
ekspresijos analizę.

Pastaba. grupinės diagramos ir taškinės diagramos duomenys rodomi tik jei išpildomi visi
normalizuotos geno ekspresijos reikalavimai, nurodyti geno ekspresijos analizės dalyje
„Plate Setup“ (plokštelės sąranka).
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Geno ekspresijos diagramos

Geno ekspresijos diagramos
CFX Manager Dx programinėje įrangoje įvairiais rodiniais rodomi geno ekspresijos duomenys. 33
lentelė pateikiamos programinėje įrangoje siūlomos diagramos parinktys.

Mygtukas Pavadinimas Funkcija

Stulpelinė diagrama Rodo normalizuotos geno ekspresijos
duomenis stulpelinėje diagramoje.

Grupinė diagrama Rodo normalizuotos ekspresijos duomenis
hierarchine tvarka, kuri grindžiama skirtingų
tikslų ir mėginių ekspresijos panašumo
laipsniu.

Taškinis grafikas Rodo kontrolinės ir eksperimentinės imties
tikslų normalizuotą ekspresiją.

Rezultatai Apibendrina visų diagramų duomenis.

33 lentelė. Geno ekspresijos diagramos parinktys
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11 skyrius. Geno ekspresijos analizė

Stulpelinė diagrama

Santykinė tikslų išraiška pateikiama šiuose dviejuose rodiniuose:

n Geno ekspresijos diagrama – rodomi tikralaikiai PGR duomenys kaip vienas iš šių variantų:

o ΔΔCq – santykinė normalizuota ekspresija, apskaičiuota naudojant kontrolinius mėginius ir etaloninius
tikslus.

o ΔCq – santykinis tikslinio geno kiekis mėginyje, palyginus su kontroliniu mėginiu.
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Stulpelinė diagrama

n Skaičiuoklė – rodoma geno ekspresijos duomenų skaičiuoklė.

Patarimas. Parinktis galite pasiekti spustelėję dešiniuoju klavišu bet kurią diagramą ar
skaičiuoklę. Išplečiamajame meniu „Plate Setup“ (plokštelės sąranka) pasirinkite „View/Edit
Plate“ (peržiūrėti / redaguoti plokštelę) ir atverkite „Plate Editor“ (plokštelės redaktorius) bei
pakeiskite šulinėlio turinį plokštelėje.

Patarimas. Dešiniuoju pelės mygtuku atvėrę meniu pasirinkite „Sort“ (rūšiuoti) ir
pertvarkykite „Target“ (tikslas) bei „Sample“ (mėginys) pavadinimų tvarką diagramoje.

Normalizuota geno ekspresija

Norėdami normalizuoti duomenis, naudokite vieno ar kelių etaloninių genų, kaip normalizavimo
koeficiento, išmatuotą ekspresijos lygį. Etaloniniai genai yra tikslai, kurie nereguliuojami tiriamoje
biologinėje sistemoje, pvz., aktinas, GAPDH arba tubulinas.

Normalizuotos geno ekspresijos (ΔΔCq) analizės nustatymas

1. Atidarykite failą (.pcrd plėtiniu).

2. Peržiūrėkite duomenis lango „Data Analysis“ (duomenų analizė) kortelėje „Quantification“ 
(kiekybinis įvertinimas). Pakoreguokite duomenis, pvz., pakeisdami ribinę reikšmę ir analizės
režimą.

3. Pasirinkite kortelę „Gene Expression“ (geno ekspresija).

4. Kortelėje „Gene Expression“ (geno ekspresija) spustelėkite „Experiment Settings“ (eksperimento
nuostatos).

5. Dialogo lange „Experiment Settings“ (eksperimento nuostatos) atlikite šiuos veiksmus:

a. Pasirinkite kortelę „Samples“ (mėginiai) ir pasirinkite kontrolę. Kai kontrolė priskirta, CFX Manager
Dx programinė įranga normalizuoja visų genų santykinius kiekius į kontrolės kiekį, kuris yra 1.

b. Pasirinkite kortelę „Target“ (tikslas) ir pasirinkite etaloninius genus. Geno ekspresijos analizei
reikia vienos kontrolės tarp tikslų jūsų mėginiuose.

6. Pasirinkite „Normalized Expression“ (normalizuota ekspresija) (ΔΔCq), jeigu dar nepasirinkta, ir
tada kortelėje „Gene Expression“ (geno ekspresija) peržiūrėkite ekspresijos lygius.

Naudojimo vadovas | 241



11 skyrius. Geno ekspresijos analizė

Santykinis kiekis

Iš esmės santykinio kiekio (ΔCq) duomenys nėra normalizuoti. Šis metodas naudojamas mėginiams,
kuriuose nėra jokių etaloninių genų (tikslų), kiekybiškai įvertinti. Paprastai, atlikdami analizę,
mokslininkai žino, kad vienas iš šių aspektų teisingas:

n Kiekviename šulinėlyje esančiame mėginyje yra vienodas RNA (RNR) arba cDNA (cDNR) kiekis.

n Bet kokio įdėto biologinio mėginio kiekio dispersija bus normalizuota po paleidimo, taikant tam tikrą
duomenų analizės metodą už programinės įrangos ribų. Pavyzdžiui, mokslininkas gali pasirinkti,
kad santykinio kiekio reikšmė būtų padalyta iš normalizuojančio faktoriaus, galbūt iš kiekviename
mėginyje esančios nukleino rūgšties svorio arba iš ląstelių, iš kurių buvo išskirta nukleino rūgštis,
skaičiaus.

Santykinis kiekio (ΔCq) analizės paleidimas

u Kortelėje „Gene Expression“ (geno ekspresija) iš dešinėje srityje esančio išplečiamojo sąrašo
„Mode“ (režimas) pasirinkite „Relative Quantity“ (santykinis kiekis) (ΔCq).

Patarimas. Norėdami palyginti rezultatus su kitų geno ekspresijos paleidimų duomenimis,
atidarykite naują geno tyrimą arba pridėkite duomenų failą į esamą geno tyrimą.

Tikslo ir mėginių duomenų rūšiavimas
Pastaba. Ši parinktis galima tik geno ekspresijos diagramose.

Pagal numatytuosius parametrus tikslų ir mėginių sąrašai pateikiami abėcėline tvarka. Dialogo lange
„Sort“ (rūšiuoti) galite rūšiuoti rodmenis atvirkštine tvarka pagal abėcėlę arba rankiniu būdu perkelti
terminą į kitą padėtį sąraše.
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Stulpelinė diagrama

Tikslo ir mėginio duomenų rūšiavimas

1. Diagramos dešiniojo pelės mygtuko meniu spustelėkite „Sort“ (rūšiuoti).

Parodomas dialogo langas „Gene Expression Chart Sorting“ (geno ekspresijos diagramų
rūšiavimas).

2. Dialogo lange spustelėkite Z–A ir surūšiuokite sąrašą atvirkštine abėcėline tvarka.

3. Norėdami rankiniu būdu perkelti terminą, jį pasirinkite ir spustelėkite atitinkamą mygtuką tarp
diagramų:

n Spustelėkite rodyklę aukštyn ar žemyn ir pasirinktą terminą perkelkite per vieną padėtį.

n Spustelėkite juostos rodyklę aukštyn ar žemyn ir pasirinktą terminą perkelkite į sąrašo viršų
ar apačią.

4. Spustelėkite OK (gerai), įrašykite pakeitimus ir grįžkite į „Gene Expression“ (geno ekspresija)
kortelę.

Geno ekspresijos duomenų koregavimas
Pasirinkę analizės režimą – normalizuotą ekspresiją (∆∆Cq) arba santykinį kiekį (∆Cq) –
pakoreguokite kortelėje „Gene Expression“ (geno ekspresija) rodomus duomenis keisdami nuostatų
parinktis diagramos dešinėje.

Patarimas. Dialogo lange „User Preferences“ (vartotojo nuostatos) nustatykite numatytąsias „Gene
Expression“ (geno ekspresija) duomenų parinktis (žr. Numatytųjų geno ekspresijos duomenų failo
parametrų nustatymas, p. 73).

Diagramos duomenys

Y ašies vertei nustatykite tiesinį mastelį, kad būtų įjungtos diagramos duomenų parinktys. Diagramos
duomenų parinktys jums leidžia pateikti duomenis diagramoje viena iš šių parinkčių:
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11 skyrius. Geno ekspresijos analizė

n Lyginant su kontrole – diagramos duomenys su ašimi vertinami nuo 0 iki 1. Jeigu paleisdami
priskiriate kontrolę, pasirinkite parinktį, kad greitai vizualizuotumėte tikslo padidinimą ir
sumažinimą.

n Lyginant su nuliu – diagramos duomenys su nuline pradžia.

Kontrolinis mėginys

Išplečiamajame meniu „Control Sample“ (kontrolinis mėginys) pasirinkite mėginį , kuris bus
naudojamas normalizuojant santykinį kiekį:

Diagramos nuostatos

Šios parinktys (apibūdintos toliau) parodomos, kai „Show Chart Settings“ (rodyti diagramos nuostatas)
pažymimas langelis: „X-Axis“ (X ašis), „Y-Axis“ (Y ašis), „Scaling“ (mastelio keitimas), „Error Type“ 
(paklaidos tipas) ir „Chart Error Multiplier“ (diagramos paklaidos daugintuvas).

X ašies parinktys

X ašies parinktis leidžia pasirinkti diagramos „Gene Expression“ (geno ekspresija) x ašies duomenis:

n Tikslas – tikslų pavadinimai grafiškai atvaizduojami ant x ašies.

n Mėginys – mėginių pavadinimai grafiškai atvaizduojami ant x ašies.

Y ašies parinktys

Y ašies parinktys leidžia jums parodyti diagramą „Gene Expression“ (geno ekspresija) viena iš šių trijų
skalių:

n Tiesinė – šią parinktį pasirinkite norėdami, kad būtų rodoma tiesinė skalė.

Patarimas. Nustačius „Linear“ (tiesinė) y ašį, įjungiamas išplečiamasis sąrašas „Graph
Data“ (diagramos duomenys), kuriame galite pasirinkti diagramos duomenis, palygintus su
kontrole ar nuliu.

n „Log 2“ – pasirinkite šią parinktį, norėdami mėginius įvertinti dideliame dinaminiame intervale.

n Log 10 – pasirinkite šią parinktį, norėdami mėginius įvertinti labai dideliame dinaminiame
intervale.
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Stulpelinė diagrama

Mastelio parinktys

Pasirinkite „Normalized Gene Expression“ (normalizuota geno ekspresija) (ΔΔCq) ir nustatykite
„Control Sample“ (kontrolinis mėginys) į „None“ (nėra), kad įjungtų mastelio parinktis geno ekspresijos
diagramoje. Pasirinkite vieną iš mastelio parinkčių, apskaičiuokite ir pateikite savo duomenis tokiu
būdu, kuris geriausiai tiktų jūsų paleidimo dizainui:

n „Unscaled“ (neskaidytas) – pateikia neskaidytą normalizuotą geno ekspresiją.

n „Highest“ (didžiausias) – suskaido normalizuotą geno ekspresiją kiekvienam tikslui kiekvieno
mėginio ekspresijos lygį padalydamas iš visų mėginių ekspresijos didžiausio lygio.

Ši skaidymo parinktis taiko suskaidytą iki didžiausio lygio formulę.

n „Lowest“ (mažiausias) – suskaido normalizuotą geno ekspresiją kiekvienam tikslui kiekvieno
mėginio ekspresijos lygį padalydamas iš visų mėginių ekspresijos mažiausio lygio.

Ši skaidymo parinktis taiko suskaidytą iki mažiausio lygio formulę.

n „Average“ (vidutinis) – suskaido normalizuotą geno ekspresiją kiekvienam tikslui kiekvieno
mėginio ekspresijos lygį padalydamas iš visų mėginių ekspresijos geometrinio vidurkio.

Ši skaidymo parinktis taiko suskaidytą iki vidutinio lygio formulę.

Paklaidos tipas

Diagramoje „Gene Expression“ (geno ekspresija) pasirinkite paklaidų skaičiavimų (paklaidų juostų)
tipą:

n „Standard error of the mean (default)“ (vidurkio standartinė paklaida (numatytoji)

n „Standard deviation“ (standartinis nuokrypis)

Diagramos paklaidų juostos daugintuvas

Diagramoje „Gene Expression“ (geno ekspresija) pasirinkite paklaidų juostos daugintuvą. Pasirinkite
vieną iš šių sveikųjų skaičių: +/- 1 (numatytoji vertė), 2 arba 3. Daugintuvo pokyčių tipas, kai
pasirenkate paklaidų tipą:

n SEM – vidurkio standartinė paklaida

n Std Devs standartiniam nuokrypiui
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Eksperimento nuostatos
Patarimas. Šis dialogo langas taip pat prieinamas lange „Plate Editor“ (plokštelės redaktorius).
Daugiau informacijos žr. Eksperimento nuostatų keitimas, p. 137.

Dialogo lange „Experiment Settings“ (eksperimento nuostatos) galite peržiūrėti arba keisti tikslų ar
mėginių sąrašą, pasirinkti etaloninius genus, pasirinkti kontrolines medžiagas arba kortelėje „Gene
Expression Analysis“ (geno ekspresijos analizė) nustatyti grupę, kuri turi būti analizuojama, jei prie
šulinėlių buvo pridėta biologinių rinkinių pavadinimų.

Dialogo lango „Experiment Settings“ (eksperimento nuostatos) atvėrimas

u Kortelės „Bar Chart“ (stulpelinė diagrama) dešinės srities apačioje spustelėkite „Experiment
Settings“ (eksperimento nuostatos).

Atveriamas dialogo langas „Experiment Settings“ (eksperimento nuostatos), kuriame rodoma
kortelė „Targets“ (tikslai).
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Stulpelinė diagrama

Nuostatų „Targets“ (tikslai) koregavimas

u Kortelėje „Targets“ (tikslai) atlikite kurį nors iš toliau nurodytų veiksmų:

n Tam, kad pasirinktumėte tikslą kaip etaloną geno ekspresijos duomenų analizei, stulpelyje
„Reference“ (etalonas) pažymėkite jo pavadinimą.

n Tam, kad pakeistumėte tikslo spalvą, spustelėkite jo langelį stulpelyje „Color“ (spalva) ir
pasirodžiusiame dialogo lange „Color“ (spalva) pakeiskite spalvą.

Pasikeitusi spalva matoma „Gene Expression“ (geno ekspresija) diagramose.

n Jei norite naudoti anksčiau nustatytą veiksmingumo reikšmę, stulpelyje „Auto Efficiency“ 
(automatinis veiksmingumas) panaikinkite tikslo žymės langelio žymėjimą ir įveskite skaičių,
rodantį tikslo veiksmingumą procentais.

Programinė įranga, naudodama „Auto Efficiency“ (automatinis veiksmingumas) funkciją,
apskaičiuoja tikslo santykinį veiksmingumą, jei tikslo duomenys apima standartinę duomenų
kreivę.

Nuostatų „Sample“ (mėginys) koregavimas

u Kortelėje „Samples“ (mėginiai) atlikite kurį nors iš toliau nurodytų veiksmų:

n Tam, kad pasirinktumėte mėginį kaip kontrolinę medžiagą geno ekspresijos duomenų
analizei, stulpelyje „Control“ (kontrolė) pažymėkite jo pavadinimą.

n Tam, kad pakeistumėte mėginio grupės spalvą, spustelėkite jo elementą stulpelyje „Color“ 
(spalva) ir pasirodžiusiame dialogo lange „Color“ (spalva) pakeiskite spalvą.

Pasikeitusi spalva matoma „Gene Expression“ (geno ekspresija) diagramose.

n Tam, kad mėginys būtų rodomas „Gene Expression“ (geno ekspresija) diagramose,
pažymėkite mėginį arba grupę stulpelyje „Show Chart“ (rodyti diagramą).

n Tam, kad mėginys būtų pašalintas iš „Gene Expression“ (geno ekspresija) diagramų,
panaikinkite mėginio arba grupės žymėjimą stulpelyje „Show Chart“ (rodyti diagramą).

Patarimas. Mėginio grupės duomenys išlieka lentelėje „Results“ (rezultatai).
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Parinkčių „Biological Set Analysis Options“ (biologinio rinkinio analizės parinktys)
keitimas

u Jei priskyrėte vieną ar daugiau biologinių rinkinių šulinėliams plokštelėje (žr. Biologinių rinkinių
priskyrimas šulinėliams, p. 130), dialogo lange „Experiment Settings“ (eksperimento nuostatos)
atveriamas sąrašas „Biological Set Analysis Options“ (biologinio rinkinio analizės parinktys),
kuriame galite prireikus keisti parinktis.

n „Target vs. Sample“ (tikslo palyginimas su mėginiu) – geno ekspresijos skaičiavimuose
naudojamas tik šulinėlio mėginio pavadinimas.

n „Target vs. Biological Set“ (tikslo palyginimas su biologiniu rinkiniu) – skaičiavimuose
naudojamas tik biologinio rinkinio pavadinimas.

n „Target vs. Sample_Biological Set“ (tikslo palyginimas su mėginiu_biologiniu
rinkiniu) – mėginio pavadinimas ir biologinio rinkinio pavadinimas kombinuojami, sukuriant
bendrą pavadinimą, kuris naudojamas skaičiavimuose.

n „T arget vs. Biological Set_Sample“ (tikslo palyginimas su biologiniu rinkiniu_
mėginiu) – biologinio rinkinio pavadinimas ir mėginio pavadinimas kombinuojami, sukuriant
bendrą pavadinimą, kuris naudojamas skaičiavimuose.

Mėginio tipo pašalinimas iš analizės skaičiavimų

u Pažymėkite jo žymės langelį dialogo lango „Experiment Settings“ (eksperimento nuostatos)
apačioje.

Pastaba. Tokiu būdu iš geno ekspresijos analizės pašalinamos kontrolinės medžiagos ir
(arba) etaloniniai tirpalai.

Tikslo stabilumo reikšmė
Tikslo stabilumo reikšmės apskaičiuojamos, kai naudojamas daugiau nei vienas etaloninis genas.
Programinė įranga CFX Manager Dx apskaičiuoja du etaloninių genų kokybės parametrus:

n Normalizuotų etaloninių genų santykinių kiekių koeficiento dispersiją (CV). Kuo mažesnė
CV reikšmė, tuo didesnis stabilumas.

n M reikšmę (M), etaloninio geno ekspresijos stabilumo matą.
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Stulpelinė diagrama

Rekomenduojamos CV ir M reikšmės pateikiamos dialogo lango „Stability Value“ (stabilumo reikšmė)
apačioje.

Kaip peržiūrėti tikslo stabilumo reikšmę

u Kortelėje „Gene Expression Bar Chart“ (geno ekspresijos stulpelinė diagrama) dešinės srities
apačioje spustelėkite „Target Stability Value“ (tikslo stabilumo reikšmė).

Pasirodo dialogo langas „Stability Value“ (stabilumo reikšmė).

Dešiniojo mygtuko paspaudimu atveriamo meniu parinktys
Dešiniuoju mygtuku spustelėkite geno ekspresijos diagramą ir pasirinkite 34 lentelė esančius
elementus.

Elementas Funkcija

„Copy“ (kopijuoti) Diagramą kopijuoja į iškarpinę.

„Save Image As“ (įrašyti
paveikslėlį kaip)

Diagrama įrašoma kaip vaizdinis failas. Nustatykite vaizdo raišką ir
dydį, o tada pasirinkite failo tipą (PNG, GIF, JPG, TIF arba BMP).

„Page Setup“ (puslapio
sąranka)

Parenkama puslapio sąranka spausdinti.

„Print“ (spausdinti) Atspausdina diagramą.

„Set Scale to Default“ (nustatyti
numatytąją skalę)

„Show All“ (parodyti viską) parodo visus duomenis stulpelinėje
diagramoje. „Scroll Bar“ (slinkties juosta) rodoma slinkties juosta,
jeigu diagramos rėme yra per daug rodytinų mėginių išlaikant
minimalų juostos plotį.

„Chart Options“ (diagramos
parinktys)

Atveriamas langas „Chart Options“ (diagramos parinktys), kad būtų
galima pakoreguoti diagramą.

„Sort“ (rūšiuoti) Rūšiuoja mėginių ar tikslų užsakymus, kurie rodomi diagramos x
ašyje.

„Use Corrected Std Devs“ 
(naudoti koreguotą standartinį
nuokrypį)

Apskaičiuoja nuokrypio juostas taikant koreguoto standartinio
nuokrypio formulę.

„Use Solid Bar Colors“ (naudoti
vientisos juostos spalvas)

Diagramoje rodo vientisas juostas.

34 lentelė. Geno ekspresijos dešiniojo mygtuko meniu elementai
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Elementas Funkcija

„X–Axis Labels“ (x ašies
etiketės)

Rodo horizontalias arba pakreiptas x ašies etiketes.

34 lentelė. Geno ekspresijos dešiniojo mygtuko meniu elementai (tęsinys)

Duomenų skaičiuoklė
35 lentelė apibūdinti duomenys, rodomi duomenų lentelėje „Gene Expression“ (geno ekspresija).

Pastaba. Reikšmės lentelėje apskaičiuojamos remiantis diagramos tipu ir nuostatomis,
pasirinktomis dešinėje srityje.

Informacija Aprašymas

Tikslas Lange „Experiment Settings“ (eksperimento nuostatos) pasirinkto
tikslo pavadinimas (amplifikuotas genas).

Mėginys Lange „Experiment Settings“ (eksperimento nuostatos) pasirinktas
mėginio pavadinimas.

Ctrl Lange „Experiment Settings“ (eksperimento nuostatos) pasirinktas
kontrolės pavadinimas.

Santykinis kiekis arba
ekspresija

Santykinis kiekis (ΔCq) arba normalizuota geno ekspresija (ΔΔCq),
priklausomai nuo pasirinkto režimo.

Santykinis kiekis arba
ekspresijos SEM (arba SD)

Santykinio kiekio arba normalizuotos ekspresijos vidurkio
standartinė paklaida (SEM) arba standartinis nuokrypis (SD),
priklausomai nuo pasirinktos parinkties.

Koreguotas santykinis kiekis
arba ekspresijos SEM (arba
SD)

Santykinio kiekio ar normalizuotos ekspresijos SEM arba SD
koreguotos vertės skaičiavimas, priklausomai nuo pasirinktos
parinkties.

Cq vidurkis Kiekio nustatymo vidurkis.

Cq SEM (arba SD) Kiekio nustatymo ciklo SEM arba SD, priklausomai nuo pasirinktos
parinkties.

35 lentelė. Informacijos, esančios stupelinės diagramos skaičiuoklėje, kortelėje „Graphing“ 
(grafikai), apibūdinimas
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Stulpelinė diagrama

Parinktis „Show Details“ (rodyti išsamią informaciją)
36 lentelė apibrėžiami duomenys, rodomi stulpelinės diagramos skaičiuoklės dešiniojo pelės mygtuko
meniu pasirinkus „Show Details“ (rodyti išsamią informaciją).

Informacija Aprašymas

Duomenų rinkinys Fluorescencijos duomenys iš vieno fluoroforo duomenų faile

Santykinis kiekis Apskaičiuotas santykinis mėginių kiekis

Santykinio kiekio SD Santykinio kiekio skaičiavimo standartinis nuokrypis

Pakoreguoto santykinio kiekio
SD

Apskaičiuotas pakoreguoto santykinio kiekio standartinis nuokrypis

Santykinio kiekio SEM Santykinio kiekio apskaičiavimo vidurkio standartinė paklaida

Pakoreguoto santykinio kiekio
SEM

Apskaičiuota pakoreguoto santykinio kiekio vidurkio standartinė
paklaida

Santykinis kiekis (lg) Santykinio kiekio, naudojamo statistinei analizei, log2

SD RQ (lg) Santykinio kiekio standartinis nuokrypis (log2)

Ekspresijos SEM (lg) Ekspresijos vidurkio standartinė paklaida (log2)

Neapdorota ekspresija Apskaičiuota neapdorota ekspresija

Neapdorotos ekspresijos SD Apskaičiuotas neapdorotos ekspresijos standartinis nuokrypis

Pakoreguotos neapdorotos
ekspresijos SD

Apskaičiuotas pakoreguotos neapdorotos ekspresijos standartinis
nuokrypis

Neapdorotos ekspresijos SEM Apskaičiuota neapdorotos ekspresijos vidurkio standartinė paklaida

Pakoreguotos neapdorotos
ekspresijos SEM

Apskaičiuota pakoreguotos neapdorotos ekspresijos vidurkio
standartinė paklaida

Neapdorota ekspresija (lg) Neapdorotos ekspresijos Log2

Neapdorotos ekspresijos SD
(lg)

Neapdorotos ekspresijos standartinis nuokrypis (log2)

36 lentelė. Informacija, esanti stulpelinės diagramos skaičiuoklėje, pasirinkus „Show
Details“ (rodyti išsamią informaciją)
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Informacija Aprašymas

Neapdorotos ekspresijos SEM
(lg)

Neapdorotos ekspresijos vidurkio standartinė paklaida (log2)

Ekspresija Normalizuota geno ekspresija

Pakoreguotos ekspresijos SD Apskaičiuotas standartinis nuokrypis

Ekspresijos SEM Vidurkio standartinė paklaida

Pakoreguotos ekspresijos SEM Apskaičiuota vidurkio standartinė paklaida

Ekspresija (lg) Ekspresijos (normalizuotos ekspresijos), naudojamos statistinei
analizei, log2

Ekspresijos SD (lg) Ekspresijos standartinis nuokrypis (log2)

Ekspresijos SEM (lg) Ekspresijos vidurkio standartinė paklaida (log2)

Cq vidurkis Kiekybinio įvertinimo ciklo vidurkis

Cq SD Kiekybinio įvertinimo ciklo standartinis nuokrypis

Cq SEM Kiekybinio įvertinimo ciklo vidurkio standartinė paklaida

36 lentelė. Informacija, esanti stulpelinės diagramos skaičiuoklėje, pasirinkus „Show Details“ 
(rodyti išsamią informaciją) (tęsinys)

252 | Sistemos CFX96 Dx ir CFX96 Deep Well Dx



Grupinė diagrama

Grupinė diagrama
Grupinėje diagramoje duomenys pateikiami hierarchine tvarka, kuri grindžiama skirtingų tikslų ir
mėginių ekspresijos panašumo laipsniu.

Pastaba. Turite pasirinkti etaloninį tikslą tam, kad būtų rodomos bet kokios duomenų diagramos,
išskyrus santykinės ekspresijos stulpelines diagramas.

Grupinės diagramos vaizde parodyta santykinė mėginio ar tikslo ekspresija:

n Didinimas (raudona) – didesnė ekspresija

n Sumažinimas (žalia arba mėlyna) – mažesnė ekspresija

n Nereguliuojama (juoda)

n Nėra apskaičiuotų reikšmių (juoda su baltu X)

Kuo šviesesnis atspalvis, tuo didesnė santykinė ekspresija. Jei nepavyks apskaičiuoti normalizuotos
Cq reikšmės, bus rodomas juodas kvadratas su baltu X.

Duomenų diagramos išoriniuose kraštuose yra dendrograma, nurodanti grupavimo hierarchiją. Tikslai
arba mėginiai, kurie turi panašius ekspresijos modelius, turės gretimų šakų, o tie, kurių modeliai
skirtingi, bus tolesni.

Nuostatos
Galite nustatyti šias parinktis:

n „Cluster By“ (grupė) – pasirinkite iš „Targets“ (tikslai), „Samples“ (mėginiai), „Both“ (abu) arba
„None“ (joks).

n „Size“ (dydis) – koreguojamas vaizdo dydis ir pakeičiamas diagramos didinimo laipsnis.

n „Split Out Replicates“ (padalyti kopijas) – rodomos atskirų kopijų vertės.

Patarimas. Galite pakeisti grupinės diagramos ir taškinio grafiko spalvų schemą iš numatytosios
raudonos / žalios į raudoną / mėlyną pasirinkdami kiekvienos diagramos šią dešiniojo pelės klavišo
meniu parinktį.

Dešiniojo mygtuko paspaudimu atveriamo meniu parinktys
Dešiniojo mygtuko paspaudimu atveriamo meniu grupinės diagramos parinktys yra tokios pačios, kaip
juostinės diagramos. Galimas parinktis žr. čia: 34 lentelė, p. 249. Be to, pasirinkite „Color Scheme“ 
(spalvų schema), kad pakeistumėte iš numatytosios raudoną / žalią į raudoną / mėlyną sumažinimo
veiksmui diagramoje vaizduoti.
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Duomenų skaičiuoklė
Skaičiuoklėje pateikiamos tikslų, mėginių ir normalizuotos ekspresijos vertės. Spustelėkite šalia tikslo
esantį žymės langelį ir jį įtraukite į grafiką arba pašalinkite iš jo.
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Taškinis grafikas

Taškinis grafikas
Taškiniame grafike rodoma kontrolės ir eksperimentinio mėginio tikslų normalizuota ekspresija. Grafiko
linijos reiškia taisyklės ribinę reikšmę. Duomenų taškai tarp eilučių rodo, kad to tikslo (geno) ekspresijos
skirtumas tarp mėginių yra nereikšmingas. Duomenų taškai, esantys už linijų, viršija taisyklės ribinę reikšmę
ir galėtų būti dominantys.

Grafiko vaizdas parodo šiuos tikslo ekspresijos pokyčius, remiantis taisyklės ribine reikšme.

n Didinimas (raudonas apskritimas) – santykinai didesnė ekspresija

n Sumažinimas (žalias arba mėlynas apskritimas) – santykinai mažesnė ekspresija

n Be pakeitimų (juodas apskritimas)

Spustelėkite ir vilkite bet kurią ribinės reikšmės liniją ir pakoreguokite taisyklės ribinės reikšmės vertę.

Nuostatos
Galite nustatyti šias parinktis:

n Kontrolinį mėginį

n Eksperimentinį mėginį

n Reguliavimo ribinę reikšmę. Didinant arba mažinant reguliavimo reikšmę, ribinių reikšmių linijos
diagramoje atitinkamai keičiasi.

Dešiniojo mygtuko paspaudimu atveriamo meniu parinktys
Taškinio grafiko dešiniojo mygtuko paspaudimu atveriamo meniu parinktys yra tokios pačios, kaip ir
stulpelinių diagramų. Galimas parinktis žr. čia: 34 lentelė, p. 249. Be to, pasirinkite „Symbol“ 
(simbolis), kad pakeistumėte diagramoje naudojamą numatytąjį apskritimo simbolį į vieną iš šių:

n Trikampis

n Kryžius

n Kvadratas

n Rombas
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Duomenų skaičiuoklė
Skaičiuoklėje pateikiamos tikslų, mėginių ir normalizuotos ekspresijos reikšmės kontroliniams ir
eksperimentiniams mėginiams. Ji taip pat parodo, ar tikslai yra padidinti, ar sumažinti, lyginant su
kontroline ribine verte. Spustelėkite šalia tikslo esantį žymės langelį ir jį įtraukite į grafiką arba
pašalinkite iš jo.
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Rezultatų

Rezultatų
Rezultatų kortelėje pateikiama skaičiuoklė, kurioje apibendrinti visų diagramų duomenys. 37 lentelė
apibūdinami duomenys, kurie rodomi rezultatų skaičiuoklėje.

Informacija Aprašymas

„Target“ (tikslas) Tikslo pavadinimas (amplifikuotas genas)

„Sample“ (mėginys) Mėginio pavadinimas

„Mean Cq“ (Cq vidurkis) Kiekybinio įvertinimo ciklo vidurkis

„Mean Efficiency Corrected Cq“ 

(vidutinis koreguotas veiksmingumo

Cq)

Kiekybinio įvertinimo ciklo vidurkis pakoregavus reakcijos
veiksmingumą

„Normalized Expression“ 
(normalizuota ekspresija)

Tikslinė ekspresija, normalizuota etaloniniam tikslui (ΔΔCq)

„Relative Normalized
Expression“ (santykinė
normalizuota ekspresija)

Normalizuota ekspresija, palyginus su kontroliniu mėginiu, dar
vadinama kartotiniu keitimu

„Regulation“ (taisyklė) Ekspresijos pokytis, palyginus su kontroliniu mėginiu

„Compared to Regulation
Threshold“ (palyginus su
taisyklės ribine reikšme)

Eksperimentinio mėginio padidinimas ar sumažinimas, remiantis
ribinės reikšmės nuostatomis

37 lentelė. Informacija rezultatų kortelėje

Pastaba. Duomenų kopijos aptinkamos tik duomenų analizės kortelių skaičiuoklėse, kuriose
buvo pasirinkta „Split Out Replicates“ (išskirti kopijas) (t. y. „Clustergram“ (grupinė diagrama)).
Gali būti neatitikimų tarp ekspresijos duomenų geno ekspresijos analizės skaičiuoklėje, jeigu
stulpelinėje diagramoje kaip kontrolinį mėginį pasirinktumėte „nėra“.
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Geno tyrimas
Sukurkite geno tyrimą, kad būtų galima palyginti geno ekspresijos duomenis iš vieno ar kelių tikralaikių
PCR (PGR) eksperimentų taikant kalibratorių tarp paleidimų, kad būtų normalizuota tarp
eksperimentų. Sukurkite geno tyrimą į jį įtraukdami duomenis iš vieno ar kelių duomenų failų (.pcrd
plėtiniu). Programinė įranga juos sugrupuoja į vieną failą (.mgxd plėtiniu).

Pastaba. Didžiausią mėginių, kuriuos galite analizuoti geno tyrime, skaičių riboja kompiuterio
RAM ir virtualios atminties dydis.

Kalibravimas tarp paleidimų
Kiekviename geno tyrime kiekvienam tikslui automatiškai bandoma atlikti kalibravimą tarp paleidimų,
siekiant normalizuoti tarpines variacijas tarp tikslų, ištirtų atskiruose PGR paleidimuose tikruoju laiku
(t. y. skirtingi .pcrd failai, gauti iš skirtingų plokštelių).

Kad programinė įranga atpažintų mėginį kaip kalibratorių tarp paleidimų, jis turi turėti tą patį tikslo
pavadinimą, mėginio pavadinimą ir, jei naudojama, biologinio rinkinio pavadinimą visose lyginamose
plokštelėse.

Pastaba. Geno tyrime turi būti bent vienas kalibravimo tarp paleidimų mėginys, kad būtų atliktas
kalibravimas tarp paleidimų. Tikslai be tinkamų kalibratoriaus tarp paleidimų mėginių bus
tvarkomi be korekcijos geno tyrime (nerekomenduojama).

Kalibratoriai tarp paleidimų gali būti taikomi dviem būdais:

n Tikslui – skirtingi PCR (PGR) pradmenys gali turėti skirtingą efektyvumą. Pagal numatytąsias
nuostatas kalibratorius tarp paleidimų taikomas visiems tos pačios plokštelės šulinėliams,
turintiems tą patį tikslo pavadinimą, pavyzdžiui, Cq, gautas su tuo pačiu tyrimu.

n Visam tyrimui – vartotojas pasirenka vieną kalibratorių tarp paleidimų, kuris taikomas visam geno
tyrimui.

Dialogo langas „Gene Study“ (geno tyrimas)
Dialogo lange „Gene Study“ (geno tyrimas) yra dvi kortelės:

n Kortelėje „Study Setup“ (tyrimo sąranka) tvarkomi geno tyrimo paleidimai.

Svarbu. Duomenų failų įtraukimas į geno tyrimą ar šalinimas iš jo nekeičia pirminio failo
duomenų.

n Kortelėje „Study Analysis“ (tyrimo analizė) rodomi kombinuotų paleidimų geno ekspresijos
duomenys.
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Geno tyrimas

Kortelė „Study Setup“ (tyrimo sąranka)
38 lentelė apibūdinti duomenys, rodomi kortelėje „Study Setup“ (tyrimo sąranka).

Stulpelio pavadinimas Aprašymas

„File Name“ (failo
pavadinimas)

Analizės duomenų failo pavadinimas (.pcrd plėtinys)

„File Folder“ (failo aplankas) Katalogas, kuriame saugomas kiekvieno geno tyrimo metu atlikto
paleidimo duomenų failas

„Date Created“ (sukūrimo
data)

Paleidimo duomenų surinkimo data

„Well Group Name“ 
(šulinėlių grupės
pavadinimas)

Šulinėlių grupės, kuri buvo pasirinkta pridedant failą prie genų tyrimo,
pavadinimas

Patarimas. Jei geno tyrimo metu norite analizuoti vieną šulinėlių
grupę, prieš importuodami duomenų failą į geno tyrimą turite
pasirinkti tą šulinėlių grupę lange „Data Analysis“ (duomenų
analizė) .

„Step“ (veiksmas) Protokolo veiksmas, kurio metu nuskaitoma plokštelė, siekiant rinkti
tikralaikius PGR duomenis

„Run Type“ (paleidimo
tipas)

Nustatytas vartotojo arba „PrimePCR“ (PGR pradmenys) paleidimas

„Protocol Edited“ 
(redaguotas protokolas)

Jei pasirinkta, rodoma, kuris protokolas, naudotas atliekant
„PrimePCR“ (PGR pradmenys) paleidimą, buvo redaguotas

„View Plate“ (peržiūrėti
plokštelę)

Atveriama plokštelės schema su kiekvieno paleidimo, įtraukto į geno
tyrimą, duomenimis

38 lentelė. Kortelė „Study Setup“ (tyrimo sąranka) dialogo lange „Gene Study“ (geno
tyrimas)
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Geno tyrimo paruošimas
Kaip paruošti geno tyrimą

1. Prieš importuodami duomenis į geno tyrimą, lange „Data Analysis“ (duomenų analizė) atlikite
šiuos veiksmus:

n Patikrinkite, ar mėginiai, kurių turinys toks pats, yra tokio paties pavadinimo. Geno tyrime
programinė įranga daro prielaidą, kad šulinėliai su tokiu pačiu tikslu ar mėginio pavadinimu
turi tokius pačius mėginius.

n Kortelėje „Quantification“ (kiekybinis įvertinimas) koreguokite pradinį lygį ir ribinę vertę (Cq) ir
optimizuokite kiekvieno paleidimo duomenis.

n Pasirinkite šulinėlių grupę, kurią norite įtraukti į genų tyrimą.

Kad galėtumėte parodyti vienos šulinėlių grupės geno tyrime duomenis, ta grupė turi būti
pasirinkta prieš importuojant duomenų failą.

Kortelėje „Study Setup“ (tyrimo sąranka) rodomas visų paleidimų geno tyrime sąrašas.

2. Dialogo lange „Gene Study“ (geno tyrimas) pasirinkite kortelę „Study Setup“ (tyrimo sąranka).

3. Spustelėkite „Add Data Files“ (pridėti duomenų failus) ir naršyklės lange pasirinkite failą.

Patarimas. Norėdami į geno tyrimą greitai įtraukti paleidimus, duomenų failus (.pcrd plėtiniu)
nuvilkite į dialogo langą „Study Setup“ (tyrimo sąranka).

4. CFX Manager Dx programinė įranga automatiškai atlieka geno tyrimo analizę, kai pridedate
duomenų failus. Pasirinkite kortelę „Study Analysis“ (tyrimo analizė) ir peržiūrėkite rezultatus.

Paleidimų pašalinimas iš geno tyrimo

u Sąraše pasirinkite vieną ar kelis failus ir spustelėkite „Remove“ (pašalinti).

Pastabų apie geno tyrimą pridėjimas

u Į tekstinį laukelį „Notes“ (pastabos) įrašykite pastabų apie failus ir analizę.
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Kortelė „Study Analysis“ (tyrimo analizė)
Kortelėje „Study Analysis“ (tyrimo analizė) rodomi duomenys iš visų geno tyrimo paleidimų. Geno
ekspresijos duomenų analizės parinktis yra tokia pati, kaip ir atskiro duomenų failo, išskyrus šį atvejį:

n Stulpelinių diagramų kalibracijos tarp paleidimų vertės (jeigu apskaičiuotos) parodomos, kai
paspaudžiate „Inter-run Calibration“ (kalibravimas tarp paleidimų).

Pastaba. Kaip kalibratoriai tarp paleidimų gali būti naudojami tik šių tipų mėginiai:

o Nežinoma

o Standartas

o Teigiama kontrolė

Neigiama kontrolė, nėra šablono kontrolės (NTC) ir nėra atvirkštinės transkriptazės kontrolės
(NRT) mėginių tipų negalima naudoti kaip kaibratoriaus tarp paleidimų.
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Geno tyrimo ataskaitos kūrimas
Kaip sukurti geno tyrimo ataskaitą

1. Prieš sukurdami ataskaitą, pakoreguokite geno tyrimo ataskaitos duomenis ir diagramas, kai
reikia.

2. Pasirinkite „Tools > Reports“ (įrankiai > ataskaitos) meniu „Gene Study“ (geno tyrimas), kad
atidarytumėte dialogo langą „Report“ (ataskaita).

3. Pasirinkite parinktis, kurias norite įtraukti į ataskaitą. Ataskaita atidaroma pagal pasirinktas
numatytąsias parinktis. Pasirinkite arba išvalykite žymės langelius, kad pakeistumėte visas
kategorijas ar atskiras kategorijos parinktis.

Galimos parinktys pateikiamos skyriaus Geno tyrimo ataskaitų kategorijos, p. 262, sąrašuose.

4. Pakeiskite kategorijų ir elementų tvarką ataskaitoje. Vilkite parinktis į reikiamą padėtį. Elementus
pertvarkyti galima tik tose kategorijose, kurioms jie priklauso.

5. Spauskite „Update Report“ (atnaujinti ataskaitą), kad atnaujintumėte „Report Preview“ (ataskaitos
peržiūra) su pakeitimais.

6. Spausdinkite arba įrašykite ataskaitą. Paspauskite įrankių juostos mygtuką „Print Report“ 
(spausdinti ataskaitą), norėdami atspausdinti esamą ataskaitą. Pasirinkite „File > Save“ (failas >
įrašyti), kad įrašytumėte PDF („Adobe Acrobat Reader“ failas) formatu, ir pasirinkite, kur norite
įrašyti failą. Pasirinkite „File > Save As“ (failas > įrašyti kaip), ir įrašykite ataskaitą nauju
pavadinimu ar naujoje vietoje.

7. (Neprivaloma) Sukurkite ataskaitos šabloną su norima informacija. Norėdami įrašyti esamas
ataskaitos nuostatas šablone, pasirinkite „Template > Save“ (šablonas > įrašyti) arba „Save As“ 
(įrašyti kaip). Tada įkelkite ataskaitos šabloną kitą kartą, kai norėsite sukurti naują ataskaitą.

Geno tyrimo ataskaitų kategorijos
Dialogo lange „Gene Study Report“ (geno tyrimo ataskaita) organizuokite geno tyrimo duomenis į
ataskaitą. 39 lentelė išvardytos visos parinktys, galimos geno tyrimo ataskaitoje

Kategorija Parinktis Aprašymas

Antraštė

Ataskaitos antraštė, poantraštė ir logotipas

39 lentelė. Geno tyrimo ataskaitos kategorijos
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Kategorija Parinktis Aprašymas

„Report Information“ 
(ataskaitos informacija)

Data, vartotojo vardas, duomenų failo
pavadinimas, duomenų failo kelias ir pasirinktų
šulinėlių grupė

„Gene Study File List“ 
(geno tyrimo failų sąrašas)

Visų duomenų failų geno tyrime sąrašas

„Notes“ (pastabos) Pastabos apie duomenų ataskaitą

Stulpelinė diagrama „Study Analysis“ (tyrimo analizė)

„Analysis Settings“ 
(analizės nuostatos)

Pasirinktų analizės parametrų sąrašas

„Chart“ (diagrama) Geno ekspresijos stulpelinė diagrama, kurioje
rodomi duomenys

„Target Names“ (tikslų
pavadinimai)

Visų tikslų geno tyrime sąrašas

„Sample Names“ (mėginių
pavadinimai)

Visų mėginių geno tyrime sąrašas

„Data“ (duomenys) Skaičiuoklė, kurioje pateikiami duomenys

„Target Stability“ (tikslo
stabilumas)

Tikslo stabilumo duomenys

„Inter-run Calibration“ 
(kalibravimas tarp
paleidimų)

Kalibravimo tarp paleidimų duomenys

Grupinė diagrama ir taškinė diagrama „Study Analysis“ (tyrimo analizė)

„Analysis Settings“ 
(analizės nuostatos)

Kiekvieno diagramos tipo nuostatos

„Chart“ (diagrama) Geno ekspresijos diagrama, kurioje rodomi
duomenys

„Data“ (duomenys) Skaičiuoklėje išvardyti kiekvieno tikslo
duomenys

39 lentelė. Geno tyrimo ataskaitos kategorijos (tęsinys)
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A priedas. Duomenų analizės skaičiavimai
„CFX Manager Dx“ programinė įranga formules apskaičiuoja automatiškai ir rezultatus parodo
kortelėse „Data Analysis“ (duomenų analizė). Šiame priede išsamiai paaiškinta, kaip „CFX Manager
Dx“ programinė įranga apskaičiuoja formules.

Reakcijos veiksmingumas
Įrodymai rodo, kad taikant kiekvieno pradmens ir zondo rinkinio veiksmingumo tikslias priemones bus
gauti tikslesni rezultatai, kai analizuojami geno ekspresijos duomenys. Veiksmingumo, taikomo geno
ekspresijos skaičiavimuose, numatytoji vertė yra 100 %. Norėdami įvertinti reakcijos veiksmingumą,
sukurkite standartinę kreivę, taikydami reprezentatyvaus mėginio serijinius skiedimus atitinkamame
dinaminiame intervale ir tada registruokite kitos geno ekspresijos analizės veiksmingumą. Jeigu jūsų
paleistyje yra standartinė kreivė, tada programinė įranga automatiškai apskaičiuoja veiksmingumą ir jį
pateikia „Standard Curve“ (standartinė kreivė) kortelėje „Quantification“ (kiekybinis vertinimas), kai
lango „Experiment Settings“ (eksperimento nuostatos) kortelėje „Targets“ (tikslai) pažymima „Auto
Efficiency“ (automatinis veiksmingumas).

Veiksmingumas (E) veiksmingumo formulėse reiškia „veiksmingumus“, kaip jie apibūdinti Pfaffl (2001)
ir Vandesompele et al. (2002). Šiose publikacijose 2 veiksmingumas (idealus padvigubėjimas su
kiekvienu ciklu) yra lygus 100 % veiksmingumui programinėje įrangoje. Jūs turite galimybę konvertuoti
savo skaičiavimus į naudojamus programinėje įrangoje taikydami šias matematines lygtis:

n E = (% veiksmingumas * 0,01) + 1

n % veiksmingumas = (E – 1) * 100
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Santykinis kiekis
Santykinio kiekio (ΔCq) formulė bet kuriam mėginiui (GOI) yra:

Pastaba. Ši formulė naudojama santykiniam kiekiui apskaičiuoti, kai nėra apibrėžtas kontrolinis
mėginys.

Kur:

n E = pradmens ir zondo rinkinio veiksmingumas. Šis veiksmingumas apskaičiuojamas pagal
formulę
(% veiksmingumas * 0,01) + 1, kur 100 % veiksmingumas = 2

n C q (min) = vidutinis Cq mėginiui su mažiausiu vidutiniu Cq, skirtas GOI

n Cq (mėginys) = vidutinis Cq mėginiui

n GOI = tikslinis genas (vienas tikslas)

Santykinis kiekis pasirinkus kontrolę
Kai priskirtas kontrolinis mėginys , mėginio su tiriamu genu (GOI) santykinis kiekis (RQ)
apskaičiuojamas pagal šią formulę:

Kur:

n E = pradmens ir zondo rinkinio veiksmingumas Šis veiksmingumas apskaičiuojamas pagal
formulę
(% veiksmingumas * 0,01) + 1, kur 100 % veiksmingumas = 2

n Cq (kontrolė) = vidutinis Cq kontroliniam mėginiui

n Cq (mėginys) = vidutinis Cq visiems mėginiams su GOI

n GOI = tikslinis genas (vienas tikslas)
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Santykinio kiekio standartinis nuokrypis

Santykinio kiekio standartinis nuokrypis
Santykinio kiekio standartinio nuokrypio formulė yra

Kur:

n SD santykinis kiekis = santykinio kiekio standartinis nuokrypis

n SD CqGOI mėginys = mėginio (GOI) Cq standartinis nuokrypis

n Santykinis kiekis = mėginio santykinis kiekis

n E = pradmens ir zondo rinkinio veiksmingumas. Šis veiksmingumas apskaičiuojamas pagal
formulę
(% veiksmingumas * 0,01) + 1, kur 100 % veiksmingumas = 2

n GOI = tikslinis genas (vienas tikslas)

Koreguotas veiksmingumas Cq (CqE)
Koreguoto veiksmingumo Cq formulė yra

Kur:

n E = veiksmingumas

Vidutinis koreguotas veiksmingumas Cq (MCqE)
Vidutinio koreguoto veiksmingumo Cq formulė yra

Kur:

n CqE = koreguotas veiksmingumas Cq

n n = kopijų skaičius
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A priedas. Duomenų analizės skaičiavimai

Normalizavimo koeficientas
Normalizuotos ekspresijos lygties vardiklis vadinamas normalizavimo koeficientu. Normalizavimo
koeficientas yra visų atitinkamo mėginio etaloninių tikslų (genų) santykinių kiekių geometrinis vidurkis,
kaip aprašyta šioje formulėje:

Kur:

n RQ = santykinis kiekis

n n = etaloninių tikslų skaičius

n GOI = tikslinis genas (vienas tikslas)
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Normalizuota ekspresija
Normalizuota ekspresija (ΔΔCq) yra jūsų tikslo (geno), normalizuoto iki etaloninių taikinių (genų ar
sekų) jūsų biologinėje sistemoje, santykinis kiekis. Norėdami pasirinkti etaloninius tikslus, atverkite
langą „Experiment Settings“ (eksperimento nuostatos) ir spustelėkite kiekvieno tikslo, kuris
naudojamas kaip etaloninis genas, etalono stulpelį.

Normalizuotos ekspresijos formulė, kuri naudojama apskaičiuoti santykiniam kiekiui (RQ), yra

Kur:

n RQ = mėginio santykinis kiekis

n Ref = etaloninis tikslas paleidimo metu, kuris apima vieną ar kelis etaloninius tikslus kiekviename
mėginyje

n GOI = tikslinis genas (vienas tikslas)

Jei etaloniniai tikslai jūsų biologinėje sistemoje nekeičia jų ekspresijos lygio, normalizuotos
ekspresijos apskaičiavimas apims krovimo skirtumus arba ląstelių skaičiaus skirtumus, kurie yra
vaizduojami kiekviename jūsų mėginyje.

Normalizuota ekspresija pasirinkus kontrolę
Pasirinkus kontrolinį mėginį lange „Experiment Settings“ (eksperimento nuostatos), programinė įranga
nustato kontrolinio mėginio ekspresijos lygį į 1. Esant tokiai situacijai, programinė įranga normalizuoja
santykinius visų tikslinių (geno) ekspresijų kiekius į kontrolinį kiekį (reikšmė = 1). Ši normalizuota
ekspresija lygi neapdorotos normalizuotos ekspresijos analizei, kai pasirinkta kontrolė.

Pastaba. Ji dar vadinama santykine normalizuota ekspresija (RNE) ir kartotiniu keitimu.
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Normalizuotos ekspresijos standartinis nuokrypis
Pakartotinis normalizuotos ekspresijos reikšmės mastelio keitimas atliekamas padalijus
normalizuotos ekspresijos standartinį nuokrypį iš jos reikšmės, atitinkančios aukščiausią arba
žemiausią ekspresijos lygį, priklausomai nuo pasirinktos mastelio keitimo parinkties. Normalizavimo
koeficiento standartinio nuokrypio (SD) formulė:

Čia:

n RQ = mėginio santykinis kiekis

n SD = standartinis nuokrypis

n NF = normalizavimo koeficientas

n Ref = etaloninis tikslas

n n = etaloninių tikslų skaičius

Priskyrus kontrolinį mėginį, nereikia atlikti standartinio nuokrypio pakartotinio mastelio keitimo,
parodyto šioje formulėje:

Čia:

n NE = normalizuota ekspresija

n RQ = mėginio santykinis kiekis

n SD = standartinis nuokrypis

n GOI = tikslinis genas (vienas tikslas)
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Normalizuota ekspresija, padidinta iki didžiausio ekspresijos lygio

Normalizuota ekspresija, padidinta iki didžiausio
ekspresijos lygio

Kai paleidimo metu nėra kontrolių, pakeiskite normalizuotos ekspresijos (NE) mastelį kiekvienam
tikslui (genui) padalydami kiekvieno mėginio ekspresijos lygį iš aukščiausio ekspresijos lygio visuose
mėginiuose. Programinė įranga nustato 1 vertės ekspresijos aukščiausią lygį ir pakeičia visų mėginių
ekspresijos lygių mastelį. Aukščiausio mastelio formulė yra

Kur:

n GOI = tikslinis genas (tikslas)

Normalizuota ekspresija, pakeista į mažiausią ekspresijos
lygį

Kai paleidimo metu nėra kontrolių, pakeiskite kiekvieno tikslo (geno) normalizuotos ekspresijos (NE)
mastelį padalydami kiekvieno mėginio ekspresijos lygį iš visų mėginių žemiausio ekspresijos lygio.
Programinė įranga nustato žemiausią ekspresijos lygį į 1 ir pakeičia visų mėginių ekspresijos lygių
mastelį. Žemiausio mastelio formulė

Čia:

n GOI = tikslinis genas (tikslas)
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Normalizuota ekspresija, pakeista iki vidutinio ekspresijos
lygio

Kai paleidimo metu nėra kontrolių, pakeiskite kiekvieno tikslo (geno) normalizuotos ekspresijos (NE)
mastelį padalydami kiekvieno mėginio ekspresijos lygį iš visų mėginių ekspresijos lygių geometrinio
vidurkio. Programinė įranga nustato vidutinį ekspresijos lygį į 1 ir pakeičia visų mėginių ekspresijos
lygių mastelį. Vidutinio mastelio formulė

Čia:

n GOI = tikslinis genas (tikslas)

n GM = visų mėginių normalizuotos ekspresijos geometrinis vidurkis
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Patikslintos normalizuotos ekspresijos standartinis nuokrypis

Patikslintos normalizuotos ekspresijos standartinis
nuokrypis

Pakartotinis patikslintos normalizuotos ekspresijos (NE) reikšmės tikslinimas atliekamas padalijus
normalizuotos ekspresijos standartinį nuokrypį (SD) iš normalizuotos ekspresijos reikšmės,
atitinkančios didžiausią (MAX) arba mažiausią (MIN) ekspresijos lygį, priklausomai nuo jūsų tikslinimo
parinkties.

Pastaba. Kai kontrolinis mėginys priskiriamas, jums nereikia standartiniam nuokrypiui naudoti
šios pakartotinio tikslinimo funkcijos.

Apskaičiuojama pagal formulę

Kur:

n NE = normalizuota ekspresija

n SD = standartinis nuokrypis

n GOI = tikslinis genas (tikslas)

n MAX = aukščiausias ekspresijos lygis

n MIN = žemiausias ekspresijos lygis

Taisyklė
Taisyklė yra priemonė padidinti ar sumažinti tikslo ekspresiją eksperimentiniame mėginyje, palyginus
su kontrole, ir nustatoma taip:

Jeigu ekspresija (eksperimentinė) > ekspresija (kontrolinė):

Jeigu ekspresija (eksperimentinė) < ekspresija (kontrolinė):

Pastaba. Stulpelinėje diagramoje ekspresija pagrįsta arba santykiniu kiekiu, arba normalizuota
ekspresija, priklausomai nuo pasirinkto režimo (žr. Stulpelinė diagrama, p. 240). Tačiau taškinei ir
grupinei diagramai taisyklė visada apskaičiuojama iš normalizuotos ekspresijos.
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Koreguotų verčių formulės
Skirtumas tarp koreguotų verčių ir nekoreguotų verčių matomas tik tada, jeigu sukurta standartinė
kreivė kaip tikralaikių PGR paleidimo dalis. Paklaidos sklaidai nustatyti programinė įranga taiko tris
lygtis:

n Standartinė paklaida

n Standartinė paklaida normalizuotai ekspresijai

n Standartinė paklaida tiriamam normalizuotam genui (tikslas)

Standartinės paklaidos formulė yra

Kur:

n n = etaloninių tikslų skaičius (genai)

n SD = standartinis nuokrypis

Normalizavimo koeficiento standartinė paklaida normalizuotos ekspresijos formulėje yra

Kur:

n n = etaloninių tikslų skaičius

n SE = standartinė paklaida

n NF = normalizavimo koeficientas

n RQ = santykinis kiekis

Tiriamo normalizuoto geno (GOI) standartinės paklaidos formulė yra

Kur:

n SE = standartinė paklaida

n GOI = tikslinis genas (vienas tikslas)

n NF = normalizavimo koeficientas

n n = etaloninių tikslų skaičius
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B priedas. CFX Manager Dx vartotojų ir
vaidmenų valdymas

„CFX Manager Dx“ programinėje įrangoje galite sukurti vartotojų ir jiems priskirti vaidmenis.
Vaidmenys riboja prieigą prie CFX Manager Dx funkcijų. Vartotojui vienu metu galima priskirti vieną
vaidmenį. Tačiau CFX Manager Dx programinės įrangos administratorius bet kuriuo metu gali pakeisti
vartotojo vaidmenį.

Patarimas. Nebūtina sukurti vartotojų, kad būtų galima naudotis CFX Manager Dx. Jeigu
nesukursite vartotojų, visa veikla atliekama per numatytojo vartotojo paskyrą „admin“.

Svarbu. Vartotojo administratorius yra numatytoji administratoriaus paskyra, kuri naudojama
pradžioje prisijungti prie CFX Manager Dx. Rekomenduojama sukurti konkretų vartotoją CFX
Manager Dx administruoti. Šiam vartotojui priskirkite administratoriaus vaidmenį ir su šiuo
vartotoju atlikite visas administravimo užduotis.

Svarbu. CFX Manager Dx programinė įranga neturi neaktyvumo skirtojo laiko funkcijos vartotojo
sesijoms. Todėl rekomenduojama naudoti „Windows“ arba trečiųjų šalių saugos priemones
(pavyzdžiui, nustatyti ekrano apsaugą su prisijungimo funkcija).

Vartotojų valdymas
Standartiniame CFX Manager Dx programinė įranga leidime vartotojo paskyra gali būti su vardu ir
slaptažodžiu.

Norėdami kiekvienam vartotojui priskirti vaidmenį, lange „User Administration“ (vartotojų
administravimas) pasirinkite iš vaidmenų sąrašo. Šiame pavyzdyje svečiui vartotojui suteikta teisė
įrašyti failus.

Vartotojų pridėjimas ir šalinimas
Pastaba. Pridėti ir pašalinti vartotojus gali tik CFX Manager Dx administratorius.

Kaip pridėti vartotojo paskyrą programoje CFX Manager Dx

1. Lange „Home“ (pagrindinis) pasirinkite „User > User Administration“ (vartotojas > vartotojų
administravimas).

Pasirodo dialogo langas „User Administration“ (vartotojų administravimas).
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2. Srityje „Manage Users“ (valdyti vartotojus) įrašykite vartotojo vardą.

3. Pasirinkite vartotojo „Role“ (vaidmuo).

Vaidmenys riboja vartotojo teises. Numatytasis vaidmuo – „Principal“ (pagrindinis).

Patarimas. Galite keisti kiekvieno vaidmens teises. Teisės pakeičiamos visiems
vartotojams, kuriems priskirta ši funkcija. Daugiau informacijos žr. Vaidmenų teisių
valdymas, p. 277.

4. (Neprivaloma) Įveskite vartotojo „Full Name“ (vardas, pavardė) ir „Password“ (slaptažodis).

5. Spustelėkite OK (gerai), kad atidarytumėte dialogo langą ir patvirtintumėte, kad norite uždaryti
langą.

6. Spustelėkite „Yes“ (taip), kad uždarytumėte dialogo langą ir langą.

Kaip pašalinti vartotoją

1. Srityje „Manage Users“ (valdyti vartotojus) pasirinkite „Remove“ (šalinti) prie kiekvieno vartotojo,
kurį norite pašalinti.

2. Spustelėkite OK (gerai), kad atidarytumėte dialogo langą ir patvirtintumėte, kad norite uždaryti
langą.

3. Spustelėkite „Yes“ (taip), kad uždarytumėte dialogo langą ir programos langą.

Pastaba. Programinės įrangos vartotojų sąraše visada turi būti vienas administratorius.
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Vartotojų valdymas

Vaidmenų teisių valdymas
CFX Manager Dx numatyti šie keturi vaidmenys:

n Administratorius (privalomas) – administratoriai turi visas teises ir jūs negalite šių teisių pakeisti.
Administratoriai taip pat gali pridėti ir pašalinti vartotojus ir keisti kiekvienam vaidmeniui priskirtas
teises.

Pastaba. Keisti bet kuriam vaidmeniui priskirtas teises gali tik administratorius.

n Pagrindinis – pagal numatytąsias nuostatas pagrindinis vartotojas turi visas teises

n Operatorius – pagal numatytąsias nuostatas vartotojas, kuris yra operatorius, turi visas teises,
išskyrus ciklų praleidimo

n Svečias – pagal numatytąsias nuostatas vartotojas, kuris yra svečias, gali tik skaityti failus

Svarbu. Vaidmeniui numatytų teisių pakeitimas taikomas visiems vartotojams, kuriems priskirtas
tas vaidmuo. Jūs negalite pritaikyti vaidmens konkrečiam vartotojui. Keisdami vaidmenims
priskirtas teises, būkite atidūs.

Teisių kiekvienam vaidmeniui nustatymas

1. Lange „Home“ (pagrindinis) pasirinkite „User > User Administration“ (vartotojas > vartotojų
administravimas).

2. Srityje „Manage Rights“ (teisių valdymas) atlikite vieną iš toliau nurodytų veiksmų:

n Jei norite pašalinti vaidmeniui priskirtą teisę, panaikinkite jos žymės langelio žymėjimą.

n Jei norite pridėti vaidmeniui teisę, pažymėkite jos žymės langelį.

3. Spustelėkite OK (gerai), kad atidarytumėte dialogo langą ir patvirtintumėte, kad norite uždaryti
langą.

4. Spustelėkite „Yes“ (taip), kad uždarytumėte dialogo langą ir programos langą.

Visų teisių visiems vaidmenims atkūrimas

u Dialogo lange „User Administration“ (vartotojų administravimas) spustelėkite „Restore Default
Rights“ (numatytųjų teisių atkūrimas).
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Prisijungimas prie CFX Manager Dx programinės įrangos
CFX Manager Dx programinė įranga reguliuoja, kas prisijungia prie programinės įrangos, dialogo
lange „Login“ (prisijungimas). Kai paleidžiate programinę įrangą, „CFX Manager Dx“ automatiškai
parodo dialogo langą „Login“ (prisijungimas), kai lange „User Administration“ (vartotojų
administravimas) pateikti du ar keli vartotojai.

Lango „Home“ (pagrindinis) viršuje CFX Manager Dx rodo prisijungusio vartotojo vardą.

Kaip prisijungti prie CFX Manager Dx

1. Dialogo lango „Login“ (prisijungimas) išplečiamajame sąraše „User Name“ (vartotojo vardas)
pasirinkite savo vardą.

2. Įrašykite savo slaptažodį.

3. Spustelėkite OK (gerai) ir užverkite prisijungimo dialogo langą ir atverkite programinę įrangą.

Vartotojų keitimas
Vartotojus galite keisti veikiant programinei įrangai.

Vartotojų perjungimas

1. Lange „Home“ (pagrindinis) pasirinkite „User > Select User“ (vartotojas > pasirinkti vartotoją) ir
atverkite dialogo langą „Login“ (prisijungimas).

2. Išplečiamajame sąraše „User Name“ (vartotojo vardas) pasirinkite vardą.

3. Įrašykite naujo vartotojo slaptažodį.

4. Spustelėkite OK (gerai), užverkite dialogo langą „Login“ (prisijungimas) ir atverkite programinę
įrangą.
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Vartotojų slaptažodžių keitimas
CFX Manager Dx vartotojai gali bet kada pakeisti savo slaptažodį.

Kaip pakeisti vartotojų slaptažodžius

1. Lange „Home“ (pagrindinis) pasirinkite „User > Change Password“ (vartotojas > keisti slaptažodį)
ir atverkite dialogo langą „Change Password“ (slaptažodžio keitimas).

2. Laukelyje „Old Password“ (senas slaptažodis) įveskite dabartinį slaptažodį.

3. Laukelyje „New Password“ (naujas slaptažodis) įveskite naują slaptažodį ir pakartokite jį laukelyje
„Confirm New Password“ (patvirtinti naują slaptažodį).

4. Spustelėkite OK (gerai), kad patvirtintumėte pakeitimą.

Jūsų vaidmens ir teisių peržiūrėjimas
Patarimas. Vartotojai, kuriems priskirti „Principal“ (pagrindinis), „Operator“ (operatorius) arba
„Guest“ (svečias) vartotojo vaidmenys, gali peržiūrėti tik savo vartotojo nuostatas, teises ir
vaidmenis.

Esamų vartotojo vaidmenų ir teisių peržiūrėjimas

u Lange „Home“ (pagrindinis) pasirinkite „User > User Administration“ (vartotojas > vartotojų
administravimas).

Kreipkitės į savo „CFX Manager Dx“ administratorių ir pakeiskite vartotojo nuostatas, teises ir
vaidmenis, išvardytus lange „User Administration“ (vartotojų administravimas).
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C priedas. LIMS integravimas
Jūs galite konfigūruoti „CFX Manager Dx“ programinę įrangą naudoti su laboratorijos informacijos
valdymo sistema (LIMS). Tam, kad galėtų būti integruota LIMS, CFX Manager Dx reikalauja, kad būtų
LIMS platformos generuota plokštelės sąrankos informacija (LIMS failas, *.plrn), protokolo failas,
sukurtas naudojant „CFX Manager Dx programinė įranga“ (*.prcl), apibrėžta duomenų eksportavimo
vieta ir eksportavimo formatas.

Pasibaigus paleidimui, CFX Manager Dx sukuria duomenų failą (.pcrd) ir įrašo jį numatytoje vietoje
duomenų eksportavimo aplanke. „CFX Manager Dx“ taip pat gali sukurti su LIMS suderinamą
duomenų failą .csv formatu ir įrašyti jį toje pačioje vietoje.

Su LIMS suderinamų duomenų failų kūrimas
Šiame priede paaiškinama, kaip nustatyti programinę įrangą „CFX Manager Dx“, kad būtų galima
kurti, įrašyti ir eksportuoti su LIMS suderinamus duomenų failus.

LIMS aplanko ir duomenų eksporto parinkčių nustatymas
Pagal numatytąsias nuostatas CFX Manager Dx LIMS protokolus, failus ir duomenų eksportavimo
failus įrašo šiame aplanke:
_ C:\Users\Public\Documents\Bio-Rad\CFX_Dx\LIMS

Galite sukonfigūruoti CFX Manager Dx ir failus įrašyti kitame aplanke, taip pat galite pakeisti LIMS
duomenų eksporto parinktis.

Kaip nustatyti LIMS aplanko ir duomenų eksporto parinktis

1. Lange „Home“ (pagrindinis) pasirinkite „Tools > Options“ (įrankiai > parinktys).

2. Dialogo lange „Options“ (parinktys) pasirinkite „Data Export Settings“ (duomenų eksportavimo
nuostatos).
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3. (Neprivaloma) Pasirinkite „Automatically export LIMS data at end of run“ (automatiškai
eksportuoti LIMS duomenis paleidimo pabaigoje).

Programinė įranga automatiškai eksportuos LIMS duomenis po kiekvieno paleidimo ir juos įrašys
nurodytoje vietoje.

4. Norėdami pakeisti numatytąsias LIMS duomenų eksporto parinktis, spustelėkite „LIMS Data
Export Settings“ (LIMS duomenų eksporto nuostatos).

Svarbu. Atgal į CFX Manager Dx LIMS duomenis galima eksportuoti tik kaip .csv failą.

5. Dialogo lange „LIMS Data Export Format Settings“ (LIMS duomenų eksporto formato nuostatos)
pasirinkite reikiamas eksporto parinktis ir spustelėkite OK (gerai).

6. Dialogo lange „Options“ (parinktys) raskite ir pasirinkite numatytąjį aplanką, kuriame norite įrašyti
LIMS duomenų failus. Kiekvienam failų tipui galite pasirinkti skirtingą vietą:

n Protokolas

n LIMS failas

n Duomenų eksportas

7. Spustelėkite OK (gerai), įrašykite pakeitimus ir uždarykite dialogo langą „Options“ (parinktys).

LIMS protokolo kūrimas
Tam, kad galėtumėte paleisti LIMS, sukurkite CFX Manager Dx protokolo failą (*.prcl) ir įrašykite jį
numatytoje vietoje LIMS protokolo aplanke.

Daugiau informacijos žr. 6 skyrius, Protokolų kūrimas.
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Su LIMS suderinamų duomenų failų kūrimas

LIMS failo kūrimas
LIMS faile (*.plrn) yra išsami informacija apie plokštelės sąranką ir protokolo failo pavadinimas. Failas
sukuriamas vidaus LIMS sistemoje. CFX Manager Dx naudojamas LIMS failas ir jo pagrindu kuriamas
plokštelės failas, skirtas naudoti su protokolo failu.

CFX Manager Dx pateikiami šabloniniai failai plokštelėms importuoti, kuriuos galite redaguoti, kad
būtų sukurti specialūs LIMS plokštės failai.

Patarimas. Šią užduotį atlieka LIMS specialistas.

Kaip sukurti LIMS failą

1. Lange „Home“ (pagrindinis) pasirinkite „View > Show > LIMS File Folder“ (peržiūrėti > rodyti >
LIMS failo aplankas).

2. Atidarykite aplanką „LIMS Templates“ (LIMS šablonai) ir pasirinkite .csv failą, kurį norite
importuoti į vidaus LIMS sistemą.

3. Naudodami LIMS, redaguokite šablono failą įvesdami reikalaujamus laukelius, nurodytus čia: 40
lentelė.

4. Įrašykite šabloną su failo pavadinimo plėtiniu .plrn LIMS failo aplanke.

Svarbu. CFX Manager Dx gali atidaryti tik .plrn failą. Norėdami paleisti LIMS, turite įrašyti
.csv failą kaip .plrn.
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Stulpelis Eilutė Aprašymas Turinys Tikslas

A 1 Plokštelės
antraštė

Neredaguoti Iš anksto
nustatytas

A, B, C 2 Laukelis /
duomenys /
nurodymas

Neredaguoti Iš anksto
nustatytas

B 3 Versija Neredaguoti Iš anksto
nustatytas

B 4 Plokštelės dydis Neredaguoti Iš anksto
nustatytas

B 5 Plokštelės tipas Įveskite „BR White“,
„BR Clear“ arba kitą
sukalibruotos plokštelės
tipą

Privaloma

B 6 Nuskaitymo
režimas

Įveskite „SYBR/FAM
Only:“ (tik SYBR/FAM:),
„All Channels“ (visi
kanalai) arba FRET

Privaloma

40 lentelė. LIMS .csv failo turinio apibrėžimas
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Su LIMS suderinamų duomenų failų kūrimas

Stulpelis Eilutė Aprašymas Turinys Tikslas

B 7 Matavimo vienetai Įveskite: „copy number“ 
(kopijos numeris), „fold
dilution“ (skiedimo
kartotinis),
„micromoles“ 
(mikromoliai),
„nanomoles“ 
(nanomoliai),
„picomoles“ 
(pikomoliai),
„femtomoles“ 
(femtomoliai),
„attomoles“ (atomoliai),
„milligrams“ 
(miligramai),
„micrograms“ 
(mikrogramai),
„nanograms“ 
(nanogramai),
„picograms“ 
(pikogramai),
„femtograms“ 
(femtogramai),
„attograms” (atogramai)
arba „percent“ 
(procentai)

Privaloma

B 8 Paleidimo ID Įveskite trumpą
aprašymą arba
brūkšninį kodą šiam
paleidimui identifikuoti
(daugiausia 30 ženklų;
neleidžiama naudoti
kablelių)

Neprivaloma

B 9 Paleidimo
pastaba

Įveskite paleidimo
aprašymą

Neprivaloma

40 lentelė. LIMS .csv failo turinio apibrėžimas (tęsinys)
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Stulpelis Eilutė Aprašymas Turinys Tikslas

B 10 Paleidimo
protokolas

Įveskite protokolo failo
pavadinimą tiksliai taip,
kaip nurodyta sąraše

Privaloma

A 11 Duomenų failas Įveskite duomenų failo
pavadinimą

Neprivaloma

A 12–15 Bus nuspręsta /
tuščia

Neredaguoti Iš anksto
nustatytas

A 16 Plokštelės
duomenys

Neredaguoti Iš anksto
nustatytas

A 17–113 Šulinėlio padėtis Neredaguoti Iš anksto
nustatytas

B–G Ch1 dažai, Ch2
dažai, Ch3 dažai,
Ch4 dažai, Ch5
dažai, FRET

Įveskite kiekvieno
naudojamo kanalo
vieną sukalibruotų dažų
pavadinimą
(pavyzdžiui, FAM)

Privaloma

H Mėginio tipas Įveskite vieną iš šių
mėginių tipų:
„Unknown“ 
(nežinomas),
„Standard“ 
(standartinis), „Positive
Control“ (teigiama
kontrolė), „Negative
Control“ (neigiama
kontrolė), NTC (jokios
šablono kontrolės) arba
NRT (jokios atvirkštinės
transkripcijos)

Privaloma

40 lentelė. LIMS .csv failo turinio apibrėžimas (tęsinys)
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Su LIMS suderinamų duomenų failų kūrimas

Stulpelis Eilutė Aprašymas Turinys Tikslas

I Mėginio
pavadinimas

Įveskite mėginio
pavadinimą

Neprivaloma

J–O CH1 tikslas, CH2
tikslas, CH3
tikslas, CH4
tikslas, CH5
tikslas, FRET
tikslas

Įveskite kiekvieno
naudoto kanalo tikslo
pavadinimą

Neprivaloma

P Biologinio rinkinio
pavadinimas

Įveskite biologinio
rinkinio pavadinimą

Neprivaloma

Q Kartotinis Įveskite kiekvieno
kartotinių rinkinio
teigiamą sveikąjį
skaičių. Reikšmė negali
būti nulis.

Neprivaloma

R–W CH1 kiekis, CH2
kiekis, CH3 kiekis,
CH4 kiekis, CH5
kiekis, FRET
kiekis

Įveskite bet kurių
standartų kiekių vertes.
Įveskite koncentraciją
dešimtaine forma.

Privaloma
visiems
standartams

X Šulinėlio pastaba Įveskite šulinėlio
pastabą (daugiausia 20
ženklų)

Neprivaloma

Y–AD Ch1 šulinėlio
spalva, Ch2
šulinėlio
spalva, Ch3
šulinėlio
spalva, Ch4
šulinėlio
spalva, Ch5
šulinėlio
spalva, FRET
šulinėlio
spalva

Įveskite vartotojo
nustatytą
pėdsako stiliaus
spalvą 32 bitų
sveikojo skaičiaus
(ARGB)
dešimtaine forma

Neprivaloma

40 lentelė. LIMS .csv failo turinio apibrėžimas (tęsinys)
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LIMS paleidimo pradžia
Kaip pradėti LIMS paleidimą

1. Atlikite šiuos veiksmus, kad atidarytumėte LIMS .plrn failą:

n Lange „Home“ (pagrindinis) pasirinkite „View > Show > LIMS File Folder“ (rodinys > rodyti >
LIMS failo aplankas) ir atidarykite tikslo .plrn failą.

n Lange „Home“ (pagrindinis) pasirinkite „File > Open > LIMS File“ (failas > atidaryti > LIMS
failas) ir atidarykite tikslo .plrn failą.

Failas atidaromas kortelėje „Start Run“ (paleidimo pradžia), esančioje „Run Setup“ (paleidimo
sąranka) vedlyje. Kortelėje „Start Run“ (paleidimo pradžia) rodoma informacija apie norimą
vykdyti eksperimentą. Joje taip pat rodomas prijungtas prietaisų blokas arba blokai, kuriuose
galite paleisti eksperimentą.

2. Kortelėje „Start Run“ (paleidimo pradžia) pasirinkite prietaisą ir spustelėkite „Start Run“ 
(paleidimo pradžia).
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Su LIMS suderinamų duomenų failų kūrimas

Duomenų eksportavimas į LIMS
Baigus paleidimą CFX Manager Dx generuoja duomenų (.pcrd) failą, jį įrašo į nurodytą duomenų
eksporto aplanko vietą.

Duomenų failo eksportavimas į LIMS

u Atverkite .pcrd failą ir pasirinkite „Export > Export to LIMS Folder“ (eksportuoti > eksportuoti į
LIMS aplanką).

Patarimas. Jeigu „LIMS Options“ (LIMS parinktys) pasirenkate „Automatically Export Data after
Run“ (automatiškai eksportuoti duomenis po paleidimo), „CFX Manager Dx“ sukuria su LIMS
suderinamą duomenų failą .csv formatu ir jį įrašo tame pačiame aplanke.
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D priedas. Trikčių šalinimas. Prisijungimo prie
CFX Manager Dx programinės įrangos
problemos

Programos žurnalas
Prieš naują paleidimą prietaisai CFX96 ir „CFX96 Deep Well“ inicijuoja savidiagnostikos testą, kad
būtų patikrinta, ar jie paleidžiami pagal specifikacijas. Programinė įranga įrašo šių testų rezultatus
„Run Log“ (paleidimo žurnalas) ir „Application Log“ (programos žurnalas) failuose. Jei vieno ar kelių
eksperimentų metu pastebėtumėte problemą, atidarykite paleidimo ir programos žurnalus, kad
sužinotumėte, kuriuo momentu prasidėjo problema.

„CFX Manager Dx“ stebi prietaiso būsenos informaciją žurnale „Application Log“ (programos
žurnalas). Naudokitės šiais žurnalais, kad stebėtumėte įvykius, susijusius su prietaisais ir programine
įranga, ir pašalintumėte triktis.
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Kaip atidaryti programos žurnalą

u Lange „Home“ (pagrindinis) pasirinkite „View > Application Log“ (peržiūrėti > programos
žurnalas).
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Trikčių šalinimas

Trikčių šalinimas
Paprastai programinės įrangos ir prietaisų ryšio problemas galima išspręsti iš naujo paleidus
kompiuterį ir sistemą. Prieš paleisdami kompiuterį iš naujo, būtinai įrašykite visus vykdomus darbus.

Pastaba. Patikrinkite, ar kompiuteryje yra pakankamai RAM atminties ir laisvos vietos diske. Turi
būti ne mažiau nei 4 GB RAM atminties ir 128 GB vietos standžiajame diske.

Nutrūkęs maitinimas
Nutrūkus maitinimui instrumentas ir kompiuteris išsijungs. Jeigu maitinimas nutrūksta trumpam,
instrumentas atnaujins protokolo paleidimą, tačiau programos žurnale bus pažymėta, kad maitinimas
nutrūko. Priklausomai nuo kompiuterio nuostatų ir maitinimo nutrūkimo trukmės, instrumentas ir
programinė įranga mėgins tęsti paleidimą, priklausomai nuo protokolo veiksmo:

n Jeigu atliekamas protokolo veiksmas be plokštelės nuskaitymo, protokolas tęsiamas, kai tik
atnaujinamas instrumento maitinimas.

n Jeigu atliekamas protokolo veiksmas su plokštelės nuskaitymu, instrumentas laukia, kol
programinė įranga bus paleista iš naujo ir atnaujins ryšį duomenims gauti. Tokiu atveju protokolas
tęsiamas tik tada, jeigu kompiuteris programinės įrangos neišjungė. Kai kompiuteris ir programinė
įranga vėl paleidžiami, protokolas tęsiamas.

Mėginių išėmimas iš reakcijos modulio nutrūkus maitinimui

Nutrūkus maitinimui galite atidaryti reakcijos modulio užrakintą motorizuotą dangtelį ir išimti savo
mėginius.

Kaip išimti fiksavimo plokštelę

1. Paspauskite fiksavimo juostą ir išimkite reakcijos modulį iš „C1000 Dx“ termociklerio.

2. Reakcijos modulį atsargiai padėkite ant stalo ar laboratorijos stalelio.
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3. Modulį padėkite taip, kad modulio priekis būtų išsikišęs 2 colius iš už krašto.

4. Šešiakampiu veržliarakčiu atsukite du didelius varžtus, esančius po reakcijos modulio priekiniu
kraštu (po dangtelio atidarymo mygtuku).

Turėtumėte modulio viduje išgirsti atsileidžiantį fiksavimo skląstį.

Svarbu. Neatsukite dviejų mažų varžtų modulio priekiniame krašte.

5. Paspauskite ir atidarykite reakcijos modulio dangtelį. Atkreipkite dėmesį, kad skląstis (tamsus,
plastikinis) nebeuždėtas. Iš bloko išimkite savo mėginius.
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6. Uždėkite fiksavimo skląstį ir jį fiksuokite dideliais varžtais, kad vėl surinktumėte reakcijos modulį
su atidarytu dangteliu.

Failų parsisiuntimas į CFX Manager Dx kompiuterį
Galite parsisiųsti instrumente esančius duomenis ir žurnalo failus ir juos perkelti į prijungto kompiuterio
standųjį diską.

Pastaba. Visi failai tikralaikių duomenų aplanke instrumento pagrindiniame bloke yra
parsiunčiami į kompiuterį.

Kaip parsisiųsti failus iš instrumento

1. Skyriuje „Detected Instruments“ (aptikti instrumentai), esančiame lange „Home“ (pagrindinis),
pelės dešiniuoju mygtuku spustelėkite tikslinį instrumentą ir pasirinkite vieną iš šių veiksmų:

n Parsisiųsti žurnalo failus

n Parsisiųsti duomenų failus

2. Pasirinkite aplanko vietą ir įrašykite parsisiųstus failus.

3. Spustelėkite „Okay“ (gerai).

CFX Manager Dx programinės įrangos įdiegimas rankiniu būdu
CFX Manager Dx programinė įranga įdiegimas rankiniu būdu

1. Jei reikia, atjunkite nuo kompiuterio visus prijungtus prietaisus.

Raskite ir atjunkite nuo CFX Manager Dx kompiuterio prietaiso USB kabelį. Prie prietaiso
prijungtas kabelio galas gali likti neatjungtas.

2. Prisijunkite prie CFX Manager Dx kompiuterio administratoriaus teisėmis.

3. Įdėkite programinės įrangos kompaktinį diską (CD).
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4. Naudodamiesi naršykle „Windows Explorer“, pasiekite CD, dukart spustelėkite CD piktogramą ir
pasirinkite „Explore“ (naršyti), kad būtų atvertas CD langas.

5. Dukart spustelėkite aplanką „CFX_Manager“, kad jį atvertumėte, o tada dukart spustelėkite
setup.exe, kad paleistumėte programinės įrangos diegimo vedlį.

6. Vadovaukitės vedlio nurodymais, kad įdiegtumėte programinę įrangą, o tada spustelėkite „Finish“ 
(baigti).

Tvarkyklių įdiegimas iš naujo
Kaip naujo įdiegti prietaiso tvarkykles

u Lange „Home“ (pagrindinis) pasirinkite „Tools > Reinstall Instrument Drivers“ (įrankiai > iš naujo
įdiegti prietaisų tvarkykles).

Pastaba. Iškilus programinės įrangos ryšio su sistema realiuoju laiku problemoms tada, kai buvo
iš naujo įdiegtos tvarkyklės kreipkitės (prieš tai patikrinę USB jungtį) „Bio-Rad“ techninės
pagalbos.
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„Minpack“ autoriaus teisių pranešimas, Čikagos universitetas, 1999. Visos teisės saugomos.

Leidžiama platinti ir naudoti pirminiu ir skaitmeniniu formatu, su pakeitimais arba be jų, jei laikomasi
šių sąlygų:

1. Platinant pirminį šaltinį turi būti pateiktas pirmiau nurodytas autoriaus teisių pranešimas, šis
sąlygų sąrašas ir šis atsakomybės apribojimas.

2. Platinant skaitmeniniu formatu turi būti pateiktas pirmiau nurodytas autoriaus teisių pranešimas,
šis sąlygų sąrašas ir šis atsakomybės apribojimas šiuose dokumentuose ir (arba) kitoje
platinamoje medžiagoje.

3. Galutinio vartotojo platinamuose dokumentuose, jeigu jie yra, turi būti šis pareiškimas:

„Šį produktą sudaro Čikagos universiteto, kaip „Argonne National Laboratory“ operatoriaus, sukurta
programinė įranga.“
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